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Welcome to PlanetPress Connect 2022.2

PlanetPress Connect is a series of tools designed to optimize and automate customer communications
management. They work together to improve the creation, distribution, interaction and maintenance of
your communications.

The PlanetPress Connect Datamapper and Designer are designed to create output for print, email
and the web within a single template and from any data type, including formatted print streams. Output
presets applied outside the design phase make templates printing device independent.

The Designer has an easy-to-use interface that makes it possible for almost anyone to create multi-
channel output. More advanced users may use native HTML, CSS and JavaScript.

PlanetPress Connect also includes a process automation server, called Workflow. It is capable of ser-
vicing response form web pages and email to provide interactive business communications. For the
user guide of Workflow, see Workflow's Online Help.

PlanetPress Connect can create documents for tablets and mobile devices that run a free Capture

OnTheGo App. Users with a Capture OnTheGo subscription can then download documents to their
own devices, interact with them and send the captured data back to PlanetPress for conversion into
additional documents or workflows.

For more information about the application refer to these websites: Capture OnTheGo and Capture
OnTheGo in the Resource Center.

This online documentation covers PlanetPress Connect version 2022.2.

Note: Since we are always looking for new ways to make your life easier, we welcome your ques-
tions and comments about our products and documentation. Shoot us an email at doc@ca.ob-

jectiflune.com.

Setup And Configuration

This chapter describes the PlanetPress Connect installation and the different considerations that are
important in regards to the installation and use of PlanetPress Connect.

e "System and Hardware Considerations" below
» "Installation and Activation" on page 27
* "Known Issues" on page 102
e "Server Configuration Settings" on page 82
e "Uninstalling" on page 112
System and Hardware Considerations

There are a variety of considerations to be aware of. These are documented in the following pages:
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e "System requirements" on page 25

+ "Database Considerations" on page 16

e "Environment considerations" on page 19

e "Known Issues" on page 102

» "Language and Encoding Considerations" on page 21

e "Antivirus Exclusions" below

« "Performance considerations" on page 23
Antivirus Exclusions

The information on this page is designed to assist IT managers and IT professionals decide what anti-
virus strategy to follow with consideration to PlanetPress and their internal requirements and needs.
This page describes the mode of operation and the files and folders used by PlanetPress as well as the
files, folders and executables that are recommended to be ignored for best possible performance and
to avoid issues caused by antivirus file locks.

IT managers and IT professionals then may decide the anti-virus strategy to follow for their internal
requirements and needs depending on the statements outlined herein.

Directories and folders

All Connect applications are installed under an arbitrarily selectable main folder. If the default install-
ation folder options were used, this installation folder would be $PROGRAMFILES%\Objectif Lun-
e\OL Connect.

The installation folder will hold all the executable files and other files and folders required for the oper-
ation of the whole product suite. All these files and folders remain static after installation. It depends
upon the company virus protection strategy, if such files and folders will be monitored or not.

We do, however, recommend that the following file or folders be excluded from antivirus protection.
Connect Service

The Connect Service is run via the executable file ServerService.exe. This file has been reported as
causing issues with some antivirus packages, so we recommend adding this file to the antivirus exclu-
sion list, if possible.

The executable will be installed to the installation target "Connect Server" sub-folder.The full install-

ation folder can be found by entering $PROGRAMFILES%\Objectif Lune\0L Connect\Connect
Server in Windows Explorer.
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AFP Input

Performance issues have been reported with the AFP Input option under Windows Server versions
from Windows Server 2012 onwards. The issues have been specifically associated with Windows Serv-
ers running Windows Defender, but the performance degradation might also be encountered when
using other Antivirus applications.

Consequently, we recommend that an exclusion be made for the afp2pdf.exe executable file in your
Antivirus application.

The afp2pdf.exe file is stored in a subfolder under the installation folder. If the exact installation folder
name is required, enter the standardized system variable $PROGRAMFILESS in Windows Explorer and
then search for afp2pdf.exe.

Working folders

Working folders for Connect are created and used on a per-user-basis under the respective user's pro-
file folder, accessible on Windows with the standardized system variable $USERPROFILE% in the sub-
folder "Connect". Working folders are:

e SUSERPROFILE%\Connect\filestore: This folder will hold non-intermediate files for the
operation of Connect. Files in this folder will be used frequently, but not with a high frequency.
Supervising this folder with a virus protection system should not have too much of an impact on
the speed of the whole Connect suite.

e SUSERPROFILE%\Connect\logs: As the name implies, log files are created and updated here.
These log files are plain text files. Virus protection may have an impact on the speed of the whole
Connect suite.

e SUSERPROFILE%\Connect\temp: Storage folder for temporary data, usually intermittent files
in multiple folders. Virus protection on this folder and its subfolders may have a serious impact on
the performance of Connect.

* SUSERPROFILE%\Connect\workspace: Usually containing settings and helper files and
folders. Supervising this folder with a virus protection system should not have too much of an
impact on the speed of the whole Connect suite.

Database 1

Depending on the components installed, a database instance is created in a folder called "con-
nect.database" under the Windows system temp folder. This folder is accessible via the standardized
system variable $TMP%. Usually, folders holding such temporary files and folders should be excluded
from a virus protection, because this influences the overall performance of the whole system at all.
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However the responsible person for the computer protection has to decide about the monitoring of such
temporary folders following the company guidelines.

Database 2

Another database instance for Connect will be hold and used under the folder, which is intended to hold
data, accessible by and for all users. The path to this folder is stored in the standardized system vari-
able $PROGRAMDATA%. The Connect database instance is located in the subfolder "Objectif Lune\OL
Connect\MariaDB".

As this database will be in extremely strong usage, virus protection on this folder and its sub-folders
may have a serious impact on the performance of Connect.

Database Considerations

This page describes the different considerations and pre-requisites for the database back-end used by
PlanetPress Connect, whether using the MariaDB instance provided by the installer, or pre-existing
(external) instance.

Using the MariaDB Instance from the Installer

The MariaDB Instance provided in the "Installation Wizard" on page 32 is already pre-configured with
options to provide the most stable back-end setup.

Installing Connect using an existing MySQL instance

If MySQL Server is already present and you wish to use it, the following should be taken into con-
sideration:
e The minimum supported MySQL version is MySQL 5.6.

» The MySQL account must have access to all permissions using the GRANT Command, including
creating databases.

» The database configuration must include the following options:

* max_connections = 200 : PlanetPress Connect uses a /ot of database connections. This
number ensures that even in high volume environments, enough connections will be avail-
able.

» max_allowed_packet = 500M : In some implementations, especially when using Capture
OnTheGo, large packet sizes are required to allow transferring binary files. This substantial
packet size maximum setting ensures that the data received by PlanetPress Connect will
be able to be stored within the database.
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+ character-set-server = utf8 , collation-server = utf8_unicode_ci, default-character-
set=utf8 : These indicate database support for UTF-8/Unicode.

e The database configuration must allow the use of mixed case table names.
This is particularly an issue on Linux MySQL installations.

e The SQL instance must be open to access from other computers. This means the bind-address
option should not be setto 127.0.0.1 or localhost.

Caution: If you chose not to install the supplied MariaDB database, and instead opt for using a
pre-existing (External) database then you yourself must ensure that the External database is

accessible to Connect.

Upland Obijectif Lune will take no responsibility for setting up database connections to any but the
supplied MariaDB database.

See "Database Considerations" on the previous page for more information about setting up
external databases.

Options available within the installer:

» The Configuration page for the local MySQL is displayed.

o MySAQL settings are pre-filled with default values if no existing MySQL database configuration is
found.

» MySAQL settings are pre-filled with existing database configuration settings, if they point to a
MySQL database type.

Installing Connect using an existing Microsoft SQL Server instance

If Microsoft SQL Server is already present and you wish to use it, the following should be taken into con-
sideration:

Caution: If you chose not to install the supplied MariaDB database, and instead opt for using a
pre-existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Upland Obijectif Lune will take no responsibility for setting up database connections to any but the
supplied MariaDB database.

See "Database Considerations" on the previous page for more information about setting up
external databases.
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Note: Since PlanetPress Connect version 1.6 the minimum required version of the MS SQL
Server is SQL Server 2012.

« When MS SQL is selected, the default values for root user are sa and 1433 for the port.

 If database settings from a previous OL Connect installation are found, the pre-exising settings
will be displayed for the matching database type. For MS SQL settings, this will only work if they
were created with Server Config Tool 1.5.0 or later, or the Installer for OL Connect 1.6.0 or later.
If the database type is changed in the Installer configuration page, the default values for this data-
base type will be displayed.
If the pre-existing database settings are set to Hsqldb, the default database type selection will be
MySQL.

» Selected database settings are stored in the preferences, and can be found in this file:
C:\ProgramData\Objectif Lune\OL Con-
nect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.prefs

When modifying Connect

 Ifthe local MariaDB is removed from an installation, the Database Configuration page will offer
additionally the Microsoft SQL Server database type with respective default values.

» Iflocal MariaDB is added to an installation, the usual MariaDB Configuration page with default
values will be displayed.

If the user has installed the Installer Supplied MySQL (2021.2 or earlier) or MariaDB (2022.1 and later)
and then switches to an external Microsoft SQL by using the Server Configuration Tool, the supplied
local database cannot be switched off. By design the installer adds a service dependency between Con-
nect Server and the supplied MariaDB \ MySQL service.

To remove this dependency the user needs to do the following

1. Have a foreign Microsoft SQL running, ready for use with Connect Server.

2. Use the Server Configuration Tool "Database Connection preferences" on page 787 to switch
the database to Microsoft SQL.

Re-start the Connect Server Service, so that the modifications become active.
Counter check that everything is working properly with Microsoft SQL.

Open a command-line prompt with full administration rights.

o g &~ »

Enter the command sc config OLConnect Server depend= /. This removes the depend-
ency.
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Please be aware: The key word depend must be followed immediately by the equal sign, but
between the equal sign and the forward slash there must be a space.

Additional information can be found here: htip://serverfault.com/questions/24821.

7. After the dependency has been removed, it is possible to stop the supplied MariaDB \ MySQL ser-
vice (OLConnect_MySQL).

Environment considerations

Terminal Server/Service Support

PlanetPress Connect does not support Terminal Server (or Terminal Service) environment as possible
under Windows 2000, 2003 and 2008. This is to say, if Terminal Service is installed on the server where
PlanetPress Connect is located, unexpected behaviours may occur and will not be supported by
Upland Objectif Lune. Furthermore, using PlanetPress Connect in a Terminal Service environment is
an infringement of our End-User License Agreement.

Virtual Machine Support
PlanetPress Connect supports the following virtual environments:
 VMWare Environments. This includes VMWare Player, VMWare Workstation as well as VMWare
ESX Server.

* VMWare VMotion. This means the virtual machine hosting PlanetPress Connect can be auto-
matically moved from one ESX server to another in a clustered installation.
Note that if all servers in a VMotion cluster are not strictly identical, you will have to provide the
Objectif Lune Activations team with all possible magic numbers so they can generate a license
that works on all servers. Obtaining the magic numbers is simply a question of manually moving
the VM on which Connect is installed to each server, and recording the magic number for each of
them.

* Microsoft Hyper-V/Azure infrastructure environments.

PlanetPress Connect is not officially supported on any other virtual machines such as Virtual PC, Par-
allels, Bochs, Xen, etc.

Caution: Copying (duplicating) a Virtual Machine with Connect installed and using both images
simultaneously constitutes an infringement of our End-User License Agreement.

Note: While some virtual machine environments (from VMWare and Microsoft) are supported,
other virtual environments (such as Parallels, Xen and others) are not supported at this time.
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Remote Desktop Support

Tests have demonstrated that PlanetPress Connect can be used through Remote Desktop. It is how-
ever possible that certain combination of OS could cause issues. If problems are encountered, please
contact OL Support and we will investigate.

PlanetPress Connect 1.3 and later have been certified under Remote Desktop.

32-bit or 64-bit Operating Systems?

PlanetPress Connect is a 64-bit software and can only be installed on 64-bit operating systems.
Antivirus Considerations

» Antivirus software may slow down processing or cause issues if they are scanning in temporary
folders or those used by PlanetPress Connect. Please see "Antivirus Exclusions" on page 14 for
more information.

» Antivirus software might interfere with installation scripts, notably a VBS script to install fonts.
McAfee, in particular, should be disabled temporarily during installation in order for MICR fonts to
install and the installation to complete successfully.

Windows Search Indexing Service

Tests have concluded that the Windows Search service, used to provide indexing for Windows Search,
can interfere with Connect when installing on a virtual machine. If the installation hangs during the last
steps, it is necessary to completely disable this service during installation.

» Click on Start, Run.

» Typein services.msc and click OK.

e Locate the Windows Search service and double-click on it.

« Change the Startup Type to Disable, and click Stop to stop the service.
e Try the installation again.

* Once complete, you may re-enable the service and start it.

Commandline switches and .ini entries

PlanetPress Connect is intended to work stably and reliably, based on Java and the Eclipse framework.
To ensure this reliability and robustness, many Java and Eclipse parameters have been tested and
tuned, which is reflected in the respective .ini entries and the used command line switches. A collection
of valuable settings has been elaborated and found its entry in PlanetPress Connect “good switches
list” (called the “whitelist”).

The protection of the end user’s system is one of our main goals and therefore we have implemented a
very strict verification mechanism, which ensures, that only these whitelisted ini entries and command-
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line switches are accepted, when one of Connect components is started and run. Please be therefore
advised, that any non-whitelisted ini entry or command-line switch will be accepted and will - if tried to

be used - lead to the respective application’s “sudden death”. If you should encounter such a behaviour
then please double-check your Connect log file/s for respective entries.

Language and Encoding Considerations
Please note the following considerations:
e Language:

PlanetPress Connect is currently offered in several languages. You can switch between these
languages via the Preferences dialog. The current languages include:

e English
e French
* German
e Spanish
« [talian
¢ Korean
» Portuguese
* Chinese (Simplified)
¢ Chinese (Traditional)
e Japanese.
The default language is English.

The PlanetPress Connect help system (this document and the online help) is currently only avail-
able in English and (for the biggest part) in French.

¢ Encoding:

Issues can sometimes be encountered in menus and templates when running PlanetPress Con-
nect on a non-English operating system. These are due to encoding issues and will be addressed
in a later release.

Network Considerations

The following should be taken into consideration in regards to network settings and communications

» Ifalocal proxy is configured (in the Internet Explorer Options dialog), the option Bypass proxy
server for local addresses must be checked, or some features depending on local com-
munication will not work.
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Firewall/Port considerations

The following describes all of the ports that can be used by an OL Connect solution. IT staff may decide
the firewall strategy to follow for their internal requirements and needs depending on the statements
outlined herein.

Listens on
port # #

Destination port

Type Comment

Messenger 5863/5864 5863/5864 TCP+UDP Used for inter-module communication
Connect Server 9340 TCP Used for Connect REST API
HTTP Server 8080 TCP

HTTPS Server 443 TCP

NodeJS Server 9090 TCP

NodeJS HTTPS Server 8443 TCP

SMTP Input plugin Eznj’; 2:::;" Sl TCP

Email Input plugin 110 TCP Default POP3 port

Secure Email Input plugin 993 TCP

Send Email plugin 25 TCP Default SMTP port

Secure Email Output plugin 587 TCP

LPR 515 TCP

LPD 515 TCP

Telnet 9100 TCP

FTP Input/Output 21 TCP

MariaDB/MySQL 3306 TCP+UDP

Microsoft SQL Server 1433 TCP+UDP

HyperSQL 9001 TCP

e Port numbers in bold type are user configurable.

e Port numbers in bold underlined type are based on the type of database used.

+ Some of the ports listed above may also be used by other modules.

» User-configurable modules may use other ports entirely, depending on the settings defined by
the end user. A few examples:
The Create Email Content plugin will use the port defined in the Mail host setting in Workflow's
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OL Connect Preferences.
The ports used by the HTTP Client Input task, Legacy SOAP Client and SOAP Client plugin
depend on the configured URL.

Performance considerations

In order to get the most out of PlanetPress Connect, it is important to determine how best to maximize
performance. The following guidelines will be helpful in extracting the best performance from Plan-
etPress Connect and they give a rough indication when it would be useful to start looking into hardware
upgrades or extra PlanetPress Connect Performance Packs.

Performance analysis details

Connect's output speed is limited to a certain number of output items (web pages, emails, or printed
pages) per minute. What the maximum total output speed will be is determined by your licence and
any additional Performance Packs you might have (see "Speed quota: Pages Per Minute" on page 88).

To get an indication of the actual Print output speed, output a Print template to a PDF or PS file, using
one single Weaver engine and the maximum target speed per job (see "Parallel Processing pref-
erences" on page 95).

Next, open the log file of the Weaver engine. By default, the log files are located in this folder:
C:\Users\ [username] \Connect\logs\WeaverEngine, where [username] is your own Win-
dows user name.

Search the log file for "PPM" (pages per minute). Repeat this a few times to determine the average out-
put speed.

Likewise, the output speed for an Email or Web template can be found by running it with one Merge
engine and the maximum target speed per job. In the Merge engine's log file, search for "PPM".

If your jobs are not running at the licensed speed, there may be several ways to improve performance,
as described below. Make sure to address all issues mentioned in this topic before deciding that you
need to invest. Note however that it is not guaranteed that the licensed speed can be achieved with any
job. Creating output for templates with very complex scripts or complex graphics resources will take a
certain amount of time, even on high-end hardware.

Improving performance beyond what can possibly be reached by using the methods described below
requires purchasing either a Performance Pack (see Performance Packs) or upgrading to PReS Con-

nect.

For advice please contact your local sales office (see Objectif Lune's Contact page).

Engine configuration

As explained in another topic ("Connect: a peek under the hood" on page 114) the Connect Server
cooperates with different engines to handle specific tasks.
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A DataMapper engine extracts data from a data file. A Merge engine merges the template and the
data to create Email and Web output, or to create an intermediary file for Printed output. The inter-
mediary file is in turn used by a Weaver engine to prepare the Print output.

Configuring these engines to match both the hardware configuration and the typical usage situation is
probably the most effective way to improve Connect's performance.

The number of engines is one of the "Parallel Processing Preferences" that let the Connect Server man-
age its workload in such a way that the highest possible output speed is achieved.

For an explanation and guidelines to these settings, see "Engine configuration" on page 87 and "Par-
allel Processing preferences" on page 95.

Note: Connect Server and Connect Designer each have their own distinct scheduling pref-
erences.

Use the Connect Server Configuration tool to change the Connect Server settings and
Designer > Windows >Preferences for changing Designer settings.

Template optimization

When you find that the speed per Merge engine - the Content Creation speed - is low, optimizing a tem-
plate can make a huge difference. For advice on how to optimize a template see: "Optimizing a tem-
plate" on page 1351.

Network and internet connections

Use a fast network and internet connection or avoid loading external or internet resources. Using
images, JavaScript or CSS resources located on a slow network or on a slow internet connection will
obviously lead to a loss of speed. While we do our best for caching, a document with 5,000 records
which queries a page that takes 1 second to return a different image each time will, naturally, slow out-
put generation down by up to 83 minutes.

Hardware configuration

When processing speed is important, the following is suggested before looking into Performance Packs
to enhance performance (and after addressing the other issues mentioned in this topic).

» Antivirus exclusions. Sometimes, virus scanners, other security software or indexing services
can interfere. It can help to disable those kinds of tools for the areas where Connect stores inter-
mediate files. You could exclude the entire C: \Users\<connectuser>\Connect folder. See
also: "Antivirus Exclusions" on page 14.
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* Use a high-performance, low-latency hard drive. Connect benefits from fast I/0. This is espe-
cially true for DataMapper engines (see "DataMapper engine" on page 90). Preferably use a
Solid State Drive (SSD) or similar for storage.

» Use at least 8+ GB High-Quality RAM. Check memory usage while the Print command is being
executed to see if you need more than the minimum of 8 GB. Assuming that the Connect Server
and the Connect database need 1GB each, and that each engine needs 1GB as well, you can
roughly estimate how much memory is needed.

» Consider using a physical machine instead of a virtual machine. When running on a Virtual
Machine, the machine may report that it has sufficient hardware (cores) available, but in a virtual
environment you need to make sure that this hardware is not being shared with lots of other vir-
tual machines.

» Consider using hardware with more physical cores. PlanetPress Connect doesn't limit the num-
ber of Merge engines that is used for a Print job, so if the number of physical cores is low, it
makes sense to see if that can be increased. When running on a virtual machine, this is usually
easy. When running on a physical machine, it means that you may have to switch hardware.

« For both virtual and non-virtual environments, make sure the machine is not busy with all kinds of
other processes.

System requirements
These are the system requirements for PlanetPress Connect 2022.2
Operating system (64-bit only)

* Microsoft Windows 11

* Microsoft Windows 10 (Pro and Enterprise versions only)

* Microsoft Windows 8.1

* Microsoft Windows Server 2022

» Microsoft Windows Server 2019

* Microsoft Windows Server 2016

* Microsoft Windows Server 2012/2012 R2

Note: PlanetPress Connect 2022.2 is expected to run on some older operating systems, but just

as Microsoft no longer supports these older operating systems, Upland Objectif Lune will not
provide support for Upland Objectif Lune products running on them.
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Virtual Environments

 VMWare/VSphere
* Hyper-V (8.0)
e Azure

« Amazon Web Services (AWS). Note that only EC2 M4 was certified, other instances may not
work as expected.

Minimum hardware requirements

As with any software application, minimum hardware requirements represent the most basic hardware
on which the software will run. Note however that settling for the minimum specification is unlikely to
produce the performance you expect from the system. It can be used when configuring a trial or a devel-
opment system, however.

» File system: NTFS (FAT32 is not supported)
e CPU: multi-core
« RAM: 6GB

» Disk Space: 4GB for the software modules, 5GB for work files*

* This depends on the amount of data you process through OL Connect. For instance, a PostScript file
containing several thousands of documents could easily take up several GBs.

Recommended hardware requirements

Due to its versatility, OL Connect is used for a wide variety of applications. Consequently, it is difficult to
determine which hardware configuration will produce the best results for any given implementation.
The following specs should therefore be viewed as a general guideline that is most likely to produce
expected results for most implementations. You should, however, keep in mind that it may not rep-
resent the optimal setup for your particular application.

For more information and tips about performance considerations, see "Performance considerations" on
page 23.

» File system: NTFS (FAT32 is not supported)

» CPU: Intel Core i7-4770 Haswell or better

« RAM: 16GB

« Disk Space: 4GB for the software modules, 20GB for work files*'
» Storage Type: Solid State Drive (SSD)

» Networking: 10Gb Ethernet
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*1 This requirement depends upon the amount of data you process through OL Connect. For instance,
a PostScript file containing several thousands of documents could easily take up several GBs.

Note: As with any JAVA application, the more RAM that is available, the faster PlanetPress Con-
nect will execute.

Requirements for individual Connect modules

OL Connect Products comprises multiple modules that can be operated separately on multiple PCs.
Each module has its own set of requirements that may differ from the other modules. While the hard-
ware requirements described above are relatively generic when installing all Connect modules on a

single server, they should not be interpreted literally for each individual module.

When installing on multiple PCs, keep the following rules of thumb in mind:
e The Connect Workflow module requires less RAM but fast hard drive access. It also benefits from
fast multi-core CPUs, in order to run processes in parallel.

» The Connect Server module requires more RAM and benefits from fast multi-core CPUs. Disk
access speed is less of a concern.

» The Connect Designer module requires more RAM and fast disk access to provide a responsive
user-experience.

» The back-end database (MariaDB by default) benefits from more RAM, speedy disk access and
fast networking as it will be solicited by all modules simultaneously.

Note: As with any JAVA application, the more RAM that is available, the faster PlanetPress Con-
nect will execute.

Editions of Connect Products

There are three editions of OL Connect. In order of their capabilities and speed, they are: PReS Con-
nect, PlanetPress Connect and PrintShop Mail Connect.

While all three editions share common modules, they are generally not used for the same purposes.
Technically speaking, their hardware requirements would therefore be the same but in practice, PReS
Connect is likely to require higher-end hardware while PrintShop Mail Connect will generally require
less power to achieve expected results.

Installation and Activation

This topic provides detailed information about the installation and activation of PlanetPress Connect
2022.2.
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Note: A PDF version of this guide is available for use in offline installations. Click here to down-

load it.
PlanetPress Connect 2022.2 is comprised of 2 different installers: one for the PlanetPress Connect soft-
ware and one for PlanetPress Workflow 2022.2.
Where to obtain the installers

The installers for PlanetPress Connect 2022.2 and PlanetPress Workflow 2022.2 can be obtained on
DVD or downloaded as follows:

« If you are a Customer, the installers can be downloaded from the Objectif Lune Web Activation

Manager (https://www.objectiflune.com/webactivationmanager/) or through the OL Update Man-
ager if it is activated.

 If you are a Reseller, the installers can be downloaded from the Objectif Lune Partner Portal site
(https://extranet.objectiflune.com/) or through the OL Update Manager if it is activated.

Installation - important information

For important information about the Installation, including requirements and best practices, please see
the following topics:

¢ "Installation prerequisites" on the next page
» "User accounts and security" on the next page
e "Migrating to a new workstation" on page 53
e "Upgrading from previous Connect versions" on page 61
Installation - "How to" guides
For information on how to conduct the installation itself, choose from the following topics:
» "Installation Wizard" on page 32
e "Running Connect installer in Silent Mode" on page 43
e "Installing PlanetPress Connect on Machines without Internet Access" on page 30
Activation

For information on licensing, please see "Activating a License" on page 50.
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Installation prerequisites
* Make sure your system meets the "System requirements" on page 25.

» PlanetPress Connect Version 2022.2 can be installed under a regular user account with Admin-
istrator privileges., see "User accounts and security" below.

» PlanetPress Connect must be installed on an NTFS file system.

» PlanetPress Connect requires Microsoft .NET Framework 4.5 already be installed on the target
system.

» Connect 2019.1 requires updated Connect License and/or Update Manager.
See "Upgrading from previous Connect versions" on page 61 for details.

¢ In order to use the automation features in Version 2022.2, PlanetPress Workflow 2022.2 will
need to be installed.
This can be installed on the same machine as an existing PlanetPress® Suite 7.x installation or
on a new computer.
For more information, please see "Information about PlanetPress Workflow" on page 59.

If Workflow installation finds that .NET 4.0 is not already installed, it will install that version as
part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then .NET 3.5
must also be installed. This will need to be installed manually, as .NET 3.5 is not included in the
Workflow setup.

User accounts and security

Windows user account

Connect requires local Windows Administrator rights when installing the software and activating the
software license. This is to allow read/write access to protected Windows folders and registry entries.

Once installed Connect requires only standard Windows user credentials to run.

The following links contain the details as to when and where Windows Administrator rights are required:

e Connect Installation: "Installation Wizard" on page 32

» Activating Connect: "Activating PlanetPress Connect" on page 52

Permissions for PlanetPress Connect Designer

PlanetPress Connect Designer does not require any special permissions to run besides that of a reg-
ular program.
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It does not require administrative rights and only needs permission to read/write in any folder where
templates or data mapping configurations are located .

If generating Print output, PlanetPress Connect Designer requires permission on the printer or printer
gueue to send files.

Permissions for PlanetPress Connect Server

The PlanetPress Connect Server module, used by the Automation module, requires some special per-
missions to run. These permissions are set during installation, in the Engine Configuration portion of
the "Installation Wizard" on page 32, but it can also be configured later by modifying permissions for the
service. To do this:

* In Windows, open the Control Panel, Administrative Tools, then Services (this may depend on
your operating system).

» Locate the service called Serverengine_UUID , where UUID is a series of characters that depend
on the machine where the software is installed.

* Right-click on the service and select Properties.

» In the Connection tab, define the account name and password that the service should use. This
can be a local account on the computer or an account on a Windows Domain. The account must
have administrative access on the machine. It should also correspond to the user account set up
in PlanetPress Worfklow.

OL Connect Server user accounts

By default, authentication is enabled on the Connect Server. During a new installation the OL Connect
Server's default authentication must be configured by specifying a user name and password. The
default username for new installations is olc-user.

More user accounts can be configured in the Server Configuration Tool (see "Security and Users Set-
tings" on page 85).

In any Connect Designer that uses a secured Connect Server, an authenticated user account must be
specified via the Designer's Preferences (see the "Connect Servers preferences" on page 804 sub-sec-
tion of the Designer Preferences dialog).

Note that prior to PlanetPress Connect version 2020.2, only one user account could be configured on a
Connect Server. The default username was ol-admin and the default password was secret.

Installing PlanetPress Connect on Machines without Internet Access

Installing PlanetPress Connect2022.2 in offline mode requires some extra steps. These are listed
below.
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Updating Connect

Updating to Connect 2019.1 from earlier Connect version
In order to update PlanetPress Connect to 2019.1 it is first necessary to update the Connect License.

For details on how to upgrade the Connect License offline see the Upgrading Connect on machines
with no internet access section in the document.

Initial Connect Installation

GoDaddy Root Certificate Authority needs to be installed
In order to install PlanetPress Connect it is necessary for the GoDaddy Root Certificate Authority to be

installed (G2 Certificate) on the host machine and for this to be verified online. When a machine hosting
the installation does not have access to the Internet, the installation will fail because the verification can-
not be performed. To solve this problem one must first ensure that all Windows updates have been
installed on the host machine. Once the Windows updates are confirmed as being up to date, then com-
plete the following steps:

1. Go to htips://certs.godaddy.com/repository and download the following two certificates to copy to
the offline machine:

» GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdroot-g2.crt
» GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps through the
subsequent wizard.

3. Now copy the PlanetPress Connect installer to the offline machine and start the installation as
normal

Windows certificate validation - Certificate Revocation List retrieval should be switched off

For your security Objectif Lune digitally signs all relevant files with our own name and certificate. The
integrity of these files is checked at various times by different, context related, methods. One of these
checks, done during the installation process, uses the Windows certificate validation check. .

The Windows certificate validation process not only checks the integrity of a file against its signature,
but also usually checks if the certificate itself is still valid. That check is done against the current Cer-
tificate Revocation List (CRL), which needs to be retrieved from the internet. However, if the machine in
question does not have internet access, the retrieval of the CRL must fail, which will lead to subsequent
validation issues.

To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to installing
Connect on machines without internet access. There is no security risk associated with this, as the
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CRLs would never be retrievable without internet access, anyway. Advantage of the switch will not only
be found during the installation and operation of Connect, but also in some speed improvements for
any application which use signed binaries.

To switch off CRL retrieval on the computer, complete the following steps:

1. Open the “Internet Options” via the Control Panel
2. Select the “Advanced” tab and scroll down to “Security” node.
3. Uncheck the entry “Check for publisher’s certificate revocation” under that node.
4. Click the OK button to close the dialog.
5. Re-start the computer.
Installation Wizard

Updating from Connect versions predating 2019.1
In order to update PlanetPress Connect to 2022.2 from Connect versions prior to 2019.1 it is first neces-

sary to update the Connect License.
For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on page 61

Starting the PlanetPress Connect installer
The PlanetPress Connect installer is supplied as an executable file.
Double click on the executable file and after a short pause the Setup Wizard will appear to guide

through the installation steps.

Note: PlanetPress Connect requires prior installation of Microsoft .NET Framework 4.5.
For a full list of other prerequisites, see "Installation prerequisites" on page 29.

Running the Installation with extra logging

The installer can be run with enhanced logging options, if needed.
To do so, run the PlanetPress_Connect_Setup_x64.exe from the command line with one of the fol-
lowing command line options:

e PlanetPress Connect Setup x64.exe --verbose

This adds extra debugging style logging to the installation process.
e PlanetPress Connect Setup x64.exe --trace

This adds full trace style logging to the installation process. The log file this produces will be very
large, as this option logs everything.
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Prerequisites Installation

The PlanetPress installer will check for prerequisite technologies as the first step in the installation pro-
cess. If this check finds some technologies are missing, it will install those technologies, before con-
tinuing with the installation.

Welcome screen

After any prerequisites are installed, the PlanetPress installer Welcome screen appears.
Click Next to continue with the PlanetPress installation.

If the installation is an upgrade over a pre-existing Connect installation, the installer will first uninstall
the earlier version.

If you would like to retain the usage information from that pre-existing Connect installation, do not
select the Remove User data checkbox option.

For information about exactly what data would be saved or deleted, please see "Pre-existing User
Data" on page 63.

License Agreement

The next page displays the End User License Agreement, which needs to be read and accepted before
clicking Next.

Component Selection

After clicking the Next button, the Component Selection page appears, in which the different com-
ponents of PlanetPress Connect can be selected for installation.

The options are:

» Base: The installation files required for any PlanetPress Connect Connect installation. This com-
ponentis not optional.

e Designer: The Designer module (see "The Designer" on page 412) can be installed standalone
(with no other installed modules) on as many machines as you like. It does not require a license
to run as a standalone designer tool . This allows any number of people to use the Designer for
creating jobs, but without production capabilities such as automation and commingling. The
Designer module is optional, but it is recommended that it always be installed.

* Messenger: The Messenger Service that allows connection between Designer and Plan-
etPress Connect Workflow. Recommended for all production installations.
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« Server: The Connect Server back-end that provides Connect production capabilities such as pro-
duction content creation (print output, HTML content for emails and web pages), automation,
commingling and picking. It is also referred to as the Connect Master Server in Connect clustered
environments.

+ MariaDB Server: A supplied MariaDB database used by PlanetPress Connect.

The database is used for referencing temporary Connect files and for sorting temporarily extrac-
ted data, and similar.

Note: When performing an upgrade installation, if the MariaDB version has not sig-
nificantly changed, then no attempt will be made to upgrade the database content.

If there is a significant MariaDB version change, the database content will be upgraded, so
that it will continue to work with the new MariaDB version.

A pre-existing MariaDB, MySQL or Microsoft SQL server (referred to as an external database, in
this documentation) could be used instead, for the same purposes. The external database could
reside on the same computer or on a separate server.

If you wish to make use of an external database, please make sure the MariaDB option is not
selected.

Caution: If you chose not to install the supplied MariaDB database, and instead opt for
using a pre-existing (External) database then you yourself must ensure that the External
database is accessible to Connect.

Upland Obijectif Lune will take no responsibility for setting up database connections to any
but the supplied MariaDB database.

See "Database Considerations" on page 16 for more information about setting up external
databases.

+ Destination folder: This is the location where Connect components are to be installed.
Use the Browse button to navigate to a folder other than the default, if required.

Note: The installation path cannot contain any non ASCII characters (such as Asian lan-
guage Unicode characters). Nor can it contain characters that Windows disallows in file-
names (such as '?', '>' or trailing spaces).

If an invalid character is entered, the Installation Path entry box will turn red and a descrip-
tion of the error will be displayed in the information area.
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The installer calculates how much disk space is required for installing the selected components, along
with how much space is available.

» Total Required Space : Displays the amount of disk space required for the selected com-
ponents.

» Space Remaining: Displays the amount of space available after installation on the drive cur-
rently in the Installation Path.

PlanetPress Connect Service Configuration

The Service Configuration page is for setting the Microsoft Windows Account that the Connect Ser-
vice component will use.

* Log on as: Defines the Windows user account and password that the Connect Server services
will use.

Note: The Windows user account must have access rights to all local and network
resources required for production, as well as Windows "Log on as a Service" rights.

The Windows user account selection entered here should be recorded for future use, as
the "Security and Users Settings" on page 85 dialog can only ever be executed through the
user account specified on this page.

* Account: The Windows user account that the service uses to login. If the machine is within
a domain, use the format domain\username.
This account must be an existing Windows profile with local Administrator rights.

» Password: The password associated with the selected user.

Use the eyeicon @ to toggle between displaying or masking the password entry.

The password is not validated for password strength, so any entry is acceptable.

» Validate Account button: Click to verify that the entered account and password com-
bination is correct and that the service is able to login.

Note: This button must be clicked and the user validated before the Next button
becomes available.

» Start service when installation is complete checkbox: Select this option to have the service
start upon installation completion (which is the default).
If unchecked, the Service will start upon machine reboot.
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PlanetPress Connect Server Connection

Set the Connect Server Connection internal username and password.

The options available are as follows:

e Port: Enter the port to use to communicate with the Connect Server.
By default the Connect Server controlled by the OLConnect_Server service communicates
through port 9340.

+ User: Enter the internal username for connection to the OL Connect Server.
The default username for new installations is olc-user.

» Password: The password associated with the selected user.

Use the eye icon @ to toggle between displaying or masking the password entry.

The password is not validated for password strength, so any entry is acceptable.

Note that prior to PlanetPress Connect version 2020.2, only one user account could be configured on a
Connect Server. The default username was ol-admin and the default password was secret.

Database Configuration

The Default Database Configuration page appears if the supplied MariaDB module was selected for
installation in the Product Selection screen. It defines the administrative root password for the MariaDB
server as well as which port it uses for communication.

The installer will automatically configure the Connect Server to use the supplied password and port.

» Port: The port on which MariaDB will expect requests to come though, and through which it itself
responds.
A check is run to confirm whether the specified TCP\IP Port Number is available on the local
machine. If it is already being used by another service (generally, an existing MySQL or MariaDB
installation), the number is highlighted in red and a warning message is displayed.

Note: The MariaDB database controlled by the OLConnect_MariaDB service com-
municates through port 3306 by default.

* Root password: Enter the password for the 'root', or administration account, for the
MariaDB server.
Use the eyeicon @ to toggle between displaying or masking the password entry.
We recommend that the password be at least 8 characters long and contain at least one of each
of the following, even though password selection strength is not enforced by the installer:
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» alower case character (a, b, c...)

e an upper case character (A, B, C ..))
e anumericdigit (1,2, 3...)

» apunctuation character (@, $, ~...)

For example: "This1s@K"

Note: When updating from an earlier Connect version, the appropriate MariaDB password
must be entered or the update will fail.

If the password is subsequently forgotten, then MariaDB must be uninstalled and its data-
base deleted from disk before attempting to reinstall.

+ Allow remote client access checkbox: Click to enable external access to the MariaDB server.
Note:
This option is required if MariaDB Server will need to be accessed from any other machine.

It will also be required if the MariaDB database is on a separate machine to this Plan-
etPress Connect installation.

Tip: This option may represent a security risk if the machine is open to the internet.

We heavily recommended that your firewall is set to block access to port 3306 from
external requests.

+ Username: Enter the MariaDB user name that will be associated with OL Connect.
The default username for new installations is olconnect.

» Password: The password associated with the selected user.

Use the eye icon ® to toggle between displaying or masking the password entry.

The password is not validated for password strength, so any entry is acceptable.
Configuring External Database Connection

The Database Connection page appears if the supplied MariaDB module was not selected for install-
ation. This page is for setting up the connection to an existing External database.

» System: Select the database type to use for thePlanetPress Connect Engine. Currently only Mari-
aDB, MySQL and Microsoft SQL Server are supported.
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¢ Host: Enter the IP Address or alias of the server where database resides.

+ Database Instance Name: Enter an existing Microsoft SQL Server's instance name.
This option only applies to existing Microsoft SQL Server instances, and not for MariaDB or
MySQL.

» Port: Enter the port on which the database server expects connections.
For MariaDB and MySQlL, this is 3306 by default.
For Microsoft SQL Server it is 1433 by default.

« Schema: Enter the name of the database into which the tables will be created.
The standard Connect schema name is "olconnect" by default.

» Username: Enter the user account of a user with database administrative rights. Administrative
rights are required since tables will need to be created/modified/dropped in the database.
If accessing a database on a different machine, the server must also be able to accept non-local
TCP connections and the user account must also be configured to accept remote connection.
For example, the "root" MySQL user entered as root@localhost is not allowed to connect from
any other machine than the one where MySQL is installed.

» Password: Enter the password for the above user account. For MySQL the appropriate pass-
word must be entered or the Connect installation will fail.

» Encrypt Connection checkbox: Check to enable encrypted connections to the external data-
base.

The secure connection to MySQL is for the "olconnect" schema.

Note: Itis not in the scope of the Connect installer to configure the MySQL database
Server to accept SSL connections. This must be done prior to the installation of Connect.

By default, the connection will not verify the server certificate (veri-
fyServerCertificate=false), which would allow connecting to a server using a self-signed
certificate. If such a certificate is required, then this setting can be changed after install-
ation within the "Database Connection preferences" on page 787 (which can be accessed
from either the "Server Configuration Settings" on page 82 tool, or the "Preferences" on
page 782 window).

» Test Connection button: Click to verify that the information provide into previous fields is valid
by connecting to the database.
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Note: This test does not check whether the remote user has READ and WRITE per-
missions to the tables under the objectiflune schema. It is solely a test of database con-
nectivity.

Ready to install

This page confirms and lists the installation selections made.

If components have been selected which have a shortcut associated with then (Designer, Server) then
you will presented with the option to Create desktop shortcuts. Select if you wish for desktop icons to
be created.

Click Install to start the installation itself. This process can take several minutes.
Installation Finished

This screen describes a summary of the components that have been installed.

» Configure update checks checkbox: This option is enabled by default. It causes the Product
Update Manager to run after the installation is complete. This allows configuring PlanetPress
Connect to regularly check for entitled updates.

Note: this checkbox may not be available in the event that an issue was encountered during the
installation.

When ready, click the Finish button to close the installation wizard, and initialize the Product Update
Manager, if it was selected.

The Product Update Manager

If the Configure Update Check option has been selected, a message will be displayed after clicking
“Finish” in the setup. The message details the information that needs to be sent back to Upland Obijectif
Lune in order to determine when/if the software needs updating.

Click “Yes” to install or open the Product Update Manager where the frequency with which the updates
can be checked and a proxy server (if required) can be specified.

Note: If the Product Update Manager was already installed by another Upland Objectif Lune
application, it will be updated to the latest version and will retain the settings previously specified.

Select the desired options and then click OK to query the server and obtain a list of any updates that
are available for your software.
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* Note that the Product Update Manager can also be called from the “Objectif Lune Update Man-
ager’ option in the Start menu.

» It can be uninstalled via Control Panel | Programs | Programs and Features.
Product Activation

After installation, it is necessary to activate the software. See "Activating a License" on page 50 for
more information.

Before activating the software, please wait 5 minutes for the database to initialize. If the software is
activated and the services rebooted too quickly, the database can become corrupted and require a re-
installation.

Pre-existing User Data

The following scenarios display what happens to pre-existing User Data in a Connect upgrade.

Note: In regards to the MySQL (Connect version 2021.2 and earlier) or MariaDB (Connect ver-
sion 2022.1 onwards) entries: these are only applicable if the OL Connect database component
was installed in a previous Connect installation.

Scenario 1: Upgrading from Connect 2021.2 or earlier with Remove User Data CHECKED

¢ |n all cases:

* Files and folders are removed from the user data folder C:\Users\<connectUser>\Connect ,
where <connectUser> is the user that installed OL Connect.

» Files and folders are removed from the following data folders:
* C:\ProgramData\Objectif Lune\OL Connect\.settings
e C:\ProgramData\Objectif Lune\OL Connect\CloudLicense
e C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs
» C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

» Files are removed from the root of the data folder C:\ProgramData\Objectif Lune\OL Con-
nect\.
If the folder is empty following this (i.e. no license or user folders were present) then the
C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

» License files as well as any content not listed above but found in the C:\Pro-
gramData\Objectif Lune\OL Connect\ folder remain untouched.

* Additional cases:
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1. If MySQL was previously installed as an OL Connect component AND the database con-
tains some user-defined schemas:

® The native OL Connect schema is removed from the MySQL database.

® The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are
keptintact, as user-defined schemas mean that the user did not have only the OL
Connect native schema content in their database.

® A message at the end of the upgrade will advise the user that some non-OL
schemas were found in the database, so the database files were not removed.

2. If MySQL was previously installed as an OL Connect component AND the database does
not contain any user-defined schemas:

® The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are
removed entirely.

Scenario 2: Upgrading from Connect 2021.2 or earlier with Remove User Data UNCHECKED

¢ |n all cases:

» The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is the user
that installed OL Connect) is retained, untouched.

» All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL Connect
remain untouched.

» If MySQL was previously installed as an OL Connect component:

¢ All schemas from the MySQL database are migrated to MariaDB, allowing the user to con-
tinue using their database content normally.
NOTE: This might take some time during the installation, depending upon the size of the
existing databases.

e The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are also
kept intact.

Scenario 3: Uninstalling Connect 2022.2 or above with Remove User Data CHECKED

¢ |n all cases:

* Files and folders are removed from the user data folder C:\Users\<connectUser>\Connect ,
where <connectUser> is the user that installed OL Connect.

» Files and folders are removed from the following data folders:
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e C:\ProgramData\Objectif Lune\OL Connect\.settings

* C:\ProgramData\Objectif Lune\OL Connect\CloudLicense

o C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs

e C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

» Files are removed from the root of the data folder C:\ProgramData\Objectif Lune\OL Con-
nect\.
If the folder is empty following this (i.e. no license or user folders were present) then the
C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

» License files as well as any content not listed above but found in the C:\Pro-
gramData\Objectif Lune\OL Connect\ folder remain untouched.

+ Additional cases:

1. If MariaDB was previously installed as an OL Connect component AND the database con-
tains some user-defined schemas:

® The native OL Connect schema is removed from the MariaDB database.

® The MariaDB database files (C:\ProgramData\Objectif Lune\OL Connect\MariaDB)
are kept intact, as user-defined schemas mean that the user did not have only the OL
Connect native schema content in their database.

® A message at the end of the upgrade will be displayed, stating some non-OL
schemas were found in the database, so the database files were not removed.

2. If MariaDB was previously installed as an OL Connect component AND the database does
not contain some user-defined schemas:

® The MariaDB database files (C:\ProgramData\Objectif Lune\OL Connect\MariaDB)
are removed entirely.

Scenario 4: Uninstalling Connect 2022.2 or above with Remove User Data UNCHECKED

¢ In all cases:

» The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is the user
that installed OL Connect) is retained, untouched.

» All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL Connect
remain untouched.

» If MariaDB was previously installed as an OL Connect component:

» All schemas from the MariaDB database are kept, allowing the user to use those database
files if they reinstall the software.
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Running Connect installer in Silent Mode

Updating from Connect versions predating 2019.1
In order to update PlanetPress Connect to 2022.2 from Connect versions prior to 2019.1 it is first neces-

sary to update the Connect License.
For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on page 61

General information

PlanetPress Connect can be installed from the command line in "silent mode" to allow for scenarios
such automated installations during company wide roll-outs, or to allow for unattended out-of-hours
updates. The trigger for the Connect Installer to run in silent mode is a text file with the fixed name
installProperties.ini located in the same folder as the PlanetPress Connect installation executable
file.

How to prepare the installProperties.ini file is detailed in the following sections.
Installation Properties file
The basic rules for the installProperties.ini file are:

¢ Comment Lines start with the semi-colon character ;'

Example: ; The options to configure an external database

» The properties are listed in Key = Value pair format.
Example: product.ServerExtension = false

* Quotes are used for path strings, but not for other string types
Example: path = "c:\Program Files\Objectif Lune\OL Connect"

» Property values are case insensitive
The installation settings fall into three distinct categories:
» "[Logging]" below for setting the installation logging options.

» "[Installation]" on the facing page for selecting what gets installed.

» "[Uninstall]" on page 47 handles properties related to product Uninstallation. These also impact
Maintenance mode.

[Logging]
This section handles Silent Installer logging options.

The logging Key pairs are as follows:

» verbose: Boolean (Default: false)
A basic log is always created by the installer, with or without the verbose option. The verbose
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option is more suitable for debugging purpose.

If set to true, then a verbose log file is created in the logging path specified in the INI file.
If no logging path is specified in the INI file, then the default one is used.

If set to false, standard logging is done.

« path: String (Default: $PROGRAMDATA%\Objectif Lunel\Installation Logs)
Sets the folder to which the installation log will be written.
Only the log folder should be specified here, not the log file name.

Note: The log file name's format is set automatically and uses the format Installer-YYYY-
MM-DD-####.#.#.1og, where:

* YYYY-MM-DD = The date the log was created

o H##H # # = The PlanetPress Connect version number

The file name for a maintenance installation begins with "Maintenance" rather than
"Installer"

Example:

; Logging properties

[Logging]

verbose = false

path = "c:\temp\Silent Install"

[Installation]

This section handles various installation parameters as well as product selection.

The logging Key pairs are as follows:

e product.<name>: Boolean (Default: false)
Each OL Connect product has its own entry, which can be set to true (to install) or false (to omit
from installation).
What products are available for installation is determined by which OL Connect branding is being
installed. The products for PlanetPress Connect branding are as follows:

e product.Designer
e product.Server

e product.MariaDB

* product.Messenger

o path: String (Default: $PROGRAMFILES%\Objectif Lune\OL Connect)
Sets the installation root folder for the PlanetPress Connect applications.
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* RegisterService.connectServer: Boolean (Default: true)
Register the Server services or not (such as in the case of a container).

» server.username: String (Default: the current user/domain installing the service)
Determines the domain and username to be used when configuring the Server service.

The username can use the following syntax formats:
e username

e domain\username
(Note: the backslash between the domain and user names needs to be escaped by another
backslash. For example: server.username = ourcompany\\pbrown01)

e username@domain

» server.password: String (Default: there is no default for this setting)
Password to use when registering the Server service.

» database.configure: Boolean (Default: true)
If set to "false", then the database configuration is skipped.

Note: If database configuration is skipped (database.configure = false), then none
of the database . xxx properties below are required, and these properties will be ignored,
even in they are included in the INI file.

» database.system: String, Optional (Default: there is no default for this setting)
Entry needs to be from one of the following options: mariadb, mysql, mssqlserver
Note: If product.MariaDB = true has been set:
¢ This setting becomes optional. Otherwise it is required.

e The value is required to be mariadb, if the value is to be provided.

e This setting is optional. Otherwise it is required.

* The value is required to be mariadb, if the value is to be provided.

« database.host: String, Optional (Default: there is no default for this setting)
If product.MariaDB = True has been set, this value is required to be setto 1ocalhost, if
provided.

» database.port: Numeric, Optional (Default: MariaDB's default port, 3306)
The database engine port.
The required entry depends upon the selection made in database.systemn.
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If product.MariaDB = True, then the port should be set to 3306.

» database.rootpassword: String (Default: there is no default for this setting)
Database root password.
There is no default value, and if this is left unspecified the installation will fail.

« database.username: String (Default: o1connect)
The username that PlanetPress Connect will use to connect to the database.

» database.password: String (Default: there is no default for this setting)
The password that PlanetPress Connect will use to connect to the database.
There is no default value, so if this is left unspecified, then the installation will fail.

» database.instance: String, Optional (Default: there is no default for this setting)
Only valid if database.system = mssglserver.

» database.schema: String (Default: there is no default for this setting)
Specifies the database schema to use. Required. (Optional if product .MariaDB = true)

» database.encryptedconnection: Boolean (Default: False)
Specifies the database schema to use.
(Optional ifif product .MariaDB = true)

» server.connection.configure: Boolean, Optional (Default: True)
If setto False, then the server connection configuration is skipped.

» server.connection.user: String (Default: olc-user)
The server connection username.

» server.connection.password: String (Default: there is no default for this setting)
The server password. Required if server.connection.configure = true.

» server.connection.port: Numeric (Default: 9340)
The server port number.

» desktopShortcuts: Boolean (Default: False)
Specifies whether desktop shortcuts are to be added or not.
This flag only takes effect if components were selected which have a shortcut associated with
then (Designer, Server). If no such were selected, then this flag will have no effect.

» Language: String, Optional (Default: en-US)
Sets the PlanetPress Connect application language settings.
Supported user locales (as language and country combination) are as follows:

¢ Chinese (PRC) - zh-CN
e Chinese (Taiwan) - zh-TW
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» English - en-US

* French-fr-FR

* German - de-DE

 [talian -it-1T

» Japanese - ja-JP

e Korean - ko-KR

» Portuguese (Brazil) - pt-BR
e Spanish - es-SP

Example:

; Installation settings
[Installation]

product.Designer = true
product.Server = true
product.PrintManager = true
product.ServerExtension = false
product.MariaDB = true
product.Messenger = true
RegisterService.connectServer = true
server.username = Administrator
server.password = ObjLune
server.connection.user = olc-user
server.connection.password = secret
database.rootpassword = @Admin2022
database.username = olconnect
database.password = @Admin2022
database.remoteaccess = true
desktopShortcuts = true

path = "c:\Program Files\Objectif Lune\OL Connect"
Language = fr-FR

[Uninstall]

This section handles properties related to Uninstallation, but also Maintenance mode installations.
These options have no effect at all if PlanetPress Connect is not present on the system.

The logging Key pairs are as follows:

* remove: Boolean (Default: False)
If the present version of the installer is already installed, this property defines the installer beha-
viour.
The installer will perform a Remove MSI action on OL Connectif remove = true, whilsta
Modify MSI action will be performed if remove = false.

Note: This option has no effect if the product is not installed on the current system
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Note: If the Remove action is taken, then the equivalent of an uninstall is done, while a
Modify action will change the components installed on the system based on the ones
defined in the INI file [Installation] section, allowing removal or addition of components in
the current installation.

» keepdata: Boolean (Default: True)
Allows the user to specify if they wish to keep or remove user data (located under
%PROGRAMDATA%\Objectif Lune\OL Connect when performing a product uninstall.

Example:

; Uninstallation/Repair properties
[Uninstall]

remove = true

keepdata = true

Properties file examples
Simple Connect installation example

Here is an example of a complete installProperties.ini file for a relatively simple PlanetPress Connect
installation.

; OL Connect silent installer properties

; Logging properties

[Logging]

verbose = false

path = "c:\ProgramData\Objectif Lune\Installation Logs"

H

Installation settings

[Installation]

product.Designer = true
product.Server = true
product.PrintManager = true
product.ServerExtension = false
product.MariaDB = true
product.Messenger = true
RegisterService.connectServer = true
server.username = Administrator
server.password = ObjLune
server.connection.user = olc-user
server.connection.password = secret
database.rootpassword = @Admin2022
database.username = olconnect
database.password = @Admin2022
database.remoteaccess = true
desktopShortcuts = true

path = "c:\Program Files\Objectif Lune\OL Connect"

;0ptional uninstallation settings
[Uninstall]

remove = true
keepdata = false
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Exit Codes
Success

« 0 = Installation completed successfully / no specific error code was returned.
Pre-Installation Check (200s)

e 201: Operating system is not 64-bit

202: Windows Operating System is too old (pre-Windows 7)

203: Minimal UAC prerequisites were not met

204: Installation user did not have administrator rights
Silent installation properties (300s)

« 301: MariaDB product was selected, but no root password was supplied

» 302: MariaDB product was selected, but no user password was supplied

« 303: User provided database is to be used, but database. system property was missing

» 304: User provided database is to be used, but database. system property had invalid value
» 305: User provided database is to be used, but database.host property was missing.

» 306: database.instance property was used with a database system other than MS SQL Server
e 307: User provided database is to be used, but database.username property was missing.
» 308: User provided database is to be used, but database.password property was missing.

« 309: Connect server/ server extension product was selected, but serv-
er.connection.password property was missing

* 310: Connect server extension product was selected, but server.connection.host property
was missing

Upgrade errors (400s)

* 401: Some Connect applications were running and need to be closed before installation can pro-
ceed.

» 402: The installer brand does not match the brand of the OL Connect version currently installed.
(PlanetPress)

* 403: The installer brand does not match the brand of the OL Connect version currently installed.
(PReS)
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* 404: The installer brand does not match the brand of the OL Connect version currently installed.
(Printshop Mail)

License file validation (500s)

+ 501: PlanetPress Connect license file is in older format
» 502: License Care Date does not allow installation of product

* 503: License brand mismatch with installer brand

Destination and selected product check (600s)

+ 601: Server and Server Extension both were selected to be installed.
Only one of the two may be installed on any one system.

» 602: No component was selected to be installed

» 603: Destination folder is invalid or there is too little disk space available
Installation aborted (700s)

e 701 -725: Installation was aborted due to user cancellation

Service stop error (800s)

e 801: OLConnect_MySQL/OLConnect_MariaDB service could not be stopped during unin-
stallation

Activating a License

PlanetPress Connect and PlanetPress Workflow both come with individual 30 day trial license periods
during which time it is not necessary to have a commercial license to run the applications.

This allows time for reviewing the applications and for organizing a commercial license. If a modi-
fication to the trail license is required, such as to allow an extension to the trial period, or for extra func-
tionality, then a new activation code will need to be requested.

Obtaining the PlanetPress Connect Magic Number

To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Number is a
machine-specific code that is generated based on the computer's hardware and software using a top-
secret Objectif Lune family recipe. Each physical computer or virtual computer has a different Magic
Number, and each requires a separate license file to be functional.

To get the PlanetPress ConnectMagic Number open the Connect Software Activation application.

¢ Open the Start Menu

» Click on All Programs and browse to the Objectif Lune folder.
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¢ Open the Connect Software Activation shortcut.
* The PlanetPress Connect Software Activation application consists of the following:
» License Information subsection:
e Magic Number: Displays the PlanetPress Connect Magic Number.
. _7Copy the magic number to the clipboard: Click to copy the Magic Number to

the clipboard. It can then be pasted in the activation request email using the Win-
dows CTRL+V keyboard shortcut.
* Licensed Products subsection:
+ Name: Displays the name of the application or module relevant to this activation.
i

The Information button provides detailed information about the application or

module license.

« Serial Number: Displays the trial license serial number or the activation serial num-
ber if the product has been activated in the past.

« Expiration Date: Displays the date when the activation will expire, or the current
date if the product is not activated.

 End-User License Agreement - Appears only when loading a license file:
» License: This box displays the EULA. Please note that this agreement is legally bind-
ing.
» | agree: Select to accept the EULA. This option must be selected to install the
license.

« I don't agree: Select if you do not accept the EULA. You cannot install the license if
this option is selected.

* Load License File: Click to browse to the Connect license file (.olconnectlicense), once
it has been received.

» Install License - Active only when a license file is Loaded: Click to install the license and
activate the software.

» Close: Click to cancel this dialog.
Even if a license file has been Loaded, it will not be installed if this dialog is Cancelled
before the Install License button was clicked.

Requesting a license

After getting the Magic Number, a license request must be done for both PlanetPress Connect and
Workflow :
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e Customers must submit their Magic Number and serial number to Objectif Lune via the Web
Activations page: hitp://www.objectiflune.com/activations. The OL Customer Care team will then

send the PlanetPress Connect license file via email.

» Resellers can create an evaluation license via the Objectif Lune Partner Portal by following the
instructions there: http://extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations team.

Accepting the license will activate it, after which the PlanetPress Connect services will need to be
restarted. Note that in some case the service may not restart on its own. To resolve this issue, restart
the computer, or start the service manually from the computer's Control Panel.

Activating PlanetPress Workflow

PlanetPress Workflow uses the same licensing scheme as PlanetPress Connect. There are two ways
of activating the license for Workflow after saving it to a suitable location:

« If only PlanetPress Workflow is installed, double-click on the license for the PlanetPress Work-
flow License Activation dialog to open. Applying the license here activates all of the Workflow
components.

« If you have both PlanetPress Workflow and PlanetPress Connect installed, it will not be possible
to double-click on the license file as this will always open the PlanetPress Connect Activations
Tool. Instead, open PlanetPress Workflow manually and apply the license through the activations
dialog within.

Activating PlanetPress Connect

To activate PlanetPress Connect, simply save the license file somewhere on your computer where you
can easily find it, such as on your desktop. You can then load the license by double-clicking on it, or
through the PlanetPress Connect Software Activation tool.

Activating the PlanetPress Connect license requires the user to have local Windows Administration
rights.

» Using a user profile that has local Windows Administration rights, open the Start Menu
» Click on All Programs, then browse to the Objectif Lune folder.
* Run the “Connect Software Activation” tool.

» Click the Load License File button, and browse for the .olconnectlicense file you received from
Upland Objectif Lune.

« Read the EULA and click the I agree option to accept it.
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» Click Install License to activate the license. The license will then be registered on the computer
and you will be able to start using the software.

Caution: After installation message will appear warning that the Server services will need to be
restarted. Just click OK to proceed.

Migrating to a new workstation

The purpose of this document is to provide a strategy for transferring a OL Connect (and/or Workflow)
installation to a new workstation.

Before installing the software

Before upgrading to a new version, even on a new workstation, consult the product's release note to
find out about new features, bug fixes, system requirements, known issues and much more. Simply go
to the product page and look for the "Release notes" in the Downloads area.

You should also consult the following pages for some technical considerations before installing:

¢ "Network Considerations" on page 21

« "Database Considerations" on page 16

* "Environment considerations" on page 19

¢ "Installation prerequisites" on page 29

e "Antivirus Exclusions" on page 14
Downloading and installing the software

In order to migrate to a new workstation, the software must already be installed on the new workstation.
Follow the "Installation and Activation" on page 27 guide to download and install the newest version of
PlanetPress Connect on the new workstation.

Backing up files from the current workstation
The first step in migrating to a new workstation would be to make sure all necessary production files

and resources are backed up and copied over to the new system.

Note: Although it is not necessary to convert all of your documents when upgrading to the latest
version, we strongly recommended doing so.

It is considered "Best Practice" to convert the documents to the version installed and then re-
send them to the Workflow Tools.

Backing up Workflow files

To save all Workflow-related files, backup the entire working directory:
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C:\ProgramData\Objectif Lune\PlanetPress Workflow 8
Here are a few important points when transferring these files:

 If you are upgrading to the latest version of Connect, it is recommended to open each template in
Designer, produce a proof making sure the output is correct. Then send the template with its data
mapping configuration, Job Creation and Output Creation preset files to Workflow by clicking on
File > Send to Workflow...

« If you still use PlanetPress 7 legacy documents, PTK files can be imported by clicking on the
Workflow tool button at the top left corner of the Workflow tool interface. If copying the P1an-
etPress Workflow 8 folderdirectly, it's important to delete any file with the .ps7 extension so
as to refresh the PostScript file for the new workstation. Deleting the .ps7 files will make Work-
flow recreate them.

» The Workflow configuration file itself is named ppwatch.cfg, and is backed up with the folders.
However, it needs to be re-sent to the Service to be used. To do this, rename the file to .OL-Work-
flow, open the file with the Workflow tool, and send the configuration.

» Locate Custom Plugins (.dll) from the below folder on the old workstation and import them onto
the new workstation:
C:\Program Files (x86)\Common Files\Objectif Lunel\PlanetPress Workflow

8\Plugins
To import the plugins:

1. Start the Workflow Configuration Tool.

2. Click on the Plug-in Bar.

3. Click on the down pointing triangle under the Uncategorized group.
4. Select Import Plug-in and select the .dll file.

» Import any external scripts used by the Run Script plugin, making sure they reflect the same
paths as on the previous workstation

 Install any external application, executable and configuration files used by the External Program
plugin, making sure they reflect the same paths as on the previous workstation

* Reconfigure local ODBC connections (i.e. create local copies of databases or recreate required
DSN entries).

» Backup and import other custom configuration files, Microsoft Excel Lookup files, making sure
they reflect the same paths as previously.

» Reinstall required external printer drivers and recreate all Windows printer queues and TCPIP
ports.
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* On the new workstation if the "TCP/IP Print Server" service is running in Windows, it is requested
to disable that service so that it does not interfere with the Workflow LPD/LPR services.

« Configure the Workflow services account as in the previous installation. If accessing, reading and
writing to network shares, it is recommended to use a domain user account and make it a mem-
ber of the local Administrators group on the new workstation. Once the user account has been
chosen:

1. Click on Tools in the Workflow Configuration menu bar.
2. Click Configure Services.
3. Select the user account.

 Ifrequired, grant permissions to other machines (Designer clients and other servers) to send doc-
uments and jobs to the new server.

» Click on Tools in the Workflow Configuration menu bar.
» Click on Access Manager

e Grant necessary permissions to remote machines.

e Restart the Workflow Messenger service.

» Reconfigure the Workflow Preferences as previously by clicking on the Workflow button at the
top left corner and clicking on Preferences:

e Reconfigure the Server Connection Settings under Behavior > OL Connect.

» For PlanetPress Capture users, reconfigure the PlanetPress Capture options under Beha-
vior > PlanetPress Capture.

» Reconfigure each of the plugins, where necessary, under Plug-in as previously.
Capture OnTheGo users may want to enable the Use PHP Arrays option under Plug-in >
HTTP Server Input 1.

» Send the configuration to the local Workflow service.
Backing up Connect Resources
The following resources are used by Connect and can be backed up from their respective folders:

» Job Presets (.OL-jobpreset):

C:\Users\ [UserName] \Connect\workspace\configurations\JobCreationConfig

* Output Presets (.OL-outputpreset):
C:\Users\ [User-

Name] \Connect\workspace\configurations\PrinterDefinitionConfig
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* OL Connect Print Manager Configuration files (.OL-ipdsprinter):

C:\Users\ [UserName]\Connect\workspace\configurations\PrinterConfig

e OL Printer Definition Files (.OL-printerdef):
C:\Users\ [User-

Name] \Connect\workspace\configurations\PrinterDefinitionConfig

 OMR Marks Configuration Files (.hcf):

C:\Users\ [UserName] \Connect\workspace\configurations\HCFFiles

Where [username] is replaced by the appropriate Windows user name.

Tip: Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a French
system, for example, it would be 'C:\Utilisateurs'.

Type suserprofile% in a Windows File Explorer and press Enter to open the actual current
user's home directory.

Other Resources

+ OL Connect Designer Templates, DataMapper or Package files, copied from the folder where
they reside.

e All PostScript, TrueType, Open Type and other host based fonts used in templates must be rein-
stalled on the new workstation.

e Import all dynamic images and make sure their paths match those in the old server.

» Make sure the new workstation can also access network or remote images, JavaScript, CSS,
JSON, and HTML resources referenced in the Connect templates.

Secondary software and licenses

The following only applies to specific secondary products and licenses that interact or are integrated
into the main product.

Image, Fax and Search Modules

* Reconfigure the Image and Fax outputs with the new host information.

» Import the Search Profile and rebuild the database in order to generate the database structure
required by the Workflow.
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Capture

1. Download the latest version of the Anoto PenDirector.

2. Before installing the PenDirector, make sure the pen’s docking station isn’t plugged into the
server. Then install the PenDirector.

3. Stop the Messenger 8 service on the old and new server from the Workflow menu bar: Tools >
Service Console > Messenger > right-click and select Stop.

4. Import the following files and folders from the old server into their equivalent location on the new
server:
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\-
capture\PPCaptureDefault.mdb
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager
C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\PGC

5. If Capture was previously using an external MySQL or Microsoft SQL Server, reconfigure the
ODBC connection details as previously from the Workflow Preferences by clicking on the Work-
flow button at the top left corner and clicking on Preferences, then reconfigure the PlanetPress
Capture options under Behavior >PlanetPress Capture > Use ODBC Database.

6. Start the Messenger 8 service on new server from the Workflow menu bar: Tools > Service Con-
sole > Messenger > right-click and select Start.

OL Connect Send

» As of version 8.6 the Connect Send plugins are installed automatically with Workflow. If you are
using an older version, run the OL Connect Send Plug-in Installer on the new Workstation to re-
install the Connect Send plugins.

» Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup.
¢ Re-run the OL Connect Send printer driver setup on client system and select the Repair option to

point the clients to the new Server URL.

Configuring the Connect Engines

Any changes made to the Server preferences require the OLConnect_Server service to be restarted to
take effect.

1. Stop the OLConnect_Server service from Control Panel > Administrative Tools > Services >
OLConnect_Server > Stop.

Page 57

Connect


http://www.objectiflune.com/OL/lib/Common/Downloads/PlanetPressCaptureResources/AnotoPenDirector.zip

2. Configure the Merge and Weaver Engines scheduling preferences as in the previous installation

* Open the Server Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server Con-

figuration\ServerConfig.exe

» Configure the DataMapper, Merge and Weaver engines preferences (see "Parallel Pro-
cessing preferences" on page 95). As of version 2018.1 these preferences include the min-
imum (Xms) and maximum (Xmx) memory utilization for the Server, Merge and Weaver
engines.

» Configure any other options for the Clean-up Service.

3. Now start the OLConnect_Server service

Configuring the Server Extensions

In the case where the OLConnect MySQL is installed on the new Master Server, it is important to recon-
nect all Server Extension systems to the new Master Server.

Perform the following action on each Server Extension:

1. Stop the OLConnect_ServerExtension service from Control Panel > Administrative Tools >
Services > OLConnect_ServerExtension > Stop.

2. Open the Server Extension Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server Exten-

sion\ServerExtension.exe

3. Click on Database Connection and configure the JDBC Database connection settings so that the
hostname points to the new Master Server.

4. Click on Scheduling and type in the location of the new Master Server.

5. Startthe OLConnect_ServerExtension service.
Transferring software licenses

Once all the above resources have been transferred over to the new server, it is recommended to thor-
oughly test the new system - in demo mode - with sample files under normal production load to identify
points of improvement and make sure the output matches the user’s expectation.

Output generated at this point will normally bear a watermark which can be removed by transferring
licenses from the old server to the new one.

» To transfer Connect and Workflow licenses, the user is usually required to complete a License
Transfer Agreement which can be obtained from their local Customer Care department.
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« |If you want to transfer your licenses to the new machine right away, you may ask your local Cus-
tomer Care department for a 30day Transition activation code for your o/d machine.

« Upgrades cannot be activated using the automated Activation Manager. Contact your local Cus-
tomer Care department.

To apply the license file received from the Activation Team:

1. Ensure that all services are stopped on your old machine before activating and starting the ser-
vices on the new machine. Attempting to run the software with the same license simultaneously
will not only run into errors but it is a breach of our EULA.

2. Start the PReS Connect, PlanetPress Connect or PrintShopMail Connect Software Activation
module:
C:\Program Files\Objectif Lune\OL Connect\Connect Software Activ-

ation\SoftwareActivation.exe
Click on Load License File to import the license.OLConnectlLicense.
Start the Software Activation module on the Extension servers, where applicable.

Click on Load License File to import the above same license.OLConnectLicense.

o o &~

Restart the OLConnect_Server service and restart the OLConnectServer_Extension service on
the Extension servers, where applicable.

7. The number of Expected Remote Merge and Weaver engines should now be configurable in the
Connect Server Configuration module (C: \Program Files\Objectif Lune\OL Con-

nect\Connect Server Configuration\ServerConfig.exe)

To apply the PlanetPress Capture License:

1. Open the Workflow Configuration.
2. Click on Help on the Menu Bar and click on PlanetPress Capture License manager to import your
license.

Uninstalling PlanetPress Connect from the previous workstation

It is recommended to keep the previous install for a few days until everything is completed. However,
once your transition is successful and complete, the OL Connect software must be uninstalled from the
original server. See "Uninstalling" on page 112.

Information about PlanetPress Workflow

If you wish to use PlanetPress Workflow (automation) in conjunction with PlanetPress Connect, you will
need to install PlanetPress Workflow 2022.2 as well. Workflow 2022.2 is provided through a separate
installer which is available on CD or for download as follows:
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 If you are a Customer, the installer can be downloaded from the Objectif Lune Web Activations
page: http://www.objectiflune.com/activations

« If you are a Reseller, the installer can be downloaded from the Objectif Lune Partner Portal:
http://extranet.objectiflune.com/

PlanetPress Workflow can be installed in parallel on the same machine as an existing PlanetPress®
Suite 7.x installation.

Note however:

« |If both versions need to be hosted on the same machine, PlanetPress Workflow 2022.2 must
always be installed after the legacy PlanetPress® Suite 7.x installation.

* When uninstalling PlanetPress Workflow 2022.2, you may be prompted to repair your legacy
PlanetPress® Suite 7.x installation.

» If PlanetPress Workflow 2022.2 has been installed alongside PlanetPress® Suite 7, Capture can
no longer be used with Workflow 7.
The plugins are now registered uniquely to Workflow 2022.2 and the messenger for Workflow 7 is
taken offline. It is only then possible to use Capture from PlanetPress Workflow 2022.2.

» PlanetPress Workflow 2022.2 and PlanetPress® Suite Workflow 7 cannot run simultaneously,
since only one version of the Messenger service can run at a time. In fact, no two versions of
Workflow can be run simultaneously on the same machine, regardless of versions.

» ltis possible to switch between different versions running by shutting down one version's ser-
vices and then starting the other. However, this is not recommended. There are no technical lim-
itations that prevent processes from previous PlanetPress Suite Workflow versions (as far back
as Version 4) to run on PlanetPress Workflow 2022.2, removing the need to run both versions.

For more information on the licensing of Workflow 2022.2, please see "Activating a License" on
page 50.

Upgrading
This page provides information about Upgrading to PlanetPress Connect version 2022.2.
Upgrade information is detailed in the following pages:
» "Upgrading from previous Connect versions" on the next page
e "Upgrading from PReS Classic" on page 66
e "Upgrading from PlanetPress Suite 6/7" on page 66
¢ "How to perform a Workflow migration" on page 75

¢ "How to perform a Capture migration" on page 79
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Upgrading from previous Connect versions
Always backup before upgrading

It is recommended that you always backup your existing Connect preferences before upgrading to a
new version. This will enable you to revert back to the previous version, in a worst case scenario in
which the new version introduces issues with your existing production processes. Whilst the probability
of such a worst case scenario is remote, it cannot hurt to take some simple precautions, justin case.

For instructions on how to do so, please see "Backup existing Connect version" on the facing page.

Note: The scheduling settings were changed significantly in version 2019.2. Please make sure to
record your current scheduling settings for reference before proceeding with an upgrade..
Users of Connect prior to 2022

Users of any version of PlanetPress Connect prior to 2022 should see the page "Pre-existing User
Data" on page 63 for information about exactly what data is saved or deleted.

Users of Connect prior to 2019.1

Users of Connect versions prior to 2019.1 should note that Update Client 1.2.40 is a prerequisite for
both OL Connect 2019.1 and Connect Workflow 2019.1 installations. Only Update Client 1.2.40 has the
capacity to upgrade the OL Connect license to the newer format that is required by the installers of
those products.

If you do not have Update Client version 1.2.40 installed already, then the next time you run your
Update Client it will show that there is an update available of itself to Version 1.2.40 (or later).

Simply click on the “Install” icon # to initiate the upgrade.

For further details on how to upgrade the Update Client and update your Connect License see the
Update Client 1.2.40 Upgrade Guide.

Note: An incomplete uninstall of OL Connect before a reinstall or upgrade to a newer version can
lead to issues.
See Product or engine exits within a second of starting in Connect's Knowledge Base.

Note: If an error occurs during uninstallation or after/when re-installing Connect after uninstalling
it, please see Problems during a Connect installation or version upgrade in Connect's Knowledge
Base.
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Backup existing Connect version

Itis recommended that you always backup your existing Connect preferences before upgrading to a
new version. This will enable you to revert back to the previous version, in a worst case scenario in
which the new version introduces issues with your existing production processes. Whilst the probability
of such a worst case scenario is remote, it cannot hurt to take some simple precautions, just in case.

Backing up a virtual machine

Backing up a virtual machine installation is relatively straight forward. Simply take a snapshot of the vir-
tual machine instance, prior to upgrading. This would save all the localized preferences and con-
figurations.

Backing up a real machine

Backup these folders
e C:\ProgramData\Objectif Lune\OL Connect\.settings\ConnectHostScope
e C:\Users\ [UserName]\Connect\filestore
e C:\Users\ [UserName] \Connect\workspacelconfigurations

e C:\Users\ [User-
Name] \Con-
nec-
t\work-

space\Designer\.metadata\.plugins\org.eclipse.core.runtime\.settings

e C:\Users\ [User-
Name] \Con-
nec-
t\work-

space\Server\.metadata\.plugins\org.eclipse.core.runtime\.settings

Where [username] is replaced by the appropriate Windows user name.

Tip: Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a French
system, for example, it would be 'C:\Utilisateurs'.

Type 3userprofile% in a Windows File Explorer and press Enter to open the actual current
user's home directory.
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Backup your database

If you want to be completely thorough and be able to exactly replicate your existing system, you should
also backup your existing Connect database.

If the default (pre Connect 2022.1) MySQL database were being used as the Connect back-end data-
base, we would recommend the MySQLDump tool be used for this. See for details on this utility
program: mysqgldump (https://dev.mysqgl.com/doc/refman/5.7/en/mysqldump.html).

Pre-existing User Data

The following scenarios display what happens to pre-existing User Data in a Connect upgrade.

Note: In regards to the MySQL (Connect version 2021.2 and earlier) or MariaDB (Connect ver-
sion 2022.1 onwards) entries: these are only applicable if the OL Connect database component
was installed in a previous Connect installation.

Scenario 1: Upgrading from Connect 2021.2 or earlier with Remove User Data CHECKED

¢ |n all cases:

* Files and folders are removed from the user data folder C:\Users\<connectUser>\Connect ,
where <connectUser> is the user that installed OL Connect.

» Files and folders are removed from the following data folders:
e C:\ProgramData\Objectif Lune\OL Connect\.settings
» C:\ProgramData\Objectif Lune\OL Connect\CloudLicense
e C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs
* C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

» Files are removed from the root of the data folder C:\ProgramData\Objectif Lune\OL Con-
nect\.
If the folder is empty following this (i.e. no license or user folders were present) then the
C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

» License files as well as any content not listed above but found in the C:\Pro-
gramData\Objectif Lune\OL Connect\ folder remain untouched.

+ Additional cases:

1. If MySQL was previously installed as an OL Connect component AND the database con-
tains some user-defined schemas:
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® The native OL Connect schema is removed from the MySQL database.

® The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are
kept intact, as user-defined schemas mean that the user did not have only the OL
Connect native schema content in their database.

® A message at the end of the upgrade will advise the user that some non-OL
schemas were found in the database, so the database files were not removed.

2. If MySQL was previously installed as an OL Connect component AND the database does
not contain any user-defined schemas:

® The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are
removed entirely.

Scenario 2: Upgrading from Connect 2021.2 or earlier with Remove User Data UNCHECKED

* |n all cases:

» The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is the user
that installed OL Connect) is retained, untouched.

» All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL Connect
remain untouched.

» If MySQL was previously installed as an OL Connect component:

e All schemas from the MySQL database are migrated to MariaDB, allowing the user to con-
tinue using their database content normally.
NOTE: This might take some time during the installation, depending upon the size of the
existing databases.

e The MySQL database files (C:\ProgramData\Objectif Lune\OL Connect\MySQL) are also
kept intact.

Scenario 3: Uninstalling Connect 2022.2 or above with Remove User Data CHECKED

¢ |n all cases:

* Files and folders are removed from the user data folder C:\Users\<connectUser>\Connect ,
where <connectUser> is the user that installed OL Connect.

» Files and folders are removed from the following data folders:
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e C:\ProgramData\Objectif Lune\OL Connect\.settings

* C:\ProgramData\Objectif Lune\OL Connect\CloudLicense

o C:\ProgramData\Objectif Lune\OL Connect\ErrorLogs

e C:\ProgramData\Objectif Lune\OL Connect\LiquibaseUpdate

» Files are removed from the root of the data folder C:\ProgramData\Objectif Lune\OL Con-
nect\.
If the folder is empty following this (i.e. no license or user folders were present) then the
C:\ProgramData\Objectif Lune\OL Connect\ folder itself is removed.

» License files as well as any content not listed above but found in the C:\Pro-
gramData\Objectif Lune\OL Connect\ folder remain untouched.

+ Additional cases:

1. If MariaDB was previously installed as an OL Connect component AND the database con-
tains some user-defined schemas:

® The native OL Connect schema is removed from the MariaDB database.

® The MariaDB database files (C:\ProgramData\Objectif Lune\OL Connect\MariaDB)
are kept intact, as user-defined schemas mean that the user did not have only the OL
Connect native schema content in their database.

® A message at the end of the upgrade will be displayed, stating some non-OL
schemas were found in the database, so the database files were not removed.

2. If MariaDB was previously installed as an OL Connect component AND the database does
not contain some user-defined schemas:

® The MariaDB database files (C:\ProgramData\Objectif Lune\OL Connect\MariaDB)
are removed entirely.

Scenario 4: Uninstalling Connect 2022.2 or above with Remove User Data UNCHECKED

* |n all cases:

» The user data folder C:\Users\<connectUser>\Connect (where <connectUser> is the user
that installed OL Connect) is retained, untouched.

» All the files and folders under the data folder C:\ProgramData\Objectif Lune\OL Connect
remain untouched.
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» If MariaDB was previously installed as an OL Connect component:

» All schemas from the MariaDB database are kept, allowing the user to use those database
files if they reinstall the software.

Upgrading from PReS Classic
PReS Classic and PlanetPress Connect are very different products.
Whilst PlanetPress Connect provides considerably more options for email and web output, one need

not abandon existing PReS Classic print jobs. They can still be run through Connect Workflow, via the
PReS Print Controls task in the Online Help of Workflow.

Upgrading from PlanetPress Suite 6/7

Note: This document is intended for people who already received their upgrade to PlanetPress
Connect. They should already have their new serial number(s) in hand and the PlanetPress Con-
nect installers.

PlanetPress Connect, Objectif Lune’s innovative technology, embodies a true Production Print as well
as an Interactive Business Communication Solution.

This document provides information on the migration process and the requirements and considerations

for existing PlanetPress Suite users to upgrade to the latest generation of our products.

What does PlanetPress Connect contain?
PlanetPress Connect is comprised of the following modules:

» PlanetPress Workflow 2022.2. This is the natural evolution of PlanetPress Suite Workflow 7
(Watch, Office or Production). PlanetPress Workflow 2022.2 is very similar to the PlanetPress
Suite Workflow 7 version but contains a number of new features and has the ability to run Plan-
etPress Connect jobs, as well as PlanetPress Suite, PrintShop Mail Suite and PReS Classic doc-
uments.

» Imaging for PlanetPress Connect is available as an option. It contains:
e PlanetPress Fax
* PlanetPress Image
* PlanetPress Search

IMPORTANT: If you owned them, you must also upgrade your Imaging modules to use the
new version.
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» PlanetPress Capture is still supported in PlanetPress Workflow 2022.2 but only with doc-
uments created with the PlanetPress Suite Design 7.

» PlanetPress Connect Designer. This is a design tool based on completely new technology. Itis
not backwards compatible and therefore cannot open PlanetPress Suite Design 7 documents. If
you want to continue editing those documents you can keep doing so in PlanetPress Suite
Design 7.

» PlanetPress Connect Server. This is the core of the Connect technology (see "Connect: a peek
under the hood" on page 114 in the Online Help: https://help.objectiflune.com/en/planetpress-
connect-user-guide/2022.2/). This new module automates the merging of data with your new tem-
plates and generates the output. It is required for PlanetPress Workflow 2022.2 to handle tem-
plates created with the PlanetPress Connect Designer. It can be installed on the same or a
different machine as PlanetPress Workflow 2022.2.

IMPORTANT: PlanetPress Connect does not contain the PlanetPress Design 7.

PlanetPress Connect does not need any printer licenses to print from PlanetPress Connect or Plan-
etPress Suite. It can also print PrintShop Mail 7 and PReS Classic documents if these programs are
licensed.

You can keep everything you have

The first thing to know is that you can keep your current PlanetPress Suite Workflow 7 configuration
and your PlanetPress Suite Design documents. When upgrading to PlanetPress Connect, they will
remain functional.

Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at the same
time. See "Information about PlanetPress Workflow" on page 59 for information about these limitations.
The only exception is the PlanetPress Suite Design tool that you can continue to use as it is not part of
PlanetPress Connect.

PlanetPress Connect installation considerations

The PlanetPress Suite could run on a computer with a minimum of only 1GB of RAM available. The
PlanetPress Connect Server with PlanetPress Workflow 2022.2, by default, requires 8 GB of RAM, but if
you intend on using the new PlanetPress Connect Designer on the same computer, you should con-
sider having at least 16 GB of RAM available. See "System requirements" on page 25.

Distributed installation or not

You can decide to install PlanetPress Connect modules all on the same computer or have each module
on a different computer. Reasons for this could be:

Page 67

Connect



» There is insufficient memory in the computer currently running PlanetPress Workflow 2022.2 to
also run PlanetPress Connect Server.

¢ You want to use a more powerful computer with more RAM and more cores to run the Server to
achieve maximum performance (see "Performance considerations" on page 23).

What do | gain by upgrading to PlanetPress Connect?

When upgrading to PlanetPress Connect, PlanetPress Watch users receive key features of Plan-
etPress Office such as the following:

» Ability to input data from PDF

* Ability to print your PlanetPress Suite documents on any Windows printer (no need for printer
licenses)

» Ability to create standard PDF output from your PlanetPress Suite documents

» Evenif you don’t recreate your existing PlanetPress Suite documents, you can easily change
your workflow to convert your output to PDF, then output them in PCL to any device supporting it.

» The full version of PlanetPress Connect can open your company to the digital world by enabling
you to send HTML responsive emails as well as creating dynamic responses and interactive web
pages.

You can reuse the content of your existing documents and map it onto responsive documents
that can be sent by email in full HTML glory and/or make them available as native HTML web
pages using the latest CSS/JavaScript features.

Note: If you were a PlanetPress Production user, you retain all functionalities within PlanetPress
Workflow 2022.2. These are automatically imported during the activation (see below).

Create new documents and integrate them into your workflow at your own pace

You can start benefiting from the innovative technology of the new PlanetPress Connect Designer right
away by designing new documents, or re-doing existing ones at your own pace. You can also now:

» Use the new DataMapper to easily map any input data into a clean data model that any designer
person can use.

» Easily create documents with tables that spread over multiple print pages, respecting widow and
orphan rules, displaying sub-totals and totals properly.

e Have text that wraps around images.
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Upgrade steps

1. To upgrade to PlanetPress Connect, the first step is to stop your PlanetPress Workflow services.
You can do so from the PlanetPress Workflow configuration tool or from the Windows Service
Management console.

2. Then, using the PlanetPress Connect setup, install the Designer and/or Server on the appro-
priate computers.

3. Then, using the PlanetPress Workflow 2022.2 setup, install PlanetPress Workflow and/or Plan-
etPress Image on the appropriate computers. (See "Installation and Activation" on page 27 for
more details.)

Note: If Workflow installation finds that .NET 4.0 is not already installed, it will install that
version as part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then .NET
3.5 must also be installed. This will need to be installed manually, as .NET 3.5 is not
included in the Workflow setup.

4. If you installed PlanetPress Workflow 2022.2 on the same computer where you had PlanetPress
Suite Workflow 6 or 7, you can use the Upgrade Wizard to import your:

» PlanetPress Workflow:
* Processes configuration
* PlanetPress Suite compiled documents
» Service configuration
* Access manager configuration
e Custom plug-ins

» PlanetPress Fax settings

» PlanetPress Image settings

* PlanetPress Search profiles

» Printer activation codes

* PlanetPress Capture database

* PlanetPress Capture pen licenses

e Custom scripts

» Content of your virtual drive
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» PlanetPress Messenger configuration

5. Ifyou installed PlanetPress Workflow 2022.2 on a different computer, please see "How to per-
form a Workflow migration" on page 75 for help importing all those settings, if you wish to import
them.

6. Tolaunch the Upgrade wizard, open the PlanetPress Workflow 8 configuration tool and, from the
Tools menu, launch the Upgrade Wizard.

IMPORTANT: Before you start this process, make sure you have a backup of your current install-

ation/computer.
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7. Then select your upgrade type:

% Upgrade wizard options

Upgrade option

Custarm Uparade ;I

Expressz Uparade
SIS Cstom Uparade
all the curnentlyinstalled P resz W orkflow
goftware to your new PlanetPress W ork low
wergion,

Select 'Custom Uparade’ if you want to choose
which of the currently installed PlanetPress

W orkHow software iz to be upagraded to wour
news PlanetPress Workflow version,

< Back Hent »
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8. Then select the product from which you wish to upgrade:

% Upgrade wizard options

Upgrade from version

IF'IanetF'ress Suite  ta PlanetPress Connect ;I

Planet ke ko PlanetPre
& WElZIOn of - F

from which to perform the upgrade, and press
et

WARMIMG - Any files upgraded fram a previous
werzion of the PlanetPress Workflow will
ovenarnite your current files bearing the same
name. Pleaze backup your curment files to avaoid
any data lozz.

Exit Hent »

9. Ifyou selected to do a Custom upgrade, select the required options:
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P "

% Upgrade wizard options @

v Al zoftware
[ [v Wirtual drive content
[w Printer activation codes [v Meszzenger configuration
[v PlanetPress Capture Databaze v PlanetPress Capture pen license

[v Cugtom scripts

-
-
-
-

v PlanetPress Fax [v PlanetPress Workfow
[v PFlanetPressz Fax settings [v Compiled documents

]| PlaneiPress mags [v Active configuration

v PlanetPrezs Image settingz | Seriee caiEuEie e

[v Access Manager
[v PlanetFrezz Search v Custom pluging

Iv PlanetPress Search Profiles

< Back MHest »

10. Then finally review the log in the final dialog for details on how it went:
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% Upgrade wizard options @

LOG: pgrade Completed. -

Exit

11. After that you will need to get the activation file for your product.
To obtain your activation file, download the PlanetPress Connect installer from the \Web Activ-
ation Manager (http://www.objectiflune.com/webactivationmanager/), follow the instructions for
the installation using the serial number provided to you. You can activate your license through
the Web Activation Manager.

12. From now on, if you need to modify your PlanetPress Design documents, simply open Plan-
etPress Design 6 or 7, edit your document and send the updated version to PlanetPress Work-
flow 8. In order to do that:

» If you have PlanetPress Design on the same computer as PlanetPress Workflow 2022.2,
you need to save the documents to PTK by using the “Send to” menu, then "PlanetPress
Workflow”, and there use the “Save to file” button. Then, from the PlanetPress Workflow
configuration tool, in the “Import” menu, select “Import a PlanetPress Document” and
select the previously saved file.

* If you have PlanetPress Design on a computer and PlanetPress Workflow 2022.2 on
another, you can simply use the “Send to” menu in the Designer and select the Plan-
etPress Workflow tool to which you want to send the PlanetPress Design document.
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How to perform a Workflow migration

What do you need to consider when upgrading from PlanetPress Suite 7 to PlanetPress Connect Work-
flow 2022.2 on a new computer?

Installing and Activating Workflow 2022.2 on a new computer

Points to consider:

» Before installing, be sure to read "Installation and Activation" on page 27. There you will find
detailed Connect Workflow installation steps as well as system requirements, notes on license
activation and much more.

 |tis recommended you retain your existing PlanetPress Suite installation for a period of time after
the PlanetPress Connect Workflow 2022.2 installation. We recommend this particularly when
undertaking migration from one to the other. Once the migration has completed, you should unin-
stall PlanetPress Suite from your original installation. In the meantime, a fresh installation of Plan-
etPress Connect will run for 30 days without requiring an activation code, to simplify the migration
process.

* Request new activation codes for your software licenses (License Transfer agreement needs to
be filled out and signed). Contact your local Activations Department. www.ob-
jectiflune.com/activations

¢ Please note that PlanetPress Suite Workflow 7 and PlanetPress Workflow 8 cannot run at the
same time. See "Information about PlanetPress Workflow" on page 59 for information about
these limitations. The only exception is the PlanetPress Suite Design tool that you can continue
to use as itis not part of PlanetPress Connect.

Printer Licences

If you are currently using Printer Licenses under PlanetPress Suite 7 and wish to continue doing so in
PlanetPress Connect Workflow 2022.2, there are a few ways in which you can reinstall those printer
activation codes onto PlanetPress Connect Workflow 2022.2. They are as follows:

 If you retained the .pac file (printer activation codes) from your previous installation, then double
click on that file from within your new computer, and the printers will get activated.

If you did not retain the pac file, you can export a new printer activation code. This is done from
the PlanetPress Suite Designer Help > Printer Activation menu option. When the "Activate a
printer" dialog is launched, right click within it and select the Export context menu option, then
save the file on the new computer. Double clicking on the .pac file will then activate all of your
printers on the new computer.
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» Login to our Web Activation Manager (www.objectiflune.com/activations) using your customer
number and password to get your Printer Activation Codes.

» If you do not have access to the computer in which PlanetPress Suite was previously installed,
print a Status Page for each printer from your Connect Workflow 8 Configuration. Do this via the
Tools > Printer Utilities menu option. Select “Print Status Page” and then select your printers
from the list.

Email the Status Page(s) to activations@ca.objectiflune.com and you will receive a .pac file in
return, with which you can activate your printer(s).

Documents and Resources

PlanetPress Suite Documents and Resources

» Backup all your PlanetPress Suite Design documents from your old computer and copy them
onto the new computer. The files use the extension .ppX, where X is the version number of the
PlanetPress Suite that created the files.

The documents do not have to be in any specific folder.

» Back up the entire directory of: "C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\Documents".
This folder contains all the PlanetPress Design documents and compiled forms (*.ptk and *.ptz).
Paste the files onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"

» Back up the latest .pwX (PlanetPress Workflow Tools Configuration) file, found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\".
Paste onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\"

There are several ways you can import Documents into PlanetPress Workflow. They are as follows.

1. In Connect Workflow go to File > Import > PlanetPress Document ... and select the .ptk doc-
ument you wish to import.
These files will most likely be found in the Documents folder on the PlanetPress Suite computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Documents"

2. Copy all the PlanetPress Suite 7 Documents and Compiled forms (*.ptk and *.ptz) from the Docu-
ments folder on the PlanetPress Suite computer and paste them into the equivalent folder on the
Connect Workflow Computer.

The PlanetPress Suite 7 folder would be "C:\ProgramData\Objectif Lune\PlanetPress Suite
7\PlanetPress Watch\Documents".
The PlanetPress Connect Workflow 8 folder will be "C:\ProgramData\Objectif Lune\PlanetPress
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Workflow 8\PlanetPress Watch\Documents"

3. Use the File > Send To menu option in PlanetPress Suite Designer and select the PlanetPress
Connect Workflow 8 to which you want to send the PlanetPress Suite Designer document.
This should work with PlanetPress Suite versions 6 and 7.

Make sure that ports 5863 and 5864 are not blocked by firewall on either machine.

Also make sure you add the PlanetPress Suite machine’s IP address to the permissions list in
Connect Workflow 8 from Tools > Access Manager.

Further information about Workflow Access Manager can be found here: Access Manager.

Windows Operating System Steps:
« Install all the Windows printer queues from the old computer, making sure they are named the
same.

« If your existing documents referenced any local dynamic image resources in a folder or in Local
Host, make sure that you import them onto the new computer as well, or make them available on

a network accessible drive.

* Any special PostScript or TrueType fonts used will also need be installed on the new computer.

» Verify that you have access to any other resources that the PlanetPress Suite used. This
includes network folders, printers, third party software and the like.

Page 77

Connect


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/Interface/Access-Manager.html

Workflow Plug-ins

Back up any custom PlanetPress Suite Workflow configuration Plug-ins (.dll) and copy them onto the
new computer.

The PlanetPress Suite Workflow plug-ins folder can be found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Plugins".

Make sure that you copy only the custom plug-ins.

Alternatively, you can download custom plug-ins from http://-
planetpress.objectiflune.com/en/suite/resources/support onto the new computer.

Once you've copied your PlanetPress Suite Workflow configurations to Connect Workflow, you can con-
firm their availability through the Plug-in Bar Uncategorized category. There you will find all the Cus-
tom plug-ins that have been installed.

Missing plug-ins will be represented in Workflow steps through the use of a "?" icon. Such as in the fol-
lowing image, which shows that the "TelescopingSortPlugin" is not installed.

Mot Found

|
“3 | Telescopings ortPlugin

I~ 11
To import a plugin:
1. Click on the popup control (# ) in the Plug-in bar.
2. Select Import Plugin
3. Browse to the location of the plug-in DLL file
4. Click on Open.
5. The new plug-in should appear in the Plug-in Bar Uncategorized category.

Configuring PlanetPress Connect Workflow 8

* Reconfigure any settings that may need to be applied to the PlanetPress Suite Messenger and
PlanetPress Workflow Tools LPD services using the Access Manager (see http://help.ob-
jectiflune.com/en/PlanetPress-workflow-user-guide/2022.2/#Workflow/Interface/Access-Man-
ager.html).
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» All PostScript and TrueType host based fonts must be reinstalled. Make sure you restart the com-
puter after this step.

 If necessary, reconfigure local ODBC connections. (i.e. create local copies of databases or recre-
ate required DSN entries)

* Manually install all external executables that will be referenced by the Connect Workflow pro-
cesses in the configuration file. If possible, retain the local path structure as used on the older
installation.

 If the Windows "TCP/IP Print Server" service is running on the new computer, it is recommended
that you disable the Server so that it does not interfere with the PlanetPress LPD/LPR services.

 If you are using images from a virtual drive, copy the entire contents of "C:\ProgramData\Objectif
Lune\PlanetPress Suite 7\PSRIP" and paste them onto the new computer here: "C:\Pro-
gramData\Objectif Lune\PlanetPress Workflow 8\PSRIP".

e Make sure to set the user who will run the PlanetPress Services. This is done by going into
Tools/Configure services. The user will need to have local administration rights in order to be
able to run the services.

For more information, see Users and Configurations
(http://help.objectiflune.com/en/PlanetPress-workflow-user-guide/2022.2/#Work-
flow/WorkflowServices/Users_and_Configurations.html).

* Once all these steps have been completed, you will need to import your configuration file. Find
the latest pwX file located on the old computer, if it is not already copied across to the new com-
puter. The default location on the old computer is “C:\ProgramData\Objectif Lune\PlanetPress
Suite 7\PlanetPress Watch\”.

On the new computer you will need to go to File > Import > Configuration Components.
Browse and find your file. If the file is not visible change the file type to *.pw7

PlanetPress Image, Fax and Search

» Reconfigure the PlanetPress Image and PlanetPress Fax outputs with the new host information.

* You must import the Search Profile and rebuild the database in order to generate the required
database structure.

PlanetPress Capture
 If you have a Capture Solution, please see "How to perform a Capture migration" below.
How to perform a Capture migration

This page provides information on how to conduct a proper migration of a Capture solution. For inform-
ation about Capture see: http://capture.objectiflune.com/en/howitworks.
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These steps must be executed after a proper Workflow Migration has been completed. Instructions on
how to do such can be found here: "How to perform a Workflow migration" on page 75.
Failure to do so will result in unexpected problems.

Note: Itis recommended that you first update your PlanetPress Suite to version 7.6 before cross-
grading to PlanetPress Connect.

Using PlanetPress Connect Workflow 2022.2 on the same computer as PlanetPress Suite 7.6

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 2022.2 on the same computer.
3. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect Workflow 8.

a. Open Workflow Service Console. This can be done either via the Windows Start Menu, or from
within Workflow Configuration application (via menu option Tools > Service Console).

b. Select Messenger in the tree list, right click and select i Stop from the context menu.

Note: These steps must be done for both PlanetPress Suite Workflow 7 and PlanetPress
Connect Workflow 8.

4. Copy the file PPCaptureDefault.mdb from this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and over-
write the existing database.

Note: Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6 a sep-
arate database has been used for the patterns alone (PPCaptureDefault.mdb).

5. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\DocumentManager"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

6. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
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to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

7. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,

a. Open Workflow Service Console. This can be done either via the Windows Start Menu, or from
within Workflow Configuration application (via menu option Tools > Service Console).

b. Select Messenger in the tree list, right click and select | Start from the context menu options.
8. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Using PlanetPress Connect Workflow 2022.2 on a different computer to PlanetPress Suite 7.6

Tip: Itis safer to migrate outside high peak production since the Capture solution cannot be run
in parallel on two computers.

Once the Capture database has been transferred to the new computer, any update made to the
old computer will be lost unless the steps to migrate are reproduce again.

Once a Pen has been docked and the data transfer done, its memory is wiped, thus rending the
parallel mode very hard to produce. It is not impossible, but describing how it can be done is bey-
ond the scope of this migration article.

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PlanetPress Connect Workflow 2022.2 on new computer.

3. The Anoto PenDirector must be installed. It if is not, you can download it from http://www.ob-
jectiflune.com/OL/lib/Common/Downloads/PlanetPressCaptureResources/AnotoPenDirector.zip

and then install it.

Note: Itis strongly recommended that you install the latest version of the PenDirector.
Please use the link provided on the previous line.

Do not get any other version of the PenDirector from the Anoto website, as they
will not have been set up correctly for our Capture solution.

Note: Prior to installation, make sure you unplug the Pen docking station from the USB
port on the computer where you are about to install the Anoto PenDirector.
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4. Do the following for both PlanetPress Suite version 7.6 and PlanetPress Connect Workflow 8.
a. Open Workflow Service Console. This can be done either via the Windows Start Menu, or from
within Workflow Configuration application (via menu option Tools > Service Console).

b. Select Messenger in the tree list, right click and select i Stop from the context menu.

Note: These steps must be done for both PlanetPress Suite Workflow 7 and PlanetPress
Connect Workflow 8.

5. Copy the file PPCaptureDefault.mdb from this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder on the new PlanetPress Connect Workflow 2022.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and over-
write the existing database.

Note: Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6 a sep-
arate database has been used for the patterns alone (PPCaptureDefault.mdb).

6. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\DocumentManager"
to this folder on the new PlanetPress Connect Workflow 2022.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

7. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder on the new PlanetPress Connect Workflow 2022.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

8. Restart the PlanetPress Connect Workflow 8 Messenger. To do this,

a. Open Workflow Service Console. This can be done either via the Windows Start Menu, or from
within Workflow Configuration application (via menu option Tools > Service Console).

b. Select Messenger in the tree list, right click and select | Start from the context menu options.

9. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.
Server Configuration Settings

This chapter describes configuring the PlanetPress Connect Server.
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The Connect Server settings are maintained by the Connect Server Configuration utility tool which is
installed alongside PlanetPress Connect.

Connect Server Configuration can be launched from the Start Menu, as seen in the following screen-
shot:

Objectif Lune
Mew

rc Connect Designer

"ﬁ' Connect Server Configurati..,

F@’ Connect Software Activation

The Connect Server Configuration dialog is separated into individual pages, where each page con-
trols certain aspects of the software.

The following pages are available:

» "Clean-up Service preferences" on page 783
e "Connection preferences" on the facing page
» "Security and Users Settings" on page 85
e "Database Connection preferences" on page 787
e Engines preferences
» "Automatic Restart Settings" on page 94
e "Hardware for Digital Signing preferences" on page 797
e "Language preferences" on page 95
¢ "Logging preferences" on page 799

e "Parallel Processing preferences" on page 95
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Connection preferences

Background

The Connection preferences are a way to control precisely how to connect to the PlanetPress Connect
Server.

This preference page was added in Connect 2018.2 to simplify management of HTTP communication
with Connect. HTTPS communication options were then added in Connect 2021.1.

These preferences allow Connect inter-engine communication to occur on an alternate port, reducing
the chances of inter-engine communication being starved of connections when running on a system
that processes very large numbers of HTTP/HTTPS connections.

Connection settings

* REST Services group. Use this to adjust the HTTP or HTTPS communication settings for Con-
nect.

e Port: Set the primary HTTP or HTTPS Server connection port number for Connect.

¢ Protocol: Select whethertouse HTTP or HTTPS.
If HTTPS is selected, the following HTTPS specific options become available:

* Root certificate: This is an optional selection. Use the Browse button to locate the
appropriate root certificate file, if one is available.

+ Server certificate: Use the Browse button to locate the appropriate server cer-
tificate file. This is a mandatory selection.

» Private key: Use the Browse button to locate the appropriate Private key file. This is
a mandatory selection.

¢ Private key Password: Enter the Private key password.

» Confirm password: Re-enter the password, to confirm it was entered correctly.

Note: Enabling HTTPS for the primary REST Services connection requires different
ports be used for the internal connections (IPC and REST) between Connect Server
and its engines.

¢ Internal communication on separate ports checkbox:
Set the internal connection communication ports. These settings are purely for Connect inter-
engine communication.
It is recommended that this option be selected.
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Note: IfHTTPS were selected as the REST Services protocol, these internal Port settings
must be entered.

Note: Please note that local security settings (including firewalls) must be taken into con-
sideration when setting Port entries.

» IPC Port: Set the internal connection port number. This cannot be the same at the primary
REST Services port number.

* REST Port: Set the internal REST connection port number. This cannot be the same at the
primary REST Services port, or the IPC Port.

e Advanced group

* Maximum threads: Sets the maximum number of HTTP threads for processing requests.
This entry should only be changed in consultation with OL.

 Maximum asynchronous tasks: Set the maximum number of requests that can be
executed simultaneously.
The default asynchronous task setting is twice the number of processing cores available to
the computer. This can be expanded, if the limitation is deemed a bottleneck.

Note: This does not limit the number of requests that can be received, just how many
are processed in parallel. Additional requests are buffered and are processed as cap-
abilities allow.

Buttons
The Connections preferences also provides you with buttons to :

* Restore Defaults. This option restores the preferences to Defaults. This applies to the current
Preferences page only, but not other Preferences.

* Apply: This option applies the settings made within the current Preferences page, but does not
close the Preferences dialog.

Security and Users Settings

This dialog controls the security settings for external applications connecting to the PlanetPress Con-
nect Server, such as PlanetPress Connect Designer, PlanetPress Workflow plugins, or scripts com-
municating through the REST API.

Caution: Itis highly recommended to keep security enabled and change the password on any
server accessible from the web.
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If these precautions are not taken, data saved in the server may be accessible from the outside!

« Enable server security: Enable to add authentication to the REST server.
- When enabled, the username and password (which cannot be blank) of an authorized user
must be entered in any remote Connect Designer that links to this Server. See the "Connect Serv-
ers preferences" on page 804 sub-section of the Designer Preferences dialog.
- When disabled, a username and password is not required to make REST request, and tasks in
PlanetPress Workflow do not require them in the Proxy tab. Nor would a username and password
be required on any remote Connect Designer that links to this Server.

» Session expiration time (mins): Select a session time (in minutes, between one minute and
one year) that the authentication stays valid for the requested process. This can reduce the num-
ber of requests to the server since an authentication request is not necessary during the session.

» Authorized Users table: The Table contains a list of all currently Authorized Users.
All required information is summarized in the table, which has buttons to the right which allow one

to Add (&), Edit (.‘?) or Delete ('-@) individual entries. Double clicking on any entry in the table

also launches the Edit dialog.

The options available in the Add/Edit dialogs are as follows:
» Username: Enter the username for the server security.
* Roles: Check the roles that apply to the user.

» Data Handler: The user can start and stop operations, get results of operations, and
view and handle data (except resources). This appears as ROLE_DATA in the table.

* Resource Handler: The user can manage resources like data mapping con-
figurations, templates, and print presets. This appears as ROLE_RESOURCE in the
table.

* Monitoring: Can monitor the server, but cannot see data, change server settings, or
modify resources.This appears as ROLE_MONITOR in the table.

» Password: Enter a password for this user for the server security. There are no specific
password requirements or restrictions.

+ Confirm password: Re-enter the password assigned to this user.

Note: Existing client sessions are not affected by changes to authorized users. Clients may only
see the effect after their session expires.
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Engine configuration

The Connect Server cooperates with different engines to handle specific tasks. A DataMapper engine
extracts data from a data file. A Merge engine merges the template and the data to create Email and
Web output, or to create an intermediary file for Printed output. The intermediary file is in turn used by a
Weaver engine to prepare the Print output. (For more information see: "Connect: a peek under the
hood" on page 114).

Settings for these engines are made in the Connect Server Configuration tool (see "Server Con-
figuration Settings" on page 82).

Connect allows for the parallelization of jobs. This means you can allocate 1 or more engines to pro-
cess jobs.

The number of each type of engine is configurable, as well as the amount of Merge engines than can
work together on the same job (determined by job size: small, medium or large) and at what maximum
speed.

The "Parallel Processing preferences" on page 95 allow you to control precisely how the PlanetPress
Connect Connect Server handles jobs.

This gives you, as solution developer or application manager, full control of how to apply a machines
power. For example, you can share the available resources to process multiple jobs at once or allocate
all resources to process one single job as fast as possible, or anything in between.

Connect distinguishes 5 type of jobs:

1. Small Print
2. Medium Print
3. Large Print
4. Email

5. Web

Connect categorizes print jobs on the number of pages they will produce. What constitutes a Small,
Medium or Large job can be configured per server (see below, in "Allocating processing power to jobs"
on page 91).

There is no distinction between small, medium and large jobs for Email and Web output.

This topic explains all of these settings and the principles behind them, and it provides guidelines for let-
ting the Server manage the workload in such a way as to achieve the highest possible output speeds.

Factors to take into account are:
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» Your licence, which imposes a speed quota (see "Speed quota: Pages Per Minute" below).

* The processing power of your machine. How many cores it has determines how many engines
can be launched (see "Launching multiple engines" on the next page).

» The size and number of jobs of one kind that need to be handled, sequentially or simultaneously.
In other words, your use case. By allocating processing power to jobs of different sizes you can
make the setup match your usage situation (see "Allocating processing power to jobs" on
page 91).

Tip: Other ways to enhance performance are described in another topic: "Performance con-
siderations" on page 23.

Speed quota: Pages Per Minute

The highest possible output speed depends first and foremost upon your licence.

With no Performance Pack, in PlanetPress Connect, one engine can generate output at 500 PPM
(Pages and emails and web pages - Per Minute). Additional Performance Packs increase this quota.
The number of engines that are allowed to operate in parallel to create the same type of output are
referred to as the Licensed task limit.

PlanetPress Connect provides 6 Licensed tasks. Additional Performance Packs will increase this num-
ber.

So, with no Performance Pack, up to 6 engines can create the same type of output in parallel, which
means the total maximum output speed is 3,000 PPM per output type (Print, Email, and Web).

One engine needs at least one free speed unit to be able to create output.

It is important to note that only output operations are limited by this quota.

+ Weaver engines always require a Licensed task to run.

* Merge engines only require a Licensed task when creating Email or Web output. Merge engines
involved in a Print process don't need a Licensed task in order to run.

+ DataMapper engines don't need Licensed tasks.

In situations where Print and Email and/or Web output are created at the same time, only the Merge
engines that create Email/Web output count towards the maximum number of Licensed tasks for that
type of output.

Spare speed units are distributed proportionally

Since the number of engines is configurable, and jobs may run concurrently, the number of engines in
use may not match the exact number of available Licensed tasks.
When there are more Licensed tasks than there are engines in use, the Connect server distributes the
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speed units and the maximum 'pages' per minute to all running jobs in proportion to the number of
engines they are using.

Note: Output speed is the speed at which the output is created by the engine in question. Data
mapping and other steps in a production process are not taken into account. The throughput
speed is the speed of the entire production process. This will always be lower than the output
speed.

Launching multiple engines

One single engine can only process a single job at a time and will run mostly single-threaded.
In order to benefit from multi-core systems it is recommended that several engines run in parallel.

As a rule of thumb, you will want to run one less engine in total on a machine than the system has
cores, leaving one CPU core free for the Connect Server and the operating system to use.

Modern hardware typically has both full cores and hyper-threading or logical cores. The logical cores
should not be counted as a full core when determining how many engines to use. As a guide, count
logical cores for only 25%-50% of a full core.

For example: on an Intel i7 CPU that comes with 4 cores and 4 additional hyper-threading cores, Win-
dows Task Manager will show 4 cores and 8 logical processors on its performance tab. On a CPU like
this, 5 or 6 engines can be configured to run in parallel.

To configure the number of engines:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings" on
page 82).

2. Under Parallel Processing, go to the Content Creation tab and set the number of Merge engines
for the various tasks.

3. Go to the Output Creation tab and set the Reserved Weaver (Output) engines.
See "Deciding how many engines of each type to launch" below.

4. Click Apply or Apply and Close.

It is advised that you do not configure more engines than can be backed by actual processing power.
This adds overhead while not adding processing power.

Deciding how many engines of each type to launch

When jobs run in parallel, different types of engines may run at the same time. It depends on the
usage situation which type of engines has the biggest impact on performance.

The more and the larger operations of a kind need to be performed simultaneously with smaller oper-
ations, the sooner you will see a performance increase when using multiple engines.
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Merge engine

Generally, launching a relatively high number of Merge engines results in better performance, as
Merge engines are involved in the creation of output of all kinds (Print, Email and Web) and because
content creation is relatively time-consuming.

DataMapper engine

Adding DataMapper engines might be useful in the following circumstances:

* When large data mapping operations have to be run simultaneously for many jobs.

* When frequently using PDF or XML based input. Particularly in the case of XML input with large
individual records.

* When the All In One plugin is used often in Workflow configurations and there are more than two
Merge engines running.

The Connect MariaDB database needs a fast storage system (SSD or other fast devices) to be able to
keep up with two or more DataMapper engines.

When the database is installed on a system with a slow hard drive, adding a DataMapper engine may
not increase the overall performance.

Weaver engine

Adding extra Weaver (Output) engine(s) might be useful when large Print jobs are to be run sim-
ultaneously with smaller Print jobs.

Memory per engine

By default, each engine is set to use up to a predetermined amount of RAM. To make optimum use of a
machine's capabilities it might be useful to increase the amount of memory that the various engines can
use.

« DataMapper engines may perform better with greater memory when running jobs containing a lot
of data.

» For complex templates with a lot of pages per document, there is a chance that Merge engines
will run better with more memory.

+ The maximum memory usage of a Weaver engine can be relevant for jobs with heavy graphics;
or for jobs that use Cut & Stack impositioning; or for jobs using particular variables that entail
page buffering (see "Content variables" on page 1333).

The Maximum memory per engine setting is found in the Engines preferences.
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These settings only control the maximum size of the Java heap memory that an engine can use; the
total amount of memory that will used by an engine is actually a bit higher.

Also keep in mind that the Connect Server and the operating system itself will need memory to keep
running.

Allocating processing power to jobs

Which engine configuration is most efficient in your case depends on how Connect is used. What kind
of output is needed: Print, Email, and/or Web? How often? How big are those jobs? Do they have to be
handled at the same time or in sequence? Would it be useful to give priority to small, medium or large
jobs, and/or to jobs of a certain kind?

Depending on the answers to these questions, you can allocate processing power to jobs in order to
run them as fast as possible, and/or in the order of your preference.

The first step in this process is to define the size of small, medium and large jobs.
Job size

Connect lets you define job sizes by setting the maximum number of pages a job can have and still be
considered a small job, and what the minimum number of pages a job can have in order to be con-
sidered large. Jobs that fall between the small and large jobs are medium jobs.

Defining small, medium and large jobs is important, as you can assign additional resources to jobs
that are considered either medium or large, via the settings for Merge and Weaver engines.

There is no recommendation regarding what number of pages constitute a small, medium or large job.
Job size is a relative concept: in a small service company a job may be considered large when it out-
puts 1,000 pages, whereas that same job in a large insurance company might be seen as small. This
setting needs to be based on an assessment of the actual (or expected) workload of Connect.

To set the job sizes:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings" on
page 82).

2. Under Parallel Processing, go to the Output Creation tab and enter the maximum number of
pages in a small job.

3. Enter the minimum number of pages in a large job.

4. Click Apply or Apply and Close.

Medium jobs will be those that fall between the maximum pages of a small job, and the minimum pages
of alarge job.

The number of engines used for small, medium and large jobs is configurable (see below).
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Running a job as fast as possible

Number of parallel engines per Print job

Two or more engines of a kind can be combined to work on the same Print job. Generally jobs will run
faster with more than one engine, because sharing the workload saves time.

However, running one job with multiple engines reduces the number of jobs that can be handled at the
same time by that kind of engine, because there are only so many engines (and speed units) available.

Note: When each individual record in a job is composed of a very large number of pages, the
Memory per engine setting and the machine's hard drive speed are probably more important than
the number of Merge engines, since one record cannot be split over multiple cores (see "Memory
per engine" on page 90).

Target speed per Print job

If a Print job of a specific size has more than one parallel speed unit assigned to it, that multiplies its
speed, however it reduces the number of Print jobs that can be run simultaneously.

When no other Print output operations run at the same time, a single job will use all available speed, or
the maximum target speed reserved for jobs of that size (see "Dividing processing power over jobs"
below).

To set a number of speed units per Print job:

1. Openthe Connect Server Configuration utility tool (see "Server Configuration Settings" on
page 82).

2. Under Parallel Processing, go to the Output Creation tab.

3. Setthe Target speed when running simultaneous jobs for small, medium and large Print
jobs.

4. Click OK or Apply.
Dividing processing power over jobs

There is a number of ways in which you can divide processing power over output operations of a certain
kind and/or size.

* Byreserving engines for jobs of a certain kind (and size, in the case of a Print job). Note that
reserved engines cannot be used by any other type of job. This means there will be fewer
engines to handle other jobs. Consequently, the other jobs may take more time and may have to
wait (or wait longer). However, if the server receives many web requests then having engines
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reserved for HTML output can help performance.

» By reserving a number of parallel engines for Print jobs of a certain size (see "Number of par-
allel engines per Print job" on the previous page). More parallel engines will make them run
faster, but they will have to wait (longer) if the required number of engines isn't available when
they come in.

» By specifying target speeds for simultaneous Print jobs of a certain size.
All of these engine configuration settings are found in the Parallel Processing Preferences:

1. Openthe Connect Server Configuration utility tool (see "Server Configuration Settings" on
page 82).

2. Under Parallel Processing, check out the information contained in both Content Creation and
Output Creation tabs.
How the Server decides if a job can be handled

In summary, this is how jobs are handled when they can run in parallel.

* Whenever a job comes in, the number of engines to use is determined. (For Print jobs, this is
based on whether the operation is small, medium or large; see "Job size" on page 91.)

« If there are enough reserved Merge engines for that type of job available then those engines will
be used.

« Ifthere are not enough reserved Merge engines available, then any unreserved Merge engine
that is available will be used.

« If no, or not enough, Merge engines are available then the job will have to wait until the required
number of appropriate Merge engines becomes available.

The following limitations apply at all times:

* The maximum number of concurrent Merge engines working on jobs of the same kind or size
may not be exceeded.

* If no - or not enough - speed units are available for that type of output, the job must wait.
Examples

Here are a few examples of use cases and settings that would be appropriate in such cases.

Batch processing. In a batch processing situation, jobs don't have to be handled simultaneously. All
jobs - whether they are big and small - are processed one after another. Every job should be handled
as quickly as possible. It is therefor recommended to assign the maximum number of engines and tar-
get speeds to all jobs. Do not reserve engines for certain jobs.
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Web requests. In online communication, response times are critical. If the Server receives a lot of Web
requests, it should handle as many as possible, as quickly as possible, at the same time. It is recom-
mended to launch as many Merge engines as possible and to reserve most of them for HTML output.
The jobs will generally be small and can do with just one Merge engine.

Mixed jobs that are processed in parallel. In a situation where small, medium and large jobs can
come in at any time and should be handled in parallel, the challenge is to find a balance between how
much power can be allocated to jobs (to minimize the time they cost) and how long they can wait. No
single job should require all of the processing power, unless it is acceptable for it to have to wait until
the maximum number of engines finally comes available - and then all other jobs will have to wait.

Automatic Restart Settings

It is considered good management to restart the Connect Engines periodically. This dialog provides the
controls for scheduling Connect Engines restarts.

Automatically restart engines to safeguard system availability

» Time Limit checkbox: This enables engine restarts to be scheduled to occur either after a spe-
cified period of time, or within a daily time window.
This means daily Engine restarts can be scheduled to run outside of production hours.

* Rolling restart checkbox: This sets the engines restarts to occur in a "rolling" fashion, whereby
each engine is stopped and restarted individually, one after the other.
Each engine is only stopped when the previously restarted engine is once again ready to start
processing.

» Restart method: Chose between restarting after a specified number of minutes (Restart after
interval) or within a daily time window (Daily restart in period).

* Restart after (minutes): Only available if Restart after interval selected.
Specify the amount of minutes that the restarts are to occur after.

» Daily restart period begin: Only available if Daily restart in period selected.
Enter the daily start time for the time window in which automatic restarts will be scheduled to
occur.

» Daily restart period end: Only available if Daily restart in period selected.
The end of the daily time window in which the automatic restarts are scheduled to occur.

Memory limit

Enter the memory limit for individual Engines. If any of these memory limits are exceeded, an automatic
restart of those Engine types will be triggered.
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» Data Mapper Engine (MB): Enter the memory limit for Data Mapper Engine.

* Merge Engine (MB): Enter the memory limit for Merge Engine.

» Weaver Engine (MB): Enter the memory limit for Weaver (Output) Engine.
Language preferences

» Display language: Select a language from the drop-down list to be used as the language of the
OL Connect Server Configuration tool, and all log files created by OL Connect Server and its com-
ponents (after the software/service is restarted).

Parallel Processing preferences

The parallel processing preferences (previously referred to as Scheduling preferences, prior to 2019.2)
page provides the means to control precisely how the PlanetPress Connect and Connect Server
handles jobs that operate in parallel.

There is considerable difference between the preferences that are available in the Designer Parallel
Processing page and the Server Configuration Parallel Processing page.

» For the Designer specific preferences, see "Parallel Processing properties (Designer Prefer-
ences)" below.

» Forthe Server Configuration specific preferences, see "Parallel Processing properties (Server
Configuration)" on page 97.

For additional information on how these preferences can enhance performance, see "Engine con-
figuration" on page 87 and "Performance considerations" on page 23.

Parallel Processing properties (Designer Preferences)
Preset selection (Designer Preferences)

Only the Custom setting is applicable to the Designer Preferences, so this option is always selected
and the field made read-only.

Content Creation Tab (Designer Preferences)

A Tab with data that relates solely to Content Creation.

The options are:

» Total Merge engines configured read only display: This is a read only entry that shows the total
number of Merge engines available. To change this value, you must update the Merge Engines in
the Engines preferences page.

¢ Multi tasking group:
When starting a new Content Creation task, the task will immediately commence if there is a
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Merge engine available. How many Merge engines to use is based on the number of records in
the input data.

Select from the following options:

« Optimize per task: This runs each task with as many Merge engines as needed (until
engines are exhausted).
Using this option means that Merge engines will not be reassigned when new tasks come
in.

This option is better suited for batch processing.

» Maximize simultaneous tasks: Merge engines will be reassigned from a running task to
new tasks when they arrive.
To accommodate as many tasks as possible, the server can dynamically reassign Merge
engines to new tasks as they arrive. Thus a running Content Creation task need not block
other tasks.
If multiple Merge engines are processing a task, an engine can be taken from that task and
reassigned to a new task.
As each task finishes, any freed up Merge engines get re-assigned back to still running
tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.

« Additional engine every (records) entry: This controls how many Merge engines are
used for a Content Creation task. It means that for every additional 'x' records in the task,
an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will be
assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines, tasks with
201-300 get assigned 3 merge engines, and so on.

Note: These entries aren't applied instantaneously. There is often a lag. That is why
you can reserve a specific number of engines for new jobs, in the options below.
Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied number,
not because it has been proven to have any significant value. It means that on an average
system (i.e., less than 10 Merge engines) any decently sized task is allowed to use all
Merge engines. It also assumes that using more than one Merge engine for less than 100
records will probably not make a big enough difference to throughput speed. Obviously,
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there are situations where these assumptions will not apply.

Note: Currently, it's only the print and PDF content creation tasks that use multiple
Merge engines.

Parallel Processing properties (Server Configuration)

Whether options are available for selection on this page or not is entirely dependent upon the Number
of engines selection made in the Engines preferences page. If either of the Merge Engines or Weaver
Engines were set to a value beyond one, then options will become available in this Parallel Processing
properties page.

Preset selection (Server Configuration)
Choose from some common usage scenarios. The preset scenarios are:

» Default - Basic settings that are good for running most things. Single jobs have preference over
multi-tasking, however.

» Batch Print - Best settings for processing jobs, one by one, in a sequential, first in first out
(FIFO) order.

* On demand Print - Best settings for processing many small print jobs simultaneously.

* On demand - Use when serving web pages, sending emails, and printing many on demand jobs
simultaneously.

e Connect Send - Settings optimized for use with Connect Send.
Connect Send needs a Merge engine available for on demand web pages, to be able to process
on demand print jobs (especially content creation), and have a Weaver engine available for cre-
ating the production output.

e Capture on the Go - Settings optimized for use with Capture on the Go applications.
Capture on the Go needs on demand content creation for web pages (the forms), emails (noti-
fications), and PDFs (persistent version of forms).

» Custom - where you can chose exactly where and how the engines are to be assigned.
Note: We would recommend basing any Custom settings on one of the preset scenarios.

Select the preset that most closely matches your day to day needs, then tweak those set-
tings.

Only the Custom setting allows you to manually set where and how the engines are to be assigned. If

selected, then options for Content Creation and Output Creation will become available under the two
Tabs named thus.
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Content Creation Tab (Server Configuration)

A Tab with data that relates solely to Content Creation.

The options are:

* Total Merge engines configured read only display: This is a read only entry that shows the total
number of Merge engines available. To change this value, you must update the Merge Engines in
the Engines preferences page.

¢ Multi tasking group:
When starting a new Content Creation task, the task will immediately commence if there is a
Merge engine available. How many Merge engines to use is based on the number of records in
the input data.

Select from the following options:

e Optimize per task: This runs each task with as many Merge engines as needed (until
engines are exhausted).
Using this option means that Merge engines will not be reassigned when new tasks come
in.

This option is better suited for batch processing.

+ Maximize simultaneous tasks: Merge engines will be reassigned from a running task to
new tasks when they arrive.
To accommodate as many tasks as possible, the server can dynamically reassign Merge
engines to new tasks as they arrive. Thus a running Content Creation task need not block
other tasks.
If multiple Merge engines are processing a task, an engine can be taken from that task and
reassigned to a new task.
As each task finishes, any freed up Merge engines get re-assigned back to still running
tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.

« Additional engine every (records) entry: This controls how many Merge engines are
used for a Content Creation task. It means that for every additional 'x' records in the task,
an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will be
assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines, tasks with
201-300 get assigned 3 merge engines, and so on.
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Note: These entries aren't applied instantaneously. There is often a lag. That is why
you can reserve a specific number of engines for new jobs, in the options below.
Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied number,
not because it has been proven to have any significant value. It means that on an average
system (i.e., less than 10 Merge engines) any decently sized task is allowed to use all
Merge engines. It also assumes that using more than one Merge engine for less than 100
records will probably not make a big enough difference to throughput speed. Obviously,
there are situations where these assumptions will not apply.

Note: Currently, it’s only the print and PDF content creation tasks that use multiple
Merge engines.

* Reserve engines for on demand tasks group checkbox:
Reassigning engines is not instantaneous when a new task arrives. To avoid inefficiencies,
Merge engines will first finish work on their current selection of records, before being reassigned.
Reserving engines better ensures that on demand tasks get picked up right away, but it also
means that less engines will be available for large tasks.

The total amount of Merge Engines available for selection here must be set in the Engines pref-
erences page.

Select from the following options:
« Email (engines): Set the amount of Merge engines to reserve for Email jobs.
 Web (engines): Set the amount of Merge engines to reserve for Web based jobs.

* Print and PDF (engines): Set the amount of Merge engines to reserve for Print output
jobs.

* Merge engines available for any task: A read only value that shows how many Merge
engines remain available for selection.

* On demand task size limit (records): An on demand task is a task that has someone (or
something) waiting for it to finish, so these typically need to finish “as soon as possible”.
Often these are single documents but not necessarily always.

This option allows you to designate what a Content Creation on demand task is, based
upon the number of records.
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Output Creation Tab (Server Configuration)

A Tab with data that relates solely to job Output Creation.

If only the single Weaver Engine is configured in the Engines preferences page, then this whole tab will
be disabled.

» Licensed speed limit (pages per minute): This read only entry shows the current license
speed limitations, in pages per minute. The speed limitations are determined by your Connect
license.

This information is to help you choose what settings would make sense when assigning the “Tar-
get speed” values later in the Tab.

» Licensed tasks limit: This read only entry shows the current license task (or job) limitations.
Note: The terms "job" and "task" can be used interchangeably.

+ Total Weaver engines configured: This read only entry shows the total number of Weaver
engines available. To change this value, you must update the amount of Weaver Engines in the
Engines preferences page.

Job sizes group:

These two settings allow you to define what type of jobs are to be considered Small jobs and what
types are to be considered Large. Any job that falls between these two settings (if there is a gap
between the two) will be considered a Medium job.

Small job max (pages): Enter the maximum number of pages a job can have and still be considered
Small.

Large job max (pages): Enter the minimum number of pages a job must have before it is considered
to be a Large job.

Reserved engines group:

These settings allow you to reserve some Weaver (Output) engines for small and medium Output
Creation tasks. This it to prevent large jobs from using all available engines and blocking small or
medium jobs from running. Since Weaver engines cannot switch tasks, such behaviour can only be
achieved through reserving engines for small and/or medium jobs.

Engines may be reserved both for small, and for medium sized jobs. Engine reservations are not
required for either though.

+ Small job (engines): Optionally enter the number of Weaver engines you wish to reserve for
Small jobs.
To make sure large batch jobs get sufficient speed during Output Creation, set a lower target
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speed for small jobs, this will automatically allow more for the large and medium jobs.

* Medium job (engines): Optionally enter the number of Weaver engines to reserve for Medium
jobs.

» Total Weaver engines configured: This read only entry shows the number of Weaver engines
still available. This is the Total engine count, minus the number of engines assigned to both
Small and Medium jobs.

To change this value, you must update the total amount of Weaver Engines in the Engines pref-
erences page.

Target speed when running simultaneous jobs group:

If a single Output Creation task is running, it will be run at the full speed in the license. But when mul-
tiple tasks run in parallel, this speed has to be divided between them. By default, the maximum speed
will be divided equally between tasks.

Use these settings to override what speed (in Pages Per Minute) should apply for each type of job. This
allows you to prioritize one or more type of job above the others. For example, if your production pro-
cess normally handles lots of small jobs, you might want to provide the smaller jobs greater speed
(throughput) than the less frequent Medium and Large jobs.

But if there are so many small jobs that they start limiting the throughput of larger jobs? If there is
always at least one small job running, then the maximum speed for the larger job will stay at half of the
licensed limit. In this case, you might want to increase the target speed for Large jobs.

There are no hard and fast answers as to what settings will work best. It will likely be a matter of trial
and error. But many sites will not need to change speed settings at all.
The options are:

+ Small job (PPM): Enter the target speed for Small jobs, in Pages Per Minute (PPM).
¢ Medium job (PPM): Enter the target speed for Medium jobs, in Pages Per Minute (PPM).
« Large job (PPM): Enter the target speed for Large jobs, in Pages Per Minute (PPM)

The entire licensed speed limit will always be distributed among jobs when running jobs sim-
ultaneously.

After assigning a target speed, any remaining licensed speed will be distributed throughout any sim-
ultaneous jobs by a ration of the target speed.

Some general rules of thumb to apply when distributing target speed:
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® Do you need to change speeds? In many cases there will likely be no need to change the target
speed.

B The target speed is not a guaranteed actual speed, but a speed limit that the engine is allowed to
exceed in order to utilize the licensed speed.

® When changing the target speed, don’t be overly precise, you are unlikely to get that exact value
anyway. It will likely be a matter of trial and error.

® Aslong as you don’t overdo it, the actual speed limit for a task will usually be higher than the tar-
get speed.

B |fthere is a chance of not getting the target speed, you will see a warning in the preference page.

This is just a warning, and nothing will break if you choose to ignore it.

Buttons
The Parallel Processing preferences also provides you with buttons to :

» Restore Defaults. This option restores the preferences to Defaults. This applies to the current
Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but does not
close the Preferences dialog.

Known Issues
This page lists important information about issues that apply to PlanetPress Connect 2022.2.
JDBC connection issue

In OL Connect version 2022.2, the SQL Server driver has been updated to version 10.2.0.jre11. As
opposed to preceding versions, this driver by default attempts to connect to a JDBC database with
encryption enabled if the encrypt parameter is missing from the connection string. This might break
existing JDBC connections, particularly those defined in scripts and in the Database Wizard's
'Advanced Mode'.

To instruct this driver to not use encryption, the ";encrypt=false" parameter needs to be presentin the
connection string.

MS SQL Server deadlock issue

Content creation tasks can get cancelled because related database transaction get deadlocked and
are chosen as the victim for resolving the deadlock.

The database exception will say something like:

Transaction (Process ID 107) was deadlocked on lock resources with another

process and has been chosen as the deadlock victim. Rerun the transaction.
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To solve the issue you might need to kill the PID and restart the process.

This will be fixed in a later release.
Installer issues

The new 2022.1 installer has some minor issues that will be fixed in a subsequent release. The issues
are:

+ After installation, the "recent files" list is cleared and the measurement units are reset from 'cm' to
'inch'.

* When updating from earlier 2022.1.x versions the bundled MariaDB connection settings are
reset.

Dynamic tables causing issues

In some specific circumstances the dynamic tables feature does not behave correctly. The following
scenarios should be avoided to prevent subsequent issues with the template:

* Using page-break-before:always onthe top TR of a TBODY causes a problem and results
in a pagination error

» Itis possible to specify conflicting attributes on a TR element:

e page-break-before:always Orpage-break-after:always combined with data-
repeat

e page-break-after:always combined with page-break-before:avoid on the next
sibling TR (or similar combinations)

These issues will be addressed in a later PlanetPress Connect release.

DataMapper: Automatic Date/Time does not work with certain negative UTC time
zone offsets

The new "Automatic" date parsing option in the DataMapper cannot parse dates with negative
UTC time zone offsets of non-zero minutes.

For example: 2021-03-01T10:00-03:00 will work, but 20271-03-01T10:00-03:30 will not.
Positive time zones with non-zero minutes (such as +70:30) are unaffected.
The negative time zone offsets affected are: UTC -02:30; -03:30; -04:30 and -09:30

This issue will be fixed in a later release. In the meantime, the workaround is to use “Custom” or
“ISO8601” date parsing options in DataMapper.
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CSS inlining colour values now converted to RGB

As of PlanetPress Connect 2021.2 when using the CSS inlining mode "Apply CSS properties on ele-
ments" for emails, all colour values are now converted to RGB, rather than to HEX.

Issues running Connect on Hyper-V 9.0

Some customers have reported difficulties running PlanetPress Connect on Hyper-V version 9.0. In
some instances PlanetPress Connect cannot install and in others the PlanetPress Connect Server ser-
vice sometime stops with a signature error.

To resolve these issue we recommend downgrading to Hyper-V version 8.0 where these issues are not
reported.

Minor font changes

As of Connect 2021.1 we no longer round fonts to pixel size. This can lead to tiny differences in the out-
put (of 1-2 pixels) when compared to earlier versions.

Changed Omit Master Page Back behaviour

In versions of Connect prior to 2020.2, if a page had no content except for a linked DataMapper back-
ground, then Connect would consider it an "empty" page when determining whether or not to "Omit
Master Page Back in case of an empty back page" (available as an option in the sheet configuration of
a section). This has now been fixed in Connect 2020.2, and such pages are no longer considered
empty.

This could impact on the output from existing templates.
Issues associating PDF files with Connect

Under certain circumstances, Connect Setups prior to 2019.2 would fail when attempting to add the
"Enhance with Connect" association with PDF files. This would then cause the setup to appear to fail.

Whilst this issue has been fixed in the Connect 2019.2 installer, if a user had previously experienced
the issue and temporarily worked around it to complete the installation, then the Connect installer will
fail on upgrade or uninstallation.

To get around this, a manual uninstall is required, or a modification to registry entries.
Issues when loading some Workflow plugins for the first time

Under some circumstances, certain of the new Workflow plugins introduced with Connect 2019.2 will
fail to load correctly when run for the first time. Instead of opening the plugin dialog as expected, the plu-
gin hangs and displays a message that it is "Loading Ul .... ". This is due to an issue with a third party lib-
rary which will be addressed in a future release.
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To get around the problem, please close and reopen the plugin. The problem only occurs on the initial
opening, and should work fine thereafter.

The license update introduced in OL Connect 2019.1 does not cater for existing
AFP input licenses

AFP Input is an add on option for OL Connect licenses. Unfortunately, the update to the 2019.1 version
of the OL Connect license does not cater for existing AFP input licenses.

If you have an existing AFP input license we ask that you contact your local Customer Care team after
the initial license update is complete and have them add the AFP input option back into your license.
(See (https://www.objectiflune.com/WebActivationManager/Carelnfo.aspx.)

Page break changes in 2019.1

Improved page breaking in Connect 2019.1 might impact upon some existing templates.
It is recommended that you check page breaking in existing jobs, where page breaks at a specific loc-
ation are a known criteria.

Issue after erroneous or incomplete update or re-installation

If one or more products (the Connect Designer, Connect Server, Software Activation, Print Manager, or
Server Configuration Tool) or engines exit within a second of starting, this may be caused by a recent
erroneous or incomplete uninstall before a reinstall or upgrade to a newer version of OL Connect. (See
Product or engine exits within a second of starting in Connect's Knowledge Base: http://help.ob-
jectiflune.com/en/kb-connect/#KB/FAQ/OL Connect/KB2019.htm.)

This may be solved by deleting the $UserProfile%\Connect\.eclipse directory.
For guidance on a full manual uninstallation please see the Solution in: Problems during a Connect

installation or version upgrade in Connect's Knowledge Base: http://help.objectiflune.com/en/kb-con-
nect/#KB/FAQ/OL Connect/KB2002.htm.

Backend database might require periodic maintenance

Databases maintain a variety of statistics in order to optimize performance. When high levels of inserts
and/or deletions occur, the statistical data keeping can struggle to keep up. Over a period of prolonged
and intensive processing this can result in a degradation in performance, with the whole database slow-
ing down as it struggles to clean itself up.

In Connect terms the effect can be felt as the Data Mapper and/or Job Creation progressively slowing
down.

To cure this issue, it is recommended that you periodically run manual maintenance on the backend
database.

If using MySQL, the following script should be run in a query window:
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set @a=null, @c=null, @b=concat ("show tables where",ifnull (concat (" "Tables in
",database(),""  like '",@c,"' and"),'')," (Ra:=concat ws(',',6@a, Tables in

",database(),""))");

Prepare “bd’ from Qb;
EXECUTE “bd’;
DEALLOCATE PREPARE “bd’;

set @a:=concat ('optimize table ',(@a);
PREPARE “sgl’ FROM (@a;

EXECUTE ‘sql’;

DEALLOCATE PREPARE “sqgl’;

set @a=null,@b=null,@c=null;

If using Microsoft SQL Server run the following command in a query window:
sp_updatestats
Windows 10 Search service impacting Connect

The Windows 10 Search service runs as a background task, indexing files and folders. It has been
noted that this background task is sometimes preventing files being added to the Connect temporary
files folder when large amounts of files are being output and copied.

If this is an issue for you, we suggest disabling Search Indexing on the C:\Users\<username>\Connect
folder.

This issue will be fixed in a later release.
Job Creation Presets: External Sorting change introduced in 2018.2

Versions prior to 2018.2 did not correctly save the line end characters for external sort configurations in
Job Creation Presets, which meant the job could not be externally sorted. This issue has been fixed in
version 2018.2. However, Job Creation Presets created with an earlier version may still have the wrong
line end character for external sorting. To fix this, open the Job Creation Preset in the new version,
reset the line end setting in the sorting options and then save the preset.

Engine Preferences: Backward Compatibility Issues introduced in 2018.2

» Prior to version 2018.2 Connect allowed a mixture of internal and external engines. As of Plan-
etPress Connect 2018.2 this is no longer allowed.

When upgrading to PlanetPress Connect 2018.2 from such installations, the pre-existing settings
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will not only no longer apply, but can cause scheduling preference conflicts for the Merge and
Weaver engines.

To fix this, any pre-existing Connect installation that was running a mixture of internal and
external Merge and Weaver Engines must first restore their scheduling preferences to the default
values. This can be done by clicking on the Restore Defaults button in the Scheduling pages of
the Server Preference or the Designer Preference dialogs.

» The Designer's scheduling settings are only updated correctly for the user actually performing
the update.

Business Graphics: Backward Compatibility Issues introduced in 2018.1

As a consequence of changes in both the user interface and the underlying technology, Business
Graphics made with a version prior to PlanetPress Connect 2018.1 may not display correctly when
opened in version 2022.2.

The currently known backward compatibility issues are listed here:
All charts

» Legend position: The position of the legend is not converted. It defaults to 'left' in a converted
chart.

* Rows are series/Columns are series: Only one type of data structure for detail tables is sup-
ported in the new version: the one that corresponds to the former Columns are series setting
(with which charts display one series per record, one bar/point per data field). After conversion to
2018.1, charts that used the Rows are series setting will be displayed as if the Columns are
series setting were used. Pie charts will thus only show data from the first record in the detail
table. If the number of records in the detail table remains consistent, then the charts can be cor-
rected by modifying the data mapping configuration (see "Preparing a data table" on page 630 in
the Online Help: https://help.objectiflune.com/en/PlanetPress-connect-user-guide/2022.2.).
Otherwise the data needs to be transposed via script.

* NOTE: Expanded custom chart scripts cannot be converted.
Pie charts

» Default colors: The default colors (used when no pie chart colors are specified) have changed.
Line and Bar charts

* Legend label: In previous versions, the name for a values series (needed for the legend) could
only be taken from a field outside the detail table. The value of the selected field would be used.
Setting a different label required expanding the chart script. After conversion, the name of the
field is used instead of the value. Setting a different label can now be done in the Edit Chart Script
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dialog (see "Selecting data for a Business Graphic" on page 628 in the Online Help:
https://help.objectiflune.com/en/PlanetPress-connect-user-guide/2022.2.

Known Font issues

The following font(s) are known to have issues in PlanetPress Connect 2022.2:

* Benton Sans CFF font
Minor differences in PCL output introduced in 2018.1

The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was updated for
Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update could lead to increased output file sizes for some PCL jobs. This is generally not a
cause for concern, however there might be some associated increase in processing times, as well as
some minor differences in the output. For example, table line widths and font spacings might differ
slightly (particularly for SMALL CAPS text), which could lead to slightly different word-wrapping in some
circumstances.

Windows Server 2016 issue
As of PlanetPress Connect 2018.1 Connect is officially supported under Windows Server 2016.

Please note, however, that the Upland Objectif Lune Update Client application might be blocked by
the enhanced security settings in Windows Server 2016.

To fix this, add http://updates.ca.objectiflune.com to the list of trusted web sites on that machine, or
lower the internet access rules.

Limit of T00MB of image files within a single job

The browser component (Mozilla Gecko) used in the WYSIWYG editor of the Designer was updated for
Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update also introduced a limit of 100MBs for image files included within a single job. The
limit is set at 100MB deliberately, as this allows most jobs to run faster. However, if a job requires more
than 100MBs of image files, then the Connect image cache size can be increased to cater for such.

Please contact OL Support for instructions on how to modify the image memory cache value, if
needed.

Print Output: Booklet Impositioning changes introduced in 2018.1

When Booklet Impositioning is enabled, all pages within a document need to be changed to duplex
prior to Impositioning . The method for duplexing jobs has been changed to now always combine exist-
ing pages into the front and backsides of sheets, rather than adding empty backsides to any simplex
pages.
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The result is that now every document in the job becomes a booklet without any empty pages between
the first page and the last page.

With some exceptions. Booklet Impositionings that require a multiple of 4 pages (Saddle binding and
Perfect binding) will still get empty pages added, when needed.

Issues with Microsoft Edge browser
The Microsoft Edge browser fails to display web pages when the Workflow's CORS option (in the HTTP

Server Input 2 section) is set to "*". This issue will be resolved in a future release.
Installation paths with multi-byte characters

When installing the Chinese (Traditional or Simplified) or Japanese versions of Connect, if the user spe-
cifies an alternative installation path containing multi-byte/wide-char characters it can break some of
the links to the Connect-related shortcuts in the Start Menu and cause an error to appear at the end of
the installer. The workaround for the moment is to use the default installation path. The problem will be
addressed in a later release.

Switching languages

Changing the language using the Window > Preferences > Language Setting menu option does not
currently change all of the strings in the application to the selected language. This is a known issue and
will be fixed in a later release.

In the meantime we offer the following workaround for anyone who needs to change the language:

1. Go to the .ini files for the Designer and Server Config:

e C:\Program Files\Objectif Lune\OL Connect\Connect Design-

er\Designer.ini

e C:\Program Files\Objectif Lune\OL Connect\Connect Server Con-

figuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es | de | fr| it | ja
| ko | pt]tw | zh
Only one of the above language tags should be selected. Once saved, Connect will appear in the selec-
ted language at next start-up.

GoDaddy certificates

When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most users should

use the default settings and click Next. In some cases, however, this may not work correctly. For this
reason those users should activate Place all certificates in the following store and then select the
Trusted Root Certification Authorities as the target certificate store.
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MySQL Compatibility
The minimum supported MySQL version is MySQL 5.6.
PostScript print presets

The print presets for PostScript were changed from Version 1.1 onwards meaning that some presets
created in Version 1.0 or 1.0.1 may no longer work.

Any PostScript print preset from Version 1.0 that contains the following will not work in Version 2022.2:
*.all[0].*

Any preset containing this code will need to be recreated in Version 2022.2.

Available Printer Models

Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of the Print
Wizard by default.

To add additional printer models click on the settings “| button next to the Model selection entry box.

Note that the descriptions of some of the printers were updated in version 1.2 meaning that if you had
version 1.n installed, you may find that the same printer style appears twice in the list, but with slightly
different descriptions.

For example the following printer types are actually identical:

» Generic PS LEVEL2 (DSC compliant)
 Generic PS LEVEL2 (DSC)
External resources in Connect

There are certain limitations on how external resources can be used in Connect. For example if you
want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you do not want
to have a copy of the file saved with the template you need to do the following:

1. The resource must be located where it can be accessed by all Servers/Slaves run as users. Fail-
ure to do this will cause the image to appear as a Red X in the output for all documents which
were merged by engines which could not access the file. The job will terminate normally and the
error will be logged.

2. The file must be referenced via a UNC path e.g.,
file:////lw2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg

* UNC paths are required because the services will be unable to access mapped network
drives (Windows security feature).
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» The engine processing the job will look on the local file system for the direct file path lead-
ing to the “resource not found” issue mentioned above.

Caution: The Designer itself and Proof Print do not use processes that run as services and they
may find local files with non-UNC paths which can lead to the false impression that the resources
are correct.

Using Capture after installing Workflow 8

If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, Capture can
no longer be used within Workflow 7. The plugins are now registered uniquely to Workflow 8 and the
Messenger for Workflow 7 is taken offline. It is only possible to use Capture from PlanetPress Connect
Workflow 8 thereafter.

Capturing spool files after installing Workflow 8

If PlanetPress Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, the Plan-
etPress Suite 7 option to capture spool files from printer queues will no longer function. The solution is
to use PlanetPress Connect Workflow 8 to capture spool files from printer queues.

Color Model in Style Sheets

The color model of colors defined in a style sheet can sometimes change after editing the style sheet.
This is a known issue and will be addressed in a subsequent release.

Image preview in Designer

If in the Windows Internet settings (Connection Settings > LAN configuration) a proxy is enabled,
but "Bypass proxy settings for local addresses" is not checked, the image preview service, conversion
service and live preview tab in the Designer will not work and exhibit the following issues:

» Images will be shown as 0 size boxes (no red 'X' is displayed).

« Live preview does not progress, and when re-activated reports "browsers is busy".

To fix the issue you must check the "Bypass proxy settings for local addresses" option.
Merge/Weaver engines when printing

The print operation in the Designer will automatically detect whether the Merge\Weaver engines are
available and display a message for the user to retry or cancel if not. Once the Merge/Weaver engine
becomes available and the user presses retry the print operation will proceed as normal. This message
can also occur in the following circumstances:

« If the server is offline and you are not using Proof Print.
* On some occasions before the Print Wizard opens.

REST Calls for Remote Services
The Server will accept REST calls for all remote services and will make commands wait indefinitely
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until the required engines become available. The Server will log when it is waiting for an engine and
when it becomes available. Note that there is no way to cancel any commands other than stopping the
Server.

Print Content and Email Content in PlanetPress Workflow

In PlanetPress Workflow’s Print Content and Email Content tasks, the option to Update Records from
Metadata will only work for fields whose data type is set to String in the data model. Fields of other
types will not be updated in the database and no error will be raised. This will be fixed in a later release.

Print Limitations when the Output Server is located on a different machine

The following limitation may occur when using the Print options from a Designer located on a different
machine to the Output Server:

» The file path for the prompt and directory output modes is evaluated on both the client AND
server side. When printing to a network share it must be available to BOTH the Designer and
Server for the job to terminate successfully.

* The Windows printer must be installed on both the Server and Designer machines.

« When printing via the Server from a remote Designer, the output file remains on the Server
machine. This is remedied by selecting “Output Local” in the Output Creation configuration.

VIPP Output

Some templates set up with landscape orientation are being produced as portrait in VIPP. It can also
sometimes be the case that text and images can be slightly displaced. These are known issues and will
be addressed in a later release of Connect.

Magic Number changes when installing Docker

Installing Docker on a system where Connect has already been installed may impact Connect's licens-
ing mechanism and require reactivation.

Note: Installing Connect after Docker has already been installed will not cause issues.

Uninstalling

This topic provides some important information about uninstalling (removing) PlanetPress Connect
2022.2.

To uninstall PlanetPress Connect select the application from within the Add/Remove programs option
under the Control Panel. This will start the PlanetPress Connect Setup Wizard in uninstall mode.

Note: The PlanetPress Connect Setup Wizard might take some seconds to appear.
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Important: Stop any active Anti-Virus software before uninstalling Connect back-
end database.

Some anti-virus systems are known to block the uninstallation of MariaDB datafiles, as well as blocking
the uninstallation of the MariaDB database application itself. If you wish to uninstall the Connect back-
end database it is highly recommended that any anti-virus application be stopped prior to uninstalling
PlanetPress Connect, as otherwise the Connect uninstallation might not work correctly.

Impacts upon other applications and services
» The Uninstall will terminate the installed Server / MariaDB service(s).

» The following applications / services should be stopped in a controlled fashion, before running
the PlanetPress Connect Uninstall:

1. PlanetPress Connect

2. Connect products on remote systems which refer to this MariaDB database.

3. Any Connect Workflow using PlanetPress Connect plugins which connect to this server.
Uninstallation Wizard

The uninstallation is done by running the PlanetPress Connect Setup Wizard in uninstall mode. The
Wizard contains the following important pages:

1. PlanetPress Connect Setup: This page allows selection of what is to be done. An modification
to the existing installation (Add or Remove Features) or full Uninstall.
NOTE: If the Uninstall option is selected the Remove user data option is made available. For
information about exactly what data would be saved or deleted, please see "Pre-existing User
Data" on page 63.

2. Component Selection: If Add or Remove Features was selected on previous screen, this
page provides options for adding or removing Connect features.
For detail descriptions of the options, see Installation "Component Selection" on page 33 .

Note: If an error occurs during uninstallation or after/when re-installing Connect after uninstalling
it, please see Problems during a Connect installation or version upgrade in Connect's Knowledge
Base.

General information

Connect consists of visible and invisible parts. The invisible parts process the Connect job to provide
the actual output. They are introduced to you in the topic: "Connect: a peek under the hood" on the
facing page.

For information about Connect logging, see "Log files" on page 118.

For a list of all file types used in Connect, see: "Connect file types" on page 119.
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You can find additional information that complements the user manuals, such as error codes and fre-
quently asked questions about PlanetPress Connect, in the Knowledge base.

Connect: a peek under the hood

Connect consists of visible and invisible parts.

The visible parts are the tools you use to create templates, data mapping configurations, and Print Pre-
sets (the Designer/DataMapper), and to create Workflow configurations (the Workflow configuration
tool).

The invisible parts process the Connect job to provide the actual output. This topic introduces you to
those parts.

Here's a simplified, graphical representation of the architecture of PlanetPress Connect. The com-
ponents described below are all located in the 'Server' part.

Workflow Server Connect Server Server

q DataMapper
Data Mapping engineF;:)

Content
Watch PlanetPress Connect G

service Server service
HTTP service Job Creation

Connect
Merge engine(s) Database

Messenger Output Weaver File Store
service Creation engine(s)

Workflow Data mapping Job
Workflow ) : . .
Configuration configurations Presets Connect Server
Service

Configuration

Console Output

Templates
Presets

Wc?rkﬂow Connect Designer
Configuration (DataMapper,
Tool Template Designer)

The Workflow server

The Workflow server (also referred to as the 'Watch service') executes processes independently, after
a Workflow configuration has been uploaded and the services have been started. The Workflow server
can run only one configuration at a time.
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There are a number of services related to Workflow. The PlanetPress Messenger service, for
example, receives the files sent to Workflow from the Designer and the Workflow configuration tool.
The Workflow Service Console lets you start and stop the different services, except the Connect server,
and see their log files (see Workflow Service Console).

Note that Workflow isn't limited to Connect functionality. It was originally developed as part of the Plan-
etPress Suite. Many of the plugins in the Workflow configuration tool are older than Connect. They
were left in for compatibility reasons, even though they aren't all useful or usable within Connect.
However, the Connect plugins cannot be used with the PlanetPress Suite software.

The Connect server

As opposed to the Workflow server, the Connect server was designed to be used only with Connect.
The Connect server performs several different tasks, all of which are related to Connect content and
content management:

It communicates with the Workflow service (with the Connect plugins, specifically) and with the
Designer when output is generated from the Designer. It creates records (by extracting data from a
data source using a data mapping configuration), and jobs. It communicates with the engines (see
below) in order to make them create content items and output (spool) files.
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The Connect server is one of the components that has to be installed with Connect (see "Installation
Wizard" on page 32).

In the Workflow Configuration Tool preferences you have to set the OL Connect server settings to
enable Workflow to communicate with the server (see Workflow Preferences).

The Connect Server Configuration tool lets you change the settings for the Connect server, the
engines and the service that cleans up the database and the file store. These settings can also be
made in the preferences of the Designer.

The Connect database

The Connect database is the database back-end used by Connect itself when processing jobs. It can
be either the MariaDB instance provided by the Connect installer, or a pre-existing (external) instance
(see "Database Considerations" on page 16).

All generated items (records, content items etc.) are stored in this database. They can be used by the
next task in the same process or in a process that runs later, making it possible to commingle Print jobs,
for example.

Note: Email content items are not stored in the Connect database.

A clean-up of the database is performed at regular intervals in accordance with the settings (see
"Clean-up Service preferences" on page 783).

The File Store

Connect has its own File Store which it uses for transient files.
The Clean-up service takes care of removing obsolete files when those files are not marked as per-
manent (see "Clean-up Service preferences" on page 783).

Tip: The File Store is accessible for customer implementations. The Workflow configuration tool
implements three tasks that allow you to Upload, Download and Delete files in the Connect File
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Store. The files can be accessed through the REST API, which means web portals could poten-
tially access the files directly without having to go through a Workflow process (see The Connect
REST API CookBook).

The engines

DataMapper engines. A DataMapper engine extracts data from a data file. The number of DataMap-
per engines is configurable (Engines preferences).

Merge enginel/s. A merge engine merges data with a template using the scripts in the template, in
order to create content items.

The number of merge engines is configurable (see Engines preferences): it can be increased depend-
ing on the capacity of the machine that runs the solution (see "Performance considerations" on

page 23).

Weaver engines. A Weaver engine creates Print output from Print content items. It takes the settings
made in Print Presets or in the Print Wizard into account.
The number of Weaver engines is configurable as well (see Engines preferences).

Note: The Proof Print function doesn't print via the Connect Server; it uses the Designer's
internal engines.

The REST API

The Connect server receives REST commands (see The Connect REST AP| CookBook), normally
either via the Workflow service or from the Designer. This design allows the Connect functionality to be

used by other applications. The server forwards the commands to the appropriate engine and returns
the results to the caller. The results are the id's of the items (records, content items, job etc.) that are
stored in the Connect database (see below). All Connect tasks except the Create Web Content task
integrate the results in the Metadata in Workflow.

The figure below shows the communication between Connect tasks and the Connect server in a Print
process.
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Printing and emailing from the Designer

To print or send email from within the Designer, the PlanetPress Connect service has to be running.
The service is started automatically when the Designer starts, but it may not be running if the Connect
Server and the Designer are installed on different computers. The PlanetPress Connect service can be
found on the Services tab in the Task Manager.

For a proof print the Connect server is not used. Proof printing is always done locally, by the Designer.

Log files
Location
Connect's log files are located in the following folder: C:\Users\ [UserName] \Connect\logs.

Where [username] is replaced by the appropriate Windows user name.

Tip: Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a French
system, for example, it would be 'C:\Utilisateurs'.

Type suserprofile% in a Windows File Explorer and press Enter to open the actual current
user's home directory.

Every time output is generated, the Designer and/or Connect Server and any engines involved in the
operation produce their own log files.

Each component writes its log files to a dedicated subfolder of the Log folder. The following folders will
likely be of the most benefit.

* Merge engines write to the 1ogs/Mergeengine folder
» Weaver engines to the 1ogs/Weaverengine folder
» DataMapper engines to the 1ogs/Datamapperengine folder

e Servertothe logs/Server folder
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Note that actions of the Cleanup service are only logged in the Server's log file. (See also: "Clean-up
Service preferences" on page 783.)

Note: Workflow services write their logs to an entirely different location. See Accessing the
Workflow logs.

Tip: For more information about Connect's architecture, see: "Connect: a peek under the hood"
on page 114.

Name

The name of a log file consists of the component’'s name, a time stamp and the Windows process ID.
The Windows process ID is needed since multiple engines of the same type could be running at the
same time, depending on the engine configuration (see "Engine configuration" on page 87) and the
size of a job.

Format

The log files are text files that can be opened in any text processor. Each log file contains a header sec-
tion containing a snapshot of the current working environment (Connect version, operating system, sys-
tem locale settings, disk and RAM information, and such like).

The logging level is configurable, as well as the exact format - the "logging pattern" - of the individual
log messages.

» The Designer's logging preferences are set via the Designer; see: "Logging preferences" on
page 799.

» The Connect Server's settings are maintained by the Connect Server Configuration utility tool;
see "Server Configuration Settings" on page 82. The logging level that is set applies to the Server
as well as the engines.

The Designer's log messages are also displayed in the Messages pane (see "Preflight Results and
Messages" on page 975). The Log Filter allows you to decide what kind of events may be shown in the
Messages pane (see "Log Filter" on page 976). That doesn't change the actual logging level of the
Designer, however; it only filters the log file.

Connect file types

This article describes the different file types that are related to PlanetPress Connect and its different
modules. These are files that are generally transferable between machines, can be sent via email or

other means.
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.OL-template: A Designer Template file (see "Templates" on page 414). Is linked to a data map-
ping configuration by default, but not necessarily.

» .OL-datamapper: A data mapping configuration file, which can include sample data (excluding
database source files such as MariaDB, MySQL, Oracle, etc). See "Data mapping con-
figurations" on page 199.

» .OL-datamodel: A data model file which can be imported or exported into either a data mapping
configuration or a template. Contains a list of fields and their data type (date, currency, string,
etc). See "The Data Model" on page 260.

» Print Presets are used when generating a job, ready for output, from Designer (see "Generating
Print output from the Designer" on page 1317) or through Workflow (see "Print processes with OL
Connect tasks" on page 172).

* .OL-jobpreset: A Job Creation Preset file has settings for data filtering and sorting, group-
ing (groups are used to split the print output), adding metadata fields, and finishing options
that override the template's Media and Section settings. (See "Job Creation Presets" on
page 1322.)

* .OL-outputpreset: An Output Creation Preset file is used to generate the actual print out-
put in the appropriate format (pcl, pdf, etc). It includes print settings such as impositioning
(N-up, cut & stack), inserter marks, tray settings, separation etc. (See "Output Creation Pre-
sets" on page 1324.)

» .OL-package: A transfer file used to package one or many of the above files (the data model
being part of both the template and the data mapping configuration). Created by using the File >
Package dialog. (See "Package dialog" on page 906.)

» .OL-script: One or more Designer scripts. Scripts personalize the output of a template. They are
either added via wizards (see "Personalizing content" on page 708) or self-written (see "Writing
your own scripts" on page 808). They can also be imported or exported from the Scripts pane in
Designer when a template is open.

e .OL-printerdef: A Printer Definition File is used by the Output Creation Preset (see "Output
Creation Presets Wizard" on page 1084) to determine what type of output to produce. These
definition files are generated by an internal application that is not currently distributed outside of
OL, but the definition files themselves can be provided.

.OL-workflow: A Workflow file used by PlanetPress Workflow. Equivalent to .pp7 files (they are,
in fact, essentially the same format), containing the processes and such used by Workflow.

OL Connect projects

An OL Connect project is an automated process, or combination of processes, in which the Connect
Server and Database are used. (For an overview of the architecture of the OL Connect software, see
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"Connect: a peek under the hood" on page 114).

Typically, an OL Connect project aims at automating (part of) a company's communication with its cus-
tomers, suppliers, or other parties. Data is received - in whatever form -, processed, stored, and used in
communications which are sent out through one or more output channels (print, email, web, etc), imme-
diately or at a scheduled time.

Automation with Workflow

The process automation server included in PlanetPress Connect is called Workflow.
The Workflow server (also sometimes referred to as the "Watch service') executes processes inde-
pendently, after a configuration has been uploaded and the services have been started.

Usually, all of OL Connect's design tools are involved in the development process:

» Input data is extracted from a data source using a data mapping configuration, created with
"The DataMapper" on page 198.

» Communications are created by merging the data with one or more templates, designed with
"The Designer" on page 412.

« If the output channel is print, Print Presets, also created with the Designer, determine how the
documents are printed.

» The pieces come together in an automated process, e.g. a Workflow configuration, created
with the Workflow Configuration Tool.

Each of the tools has its own Online Help, but if you're new to either Workflow or the OL Connect soft-
ware in its entirety, this chapter will help you get started on building OL Connect solutions.

Tip: Sample Project

The OL Connect software comes with a number of Sample Projects that generate a Workflow con-
figuration, and any Connect templates, data mapping configurations, and Print Presets required
to make the project work. For more information, see "Sample Projects" on page 918 in the online
help or the Sample Projects overview video on the OL Learn website.

Typically, in an OL Connect project there is a number of Workflow processes that communicate with
the Connect Server, Database and/or File Store through one or more of the specially developed OL
Connect tasks.

For help on building these Workflow processes see "Workflow processes in OL Connect projects” on
page 168 and "OL Connect tasks" on page 169.

Using the REST API

The OL Connect Server, Database and File Store can also be accessed through the REST API, i.e. ina
script. The script could be part of a Workflow process (i.e. a Run Script task), but it could also be in a
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web page or portal, which means you could potentially access the OL Connect Server, database and
File Store directly, without having to go through a Workflow process, or with another automation tool
such as Node-RED.

The OL Connect REST API gives access to a number of areas including its processes, data entity man-
agement and File Store operations.
These services can be used to perform various interactions with the OL Connect server such as:

» Upload and manage data files, data mapping configurations and templates in the File Store.
» Create, manage and find data entities internal to the OL Connect Server.

» Create and monitor processing operations within the OL Connect Server.

For examples and the REST API reference see The Connect REST API CookBook.

The Designer can send templates, data mapping configurations and print presets to a Connect
Server; see "Sending files to Connect Server or to another server" on page 419.

Versioning

You can create versioned projects. A versioned project retains a record of the changes made to any file
in the project. You can review changes, and also revert to a previous version of a project, if necessary.

Note: Versioned projects are created from the Project menu at the top of the Welcome (or Home)
screen. Projects created with the Sample Projects wizard are not versioned.

As you work on your project files, you can commit the files in the project at any time. When you commit
the project, a snapshot of the project is saved as a version. Any additional information associated with a
resource in the project is recorded alongside the file.

Use the Project Files option in the Project menu to display the list of resources in the project.

d F
File Edit Insert Format Context Section View Window | Project
NHehe &l @& 1" ® open.

Paragraph v | Default v A MNew...

| B e 2 | Commit...
[/ Resources | 5= Outline Project files

Media Versioning history

The files comprising a Project display in the Project Files panel.

Page 122

elalal=


http://help.objectiflune.com/en/PlanetPress-connect-rest-api-cookbook/2022.2/

- Attributes | B8 Styles | == Translations = B8

-1 General

|| Data Model |[C] Parameters | T Project files » | I Versioning History| = B

letter-oasis

€

Project files
= .gitignore
& Ietter-oasis-en.OL-template
{z} letter-oasis.OL-datamapper

Use the Versioning History option in the Project menu to display the history of all changes. The Ver-
sioning History panel contains a complete record of who did what, on which date, and for which

reason.

- Attributes B Styles| = Translations = B8
= General

|| Data Model |5 Parameters | O Project files | I Versioning History x = B8

Versioning history

€

Commit ID Message Com.. Committed on *
| Adfcl618 ¢ Updated template for conn.. New  2022-03-22T15:22:31
cd0e44f6 ¢ initial commit New  2022-03-22T15:21:04
Commit message Committed items
Updated template for connect 2022.1 modifi... letter-oasis-en.OL-template

You can elect to revert to a version from within the history if something turns out to be flawed in your cur-
rent project.

Both the Designer and the DataMapper use Git integration to maintain the history of a Project.

Note: The first time you open or create a new project you may be prompted to enter your name
and email. This is used to identify changes in the project history.

Versioned projects

A versioned project is essentially a folder that contains a collection of related files whose changes are
tracked. When you create a versioned project, all changes to the project are recorded and stored in the
project history. You can use the project history to review changes made to the project, and even revert
to a previous version if something goes wrong.
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As you work on your project files, you can commit files in the project at any time. When you commit files
in the project, a snapshot of the project is saved as a version, along with your name, your commit mes-
sage, and the date. The status of each file - whether it was added, modified, etc. - is recorded as well.

OL Connect uses Git integration to maintain the history of a versioned project in a local repository. Pro-
jects can be created and committed from within OL Connect Designer and DataMapper.

Creating versioned projects

Versioned projects are created from the Project menu at the top of the screen in OL Connect Designer
and Datamapper.
You have two options:

» Create a new versioned project that is only stored /ocally.

» Clone a project that exists on a cloud-based platform into a local repository.
How to clone a project is explained in "Versioned projects in the cloud" on page 129.
This is how you create a new /ocal project:

1. Select Project > New from the menu at the top of the screen.

d PReS Connect Designer (Project: promotional-letter)
File Edit Insert Format Context Section  View Window  Project  Help

& E@' @"%&5._-?| I—Ca Open...
| BB ® k2[4 [z =08 New.
i/ Resources| o= Outline ] |4~ B [g Clone.
| type filter text Close
w ||, Media £ Project files
L] Media1 E'  Versioning history
w ||, Master pages
|| Master page 1 =t Commit...
v |[J Contexts 4 Publish Commits
L[] Print 4 Publish tags...
d Images & Check remote changes
|| Fonts
|| JavaScripts - Check and apply changes
w || Stylesheets I :_I ]

The first time you create a project you may be prompted to enter in your name and email address.
This information is required by Git, and your name is used to identify changes in the project his-

tory.
Via the menu: Window > Preferences > Versioning, you can change this information at any
time.
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2. Each versioned project needs to be stored in its own folder. Select the folder in which to store the
project. The folder name will actually become the name of the project.

The software suggests to store all versioned projects in the OL Connect folder that is located in
the Documents folder, with each project having its own folder under Documents/OL Connect.

Tip: If the folder doesn't exist yet, right-click in the right part of the dialog, where the exist-
ing folders are listed, and select New. Type the name of the folder that you wish to create
and click OK.

Note: If you select an existing folder, be aware that any file that is present in that folder will
automatically become part of the project.

3. Now you can create a new template or data mapping configuration (File > New) or open an exist-
ing one (File > Open) .
As soon as you save a file in the project folder, it becomes part of the project.

Tip: You can add a Workflow configuration to a versioned project, simply by saving it in the
project folder and then committing the project.

4. Torecord this version in the repository, select Project > Commit. This records the project files
as a new version in the repository. Remember to save any changes before you commit.

Note: The .gitignore file in the project folder tells Git which subfolders and files should not
be committed.

5. Enter information to describe the changes, then select OK. Describing the changes is important
as it will allow you, later, to readily identify each version as you browse through the project his-
tory.

Page 125

Connect



d Commit TEssage

Committed itemns

Commit item State
Project 1 Draft.OL-template untracked
initial content. OL-template untracked

Comrmit message

Title: Initial Draft

Body:
¥ Please enter the commit message for your changes.
¥ Lines starting with  will be ignored

&

# untracked: Project 1 Draft.OL-ternplate

# untracked: initial content.OL-ternplate

Once created or opened, a versioned project remains open until it is closed via the menu: Project >
Close, or until (a file from) another project is opened. As long as a project is open, the software will
open the project folder every time you want to open or save a file.

Note: Versioned projects have a hidden .git folder. Do not remove this folder. It contains the ver-
sion history and, in the case of an online versioned project, information about the remote repos-
itory.

Viewing project history

The project history contains the records for all of the changes made to each resource in the project.
When you commit a project, a snapshot of the project resources is stored as a version. You can review
the versions to see what changes were made, who made them, and when they were made.

To see the history of the project:
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1. With the project open in Designer, select Project > Versioning history from the menu bar.

2. The history displays in the Versioning History tab.

You can select a version from the list to display more information about the changes made in that ver-

sion.
. Attributes | B Styles| = Translations = 8
-~
= General >
[ Data Model |2 Parameters| [ Project files| ] Versioning History > =
Versioning history @
Commit ID Message Com.. Committed on +*
‘ 4dfc0618 * Updated template for conn.. New  2022-03-22T15:22:31
cdOed4fo + initial commit New  2022-03-22T15:21:04
Commit message Committed items
Updated template for connect 2022.1 modifi.. letter-oasis-en.OL-template

Restoring a version

To restore a previous version, select the version, then select the Restore icon. The project is reset to
the state it was in when that version was committed.

Reverting individual files

Instead of restoring an entire version you may revert individual files to a previously committed version.
This is done in the Project files panel. Right-click the file and select Revert. Remember to commit the
project so that the reverted files become part of the current version.

Viewing project content

Select the Project files option from the Project menu to display the list of resources in the project.
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d PRe5 Connect Designer (Project: prometional-letter)
File Edit Insert Format Context Section  View Window  Project  Help

= & @ @ &[5 [$ Open.
| E - ®dhi2 5 = =08 New.

LEl Resources 0= QOutline =] |4 E (g Clone..
| type filter text Close
v || Media 9 Project files
[ Media T 5l Versioning history
w || Master pages
|| Master page 1 =1 Commit...
v [ Contexts 4 Publish Commits
L[] Print & Publish tags...
1 Images 4 Check remote changes
|| Fonts
[l JavaScripts a Check and apply changes
w || Stylesheets il :_I ]

The files comprising a project display in the Project files panel.

' Attributes | & Styles | -— Translations = B8

-1 General

|| Data Model | Parameters | O Project files > | [ Versioning History)] = B

letter-oasis

€

Project files
=l .gitignaore
¢ letter-oasis-en.OL-template
{z} letter-oasis.OL-datamapper

Using tags

The Tag functionality allows any commit to be identified with a user-defined label. Think of it as setting
a flag on your versioning history whenever you want to highlight that, at that specific stage, something
is more remarkable than on other commits. For instance, you can mark the latest commit with a tag
named Version_1, thereby indicating that this is the first version of the entire project that goes into pro-

duction.

To do that, simply right-click on one of the commits in the Version History and select Set Tag, then

enter a tag name.
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Versioning history & @

Commit.. Message title Committed by Committed ... | 4
12253664 W@  Channnd camathinn in tha lnks Noe 2022-10-18... .| =
91546ac3 4p & Restore this version 24 2022-10-18...

4F Settag..

Note: Tag names must be unique. A different capitalization does not make a name unique.
Spaces are not allowed.

The Versioning history panel displays any tags immediately before the message title:

Versioning history & @
Commit.. Message title Committed by Committed ... | 4
. c2a5a664 4@ |Version 1)Changed some John Doe 2022-10-18... |
91546acs + Initial upload Filipus24 2022-10-18...

You can add as many tags as you like, and you can delete them (right-click the tag, then click Delete)
and re-use them on a different commit (which is the equivalent of moving a tag).

Versioned projects in the cloud

If a versioned project is stored on the cloud, you, and other members of your team if you so decide, can
work on the project from anywhere and download the very latest version of the files at all times.

OL Connect Designer and Datamapper let you clone a Git repository that exists in the cloud to a local
repository, and keep the online and local projects in sync. This topic explains how to do that.

For instructions on how to create and maintain a versioned project that is only stored locally, see "Ver-

sioned projects" on page 123.

Note: Options to upload a local project to a new or existing online repository, and to branch (fork)
and merge cloud-based versioned projects in OL Connect will be added in a later release.
Before you start

Before you can start working with versioned projects in the cloud, there are a couple of things you need
to do. These steps are only needed once.

Create an account

OL Connect integrates with Git to maintain the history of a versioned project. Git is a Version Control
System (VCS) that enables developers to save snapshots of projects over time. Web-based platforms
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like GitHub, BitBucket and Azure DevOps offer a Git repository hosting service that allows projects to
be worked on collaboratively.

The first thing you need is an account with a Git repository hosting service. GitHub, BitBucket and
Azure DevOps have been tested with OL Connect. Others haven’t been tested, but if they are Git-
based, they should work the same way.

Obtain a token

Secondly, you have to log on to your Git repository hosting service and go into your profile settings to
obtain a token. This is called an app password in BitBucket, or a personal access token in GitHub and
Azure DevOps. OL Connect will use it as the password to your account when it needs to read or write
information in the online repository.

The token can control which operations are allowed. Allow all operations, so that OL Connect will be
able to perform all tasks as needed.

When the token has been generated, it is displayed only once.

Example: go3 bGyW5G1IQx4RWsttlkmxPJZBCcFY2UH36B8VP

Make sure to copy the token somewhere, because you won’t be able to see it again!
Set up OL Connect

The user name of your account with a Git repository platform, and the personal access token or app
password obtained from that same platform, must be entered in OL Connect, so that the software can
access your versioned projects in the cloud.

In the Designer, select Window > Preferences in the menu, go to Versioning and provide the
required information under Remote repository.

Creating a cloud-based versioned project

Once you have created a Git repository in the cloud, you can clone that project in OL Connect and keep
it in sync with the online project.

Here are the steps to create and clone a cloud-based versioned project:

1. Log on to your Git repository hosting service and create a new project that will host the files for a
new project. In BitBucket, for example, it looks like this:
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Start a new repository

A repository contains all of your project's
files, revision history, and collaborator

discussion.

JohnDoe /  print-promotional-jobs

O Public
Anyone on the internet can see this

repository

@ & Private

You choose who can see and commit

to this repository

2. Make sure that the remote repository contains at least one file. If it is completely empty, add one
file to it. This could be an empty readme.txt or .gitignore file.
With BitBucket this isn't necessary; a new Bitbucket repository always has a .gitignore file.

Note: A remote repository that is completely empty will cause an error when cloning it in
OL Connect. This will be fixed in a future release.

3. Once the new repository has been created, you are presented with the URL of the new project.
Copy the URL; you will need it in a following step.

4. Open OL Connect Designer and select the Clone option in the Project menu.

The first time you create a project you may be prompted to enter in your name and email address.
This is required by Git. Your name is used to identify changes in the project history.
This setting is also accessible via the menu: Window > Preferences > Versioning.
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5. Enterin the URL of the remote repository.

6. Inthe Destination field, enter the name of the folder where the local copy of the versioned pro-
ject should be stored.
The software suggests to store all versioned projects in the OL Connect folder that is located in
the user's Documents folder, with each project having its own folder under Documents/OL Con-
nect.
The folder name will actually become the name of the project. By default, the local repository is
created with the same name as the online repository. For example, if the URL to the online repos-
itory is 'https://github.com/jdoe/promotional-print-project' then the destination folder will be
'C:\Users\<username>\Documents\OL Connect\promotional-print-project'. You can adjust the
local project name if you want to.

7. Click the Refresh icon next to the Branch field, to update the list of branches that are available in
the remote repository, and select the branch that you want to clone from the drop-down list.

8. Click OKto clone the project. The project will be stored in the destination folder.

Now you can open an existing template or data mapping configuration (File > Open) or create a
new one (File > New).

As soon as you save a file in the project folder, it becomes part of the project.

Note: Versioned projects have a hidden .git folder. Do not remove this folder. It contains
the version history and, in the case of an online versioned project, information about the
remote repository.

Tip: "Sample Projects" on page 918 are locally stored versioned projects. To turn a Sample Pro-
ject into an online versioned project, you could create a new project in your online repository and
add all of the Sample Project files to the online project before cloning it in OL Connect. Include
the local .gitignore file, but don’t upload the existing (hidden) .git folder.

Keeping the local and online projects in sync

Before synching your local repository with the online repository, select Project > Commit. This records
the project files as a new version in the local repository. Remember to save any changes before you
commit.

Publishing changes

Publishing the local changes to your online repository is done via the Publish Commiits... option in the
Project menu. A confirmation dialog is displayed, stating that the changes have been published, or, if
there are new changes in the remote repository, that you have to download the changed files first.
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Note: The .gitignore file in the project folder tells Git which subfolders and files should not be
committed.

Tags that you add to versions have to be published to the remote repository via the Project > Publish
tags... option.

See also: "Using tags" on page 128.
Downloading remote changes

When you select Project > Check and apply changes OL Connect retrieves changed files from the
remote repository and downloads them to your local project. This updates your local project with the
most recent version of files in the remote repository.

You can also check for remote changes without immediately downloading the changed files: select Pro-
ject > Check remote changes from the menu bar.

Conflicts

A 'conflict' arises when both the remote version and the local version of a file have been changed. If
there are conflicting files when you download remote changes, you will be asked whether you want to
overwrite the local files ("Keep Remote") or discard the remote changes ("Keep Local"). Before a local
file is overwritten, a backup of the local file is made.

Preventing conflicts

If multiple people have access to the files in a remote project, check for remote changes on a regular
basis, to make sure that you work with the latest files. It is important to prevent conflicts in files, since
there is no way or tool yet to resolve conflicts in OL Connect files like templates and data mapping cofig-
urations.

OL Connect automatically checks for remote changes and displays a message when one or more files
in the remote repository have changed. The setting Minutes between remote checks determines how
often OL Connect will check the remote repository for changes if a cloud-based versioned project is
open. You can find this setting in the preferences; from the menu at the top, select: Window > Prefer-
ences > Versioning.

Synchronization information in the project history

Whenever you publish commits to, or pull changes from the online repository, the versioning history
panel (Project > Versioning history) is updated to reflect whether the local and remote versions are
in sync.

A full circle before the message means the local and remote versions of that commit are in sync.
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Half a circle on the left hand side of the axis indicates the commit was made locally but has yet to be
published to the online repository.

Versioning history 5 @
Commit.. Message title Committed by Committed ... | 4
c2a5a664/ ] \ Changed something in the John Doe 2022-10-18.. | &
91546ac8u Initial upload John Doe 2022-10-18...

If someone were to make changes to the online version that the local version doesn’t have yet, then
that half circle would be on the right hand side of the axis.

See also: "Viewing project history" on page 126.

Sample Projects

A Sample Project generates a small Connect solution that is ready to be tested and deployed. The solu-
tion contains a specific Workflow configuration, as well as the Connect templates, data mapping con-
figurations, and any Job Presets and Output Presets that are used in that configuration.

This chapter describes the Sample Projects and the projects that they install. It will help you install,
comprehend and customize the projects.

There is an introductory Sample Projects overview video on the OL Learn website.

For generic information about Connect solutions and their components, see "OL Connect projects” on
page 120.

Note: The projects require that the Connect Server and Connect Workflow be installed on the
local machine.

These are the projects that can be installed with a wizard.

« Print promotional jobs. This project generates a batch of basic personalized letters, in the
format that was selected in the wizard: PDF, PCL or PostScript Level 3. (See: "Sample Project:
Print Promotional Jobs" on page 148.)

The Workflow configuration uses the All In One plugin (see "Print processes with OL Connect
tasks" on page 172).

¢ Print transactional jobs. This project creates print content items - invoices - and uses multiple
Create Output tasks to generate various print output variants:
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o Asingle PDF for the entire job (in which the invoices are grouped per customer).
° One PDF per customer.
° One PDF perinvoice.

(See: "Sample Project: Print Transactional Jobs" on page 153.)

The Workflow process implements the typical Print plugins (see "Print processes with OL Con-
nect tasks" on page 172).

+ Basic web page. This project serves a simple web page, personalized via URL parameters.
(See: "Sample Project: Serving a Web Page" on page 164.)

» Submitting data with webforms. This project illustrates how to serve multiple web pages, one
of them a web form, using a single Workflow process. It stores submitted data in the Data Repos-
itory. (See "Sample Project: Submitting Data with Web Forms" on page 159.)

» Basic email setup. This project sends email messages with attachments. Pre-rendered PDFs
are attached based on the provided sample data. (See "Sample Project: Basic Email" below.)

» Capture OnTheGo Timesheets. This project deploys and serves COTG Timesheet forms. Addi-
tional processes capture the submitted data and output them in JSON, XML and PDF. In order to
create the PDF, the data are merged with a Connect template. (See: "Sample Project: COTG
Timesheets" on page 141.)

Tip: All projects created with the Sample Projects wizard are local versioned projects. Any time
you commit files in the project, a snapshot of the project is saved as a version. See "Versioned
projects" on page 123 for more information about this feature.

Sample Project: Basic Email

The Basic Email Sample Project creates an OL Connect project that sends emails with two attach-
ments: a Return and Refund Policy (PDF) which is the same for all emails, and a delivery note (PDF)
which is attached to the email dynamically. The email has a mailto link.

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-
site (start at 21:07) or on Youtube: Email.

Installing the project

To start the Sample Project, select File > New > Sample Projects > Basic Email from the menu. (See
also: "Basic Email - Sample Project" on page 919.)

Note: In order to use the project, OL Connect Server and OL Connect Workflow must be installed
on the local machine.
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The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store itin the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The Work-
flow configuration" on page 138).

The variable is used in the data mapping configuration (see "Project details" on the next page).

In addition you have to make the settings for outgoing mail (for the details see "Basic Email - Sample
Project" on page 919).
These settings are copied to the Create Email Content task in the Workflow process.

Finally, enter the username and password that will allow the software to access the Connect Server.
Testing and running the project

Once the Sample Project has finished the installation, the project is ready to be tested.

1. Ifthe templates and data mapping configurations haven't been sent to Workflow yet, do that
first (see "Sending files to Workflow" on page 418). This requires that the Workflow service is
running (see Starting the Workflow service in Workflow's Online Help).

2. Locate the Workflow configuration in the project folder and open it in OL Connect Workflow.
3. Select the em_basic_sending_email process

4. Open the Debug ribbon and click Run.

The process should send the email messages along with a delivery note and the Return and Refund
Policy to the email address entered in the Sample Project. This is the sender's address.

Running the project

Having tested the project, you will be ready to send it to Workflow; see Saving and sending a Workflow

Configuration in Workflow's Online Help.
The project will run when you copy the Sample Data.xml file from the Configurations\Data folder to the
Workspacelln folder.

By default the project will still send all the emails to the sender's address. To change this:

Page 136

elalal=


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowServices/Start_Stop_Service.html
https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowConfigurations/Saving_and_sending.html
https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowConfigurations/Saving_and_sending.html

1. Open the Create Email Content task and select the Email Info tab; then uncheck the Send emails
to sender (test mode) option.

2. Replace the test data with real data:
a. Openthe Sample Data.xml file. You will find it in the Configurations\Data folder.
b. Replace the email addresses in this file by real email addresses that you have access to.

c. Copy the modified sample data file from the Configurations\Data folder to the Workspace\ln
folder.

The emails should now be sent to the email addresses that you entered in the sample data file.

Project details
The email template

The email's design is in the EM_BASIC Email Message template. It contains one Email section (see
"Email templates" on page 480).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 671). The style
rules are in the context_htmlemails_styles.css file. Note how they use HTML tags, IDs and classes to
select elements. (See also: "Selectors in OL Connect" on page 825.)

The @media rules make the email responsive (see also: "Designing an Email template” on page 472).

Note: Even though email clients do not read CSS files, CSS files can be used with the Email con-
text in the Designer. See "Using CSS files with HTML email" on page 474.

Two attachments are added to the email, in different ways.

+ The Return and Refund Policy PDF is stored in the template (in the Images folder). Right-click
the Email section and select Attachments to see how this is attached to the email.

» The delivery note is a dynamic attachment, based on a data field. It is attached to the email by
the Attachment script. To learn how to create dynamic attachments, see "Dynamic
attachments: creating file names based on data fields" on page 490.

All scripts are listed on the Scripts pane. You can double-click to open them.

Tip: Hover over the name of a script in the Scripts pane to highlight parts of the template that are
affected by the script.

+ Some data are added to the email via simple text scripts. Such scripts search the template in

order to replace a certain text that is surrounded by @ (e.g. @First@) by the correct data. (See:
"Variable data in text: scripts and placeholders" on page 726.)
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» The To and Subject scripts apply to email fields. (Click Email Fields at the top of the email to
expand all email fields.) For information about this kind of scripts, see: "Email header settings" on
page 483.

e Finally, there are two custom scripts:

* The Personalize Support link script adds the order number to the 'support team' link
(which is a mailto link).

» The Year script puts the current year in the footer.
For more information about writing custom scripts, see: "Writing your own scripts" on page 808.
The Workflow configuration
The project's Workflow configuration, Sending Email, contains just one process. It is a simple OL Con-
nect Email process (see "Email processes with OL Connect tasks" on page 171).

To open the configuration, open Workflow, click the Workflow button, select Open and browse to the
project's Configurations\Resources folder.

Double-click on a task to see its properties.

» The Folder Capture task reads the project's Workspace path from a global variable. The value of
that variable is set by the Sample Project when it installs the project.

» The Execute Data Mapping task extracts data from the sample data file and outputs them in the
Metadata.

* The Create Email Content task creates the emails, using the Metadata as data source.
Note that it sends the emails in test mode, which means it will send the emails to the sender.
The settings on the Email Info tab are taken from the Sample Project.

» The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
This step is sometimes useful when running a project step by step in Debug mode, as it forces
preceding tasks to return their output to the Workflow process. The Create Email Content task,
however, does not return the generated emails to the Workflow process.

The data mapping configuration

The Workflow process uses a data mapping configuration, made with "The DataMapper" on page 198:
EM_BASIC Data.

To open the data mapping configuration, open the Designer, select File > Open from the menu and
browse to the Configurations\Resources folder.

This data mapping configuration will of course only work with the appropriate data files. It was designed
for XML files that are structured like this file: Sample Data.xml (in the Con-
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figurations\Resources\Data folder).
The sample data yields 5 records with customer data including a detail table with invoice details.

Much of the information in the extracted records isn't used in the email, but was used to create the deliv-
ery notes.

The email addresses are used in the template (in the To field), but ignored in the Workflow process
because it sends emails in test mode (see "The Workflow configuration" on the previous page).

Using a Workflow variable

The path to the delivery note is constructed via JavaScript:
automation.variables.em_basic_workspace + \Delivery Notes\\' + record.fields.OrderNumber + '.pdf’;

The script uses a property: automation.variables.em_basic_workspace, which is defined in the Pre-
processor step. (See also: "Properties and runtime parameters" on page 249.)

In this case, the variable holds the project's path. The order number in the path is extracted from the
sample data.

Note: In order to use the value of a Workflow variable - an 'Automation variable' - as a property in
the Preprocessor step, the property and the Workflow variable must have the exact same name.

To see the script, click on the DeliveryNote field in the Data Model pane at the right; then take a look at
the Step Properties pane (in the middle).

To see where the property is defined, click the Preprocessor step on the Steps pane (at the left); then
look at the Properties section on the Step Properties pane.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

Input data

If your input data is in a file, but the file is of a different type or has a different structure, create a new
data mapping configuration to match it. (See "Creating a new data mapping configuration" on

page 200.)

When it's finished, send the new data mapping configuration to Workflow (see "Sending files to Work-
flow" on page 418).

Then open the Workflow configuration, double-click the Execute Data Mapping task to open it and
select the new data mapping configuration.
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To capture input data from a different source:

1. Replace the Folder Capture Input task by the appropriate Input task. See: Input tasks in Work-

flow's Online Help.

2. Add a Send to Folder task directly after the new Input task and set its output folder to the Work-
space\Debug folder (% {global.pr prom workspace}\Debug). This task writes the job file
to a file, which can then be used as sample data file when creating a data mapping configuration
and debugging the Workflow process.

3. Run the process once (see "Testing and running the project" on page 136) to capture the job file
that contains the input data.

4. Use that file to create a new data mapping configuration, send the data mapping configuration to
Workflow, and adjust the Workflow configuration, as described above.

Note: If the input data is JSON, you don't need a data mapping configuration: JSON data can be
used in a template as is. See: "Adding JSON sample data" on page 720.

However, if you want the data to be saved in the OL Connect database, put the XML/JSON Con-
version plugin before the Send to Folder task to convert the JSON to XML, and create an XML
data mapping configuration to extract the data.

The email

Often this type of email has a Call to Action button which redirects the user to the website of the
vendor, where the user could log on to the site and follow an online payment process, for instance.
To get an example (or to start over) you could use one of the template wizards that start an 'action
email'; see "Email Template Wizards" on page 477.

You could add text, images and other elements to the email (see "Content elements" on page 566) and
change the layout (see "Styling and formatting" on page 671). Keep in mind though that there are spe-
cial design standards for HTML email (see "Designing an Email template" on page 472).

In order to further personalize the email, open your data mapping configuration (or JSON data, if the
input data will be in that format; see "Adding JSON sample data" on page 720) and use the data fields
to personalize the email. (See: "Personalizing content" on page 708.)

Tip: The Designer can have one data mapping configuration and one template open at the same
time. Use the tabs at the top of the workspace to switch between the two. Click the synchronize
button on the Data Model pane to make sure that the Data Models are the same in both.

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418).
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Finally, in Workflow, adjust the process: double-click the Create Email Content task to open it, and
select the new template. This is only necessary when the file name has changed.

Workflow configuration

The current Workflow configuration is very simple. In reality, a process that generates email output will
be part of a larger project, in which, for example, invoices are produced in a separate process, stored in
a folder and attached to an email at a later time.

For general information about processes in Workflow see About Processes and Subprocesses, in the

Online Help of Workflow.
Sample Project: COTG Timesheets

The COTG Timesheets Sample Project creates a Capture OnTheGo project that creates a web page
with a web form and serves it to the COTG app. When the form is submitted, the project handles the
submitted data by creating an XML, JSON and PDF output file in a folder.

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-
site (start at 25:19) or on Youtube: COTG Timesheets.

Installing the project

From the menu, select File > New > Sample Projects > COTG Timesheets to start the wizard.

The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store itin the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The Work-
flow configuration" on page 144).

You also need to enter the host. This address will be used by the COTG app to download forms and
submit data to the OL Connect Workflow service.

If you want to use localhost, the OL Connect Server, Workflow and COTG app must be installed on the
local machine.

A valid COTG account, Repository ID and password are also necessary. You could use dummy data
to create the Sample Project and finish the installation, but you won't be able to test the project.

For more information about the options, see: "COTG Timesheets - Sample Project" on page 920.

Finally, enter the username and password that will allow the software to access the Connect Server.
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Tip: If you own PlanetPress Connect or PReS Connect, free COTG trial licenses may be avail-
able to you; see http://www.captureonthego.com/en/promotion/.

Note: Your network setup may make it impossible for the COTG app to communicate with the OL
Connect Workflow service. The app needs to be able to communicate with OL Connect Workflow
in order to download forms and submit data. Network and firewall settings may block these
requests. Please contact your local IT department for advise on how this can be resolved in your
setup.

Testing the project
Once the Sample Project has finished the installation, the project is ready to be tested.

1. If the templates and data mapping configurations haven't been sent to Workflow yet, do that first
(see "Sending files to Workflow" on page 418).
This requires that the Workflow service is running (see Starting the Workflow service in Work-

flow's Online Help).

2. Send the Workflow configuration to the Workflow service; see Saving and sending a Workflow

Configuration in Workflow's Online Help.
3. Open the Workflow configuration from the project's Resources\Workflow folder.

4. Selectthe cotg_ts_deploy_form process, open the Debug ribbon and click Run to execute the
process. This deploys a number of forms to the COTG account entered in the Wizard.

Note: The process is pre-configured to use the sample data file, which comes with the pro-
ject, when it runs in Debug mode.
Alternatively you could copy the sample data file to the In folder.

5. Launchthe COTG app and log in using the COTG account that you entered in the Sample Pro-
ject.

In the app, open the Repository and download one of the forms.
From the app's Library, open the form.

Enter data and draw a signature.

© ® N o

Submit the form.
Note: If the COTG app is unable to submit the data, you may have to change your network setup

or remove the built-in restrictions in Windows 10 that prevent applications from sending data to
the same computer. See "Installing the project" on the previous page.
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Project details
The templates
The form

The COTG Timesheet Form template contains a Web context with one Web section: Section 1 (see
"Web pages" on page 498 and "Forms" on page 640). The form has regular Form elements as well as
COTG elements (see "Form Elements" on page 644 and "COTG Elements" on page 633).

The template was started with the Time Sheet Wizard (see "Capture OnTheGo template wizards" on
page 525), which also provides the necessary JavaScript files and style sheets.

Most of the scripts are simple Text Scripts (see "Using the Text Script Wizard" on page 729). They put
data in one of the form's fields, selecting the field by its ID.

Tip: Hover over the name of a script in the Scripts pane to highlight parts of the template that are
affected by the script.

» The guid script adds data to the guid field. This is a hidden field. It is only visible in the Source
view.

» The result of the form action script is added to the form's action attribute. To see how that is
done, double-click the script; then click Options.

» The Year script puts the current year in the footer of the page. This is a custom script. For more
information about writing scripts, see: "Writing your own scripts" on page 808.

The report

The COTG Timesheet Report template contains a Print context with one Print section: Section 1
(see "Print sections" on page 447) and one Master Page (see "Master Pages" on page 462).

Personalization is mostly done via simple text scripts. Such scripts look for a text surrounded by @
(e.g. @city@) and replace that by the correct data. (See: "Variable data in text: scripts and place-
holders" on page 726.)

The template also contains a dynamic table which is filled and expanded dynamically by the scripts in
the Table folder. To learn how to insert and edit such a table, see "Dynamic Table" on page 742.

Note that this table does not use one of the default table styles, and that the style sheet with the default
table styles is not present in the template. To add that style sheet to the template, insert a table using
the Dynamic Table wizard.
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The data mapping configurations

This project has two data mapping configurations, made with "The DataMapper" on page 198. To open
one of them, select File > Open from the menu in the Designer and browse to the Con-
figurations\Resources folder.

COTG Timesheet Form

The COTG Timesheet Form data mapping configuration is designed to extract data from the sample
data file (Sample Data.xml).

The configuration also adds two fields to each record, using JavaScript: a unique ID (guid) and a field
that contains the action of the Form.

Note that the COTG account is the same in all of the records in the sample data. It is inserted into the
sample data by the Sample Project.

COTG Timesheet Report

The COTG Timesheet Form data mapping configuration is designed to extract the data that are sub-
mitted via the app. It first extracts the common fields, and then the information from the rows in the
form, in a loop. For information about how to extract a variable number of similar elements from an XML
file, see: "From an XML file" on page 238.

In order to create this data mapping configuration, the input data needed to be saved to afile first (see
"Saving input as sample data" on page 146).

The sample data file is located in the Configurations\Data folder, but you will also see it when you
open the data mapping configuration itself.

The Workflow configuration

There are four processes in the COTG Timesheets Workflow configuration. Some of them use the OL
Connect tasks that are normally used in a Web process or a Print process (see "Web processes with
OL Connect tasks" on page 174 and "Print processes with OL Connect tasks" on page 172).

Creating the forms

The cotg_ts_deploy_form process is triggered when any file enters the Workspace\ln folder, but its
Execute Data Mapping task expects an XML file that is structured exactly like the Sample Data.xml file
(in the Resources\Data folder).

The Execute Data Mapping task outputs records in the Metadata.

Subsequently, the Metadata Sequencer task creates a loop; the rest of the process is performed as
many times as there are records in the Metadata, for one record at a time:
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* The Set Job Infos and Variables task reads data from the (current record in the) Metadata and
puts them into variables.

* The Create Web Content task merges the record with the COTG Timesheet Form template.

* The Send to Folder task saves the form to the Forms folder in the project folder, using the value
of one variable as the file name.

e Finally, the Output to Capture OnTheGo task sends information about the form to the COTG
Server. Double-click the task to see how variables are used in its settings.

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. Tasks will only
return their output to the process - where it can be viewed - as long as they are followed by another
task.

Serving a form

When the user chooses to download a form in the app, the app sends a request using the URL that was
set for the form in the properties of the Output to Capture OnTheGo task (on the Deposit tab). The URL
contains one parameter: a unique ID.

The cotg_ts_serve_form process receives the request and loads the form (if it exists). The Load
External File task replaces the job file with the form. At the end of the process the Server Input task
returns the job file (the form) to the app.

Capturing data and generating output

When the user submits a form, the cotg_ts_capture_data process writes the job file - the request in
the form of XML - to a Temp folder in the Workspace and sends a response code to the app. This way
there is no need for the COTG user to wait while output is being generated. The response to the app
can be sent right away.

The cotg_ts_generate_report process picks up the XML file from the Temp folder, converts it to JSON
and saves it to a JSON file. Note how the Branch task keeps a backup of the job file. It is the backup
file - the XML - that is handed down to the next Branch, where it is saved as an XML file.

Finally, the process extracts data from the job file and merges them with the COTG Timesheet Report
template, generating a PDF.

All output files are stored in the Workspace\Out folder

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.
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Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

The form
If you want to add inputs to the form and extract the submitted data, here's how to do that.

1. Open the Web section and add elements to the Web Form (see "Using COTG Elements" on
page 536 and "Using Form elements" on page 507).
You could also add text, images and other elements (see "Content elements" on page 566) and
change the layout of the page (see "Styling and formatting" on page 671).

2. Save the template and send it to Workflow (see "Sending files to Workflow" on page 418).

3. Upload the Workflow configuration to the server (see Saving and sending a Workflow Con-

figuration in Workflow's Online Help) and let the process save the input data to a file (see "Saving
input as sample data" below).

4. Use the saved file to expand the data mapping configuration (see "Opening a data mapping con-
figuration" on page 204). Send the data mapping configuration to Workflow.

5. Send the Workflow configuration to the server.

Saving input as sample data

Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-con-
figured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin Con-
nect Workflow.

2. Select the process.
3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and sending a

Workflow Configuration) and run it again, with a custom name value.
The Send to Folder step will now write the input data - the job file - to a file in the Work-
space\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the process.

Tip: The saved file can be used to create a data mapping configuration.
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The report

Using different data in the report requires changing the COTG Timesheet Report template (see "Per-
sonalizing content" on page 708).

Tip: The Designer can have one data mapping configuration and one template open at the same
time. Use the tabs at the top of the workspace to switch between the two. Click the synchronize
button on the Data Model pane to make sure that the Data Models are the same in both.

You could also:

» Add text, images and other elements (see "Content elements" on page 566)
* Change the layout (see "Styling and formatting" on page 671)

* Change the "Media" on page 465. If you have an image of the stationery the PDF will be printed
upon, add it to the Media to make designing the template little easier.

e Change the "Master Pages" on page 462

* Add sections (see "Print context" on page 443)

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418) and
send the Workflow configuration to the server again.

Workflow configuration

To transform the project into a real solution, the Workflow configuration has to be adapted in two import-
ant respects.

e The timing and manner of the production of forms will need to change. The Input task of the
cotg_ts_deploy_form process must be adapted to the actual input data. You will also need to
create an appropriate data mapping configuration for that data, which probably means saving the
input as sample data first (see "Saving input as sample data" on the previous page).

* How the submitted data must be handled depends entirely on what they are used for. You may
have to write them to a database and use them in an email, for example.
The cotg_ts_generate_report process demonstrates only a few of the things that you can do
with the submitted data.

Tip: The Submitting Data with Web Forms Wizard shows how to use a data selection func-
tion - xmlget () -to read data from the request XML and how to store data in the Data
Repository (see "Sample Project: Submitting Data with Web Forms" on page 159).

For general information about processes in Workflow see About Processes and Subprocesses, in the
Online Help of Workflow.
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Sample Project: Print Promotional Jobs

The Print Promotional Jobs Sample Project creates a simple, yet complete OL Connect project that pro-
duces promotional print output.

The project extracts data from an XML file and uses that data to personalize a promotional letter. The
output is a single file containing all the letters, in the format that was selected in the wizard (PDF, PCL
or PostScript Level 3).

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-

site (start at 0:52) or on YouTube: Print Promotional Jobs.

Installing the project

Select File > New > Sample Projects > Print Promotional Jobs from the menu to start the Print Pro-
motional Jobs Sample Project. (See also: "Promotional Print Jobs - Sample Project" on page 922.)

Note: In order to use the project, OL Connect Server and OL Connect Workflow must be installed
on the local machine.

The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store it in the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "Workflow
configuration" on page 151).

That variable is used in the settings of the Capture Folder and Send to Folder tasks.

Next, you have to select the desired output type: PDF, PCL or PostScript Level 3. Each of the output

types is available in two variants. The 'Stationery' variants will include the virtual stationery (stored in
the OL Connect template) in the output. This is a setting in the Output Creation Preset (see "Print set-
tings" on page 150).

Finally, enter the username and password that will allow the software to access the Connect Server.
Testing and running the project

Once the Sample Project has finished the installation, the project is ready to be tested.

Page 148

PlanetPress.
BDNNE


https://learn.objectiflune.com/videos/project-wizards-overview/
https://youtu.be/6TD1rHD5m7g?t=52

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin OL Con-
nect Workflow.

2. Selectthe pr_prom_generate_output process.

3. Open the Debug ribbon and click Run.

In Debug mode, the first Input task is skipped and the process is executed using a sample data file.
This project is pre-configured to use the file: Sample Data.xml.

A successful test run results in a subfolder in the Workspace\Out folder, named after the current
month and year. The Print output is written to that subfolder. It consists of one file that should have the
proper file extension.

Running the project

Having tested the project, you will be ready to send it to the Workflow service; see Saving and sending
a Workflow Configuration in Workflow's Online Help.

To test the project, which then runs on the server, copy the Sample Data.xml file from the Con-
figurations\Data folder to the Workspace\ln folder. The output should appear in the same folder as
before.

Project details
The letter template

The promotional letter is designed in the PR_PROM Letter template. It contains one Print section
(see "Print sections" on page 447).

There are two Master Pages that are each applied to different pages in the Print section (see "Applying
a Master Page to a page in a Print section" on page 464).

The Media contains the virtual stationery. Whether this is included in or omitted from the final output
depends on a setting in the Output Creation Preset.

Personalization is mostly done via simple text scripts. Such scripts look for a text surrounded by @
(e.g. @city@) and replace that by the correct data. (See: "Variable data in text: scripts and place-
holders" on page 726.)

A few scripts are a little bit more sophisticated.

» The sales_rep script combines some data fields and adds a line break. Double-click the script to
open the Text Script Wizard with which this script was made. (See: "Using the Text Script Wiz-
ard" on page 729.)

» The Promo script shows or hides a paragraph (with the ID 'promo') depending on whether the
customer's address is in Montréal. (See: "Showing content conditionally" on page 734.)
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¢ The year script changes the year in the conditional paragraph to the current year. This script only
has to look for @year@ in an element that has the ID 'promo’, instead of in the entire letter, which
makes it run faster.

» The Dynamic Signature script switches the signature, with a file name based on a data field.
(See: "Dynamic images" on page 741.)

» The sender's address is adjusted depending on where the customer lives. The two different
sender's addresses are saved in snippets. (See: "Loading a snippet via a script" on page 831.)

Styling is done via CSS. The context_all_styles.css file contains style rules for certain HTML elements
(level 1 and 2 headings) and for elements with a certain class or ID.

The data mapping

The data with which the template is merged come from an XML file: Sample Data.xml. They are extrac-
ted from the XML file with a data mapping configuration: , made with the DataMapper module in the
Designer.

The data mapping configuration is very straightforward. It extracts all data without modifications and it
does no pre- or post-processing. Simple data mapping configurations like this are made with the XML
Data Mapping Wizard (see: "Using the wizard for XML files" on page 213). The wizard creates a con-
figuration with only one step: the Extract All step.

Of course, this will only work with the appropriate data files. This data mapping configuration was
designed for XML files that are structured like this file: Sample Data.xml.

The sample file is located in the Configurations\Data folder, but you will also see it when you open the
data mapping configuration itself: select File > Open from the menu; browse to the Con-
figurations\Resources folder and select the data mapping configuration: PR_PROM Data XML.

Print settings

The Print context and Print sections can have their own print settings, such as Duplex printing or bind-
ing style (see "Print settings in the Print context and sections" on page 444). But in this template, they
don't have any. The way the letter is outputted is determined (mostly) by an Output Creation Preset.

The Sample Project installs six Output Creation Presets; two for each type of output. Per output type,

all settings in the Output Creation Presets are the same, except one: Print Virtual Stationery. The ones
that have this option enabled will include the Media - the Virtual Stationery - in the output. The other pre-
sets will not print the Media.

Only the selected Output Creation Preset is put to use in the Workflow configuration.

To see the exact settings, open an Output Creation Preset in the Designer: first select File > Output
Creation Presets from the menu; then click the Import button and browse to the Con-
figurations\Resources\Output presets folder to select the preset.
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Note that the Output Type, on the Print Options page in the Output Creation dialog, is set to Prompt
for file name. This setting is overruled in the Workflow configuration (see below).

Workflow configuration

Whenever new input data appears in the Workspacel\ln folder, the letter template is automatically
merged with it and then printed. That is, if the Workflow server is running with the Workflow con-
figuration installed by the Sample Project.

This project's Workflow configuration: Print Promotional Jobs, contains just one process: a basic OL
Connect Workflow Print process (see "Print processes with OL Connect tasks" on page 172).

It consists of three plugins:

» The Folder Capture Input task. This task retrieves all XML files that enter the Workspace\in
folder.

« The All In One plugin. This plugin uses the data mapping configuration and template that come
with the project, and the Output Creation Preset selected in the Sample Project. The plugin is set
to handle the output 'Through Workflow'. This means that the task will return the output file to the
Workflow process.

« The Send to Folder Output task. This task writes the output file to a subfoler in the Work-
space\Out folder. It makes use of system variables (see Standard variables) to dynamically cre-
ate a subfolder based on the current month and year (%M_%y). The name of the file consists of
the original file name (%0), the current time (%h%n%s) and the file extension. The file extension
(.pdf, .pcl or .ps) matches the output technology selected in the Sample Project.

Both the Folder Capture and the Send to Folder task read the project's Workspace path from a global
variable. The value of that variable is set by the Sample Project when it installs the project.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

Input data

Here's how to adjust the project to input data that has a different structure or file type or comes from a
different source.
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1. Create a new data mapping configuration to match your input data. (See .)

2. When it's finished, send the new data mapping configuration to Workflow (see "Sending files to
Workflow" on page 418).

3. Open the Workflow configuration: Print Promotional Data.

4. Double-click the Folder Capture Input task and change the file mask, or replace the task by the
appropriate Input task. See: Input tasks in Workflow's Online Help.

5. Double-click the All In One task and select the new data mapping configuration on the Data Map-
per tab.

Note: If the input data is JSON, you don't need a data mapping configuration: JSON data can be
used in a template as is. See: "Adding JSON sample data" on page 720.

However, if you want the data to be saved in the Connect database, let the XML/JSON Con-
version plugin convert the JSON to XML and create an XML data mapping configuration to
extract the data.

Template

There are countless ways to customize the template to meet your exact requirements. You could, for
example:

» Add text, images and other elements (see "Content elements" on page 566)
» Change the layout (see "Styling and formatting" on page 671)

» Change the "Media" on page 465

e Change the "Master Pages" on page 462

* Add sections (see "Print context" on page 443)

In order to further personalize the letter, you need to open your data mapping configuration. (See: "Per-
sonalizing content" on page 708.)

Tip: The Designer can have one data mapping configuration and one template open at the same
time. Use the tabs at the top of the workspace to switch between the two. Click the synchronize
button on the Data Model pane to make sure that the Data Models are the same in both.

When the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418).

Finally, in Workflow, adjust the process: double-click the All In One task to open it, and select the new
template on the Content Creation tab. This is only necessary when the file name has changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow Configuration in
Workflow's Online Help).
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Print output

To save the output to another kind of file, you could use one of the other Output Creation Presets. To do
that, adjust the process in Workflow: double-click the All In One task to open it, and select the Output
Creation Preset of your choice on the Output Creation tab.

To change the settings in an Output Creation Preset, open it in the Designer:

1. Select File > Output Creation Presets from the menu

2. Click the Import button and browse to the Configurations\Resources\Output presets folder to
select the preset.

All of the presets provided by the wizard save the output to one file. You might want to save the output
to a number of files, for instance, one per customer. The Transactional Print Jobs project shows you
how to do that.

Sample Project: Print Transactional Jobs

The Print Transactional Jobs Sample Project creates an OL Connect project that produces trans-
actional print output. It prints invoices to:

o A single PDF for the entire job (in which the invoices are grouped per customer).
°© One PDF per customer.

° One PDF perinvoice.

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-
site (start at 7:56) or on YouTube: Print Transactional Jobs.

Installing the project

Select File > New > Sample Projects > Print Transactional Jobs from the menu to start the wizard.
See also: "Transactional Print Jobs - Sample Project" on page 923.)

Note: In order to use the project, OL Connect Server and OL Connect Workflow must be installed
on the local machine.

The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store itin the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.
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The selected folder's path is saved to a global variable in the Workflow configuration (see "Workflow
configuration" on page 157).

That variable is used in the settings of the Capture Folder task.
The path is also copied to the Output Creation Presets which are used in the Create Output tasks.

Finally, enter the username and password that will allow the software to access the Connect Server.
Testing and running the project

Once the Sample Project has finished the installation, the project is ready to be tested.

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin OL Con-
nect Workflow.

2. Select the pr_tran_generate_output process.

3. Open the Debug ribbon and click Run.

The debugger always skips the first Input task. It needs a sample data file to work with. Normally you'd
have to select a sample data file in Workflow. However, the project is pre-configured to use this file:
Sample Data.xml (located in the project's Configurations\Data folder). The dates in the file are based
on the date on which the project is installed.

A successful test run results in the following output in the Workspace\Out folder:

¢ One PDF containing all invoices, grouped by customer number.
» A subfolder containing PDFs that have one invoice each.

» A subfolder containing one PDF per customer. (Some customers have more than one invoice.)
Running the project

Having tested the project, you will be ready to send it to PlanetPress Workflow service; see Saving and
sending a Workflow Configuration in Workflow's Online Help.

To test the project when it runs on the server, copy the Sample Data.xml file from the Con-
figurations\Data folder to the Workspace\ln folder. The same output should appear in the same folders
as before.

Project details
The invoice template

The invoice is designed in the PR_TRAN Invoice template. It contains one Print section (see "Print
sections" on page 447) and one Master Page (see "Master Pages" on page 462).

The Media (virtual stationery) is included in the output - it is printed on the page's background -, accord-
ing to a setting in the Output Creation Presets.

Page 154

PlanetPress.
BDNNE


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/#Workflow/WorkflowConfigurations/Saving_and_sending.html
https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/#Workflow/WorkflowConfigurations/Saving_and_sending.html

Styling is done via style sheets (see "Local formatting versus style sheets" on page 671). The style
rules are in the context_print_styles.css file. Note how they combine the HTML tag, ID and class of ele-
ments to select them. (See also: "Selectors in OL Connect" on page 825.)

Scripts

Scripts personalize content. Most of the scipts in the Information folder (on the Scripts pane) are made
with the Text Script Wizard (see "Using the Text Script Wizard" on page 729).

Tip: Hover over the name of a script in the Scripts pane to highlight parts of the template that are
affected by the script.

Text that should be replaced by data is not only surrounded by @ (e.g. @date@) but also wrapped in a
span (see "Span" on page 625). Each span has an ID, or a class if the same text occurs more than
once, to use that as the selector of the script. The selector of the Invoice Total script, for instance, is a
class: .inv-total.

Wrapping elements in a box (see "Boxes" on page 623) or in a semantic HTML element makes it easier
to target them in a script or in a style sheet. Place the cursor in the element or select multiple elements.
Then, on the menu, click Insert > Wrap in Box. You can now use the wrapper element as a script's or

style's selector; see "Using the Text Script Wizard" on page 729 and "Styling and formatting" on

page 671.

The Text Script Wizard has an Expand button that opens the Script Editor, where you can edit the
code or add your own. (For an introduction, see "Writing your own scripts" on page 808).

When you double-click on the Invoice Meta script, the Script Editor opens immediately. This script
shows how to add data using the replace() method (see https://www.w3schools.com/jsref/jsref

replace.asp).
Note that this is a native JavaScript function. Functions that are only available in Designer scripts are

listed in the "Designer Script API" on page 1168.

Dynamic Table

The table in the invoice is a Dynamic Table. It is filled and expanded dynamically by the scripts in the
Products folder. To learn how to insert and edit such a table, see "Dynamic Table" on page 742.

Note that this table does not use one of the default table styles, and that the style sheet with the default
table styles is not present in the template. To add that style sheet to the template, insert a table using
the Dynamic Table wizard.

The data mapping configuration

The template is merged with data from an XML file: Sample Data.xml. They are extracted from the XML
file with a data mapping configuration, made with the DataMapper (see "The DataMapper" on
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page 198).

The data mapping configuration first extracts the common invoice fields, and then the transactional
data, in a loop. For information about how to extract transactional data from an XML file, see: "From an
XML file" on page 238.

Of course, this will only work with the appropriate data files. This data mapping configuration was
designed for XML files that are structured like this the sample file: Sample Data.xml.

It is located in the Configurations\Data folder, but you will also see it when you open the data mapping
configuration itself: select File > Open from the menu; browse to the Configurations\Resources
folder and select the data mapping configuration: PR_TRAN Data XML.

Print settings

A Print context and Print sections can have their own print settings (see "Print settings in the Print con-
text and sections" on page 444). The only print setting that the Print section has in this template, is the
Duplex setting. (Right-click the section and select Sheet Configuration. See also: "Sheet Con-
figuration dialog" on page 939.)

All other print settings are in the three Output Creation Presets. These are used by the Create Output
tasks in the Workflow process.

To see the exact settings, open an Output Creation Preset in the Designer: first select File > Output
Creation Presets from the menu; then click the Import button and browse to the Con-
figurations\Resources\Output presets folder to select the preset.

The three Output Creation Presets all create PDF output, add the template's name to the PDF's meta
data, and save the file in a certain directory. They all have the Print Virtual Stationery option enabled.
So, what are the differences between these presets?

Groups and separation

The PR_TRAN PDF Full Job preset outputs only one file.

The PR_TRAN PDF per Invoice preset outputs one file per invoice, separating the output by doc-
ument.

The PR_TRAN PDF per Customer preset outputs one file per customer, separating the output by doc-
ument set.

The last output preset needs the invoices in the job to be grouped in document sets first (by customer
number, in this case). That is what the Job Creation Preset does. This preset is used by the Create
Job task in the Workflow configuration.

Variable file names

The Job Creation Preset does something else, too: it attaches extra information - meta data - to the doc-
uments and to the document sets. Both Output Creation Presets that produce multiple files use that
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information in the output file names.

They do that by using a variable in the file output mask field. The variable refers to certain meta data
attached to items at a certain level (the document or document set, respectively). For more information
see "Print output variables" on page 1330.

Workflow configuration

Whenever new input data appears in the Workspacel\ln folder, the invoices are automatically merged
with the data and printed to one file, one file per customer, and one file per invoice. That s, if the Work-
flow server is running with the Workflow configuration installed by the Sample Project. (See "Running
the project” on page 154.)

This project's Workflow configuration contains just one process. It is a typical OL Connect Print process
(see "Print processes with OL Connect tasks" on page 172), with the difference that it does not have
one Create Output task, but three. Each of them uses its own Output Creation Preset (see "Print set-
tings" on the previous page).

Note that the Branch tasks back up the job file and job information, so that the main branch continues
with a job file that is unaffected by what happens to the job file inside the branch.

The Folder Capture task reads the project's Workspace path from a global variable. The value of that
variable is set by the Sample Project when it installs the project.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

Input data

Here's how to adjust the project to input data that has a different structure or file type or comes from a
different source.

1. Create a new data mapping configuration to match your input data. (See .)

2. When it's finished, send the new data mapping configuration to Workflow (see "Sending files to
Workflow" on page 418).

3. Open the Workflow configuration: Print Promotional Data.

4. Double-click the Folder Capture Input task and change the file mask, or replace the task by the
appropriate Input task. See: Input tasks in Workflow's Online Help.
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5. Double-click the All In One task and select the new data mapping configuration on the Data Map-
per tab.

Note: If the input data is JSON, you don't need a data mapping configuration: JSON data can be
used in a template as is. See: "Adding JSON sample data" on page 720.

However, if you want the data to be saved in the Connect database, let the XML/JSON Con-
version plugin convert the JSON to XML and create an XML data mapping configuration to
extract the data.

Template

There are countless ways to customize the template to meet your exact requirements. You could, for
example:

» Add text, images and other elements (see "Content elements" on page 566)
» Change the layout (see "Styling and formatting" on page 671)

» Change the "Media" on page 465

e Change the "Master Pages" on page 462

* Add sections (see "Print context" on page 443)

In order to further personalize the invoice, you need to open your data mapping configuration. (See:
"Personalizing content” on page 708.)

Tip: The Designer can have one data mapping configuration and one template open at the same
time. Use the tabs at the top of the workspace to switch between the two. Click the synchronize
button on the Data Model pane to make sure that the Data Models are the same in both.

Note that a "Dynamic Table" on page 742 can't exist without a detail table in the data.
When the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418).

Finally, in Workflow, adjust the process: double-click the Create Print Content task to open it, and
select the new template. This is only necessary when the file name has changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow Configuration in
Workflow's Online Help).

Print output

To save the output to another type of file, or to send it to a printer, you must change the Output
Creation Presets. Output Creation Presets are edited in the Designer.
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1. Select File > Output Creation Presets from the menu.

2. Click the Import button and browse to the Configurations\Resources\Output presets folder to
select the preset.

3. Click Next and adjust the Printer and Output options.

To separate the output differently, for example, by city in which the customers live, you need to change
the Output Creation Preset as well as the Job Creation Preset.

1. Open the Job Creation Preset in the Designer: select File > Job Creation Presets from the
menu.

2. Change the Grouping Options by selecting the relevant fields on the Job, Job Segment,
and/or Document Set tab.

3. Adjust the Separation Options in the Output Creation Preset accordingly.

Tip: The Execute Data Mapping task, Create Job and Create Output task may be replaced with
the All In One task, with its Output Creation set to None. Using the All In One instead of the sep-
arate tasks makes the process a little faster.

Sample Project: Submitting Data with Web Forms

The Submitting Data with Web Forms Sample Project creates an OL Connect project that responds to a
request by serving a web page with a web form. When the form is submitted, it handles the submitted
data, saving them to the Data Repository.

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-
site (start at 16:50) or on Youtube: Submitting Data with Web Forms.

Installing the project

From the menu, select File > New > Sample Projects > Submitting Data with Web Forms to start
the wizard. See also: "Submitting Data with Web Forms - Sample Project" on page 923.)

Note: In order to use the project, OL Connect Server and OL Connect Workflow must be installed
on the local machine.

The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store itin the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.
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The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The Work-
flow configuration" on the next page).

Finally, enter the username and password that will allow the software to access the Connect Server.
Testing and running the project
Once the Sample Project has finished the installation, the project is ready to be tested.

1. If the templates and data mapping configurations haven't been sent to Workflow yet, do that first
(see "Sending files to Workflow" on page 418). This requires that the Workflow service is running
(see Starting the Workflow service in Workflow's Online Help).

2. Send the Workflow configuration to PlanetPress Workflow service; see Saving and sending a
Workflow Configuration in Workflow's Online Help.

3. Access the web page by entering the following URL in a browser on the machine that runs Work-
flow: http://localhost:9090/form. (The process starts with a NodeJS Server Input task,
and Workflow's NodeJS Server listens on port 9090 by default.)

4. Fillin some data and submit the form. You will now be presented with a Thank You web page.

Saving input as sample data
Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-con-
figured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin Con-
nect Workflow.

2. Select the process.
3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and sending a
Workflow Configuration) and run it again, with a custom name value.
The Send to Folder step will now write the input data - the job file - to a file in the Work-
space\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the process.
Note however that the process will not return the web page to a browser, as it wasn't started by a
browser.
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Tip: The saved file can be used to create a data mapping configuration.

Project details
The web templates

Both web pages are designed in the WEB_FORM Web Page template. It contains a Web context with
two Web pages: form and thank_you (see "Web pages" on page 498).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 671). The style
rules are in the context_web_styles.css file. Note that they use the HTML tag (e.g. section), ID (#thelD)
and/or the class (.theclass) of elements to select them. (See also: "Selectors in OL Connect" on

page 825.)

Dynamic content is inserted by scripts, which are listed on the Scripts pane. You can double-click a
script to open it.

The scripts in the Thank you folder only affect the thank_you Web page; on the form Web page, noth-
ing matches their selectors.

Tip: Hover over the name of a script in the Scripts pane to highlight parts of the template that are
affected by the script.

* Most of the scripts in the Thank you folder directly insert data that were submitted via the Web
form; see "Variable data in text: scripts and placeholders" on page 726.

* The Snippets script (also in the Thank you folder) loads two snippets, depending on the values
of two data fields (see "Loading a snippet via a script” on page 831). Note that it selects the table,
in order to insert the snippet after the table (via results.after (); see "after()" on page 1242).

» The Year script puts the current year in the footer of both Web pages.

For more information about writing scripts, see: "Writing your own scripts" on page 808.

The Workflow configuration

The project's Workflow configuration contains just one process: an OL Connect Web process (see
"Web processes with OL Connect tasks" on page 174).

Its NodedS Server Input task has two HTTP Action entries: form and thank_you. This means the pro-
cess will be triggered when the server receives a request that ends with either /form or /thank_you.

The request is saved to an XML file, which becomes the job file.

The Text Condition task checks if the request's header is thank_you. (For the function that is used to
read the header from the job file, see: XML data selections.)
Ifitis, the tasks in the branch run. The submitted data are merged with the thank_you Web section and
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saved in Workflow's Data Repository.

Otherwise the main branch renders and returns the web form.

Note how the Section setting in the Create Web Content tasks determines which web page is outputted
(double-click the task to open the properties).

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. When it is followed
by another task, the Create Web Content task returns its output to the Workflow process, where it can
be viewed (click View as HTML).

The data mapping configuration

To extract the submitted data from the job file (the request XML), the process uses the data mapping
configuration: WEB_FORM Data.
To open it, select File > Open from the menu and browse to the Configurations\Resources folder.

In order to create the data mapping configuration, the input data needed to be saved to a file (see "Sav-
ing input as sample data" on page 160).

The sample data file is located in the Configurations\Data folder, but you will also see it when you
open the data mapping configuration itself.

For more information about data mapping configurations see "The DataMapper" on page 198.
Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

The form

If you want to add inputs to the form and use the submitted data in the Thank You web page, here's how
to do that.

1. Open the form Web section and add inputs to the Web Form (see "Using Form elements” on
page 507).

2. Save the template and send it to Workflow (see "Sending files to Workflow" on page 418).

3. Upload the Workflow configuration to the server (see Saving and sending a Workflow Con-

figuration in Workflow's Online Help) and let the process save the input data to a file (see "Saving
input as sample data" on page 160).
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4. Use the saved file to add the new data to the data mapping configuration (see "Opening a data
mapping configuration" on page 204). Send the data mapping configuration to Workflow.

5. Open the thank_you Web section and use the new data fields to personalize the page (see: "Per-
sonalizing content” on page 708). Then send the template to Workflow again.

Tip: The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the
synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

6. Send the Workflow configuration to the server.
Web pages

Apart from the form, there are lots of ways to modify the template. You could add text, images and other
elements (see "Content elements" on page 566) and change the layout of the web pages (see "Styling
and formatting" on page 671).

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418).

Finally, in Workflow, adjust the process: double-click the Create Web Content task to open it, and
select the new template. This is only necessary when the file name has changed.
Send the Workflow configuration to the server (see Saving and sending a Workflow Configuration in

Workflow's Online Help).

Note: If you want the web pages to be responsive (have a different layout on screens of dif-
ferent sizes), you could add Media Queries to the style sheet (see Media Queries on W3schools),
or start a new template with a wizard; see "Creating a Web template with a Wizard" on page 493.

Workflow configuration

Serving the two web pages could also be achieved using separate processes, but in fact it is more effi-
cient to have a single process, as activity needs to be monitored for each process.

In real life the submitted data will probably not be stored in the Data Repository, but used differently.
This means that the Push to Repository task will need to be replaced by the appropriate tasks, but that
won't change the way the submitted data is retrieved.

To see how the current process does that, double-click the Push to Repository task and take a look at
the task's properties. The xmlget() function, used in the Value fields, is a data selection function (see
Data Selections). Data selection functions are available in many plugins, in any field that accepts vari-

ables. Try right-clicking a field and select Get Data Location from the contextual menu. (See also: Vari-
able Task Properties.)
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For general information about processes in Workflow see About Processes and Subprocesses, in the

Online Help of Workflow.
Sample Project: Serving a Web Page

The Serving a Web Page Sample Project creates an OL Connect project that responds to a request by
serving a web page. This project extracts data from a parameter in the given URL and shows the value
on the web page.

For an introduction to this Sample Project, see Sample Projects overview video on the OL Learn web-

site (start at 12:44) or on Youtube: Serving a Web Page.

Installing the project

To start the Sample Project, select File > New > Sample Projects > Serving a Web Page from the
menu. (See also: "Serving a Web Page - Sample Project" on page 924.)

Note: In order to use the project, OL Connect Server and OL Connect Workflow must be installed
on the local machine.

The wizard lets you select the folder in which you want the solution to be installed. Since Sample Pro-
jects are versioned (see "Versioned projects" on page 123), the software suggests to store itin the OL
Connect folder that is located in your Documents folder. By default, all versioned project have their
own folder under Documents/Connect.

In the selected folder, the Sample Project will create two subfolders: Configurations and Workspace.
The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that may be
used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The Work-
flow configuration" on page 166).

Finally, enter the username and password that will allow the software to access the Connect Server.
Testing and running the project
Once the Sample Project has finished the installation, the project is ready to be tested.

If the templates and data mapping configurations haven't been sent to Workflow yet, do that first
(see "Sending files to Workflow" on page 418).

This requires that the Workflow service is running (see Starting the Workflow service in Workflow's

Online Help).

To test the project:

Page 164

elalal=


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/ProcessSubprocess/About_Processes_Subprocesses.html
https://learn.objectiflune.com/videos/project-wizards-overview/
https://youtu.be/6TD1rHD5m7g?t=764
https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowServices/Start_Stop_Service.html

1. Send the Workflow configuration to the OL Connect Workflow service; see Saving and sending
a Workflow Configuration in Workflow's Online Help.

2. Access the web page by entering the following URL in a browser on the machine that runs Work-
flow: http://localhost:9090/hello.

3. Follow the instructions on the page to see how values in the URL change the text of the page.

Saving input as sample data
Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-con-
figured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin Con-
nect Workflow.

2. Selectthe process.

3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and sending a
Workflow Configuration) and run it again, with a custom name value.
The Send to Folder step will now write the input data - the job file - to a file in the Work-
space\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the process.
Note however that the process will not return the web page to a browser, as it wasn't started by a
browser.

Tip: The saved file can be used to create a data mapping configuration.

Project details
The web template

The web page is designed in the WEB_HELLO Web Page template. It contains one Web section (see
"Web pages" on page 498).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 671). The style
rules are in the context_web_styles.css file. Note how they combine the HTML tag, ID and class of ele-
ments to select them. (See also: "Selectors in OL Connect" on page 825.)

There are only two scripts in the template, as you can see on the Scripts pane. You can double-click to
open them.
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Tip: Hover over the name of a script in the Scripts pane to highlight parts of the template that are
affected by the script.

e The My name is script looks for an element that has the ID: hero. Inside that element it looks for
the text: @name@ and replaces that with either the default name ("John Doe") or the name given
in the URL.

* The Year script puts the current year in the footer.

For more information about writing scripts, see: "Writing your own scripts" on page 808.

Tip: You don't have to write a script yourself if you just want to insert some data directly into the
template. You could simply drag-and-drop the data on the template or use a wizard (see: "Vari-
able data in the text" on page 708).

The Workflow configuration

The project's Workflow configuration, Serving a Web Page.OL-workflow, contains just one process.
Itis a simple OL Connect Web process (see "Web processes with OL Connect tasks" on page 174).

The NodedS Server Input task's HTTP action is set to hel1o. This means that this process will be
invoked whenever someone tries to access the Workflow server with this URL: http://{server's
address}/hello.

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. If it wouldn't be fol-
lowed by another task, the Create Web Content task would not return its output to the Workflow pro-
cess, where it can be viewed (click View as HTML).

The data mapping configuration

When the browser sends the request to Workflow, the Workflow process starts and puts the request
into XML, including the values that were given in the URL. To extract those values from the 'job file' (the
XML) the process uses a data mapping configuration, made with the DataMapper: WEB_HELLO Data.

To open the data mapping configuration, select File > Open from the menu and browse to the Con-
figurations\Resources folder.

To create the data mapping configuration, the input data needed to be saved to a file first (see "Saving
input as sample data" on the previous page).

The sample data file is located in the Configurations\Data folder, but you will also see it when you
open the data mapping configuration itself:

For more information about data mapping configurations see "The DataMapper" on page 198.
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Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to make
changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine that
also has a different regional setting? Then indicate the desired encoding in the Designer preferences
(see "Sample Project deployment settings" on page 802) before installing the project.

Input data

If you want to add other parameters to the URL and use those data in the template, here's how to do
that:

1. Run the project, add more parameters to the URL and let the process save the input data to a file
(see "Saving input as sample data" on page 165).

2. Use thefile to create a new data mapping configuration that extracts the additional data. (See
"Creating a new data mapping configuration" on page 200.)

3. Send the new data mapping configuration to Workflow (see "Sending files to Workflow" on
page 418).

4. Open the Workflow configuration, double-click the Execute Data Mapping task to open it and
select the new data mapping configuration.

5. Use the data in the template (see: "Personalizing content" on page 708), send the new template
to Workflow and select it in the properties of the Create Web Content task.

6. Send the Workflow configuration to the server (see Saving and sending a Workflow Configuration

in Workflow's Online Help).

Alternatively you could use input data from a Web form. This is demonstrated by another Sample Pro-
ject:.

Web page
There are countless ways to modify the template. You could add text, images and other elements (see
"Content elements" on page 566) and change the layout (see "Styling and formatting" on page 671).

In order to further personalize the web page, open your data mapping configuration (or JSON data, if
the input data will be in that format; see "Adding JSON sample data" on page 720) and use the data
fields to personalize the page. (See: "Personalizing content" on page 708.)

Tip: The Designer can have one data mapping configuration and one template open at the same
time. Use the tabs at the top of the workspace to switch between the two. Click the synchronize
button on the Data Model pane to make sure that the Data Models are the same in both.

Page 167

Connect


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowConfigurations/Saving_and_sending.html

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 418).

Finally, in Workflow, adjust the process: double-click the Create Web Content task to open it, and
select the new template. This is only necessary when the file name has changed.
Send the Workflow configuration to the server (see Saving and sending a Workflow Configuration in

Workflow's Online Help).

Note: If you want the web page to be responsive (have a different layout on screens of different
sizes), it is recommended to start a new template with a wizard; see "Creating a Web template
with a Wizard" on page 493.

Workflow configuration

The current Workflow configuration is very simple. In a real-life solution, a process that generates a
web page could be part of a larger solution, in which, for example, emails are generated with alink to a
personal landing page.

For general information about processes in Workflow see About Processes and Subprocesses, in the

Online Help of Workflow.

Workflow processes in OL Connect projects
About Workflow processes

A Workflow configuration consists of one or more processes. Each of these processes waits until it is
time to run or until it receives the necessary input, and then does its job. A process is made up of tasks
(also referred to as plugins). In the Workflow configuration tool they are divided into groups. For
example:

» Input tasks look for certain input data on a certain channel and start a process when they find it.
The data that enter the process are handed from one plugin to the next in the form of a file: the
'job file'.

* Process logic tasks help you to control the process, for example by branching it, creating a loop,
or referring to another process or a subprocess.

» Action tasks perform a wide variety of operations.

» Metadata - data about a job, kept in the process - can be accessed and manipulated using
Metadata tasks.

* OL Connect tasks enable the process to communicate with the Connect Server and/or data-
base. (See: "OL Connect tasks" on the next page.)

» A process ends with an Output task.

Page 168

elalal=


https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/WorkflowConfigurations/Saving_and_sending.html
https://help.uplandsoftware.com/objectiflune/en/planetpress_workflow/2022.2/Workflow/ProcessSubprocess/About_Processes_Subprocesses.html

Note: Workflow was originally developed - and is still used - as part of PlanetPress Suite. Never-
theless, most plugins are just as useful in Connect as in PlanetPress Suite. Where plugins are
restricted to one software package or the other, it is indicated in Workflow's Online Help.

Common OL Connect Workflow processes

In an OL Connect project there are typically a number of Workflow processes that communicate with
the Connect Server and/or database through one or more of the OL Connect tasks.

These are the most common Workflow processes in Connect solutions.

» Print process. A process that results in print output implements either the typical OL Connect
Print plugins, or the All in One plugin which combines the Print plugins; see "Print processes with
OL Connect tasks" on page 172.

« Email process. An email process outputs one or more emails; see "Email processes with OL
Connect tasks" on page 171.

 Web process. A web process serves one or more web pages. The output can vary from a plain
and simple web page to an extensive web form. See: "Web processes with OL Connect tasks" on
page 174.

 COTG processes. The process that creates a form for the Capture OnTheGo app is in essence
a web process, but a COTG solution consists of more than one process. The typical COTG pro-
cesses are described here: "Capture OnTheGo Workflow processes" on page 176.

Tip: Sample Project

The OL Connect software comes with a number of Sample Projects that generate a Workflow con-
figuration, and any Connect templates, data mapping configurations, and Print Presets required
to make the project work. For more information, see "Sample Projects" on page 918 in the online
help or the Sample Projects overview video on the OL Learn website.

In each process, runtime parameters can pass variables from PlanetPress Connect Workflow to the
template, data mapping configuration or Job Creation Preset. For more information see "Runtime para-
meters" on page 1352.

OL Connect tasks

In Workflow there is one set of plugins developed especially for OL Connect: the OL Connect tasks.
These plugins are designed to communicate to the OL Connect Server and database, and work with
components that are only available within OL Connect: templates, data mapping configurations, and
Print Presets.
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This topic describes the available OL Connect tasks, which are commonly used in Workflow processes
in OL Connect projects (see "Workflow processes in OL Connect projects” on page 168).

Data extraction

The Execute Data Mapping task is likely to appear in a lot of OL Connect Workflow processes. It gen-

erates a record set in the OL Connect database by executing a data mapping configuration on a data
source.

Output creation
Merging the records with a template is the job of one of the following tasks.
Email

The Create Email Content task creates email content items and sends them to the recipient. See "Email

processes with OL Connect tasks" on the next page.
Web

The Create Web Content task can handle only one record at a time and returns a web page. See "Web

processes with OL Connect tasks" on page 174.
Print

The Create Print Content task generates a set of Print content items in the OL Connect database, but it

is not an Output task. Following this task, the Create Job task assembles Print content items into a Print
job. The Create Output task turns the job into a print output file.

The All In One task combines the four tasks involved in a Print process. If a process's only goal is to cre-
ate Print output, this task is often the better choice because it is faster and more efficient. (See "Print
processes with OL Connect tasks" on page 172.)

However, sometimes using the separate tasks is inevitable.

For example when you want to merge jobs with the Merge Jobs task, or when Print content items cre-
ated at different times should be put into the same job, or when the same extracted data should be

used to create different kinds of output.

The Create Preview PDF task generates a PDF preview for a single record as fast as possible. This pre-

view is typically used for PDF previews embedded in web pages.

PlanetPress Suite Documents

The Create PDF/VT task creates PDF/VT files from a PlanetPress Suite Document (created with Plan-
etPress Design). This PDF/VT is compatible with the Create Print Content task directly, without the
use of an OL Connect template (PDF/VT mode).
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OL Connect database
The following tasks let you act directly upon the OL Connect database:

e The Set Properties task adds properties as tags to items/sets in the OL Connect database.

» The Retrieve ltems task retrieves items (records, or content items, etc.) or sets of items from the
OL Connect database, by ID or by property.

Note: Combined, the Set Properties and Retrieve Items tasks make it possible to batch
and commingle Print content items.

The following two tasks use the Metadata (data about the current job, maintained in the Workflow pro-
cess; see Metadata) to do something with records in the Connect database:

e The Mark Connect Sets for Deletion task marks the sets found in the current Metadata as 'to be

deleted' in the OL Connect database, so that they will be deleted the next time the database's
Cleanup process runs.

» The Update Data Records task updates records in the OL Connect database using values from

the current Metadata.
File Store

The OL Connect Server has a File Store which it uses for transient files. This File Store is managed by
the Cleanup service who takes care of removing obsolete files when those files are not marked as per-
manent.

You can make use of the File Store in your own Workflow processes. The Workflow configuration tool
has three tasks to that end: the File Store - Upload File task, File Store - Download File task, and File

Store - Delete File task.

Email processes with OL Connect tasks

Sending out emails, based on a Connect template, via an automated process requires you to design a
Connect email process in the Workflow configuration tool.
This topic explains which tasks and files are used in a Connect email process.

Tip: An easy way to create a Connect email project, including the Workflow configuration and the
files that it needs, is to use a Sample Project. See "Sample Project: Basic Email" on page 135.
The structure of an OL Connect email process

In an OL Connect Email process only one plugin is essential: the Create Email Content plugin.

The Create Email Content task creates a set of emails, using the Email context in a Connect template,
and sends them to the email server.
You have to select the Connect template in the task's properties.
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If the template doesn't need any data, you can set the Data Source of this task to JSON and enter an
empty JSON string: {}.

However, if the template should be merged with data, you will need to add one or more tasks to provide
the required data. The Create Email Content task must receive either Metadata containing information
regarding a valid Record Set, or JSON data. This can be the output of tasks like:

* An Execute Data Mapping task which retrieves data from the job file (such as the request XML ).
In addition to creating records in the Connect database, this task can output the (IDs of the)
records in the Metadata.

* A Retrieve Items task which retrieves an existing record set from the Connect database and out-
puts it in the Metadata or as JSON data.

* A Create File task that creates a JSON file.
+ Etc.

Which task or tasks fit best, depends on where the data come from.

The Create Email Content task can be found on the OL Connect tab of the Plug-In Bar in Workflow.
For a description of all OL Connect tasks, see "OL Connect tasks" on page 169.

Files used in a Connect email process
Before creating the Email process in the Workflow configuration tool, you will need to create:

* Atemplate with an Email context. (See "Creating a template" on page 415.)

« If the email should contain variable data, you might need to make a data mapping configuration
(see "Creating a new data mapping configuration" on page 200). If the input is going to be JSON
data, you could add them to the design using a JSON file (see "Adding JSON sample data" on
page 720).

Templates and data mapping configurations must be sent from the Designer to PlanetPress Workflow
before they can be used in the Workflow process; see "Sending files to Workflow" on page 418.

The next step is to create a process in PlanetPress Workflow that generates Email output, using these
files.

For more information about how to create a process in Workflow, please refer to the Online Help of
Workflow.

Print processes with OL Connect tasks

Generating print output from a template via an automated process requires you to design a print pro-
cess in the PlanetPress Workflow configuration tool.
This topic explains which tasks and files are used in a print process.
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Tip: An easy way to setup a print project in OL Connect, including the print process and the files
that it needs, is to use a Sample Project. There are two Sample Projects that create a sample
print project. See "Sample Projects" on page 918.

There is also a Walkthrough sample that helps you build a Print process for Connect doc-

uments in the Workflow Configuration tool by yourself, step-by-step: Creating a Print process in
Workflow.

The structure of a print process

In its simplest form, such a process may consist of only two plugins: an Input task and the All In One
plugin.

The All In One task combines the following four OL Connect tasks:

« The Execute Data Mapping task, or the Retrieve Items task.
The Execute Data Mapping task extracts data from the job data file and puts them in a record set.
This task works according to the instructions in a data mapping configuration, made with the
DataMapper (see "Data mapping configurations" on page 199).
The Retrieve ltems task can be used to retrieve records from the OL Connect database.

* The Create Print Content task. This task merges data with a template, resulting in Print Content
Iltems. Templates are made with the Designer (see "Templates" on page 414).

» The Create Job task. This task turns a set of Print Content Items into a print job. Any settings are
passed on to Workflow via a Job Creation Preset.

» The Create Output task. This task creates the actual output file(s). Any settings are passed on to
Workflow via an Output Creation Preset.

The All In One task is the fastest and most efficient way to create print output. The task exchanges less
data with the server than the separate plugins do and it has multi-threading support: it can produce the
data set and content items in parallel.

Nevertheless, the separate plugins would be used in the following situations:

» The record set, created by the Execute Data Mapping task, is also needed to create another kind
of output in the same process.

e Theinputis JSON data, which can be used directly. In this case there is no need to use the
Execute Data Mapping task or Retrieve Items task.

» Ifthe input data is paginated (e.g. a PDF) and doesn't need to be merged with a template, the
Execute Data Mapping task can create Print Content Items as well. This makes it possible to omit
the Create Print Content task.
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» The necessary Print Content Items have already been created, whether in the same or in another
Workflow process. Print Content Items can be retrieved from the OL Connect database using the
Retrieve Items task. Subsequently, the Create Job and Create Output tasks can generate print
output from them.

Note that at the time the Print Content Items are created, their ID or the Print Content Set ID
needs to be stored somewhere where the print process can access them, in order to retrieve the
Print Content Iltems.

The tasks mentioned here can all be found on the OL Connect tab of the Plug-In Bar in Workflow. For a
description of each task, see "OL Connect tasks" on page 169.

Files used in a print process
Before creating the print process in the Workflow configuration tool, you will need to create:
» A template with a Print context. (See "Creating a template" on page 415.)

In addition, the process may use:

+ A data mapping configuration, or a data model at the very least, if the documents should con-
tain variable data. (See "Creating a new data mapping configuration” on page 200.)

* A Job Creation Preset. (See "Job Creation Presets Wizard" on page 1069.) A Job Creation Pre-
set defines where the output goes and makes it possible to filter and sort records, group doc-
uments, and add metadata.

¢ An Output Creation Preset. (See "Output Creation Presets Wizard" on page 1084.) An Output
Creation Preset can split a print job into smaller print jobs, and set printing options such as bind-
ing, OMR markings and the like.

All of these files are made with the Designer and need to be sent to PlanetPress Workflow before they
can be used in the Workflow process; see "Sending files to Workflow" on page 418.

When the necessary files have been created and sent to Workflow, the next step is to create a process
in PlanetPress Workflow that generates Print output, using these files.

For more information about how to create a process in Workflow, please refer to the Online Help of
Workflow.

Web processes with OL Connect tasks

Serving a web page, made with a template, via an automated process requires you to design a web pro-
cess in the PlanetPress Workflow configuration tool.
This topic explains which tasks and files are used in a web process.
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Tip: An easy way to start an OL Connect web project including the web process and the files that
it needs, is to use a Sample Project. There are two Sample Projects that generate a sample web
project. See "Sample Projects" on page 918.

Note: With a trial or reseller license, Connect Web output is limited to the /ocalhost. This means
that the Connect Server and Workflow must be on the same workstation in order to create Web
output.

The structure of a web process
In a web process two plugins are essential:

¢ An Input task.
* The Create Web Content plugin.

If the Input task is a Server Input task, that task will return the output of the process - the web page - to
the caller.

The HTTP Action of the Server Input task determines how the process is triggered. If, for example, the
HTTP Action is /hello, the process will be invoked when the Workflow server receives a request for a
resource called hello. (You could, for example, trigger the process by typing the following URL in the
address bar of your browser: http://localhost:9090/hello, if the browser runs on the same machine as
the Workflow server and the Input task is a NodeJS Server Input task. The protocol could be HTTPS,
depending on the settings of the Input task.)

To trigger the process from a Web Form, set the Action of the Form to the HTTP Action of the Input
task. (See "Forms" on page 640.)

The Create Web Content task creates an HTML output file from the Web context in a template.
Select the Web template in the task's properties.

If the Web template doesn't need any data, you can set the Data Source of this task to JSON and enter
an empty JSON string: {}, or set it to Record ID and enter 0 (zero).

However, if the template should be merged with data, the task needs either a valid Record ID or a
JSON object. In that case, one or more steps must be added to the process to provide the required
data. For example:

* An Execute Data Mapping task that retrieves data from the job file (such as the request XML).
This task outputs one or more records to the Metadata. By default, the Create Web Content task
uses the first Record ID from the Metadata.

* A Retrieve Items task that retrieves an existing record from the OL Connect database and out-
puts it in the Metadata or as JSON object.

Which task or tasks fit best, depends on where the data must come from.
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Of course, numerous other tasks could be added to the process. If you'd want to save the output of the
Create Web Content task - the web page - to afile, for example, the task would have to be followed by a
Send to Folder task.

The Create Web Content task can be found on the OL Connect tab of the Plug-In Bar in Workflow.
For a description of all mentioned OL Connect tasks, see "OL Connect tasks" on page 169.

Files used in a web process

Before creating the web process in the Workflow configuration tool, you will need to create:

+ Atemplate with a Web context. (See "Creating a template" on page 415.)

 If the web page should contain variable data, you might need to make a data mapping con-
figuration (see "Creating a new data mapping configuration" on page 200). If the input is going to
be JSON data, you could add them to the design using a JSON file (see "Adding JSON sample
data" on page 720).

Templates and data mapping configurations need to be sent from the Designer to PlanetPress Work-
flow before they can be used in the Workflow process; see "Sending files to Workflow" on page 418.

The next step is to create a process in PlanetPress Workflow that generates Web output, using these
files.
For more information about how to create a process in Workflow, please refer to the Online Help of

Workflow.
Capture OnTheGo Workflow processes

A Capture OnTheGo solution requires no less than three basic processes in a Workflow configuration:

* One process that generates a document (most often, a form), stores it and notifies the COTG app
of the document's existence. Note that this process doesn't send the actual document. It sends a
ticket to the Capture OnTheGo Server so that when the intended user logs in, the name of the
document will appear in the app's Repository, signaling to the user that the document can be
downloaded.

The key task in this process is the Output to Capture OnTheGo plugin.

* One process that authenticates and replies to document requests from COTG users. This pro-
cess returns the actual document directly to the app. It starts with a Server Input task (the
NodedS Server Input task or the older HTTP Server Input task), which returns the final output of
the process to the caller.

» One process that receives and handles the data when a COTG user submits a form. This process
starts with a Server Input task as well.

The three basic processes are described in more detail in the Capture OnTheGo manual: Basic pro-
cesses involved in COTG.
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Tip: An easy way to create a COTG solution, including the Workflow configuration and other files
that it needs, is to use the COTG Timesheets Sample Project. See "Sample Project: COTG
Timesheets" on page 141.

Batching and commingling

A Connect Print process in its simplest form merges data with a template and creates the print job(s) in
one go, as shown in "Print processes with OL Connect tasks" on page 172.

In reality, however, a company might want to create letters and invoices during the week, for example,
and then print them out only over the weekend. For such a scenario, it would be better to separate the
data mapping and content creation process from the production of the actual print job(s), and work with
print batches.

Batching means gathering and then printing previously created print content items.
Commingling refers to documents originating from different templates being combined into one print
batch.

This topic explains how to batch, commingle, and - not the least importantly - sort and separate items
into print batches with Connect.

The Workflow tasks mentioned here can all be found on the OL Connect tab of the Plug-In Bar in Work-
flow. For descriptions of the tasks, see "OL Connect tasks" on page 169.

Batching

Batching refers to creating print jobs from print content items that were created earlier. A batching print
process is split up in 2 phases:

* Phase 1: Content is created by merging a print template with data. Newly created print content
items are always automatically saved in the Connect database®. Information about the set of
items (the "content set"), including the Content Set ID, gets stored in the database as well.

« Phase 2: Print content items are retrieved from the Connect database using the Retrieve ltems
task. The Create Job and Create Output tasks transform these items or sets into one or more
print jobs.

In order to retrieve print content from the Connect database in the second phase, some preparatory
work must be done in the first phase. What needs to be done exactly depends on what you want to
retrieve, and how.

Sorting and separating the output also requires some preparation (see "Sorting and grouping items in
print batches" on page 179).

'Database entries get cleaned up automatically as well. Make sure that the Cleanup Service is con-
figured appropriately, so that it doesn't remove relevant record sets and content sets before batching
starts (see "Clean-up Service preferences" on page 783).
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What to retrieve: content sets or content items

The Retrieve ltems task can retrieve only one type of entity from the Connect database at a time:
records, record sets, content items and so forth. Since the Create Job task can only work with print con-
tent items or content sets, in a batching print process the choice is narrowed down to these two pos-
sibilities.

Here are a few things to consider:

 If you want the Create Job task to use a Job Creation Preset, you must retrieve content sets. A
Job Creation Preset can filter, sort, and group print content items, add meta data and make fin-
ishing settings (see "Print Presets" on page 1321).

» From a performance perspective, working with content sets is better. Retrieving content sets is
faster than retrieving content items and thus can improve performance. Also, working with Job
Creation presets is more efficient than working with individual content items in Workflow.

» If you decide to retrieve content sets, you may still have to do preparatory work on the content
item level to enable a Job Creation preset to sort the output (see "Sorting and grouping items in
print batches" on the next page).

How to retrieve: selection methods

The Retrieve Iltems task can retrieve items/sets by ID or based upon conditions.

Retrieving items/sets by ID

New print content items are automatically saved in the Connect database when the Create Content
task creates them. The task returns the IDs of those items, as well as the ID of the content set, to the
Workflow process via Metadata (see About Metadata).

In order to retrieve (sets of) items by ID later on, you will have to get the IDs from the Metadata and
store them somewhere else. Workflow's Data Repository would be a good place to store them in; you
can use the Push to Repository task to store the IDs there.

Retrieving items or sets using conditions

When the Retrieve Items task retrieves items or sets based upon conditions, the respective database
entities are matched against the values of data fields or by the values of properties set on entities in
the Connect database.

» Values: Print content items and sets don't contain data fields, but they do have a link to the data
record with which they were created, so selecting and sorting them by value is still a possibility.

» Properties are key/value pairs that can be set on entities in the Connect database. There are
two ways to do that:
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» Using the Set Properties task.
Ideally, the Set Properties task directly follows the Create Print Content task in a Workflow
process. The Create Print Content task returns the IDs of the content items as well as the
ID of the content set to the process via the Metadata. Using those IDs, the Set Properties
task can either set properties on all new Content Items or on the Content Set that was
just created.
Use two consecutive Set Properties tasks to set properties on both levels.

» Through a Post Pagination script in the template. (See "Post Pagination Scripts" on
page 850 and "contentitem" on page 1298.)

In order to retrieve (sets of) items by data values, you may have to adjust the data mapping con-
figuration (see "Data mapping configurations" on page 199).

Note that a property can only be used to retrieve entities on the level on which the property was expli-
citly set. For example, when you set a property on a content set, you can only use that property to
retrieve the content set in its entirety (i.e. all content items that belong to that content set); itisn't pos-
sible to retrieve individual content items using that property. Properties added to a content set are not
propagated to the individual items in that content set.

To label both a set and the items in it, use the Set Properties task twice.

Note: Data field values and properties of items in the Connect database are also used when sort-
ing the output. Make sure to set properties that are necessary for sorting on the content item
level.

Commingling
When documents in one print batch originate from different templates, that is called commingling.

Commingling isn't very different from batching in how it's done. The content creation phase will likely be
a little different, as there will probably be a separate process or branch for each of the templates used
to create the print content.

However, sorting and grouping can become more important when print content items are com-
mingled. For instance, when invoices and letters are commingled, they probably need to be grouped
per customer, and sorted in a certain way. Ensure that there is a unique ID in the different data sets that
can be used to group items together that belong to the same mail piece.

Sorting and grouping items in print batches

Print content items can be grouped and sorted by the values of data fields or by the values of prop-
erties set on them in the Connect database.
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» Values: Print content items and sets don't contain data fields, but they do have a link to the data
record with which they were created, so selecting and sorting them by value is still a possibility.

« Properties are key/value pairs that can be set on entities in the Connect database. There are
two ways to do that:

» Using the Set Properties task.
Ideally, the Set Properties task directly follows the Create Print Content task in a Workflow
process. The Create Print Content task returns the IDs of the content items as well as the
ID of the content set to the process via the Metadata. Using those IDs, the Set Properties
task can either set properties on all new Content Items or on the Content Set that was
just created.
Use two consecutive Set Properties tasks to set properties on both levels.

* Through a Post Pagination script in the template. (See "Post Pagination Scripts" on
page 850 and "contentitem" on page 1298.)

Sorting by property is only possible if the property has been set explicitly on the respective content
items (not content sets) in the Connect database.

It is also important to note that in order to use a data field or property in a sorting rule, it should be
presentin all content items.

You may have to set properties on content items (not content sets) or add data fields to a data model
(see "Data mapping configurations" on page 199), for no other reason than to sort the items by them
eventually.

In Connect there are two places where you could group and sort print content after it has been retrieved
from the Connect database:

¢ In a Job Creation Preset.

* On the Batching/Commingling tab of the Retrieve Items task.

Job Creation Preset

Based on the settings in a Job Creation Preset, the Connect Server can filter, sort, and group print con-
tent items, add meta data and make finishing settings (see "Job Creation Presets" on page 1322). Com-
pared with the Batching/Commingling tab of the Retrieve ltems task, a Job Creation Preset offers a /ot
more options. It is also usually more efficient; that's why it's the recommended method, for larger jobs
at least.

A Job Creation Preset can only take content sets as input. So, if you want to use a Job Creation Pre-
set, the Retrieve Items task must retrieve content sets from the Connect database, not content items.
This also means that if you want to use properties in conditions to retrieve the correct items, those prop-
erties must be set on the content set level.
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However, any properties that you want to be used for filtering, grouping or sorting must be set on the
content items.

Batching/Commingling tab of Retrieve Items task

The Batching/Commingling tab of the Retrieve Items task allows you to group and sort print content on
two levels. You can:

» Bundle content items into "documents" (mail pieces) and sort the items within each document.

e Putdocuments in "groups", and define how documents are sorted within a group.

Note that this tab is only available when the Retrieve Items task is configured to retrieve content items
- not content sets.

Separating the output

Print output in batches can be separated just like all other print output, using an Output Creation Preset
in the Create Output task (see "Output Creation Presets" on page 1324).

This requires that the output be grouped beforehand, either via a Job Creation Preset or via the Batch-
ing/Commingling tab of the Retrieve Items task.

Note that the terminology used on the Batching/Commingling tab and in an Output Creation Preset is
slightly different.

» Select Document Set in the Separation Settings to separate the "documents" defined on the
Batching/Commingling tab.

» Select Job Segment in the Separation Settings to separate the "groups" defined on the Batch-
ing/Commingling tab.

OL Connect automation with Node-RED

Node-RED is a programming tool for wiring together hardware devices, APIs and online services. It
was originally developed by IBM as an open source project and evolved into a general purpose loT/lloT
(Internet of Things/Industrial Internet of Things) programming tool. It provides a browser-based editor
that makes it easy to wire together flows using the wide range of nodes in the palette.

Objectif Lune has added its own set of nodes to this palette: OL Connect nodes. These nodes allow
Node-RED to communicate with the OL Connect server and access the OL Connect database and File
Store.

The information in this chapter will help you get started using Node-RED as an automation tool with OL
Connect. It focuses on the OL Connect nodes, the settings that need to be made to communicate with
the OL Connect server, and the most common flows in OL Connect solutions with Node-RED.
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Tips and techniques regarding standard nodes and tasks in such solutions can be found in another
topic: "Node-RED: nodes and common techniques" on page 184.

For general information about Node-RED, please refer to Node-RED's website: nodered.org.
Installation

Follow the instructions on Downloading and installing Node.js and npm | npm Docs (npmjs.com).

Start the Node-RED editor. Next, download and install the OL Connect Nodes using the Palette mod-
ule: in the right-hand sidebar, click Manage Palette and look for 'olc'.

OL Connect nodes

In a Node-RED application for OL Connect, flows communicate with the Connect Server and access its
Database and/or File Store through one or more OL Connect nodes.

» capture folder

This node monitors a folder for incoming files. The folder path can be set via a global variable.
Typically these global variables are populated in a startup flow.

» data mapping, data get, set properties

These three nodes access the OL Connect database in order to either store or retrieve data -
extracted from data files - or to set properties on the data.

* paginated content, paginated job, paginated output, all in one, preview pdf
These nodes are create print output.
¢ email content

This node renders emails, which can then be sent using third party nodes, via an Email Service
Provider (for example SendGrid).

¢ html content
This node renders web pages or Capture OnTheGo forms based on an OL Connect template.
e preview image

This node merges the Print, Email or Web context of an OL Connect template with a single record
and returns an image.

« file upload, file download, file delete

These nodes access the OL Connect File Store, which holds OL Connect resources such as tem-
plates and data mapping configurations as well as output files such as email content and PDF
files.

» set properties
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This node allows to set properties on data in the OL Connect Database.
« cotg publish, cotg delete

Using these nodes, Capture OnTheGo forms can be published to or deleted from the Capture
OnTheGo repository.

In addition, one configuration node is used by all nodes except the cotg nodes:

* Add new OL Connect Server config node

This node allows entering a URL and credentials to connect to an OL Connect server.
Note that these OL Connect Server settings are not exported with a flow and must be recon-
figured in each flow.

Note: The documentation of all individual nodes is embedded in Node-RED's editor. Hover over
a node in the palette at the left, or select the node in a flow; then click the book icon.

Connection settings for OL Connect Server

In order to setup a OL Connect Server connection:

1. Add one of the OL Connect nodes (not a cotg node) to a flow.

2. Double-click the node to open its Properties window and click the Edit Server icon (a pencil).
3. Enter the URL, user name and password to use to connect to the OL Connect Server.
4

. Click Done.

The next time you add an OL Connect node to this flow, the server will appear in the list of servers in
that node's Properties window.

Note: OL Connect Server settings are not exported with a flow and must be reconfigured in each
flow.

OL Connect resources in Node-RED

OL Connect resources are files created with the Designer or DataMapper. In order to use them in the
OL Connect nodes in a flow in Node-RED they need to be deployed to the OL Connect Server first.

Deployed resources are registered in the OL Connect database and saved in the File Store. OL Con-
nect nodes can either refer to them by name or by using the internal database ID (also referred to as
the managed file ID). The simplest approach is to use the resource name in the respective field of the
node.

There are two ways to deploy OL Connect resources to the File Store: using the Designer or from
within a flow in Node-RED's editor.
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» Forinstructions on sending files to the File Store from the Designer, see "Sending files to Con-
nect Server or to another server" on page 419.

¢ OL Connect's file upload node sends files to the File Store from within a flow. When used in a
Startup flow the uploaded files will be available to all flows in the project. See: "OL Connect Star-
tup flow" on page 189.

Flows in an OL Connect application

These are some of the typical flows in a Node-RED OL Connect solution.

o Startup flow

A Startup flow initializes variables in Node-RED's context - through which information is shared
between nodes without using the messages that pass through a flow - and deploys Connect
resources for the project. See "OL Connect Startup flow" on page 189 for a detailed description.

¢ Print flow

A print flow creates and outputs paginated content. See "An OL Connect print flow in Node-RED"
on page 191.

¢ Email flow

An email flow creates email content and stores it in the File Store or sends it immediately using
an email service provider. See "An OL Connect email flow in Node-RED" on page 190.

* Web (form) flow

A web flow creates web content and stores it in the File Store or serves itimmediately. See "An
OL Connect web flow in Node-RED" on page 195.

¢ COTG flows

Capture OnTheGo flows create and send forms to the Capture OnTheGo mobile application and
process data that is sent back from the application. See "Capture OnTheGo flows in Node-RED"
on page 197.

* PDF preview flows

A PDF preview flow provides a PDF preview, usually at the request of a browser. See "An OL
Connect preview PDF flow in Node-RED" on page 194.

Node-RED: nodes and common techniques

The nodes and common techniques described in this chapter will help you to start creating flows for an
OL Connect application in Node-RED.

The typical flows that an OL Connect application may have are described separately; see "Flows in an
OL Connect application" above.
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For the user documentation of Node-RED, please refer to Node-RED's website: nodered.org.
See also: "OL Connect Startup flow" on page 189

Tip: Add a debug node after a node to verify that the contents of a property of the msg object are
changed as expected.

Nodes used in OL Connect flows

In addition to the "OL Connect nodes" on page 182, these standard nodes will often be used in OL Con-
nect applications:

* The inject node triggers the flow. It can be setup in a way that it triggers the flow whenever it is
deployed or when Node-RED is started (see "OL Connect Startup flow" on page 189). It can also
be used to inject the full path to a (sample) data file into a flow.

e The HTTP in node creates an HTTP end-point for creating web services.

* Any flow that starts with an HTTP in node must have a path to an HTTP response node oth-
erwise requests will eventually timeout.

* The read file node loads afile. If the file is a JSON file, the resultis a JSON string.
¢ The write file writes the content of msg.payloadto afile.

» The JSON node parses a JSON string and adds the keys with their values as properties to
msg.payload.

* The change node can initialize variables and change their value.

« The function node executes JavaScript code. See htips://nodered.org/docs/user-guide/writing-

functions.

» The debug node displays the content of the msg object, which is passed between nodes in a
flow, in the debug message console. Add a debug node - one for each property of the msg object
- after another node to verify that the properties are changed as expected.

» The split node turns a single msg.payload consisting of an array into a series of messages,
each of which has a payload containing one of the array's elements. Note that the Split node only
works on msg.payload and not on its child objects.

 the ability to have multiple output channels in a Switch node and the fact that these channels can
be linked back to a node on the primary/main branch down stream.

These are some useful nodes created by third parties:

Page 185

Connect


https://nodered.org/
https://nodered.org/docs/user-guide/writing-functions
https://nodered.org/docs/user-guide/writing-functions

» The fs-ops-dir node (package: node-red-contrib-fs-ops) lists files in a directory.

+ The watch-directory node captures incoming files. This node is preferable to the standard
watch node as the watch node may trigger the flow before a file is completely written, which can
become problematic when processing larger input files.

Reading a JSON file

In order to load a JSON file you can use a read file node. Set the Filename property to the full path.
Note that when Node-RED's project feature is used, the path is relative to the project location under

NR's user directory (5userprofile%/.node-red/).

Example: When triggered, a startup flow must read the manifest.json file.

» Add a read file node after the inject node that triggers the flow, and connect their
ports.

» Double-click the read file node to view its properties.

» Paste or enter the full path to manifest.json in the Filename property. For
example: C:\projects\project-a\resources\manifest. json, or, when
using Node-RED's project feature: node-red\projects\project-a\mani-

fest.json.
* You can change the Name of the node, for example into: Read manifest.

e Click Done.

Parsing a JSON string

When a JSON file is read, the result is a JSON string. In order to access its data, that string needs to be
parsed to its JavaScript Object representation. Node-RED provides the JSON node to do this con-
version.

The parsed data is written to the payload property of the msg object, which is passed on to the next
node. Keys in the JSON become properties of the payload.

Example

After reading the manifest.json file using a read file node, a startup flow must parse the JSON string in
order to add the keys and values to msg.payload. The manifest.json file has the following content:

{

"email": "Laura from OL Acme <laura@ol-acme.com>",
"someApi": "http://localhost/myendpoint",
"workspace": "C:\\workspace",

"resources": |

"olsg-invoice.OL-template",
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"olsg-invoice-XML.OL-datamapper"

1. Add a JSON node after the read file node. Make sure the JSON node is connected to the output
port of the read file node.

2. Add a debug node and connect the JSON node to the input port of that debug node so that the
result can be viewed in the debug message console, once the flow is deployed.

After the JSON file is parsed, the msg object will have the following properties: msg.payload.email,

msg.payload.somelApi,msg.payload.workspace and msg.payload.resources.
Using variables

There are various ways to set and get the values of (global and other) variables, for example:

» Viathe change node. A 'Set' rule can set the value of one variable to a hard-coded value or to the
value of another variable (e.g. 'Set' global .email tomsg.email object).

» Via the function node, using JavaScript. The node has access to the msg object as well as to the
different contexts: context (i.e. the node's local context), , f1ow and global.

The Context sidebar in the editor of Node-RED displays the contents of the context data store and
allows to view the stored variables. The view consists of three sections, one for each context: node,
flow and global.

Variables stored in the global context of Node-RED are visible to all nodes, in all flows, on all tabs.
Through these variables, information is shared between nodes without using the messages that pass
through a flow.

Example

After parsing a JSON string, a startup flow must initialize global variables to the values of properties of
msg.payload.
1. Insert a change node after the JSON node (wire the input port and the output port).
2. Double-click the change node to view its properties.
3. Create arule for each of the values. For example:
'Set": global.email
To:msg.payload.email

4. Click Done.
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5. Add a debug node and connect the change node to the input port of that debug node so that the
result can be viewed in the debug message console.
Setting and moving msg properties
There are various ways to set and move values of properties in the msg object.
» Viathe change node. Select 'Set' to set a value; select 'Move' in order to move a value from one
property to another property.
» Via the function node. The value of a property can be set or replaced using JavaScript.

After reading and parsing a manifest.json file, a startup flow needs to move the names of some
OL Connect resources frommsg.payload.resources tomsg.payload

. Add a change node to the flow.

. Create arule to 'Move' msg.payload.resources tomsg.payload.

Iterating over items in an array

Ifitems in an array need to be passed on individually, the flow will need to iterate over the items. This
kind of loop is handled by Node-RED's split node. The split node turns a single msg.payload, con-
sisting of an array, into a series of messages, each of which has a payload containing one of the array's

elements.

Note that the split node only works on msg.payload and not on its child objects.

Example: A startup flow needs to iterate over the array in msg . payload that contains the
names of OL Connect resources.

* Insert a split node into the flow.

» Add a debug node to verify that Node-RED creates a new message for each

resource name.

Concatenating strings

To concatenate two strings in different variables, one could use a function node and script it, or use a

change node. Example
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Example: A startup flow needs to upload an OL Connect resource to the OL Connect server, but
the resource name in msg.payload lacks the path. The path is stored inmsg. re-
sourceFolder. To construct the full path and pass it via msg. fi1eName, the flow can use a
change node.

» Add a change node and a file upload node.

* Double-click the change node and create a rule to 'Set' msg. fileName to
msg.resourceFolder & payload. The latteris a JSONata expression.

OL Connect Startup flow

A Startup flow is used in Node-RED projects for OL Connect to initialize global variables and to
deploy OL Connect resources for the project.

A typical startup flow involves the following standard nodes: inject, read file, JSON, change, split,
and debug (see "Nodes used in OL Connect flows" on page 185), and one OL Connect node: file
upload (see "OL Connect nodes" on page 182).

Triggering a startup flow

The inject node can trigger a flow in Node-RED. It can be set to do that when the flow is deployed or
when Node-RED is started, by selecting the Inject once after option in its Properties window.

In order to validate the setup you could add a debug node and connect this to the inject node (i.e. join
the output port of the inject node with the input port of the debug node). Deploying the flow triggers the
inject node, which by default adds a timestamp to the payload of the msg object which is passed
between nodes in a flow. The timestamp becomes visible on the debug tab when you click the Debug
icon in the sidebar.

When the flow is deployed for the first time, a suffix appears after the inject node's name, e.g. "1". The
suffix indicates the number of times the flow has been triggered.

Initializing global variables

Variables stored in the global context of Node-RED are visible to all nodes, in all flows on all tabs. The
values could be set in a change node or scripted in a function node, for example (see "Using vari-
ables" on page 187).

Instead of hard-coding the values, they could be read from a JSON file. The flow would need a read file
node and a JSON node to read the JSON file and transform the keys in the JSON into properties of the
msg.payload. Next, a change node can 'Set' global variables to those properties.

Tip: OL Connect's capture folder node can read the name of the folder to be monitored for
incoming files from a global variable.
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Deploying OL Connect resources
OL Connect's file upload node uploads a single file to the File Store.

This node requires the path to the resource. This should be the full path to the resource or a path rel-
ative to either the Node-RED installation or a path relative to the current Node-RED project.

If not configured in the node's properties, the node expects this information in msg. filename.

Make sure to check the Mark as permanent option. A file marked as permanent will not be removed by
OL Connect's Clean-Up Service.

Also make sure to select the correct OL Connect server, or enter the connection details (see "Con-
nection settings for OL Connect Server" on page 183).

Tip:

. You may need to iterate over an array that contains the names of the
resources and upload them one by one. This can be done by adding a split
node before the file upload node. See "lterating over items in an array" on
page 188.

. The split node only works on msg.payload, not on its child objects. You
may need to move the array that contains the resource names to the pay-
load. See "Setting and moving msg properties" on page 188.

. To construct the path you may need to concatenate strings. See "Con-
catenating strings" on page 188.

An OL Connect email flow in Node-RED

This topic explains which nodes and files are used in a typical OL Connect email flow in Node-RED.

Tip: An easy way to create the files that the typical OL Connect email flow needs, is to use a
Sample Project. See "Sample Project: Basic Email" on page 135. You would use all files except
the Workflow configuration file.

The structure of an OL Connect email flow

In an OL Connect email flow only one plugin is essential: the email content plugin.

The email content node creates a set of emails, using the Email context in a Connect template.
If the template doesn't need any data, setmsg.payloadto an empty JSON string: {}.

If the template should be merged with data, you will need to provide the required data. The data can be
the output of tasks like:
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* An OL Connect data mapping task which retrieves data from the job file (such as the request
XML). In addition to creating records in the Connect database, this task can output the (IDs of
the) records.

» An OL Connect data get node which retrieves an existing record set from the Connect database.
« A standard create file node that creates a JSON file.

+ Etc.

Which node or nodes fit best, depends on where the data come from.

Tip: A number of nodes accept runtime parameters. These can be passed via the parameters
property of the msg object which is passed between nodes. For example, a runtime parameter
named brandld would be passed viamsg.parameters.brandId. Use a function node or
change node to set the property.

Files used in an OL Connect email flow

Before creating the email flow in the editor of Node-RED you will need to create:

¢ Atemplate with an Email context. (See "Creating a template" on page 415.)

« If the email should contain variable data, you may need to create a data mapping configuration
(see "Creating a new data mapping configuration" on page 200). If the input is going to be JSON
data, you could add them to the design using a JSON file (see "Adding JSON sample data" on
page 720).

Note that before templates and data mapping configurations can be used in a flow, they must be sent to
the OL Connect server separately. This can be done from the Designer (see "Sending files to Connect
Server or to another server" on page 419) or in a startup flow (see "OL Connect Startup flow" on

page 189).

An OL Connect print flow in Node-RED

This topic gives an overview of the nodes and files that are used in a typical OL Connect print flow in
Node-RED.

An easy way to create some example files to work with is to use a Sample Project. There are two
Sample Projects that create a sample print project; see "Sample Projects" on page 918. For a print flow
in Node-RED you would use all files except the Workflow configuration file.

If the objective of the flow is to serve a preview of a PDF, take a look at this topic: "An OL Connect pre-
view PDF flow in Node-RED" on page 194.
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The structure of a print flow

In its simplest form, a print flow may consist of only two nodes: one node that captures a data file, such
as a watch, watch-directory or read file node, and the OL Connect all in one node.

The all in one node combines the following four OL Connect nodes:

* The data mapping node that extracts data from a file and stores a record set in the database, or
the data get node that retrieves previously extracted data from the database.

° The data mapping node needs a data mapping configuration, made with the DataMapper
(see "Data mapping configurations" on page 199), and a data file of course.

o All the data get node needs is a Record Set ID.

» The paginated content node. This node merges the data with a template, resulting in Print Con-
tent Items. Templates are made with the Designer (see "Templates" on page 414).

* The paginated job node. This node turns a set of Print Content Items into a print job. Any job set-
tings are passed on via a Job Creation Preset which is made with the Designer (see "Job
Creation Presets" on page 1322).

» The paginated output node. This node creates the actual output file(s) and stores them in the
File Store. Any settings that it needs are passed on via an Output Creation Preset which is made
with the Designer (see "Output Creation Presets" on page 1324).

The nodes listed here are OL Connect nodes; see "OL Connect nodes" on page 182.

The OL Connect nodes are built are built in such a way that the output of a node is automatically recog-
nized as input by the next node.

e The data mapping node outputs a data set ID in msg.dataSetId which is used by the pagin-
ated content node to retrieve the data and create a set of content items.

« The paginated content node outputs a content set ID in msg.contentSetId which is used by
the paginated job node to create a print job.

* The paginated job node outputs a job set ID tomsg. jobSetId which is used by the paginated
output node to generate output.

To build the flow you also need some nodes that are available by default or have been made by other
parties. See "Nodes used in OL Connect flows" on page 185.

The all in one node is the fastest and most efficient way to create print output, as in that case multi-
threading is supported: the data set and content items are produced in parallel.

The separate nodes would be of use in situations like the following:
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e The record set, created by the Execute Data Mapping task, is also needed to create another kind
of output in the same flow.

e The inputis JSON data which can be used directly and doesn't need to be stored in the database.
In this case there is no need to use the data mapping node or data get node.

* The Print Content Items have already been created, either in the same flow or in another flow.
Print Content Items can be retrieved from the OL Connect database using the data get node.
Subsequently, the paginated job and paginated output nodes can generate print output from
them.

Note that at the time the Print Content Items are created, their Print Content Set ID needs to be
stored somewhere where the print flow can access them, in order to retrieve the Print Content
Items. You could for example use MongoDB.

Retrieving the output

The print output node outputs two things: the ID of the output location in the File Store and an array
containing the output file(s). Connect the print output node with the OL Connect file download node
to download a ZIP archive of the entire job based on the msg.managedFileId provided by the print
output node. The data is read into a data buffer which allows it to then be written to disk using the write
file node.

The target location can set by entering the full path in the Filename field of the file node. The other
option is to set it dynamically in msg. £ilename, using a change or function node.

Downloading individual output files

The array that the print output node outputs can be used to download the files individually.

You will need a split node to iterate over the array in msg.payload and generate a new message for
each file, setting msg.payload to the respective file name. See "lterating over items in an array" on
page 188.

Make sure to clear the Filename field in the write file output node before deploying the flow. A value
configured in the node takes precedence over the msg property - msg. filename in this case - and will
be used for every file, overwriting the previous file.

Files used in a print flow

Before creating a print flow, you will need to create:
« Atemplate with a Print context. (See "Creating a template" on page 415.)

In addition, the flow may use:
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» A data mapping configuration, if the documents should contain variable data that is extracted
from some data source. (See "Creating a new data mapping configuration" on page 200.)

* A Job Creation Preset. (See "Job Creation Presets Wizard" on page 1069.) A Job Creation Pre-
set defines where the output goes and makes it possible to filter and sort records, group doc-
uments, and add metadata.

¢ An Output Creation Preset. (See "Output Creation Presets Wizard" on page 1084.) An Output
Creation Preset can split a print job into smaller print jobs, and set printing options such as bind-
ing, OMR markings and the like.

All of these files are made with the Designer and need to be sent to the OL Connect server before using
them in a flow; see "OL Connect resources in Node-RED" on page 183.

An OL Connect preview PDF flow in Node-RED

This topic gives an overview of the nodes and files that are used in a OL Connect PDF preview flow in
Node-RED.

An easy way to create some example files to work with is to use a Sample Project. There are two
Sample Projects that create a sample print project; see "Sample Projects" on page 918. For a PDF pre-
view flow in Node-RED you would use the template and possibly the data mapping configuration; you
would not use the Workflow configuration file.

The structure of a preview PDF flow

Serving a preview to a browser

Typically, a PDF preview flow consists of at least three nodes: an http in node that receives the
request, the preview pdf node which is one of the "OL Connect nodes" on page 182, and the http
response node to serve the preview.

The http in and http response nodes are standard nodes. See "Node-RED: nodes and common tech-
niques" on page 184.

The HTTP in node will pass any query parameters via the payload as JSON data. Query parameters
are key/value pairs attached to the end of an URL. The first parameter is appended to the URL using a
? (question mark). If there are multiple parameters, an & (ampersand) is added in between them.

For example: http://localhost:1881/hello?first=John&last=Doe.

The preview pdf node accepts JSON data provided via the msg.payload property. Note that in order
to merge the data with a template, the parameter names must match field names in the template's data
model.

The template to use can be configured in the preview pdf node or passed via the msg. template prop-
erty. (See: "Setting and moving msg properties" on page 188.)
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The preview pdf node accepts runtime parameters. These can be passed via the parameters prop-
erty of the msg object which is passed between nodes.
For example, a runtime parameter named brandld would be passed viamsg.parameters.brandId.

Creating and saving multiple PDF files

A PDF preview is usually needed in online solutions, but the preview PDF node can also be used in situ-
ations where a PDF file can be produced without an Output Creation Preset.

In such situations the flow could for example have an OL Connect data get node (see "OL Connect
nodes" on page 182) that outputs an array of Data Record IDs, followed by a standard split node, OL
Connect's preview pdf node and a standard write file node.

The preview pdf node can only take one data record ID at a time. That's why you will need the split
node to iterate over the array in msg.payload and generate a new message for each file, setting
msg.payload to the respective Data Record ID. (See "lterating over items in an array" on page 188.)

Make sure to clear the Filename field in the write file output node before deploying the flow. A value
configured in the node takes precedence over the msg property - msg. filename in this case - and will
be used for every file, overwriting the previous file.

Files used in a preview PDF flow

Before creating a preview PDF flow, you will need to create:
« Atemplate with a Print context. (See "Creating a template" on page 415.)
In addition, the flow may use:

» A data mapping configuration, if the document(s) should contain variable data that is extracted
from some data source. (See "Creating a new data mapping configuration" on page 200.)

These files are made with the Designer and need to be sent to the OL Connect server before using
them in a flow. For instructions see "OL Connect resources in Node-RED" on page 183.

An OL Connect web flow in Node-RED

This topic explains which nodes and files are used in a typical OL Connect web flow in Node-RED.

Tip: An easy way to create the files that the typical OL Connect web flow needs, is to use a
Sample Project. See "Sample Project: Serving a Web Page" on page 164. You would use all
files except the Workflow configuration file.

The structure of an OL Connect web flow

In an OL Connect web flow only one plugin is essential: the html content plugin.
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The html content node creates a set of web pages, using the Web context in a Connect template, and
stores them in the File Store or servesiit.
If the template doesn't need any data, set msg.payload to an empty JSON string: { }.

If the template should be merged with data, the data can be the output of another node. Nodes that out-

put data that can be used by the html content node are:

« AnHTTP in node. It will pass any query parameters via the payload. Query parameters are key/-
value pairs attached to the end of an URL. The first parameter is appended to the URL using a ?
(question mark). If there are multiple parameters, an & (ampersand) is added in between each.
Example: http://localhost:1881/hello?first=Peter. Note that in order to use them as data, the para-
meter names must match field names in the template's data model.

The flow should end with a http response node which serves the HTML output.

* An OL Connect data mapping node which retrieves data from the job file (such as the request
XML). In addition to creating records in the Connect database, this task can output the (IDs of
the) records.

* An OL Connect data get node which retrieves an existing record set from the Connect database.
» A standard create file node that creates a JSON file.

+ Etc.

Which node or nodes fit best, depends on where the data come from.

The html content node accepts runtime parameters. These can be passed via the parameters prop-
erty of the msg object which is passed between nodes. For example, a runtime parameter named
brandld would be passed viamsg.parameters.brandId.

Tip: Use a change node or function node to set a property. See also: "Node-RED: nodes and
common techniques" on page 184.
Files used in an OL Connect web flow

Before creating the web flow in the editor of Node-RED you will need to create:

* Atemplate with a Web context. (See "Creating a template" on page 415.)

» Ifthe HTML file should contain variable data, you may need to create a data mapping con-
figuration (see "Creating a new data mapping configuration" on page 200). If the input is going to
be JSON data, you could add them to the design using a JSON file (see "Adding JSON sample
data" on page 720).

Note that before templates and data mapping configurations can be used in a flow, they must be sent to
the OL Connect server separately. This can be done from the Designer (see "Sending files to Connect
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Server or to another server" on page 419) or in a startup flow (see "OL Connect Startup flow" on
page 189).

Capture OnTheGo flows in Node-RED

Capture OnTheGo is an OL Connect solution that allows to create and send digital forms to the COTG

App(iOS, Android or Windows 10) and processes any data that is returned by the app after a form has
been filled out.

A Capture OnTheGo solution typically consists of three basic flows.

* The flow that makes a document available to COTG App users.
* The flow that replies to document requests from COTG App users.

» The flow that receives data from Capture OnTheGo App users.

A Capture OnTheGo Repository ID and password are required in order to configure the COTG node in
these flows.

Making a form available to COTG app users

The flow that creates and publishes COTG forms will usually have the following nodes.

» Typically the trigger will be an endpoint set up using the http in node, but the flow could also be
triggered by an input node like the OL Connect capture folder node, the standard watch node or
the third-party watch-directory node (see "Nodes used in OL Connect flows" on page 185).

» In order to create a personalized form or document, incoming data must be processed.
Once the data file is received, the data mapping node uploads it to the Connect Server and sub-
sequently extracts the data using a data mapping configuration. It outputs a data set ID in
msg.dataSetId.

» The data get node retrieves the records from the database using the data set ID. It stores the
retrieved data records in an array on msg.payload.

¢ Node-RED's split node can be used to iterate over the records. In each iteration the record val-
ues of a single record are written to msg.payload.

* A change node sets any msg properties that the file node and the cotg publish node need, such
as the order ID, customer name, COTG account and the file name of the form.

¢ OL Connect's html content node takes the record ID in msg.payload as its input and renders
the form. It outputs the HTML to msg.payload.

e The file node writes the HTML contentin msg.payload to disk.

* The cotg publish node informs the Capture OnTheGo Server that a new document is available
for download. The node returns the ID of the form on the COTG serverin msg.documentId.
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Tip: Store the form ID in a text file or database along with the order ID and/or GUID. This
makes it possible to find and delete the form (using the cotg delete node) when form data
is submitted.

Serving the form
As soon as a COTG app user taps a button to download a new form, the second flow springs into action
to serve the requested COTG form.

* The http in node receives the request from the COTG app.

* A change node can be used to construct the path to the form file (see "Concatenating strings" on
page 188) and storeitinmsg. filename.

e The file node reads the file from the location given in msg. filename. The form data is returned
inmsg.payload.

* The http response node sends the response back to the request received from the http in node.
It is recommended to add a catch node to catch any errors thrown by the file node and return the applic-
able error code to the browser.

Although it is possible to design the flow to produce the form on demand, this can negatively affect
response time because the template must be merged with data first.

Processing received data

The last required flow in a Capture OnTheGo solution will have an http in node set up to receive data
from the COTG app.

The data may be processed in a variety of ways, as required.

In order to make the COTG app delete the form from the device's library upon successful transmission
of the data, the flow must return status code 291 via the http response node.

The DataMapper

The DataMapper is the tool to create a data mapping configuration. Data mapping configurations are
used to extract data and transpose that data into a format that can be shared amongst different layouts
and outputs created with the OL Connect Designer and Workflow.

The original data, located in a file or database outside of OL Connect, is called a data source.

The first step in the data extraction process is making settings for the input data (see "Data source set-
tings" on page 223), including boundaries for each record inside the data sample. When you define the
boundaries, you are actually defining a series of records inside your data sample file.

After configuring these settings you can start working on the logic to extract data from each of those
records. You need to identify and extract data from each record. To achieve this, you will create a data
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mapping workflow, consisting of multiple steps (extractions, loops, conditions and more) (see "Data
mapping workflow" on page 221 and "Extracting data" on page 229).

When this process is complete, the result is a Data Model. This model contains the necessary inform-
ation to add variable data to OL Connect Designer templates. (see "The Data Model" on page 260 for
more information). It has a generic format with an emphasis on content, free from any restrictions
imposed by the file types or the origin of the data. This allows a same layout or output to be populated
with data from different sources and formats without the need to modify it.

DataMapper basics

Connect’s DataMapper lets you build a data mapping workflow to extract data from a variety of data
sources. The data mapping workflow consists of multiple 'steps' which process and extract data from
each record of a data source and store it in a new, extracted record set. The data mapping workflow is
saved in a data mapping configuration.

1. Create a new data mapping configuration.

Run the Designer and start creating a data mapping configuration by selecting a data source.
See "Data mapping configurations" below.

2. Configure settings for the data source.

The data source can be a file (CSV, PDF, TXT, XML, JSON) or a particular database. Configure
how the data source is read by the DataMapper and create a record structure. See "Data source
settings" on page 223.

3. Build the data mapping workflow.

A data mapping workflow always starts with the Preprocessor step and ends with the Post-
processor step. You can add as many steps as you like and edit the Data Model of the extracted
data as required. See "Data mapping workflow" on page 221 and "The Data Model" on page 260.

What's next?

Use the data mapping configuration in the Designer module to create templates for personalized cus-
tomer communications. To learn more, see "The Designer" on page 412.

In Workflow, a data mapping configuration can be used to extract data. The extracted data can then be
merged with a Designer template to generate output in the form of print, email or a web page. See Work-
flow and "OL Connect tasks" on page 169.

Data mapping configurations

A data mapping configuration file contains the information necessary for data mapping: the settings to
read the source file (Delimiter and Boundary settings), the data mapping workflow with its extraction
instructions ('Steps'), the Data Model and any imported data samples.
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Data mapping configurations are used in the Designer to help add variable data fields and per-
sonalization scripts to a template. In fact, only a Data Model would suffice (see "Importing/exporting a
Data Model" on page 261). The advantage of a data mapping configuration is that it contains the extrac-
ted records to merge with the template, which lets you preview a template with data instead of field
names.

Itis also possible to generate output of a data mapping configuration directly from the Designer (see
"Generating output" on page 1314).

Ultimately data mapping configurations are meant to be used by "OL Connect tasks" on page 169 (i.e.
the Execute Data Mapping task or All in One task) in OL Connect Workflow processes, to extract data
from a particular type of data file. Typically the extracted data is then merged with a template to gen-
erate output in the form of print, email and/or a web page. To make this happen, the data mapping con-
figuration as well as the template and any Print Presets have to be sent to Workflow; see "Sending files
to Workflow" on page 418.

Alternatively these files can be sent to the Connect Server directly; see "Sending files to Connect
Server or to another server" on page 419.

Creating a new data mapping configuration

A new data mapping configuration can be made with or without a wizard. When you open a data file
with a DataMapper wizard, the wizard automatically detects a number of settings. You can adjust these
settings. Next, the wizard automatically extracts as many data fields (or metadata, in case of a PDF/VT
file) as it can, in one extraction step.

Without a wizard you have to make the settings yourself, and configure the extraction workflow manu-
ally.

Note: The DataMapper doesn’t use the data source directly, rather it uses a copy of that data: a
data sample. Although the data sample is a copy, it is updated each time the data mapping con-
figuration is opened or whenever the data sample is selected.

More samples can be added via the Settings pane; see "Data samples" on page 317.

From a file

To start creating a data mapping configuration without a wizard, first select the data file. There are two
ways to do that: from the Welcome screen and from the File menu.

¢ From the Welcome screen
1. Click New DataMapper Configuration.

2. From the From a file pane and select a file type:
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 Comma Separated Values or Excel (CSV/XLSX/XLS),
* Microsoft Access

 PDF, PS, PCL

e Text

o XML

» JSON

3. Click the Browse button and open the file you want to work with (for a database, you may
have to enter a password).

4. Click Finish.
* From the File menu

1. Click the File menu and select New.

2. Click the Data mapping Configuration drop-down and select Files and then the file type:
e CSV, XLSX or XLS (Comma Separated Values or Excel),
» JSON File
» Microsoft Access
» PDF, PS, PCL File
e TextFile
e XML File

3. Click Next.

4. Click the Browse button and open the file you want to work with.

5. Click Finish.

After opening the file, you have to make settings for the input data (see "Data source settings" on
page 223) to make sure that the source data is parsed correctly and divided into logical units of data the
way you want. Then you can start building the data extraction workflow.

* Also select XML if you want a JSON file to be converted to and treated like XML. If there is
no root element in the JSON it will be added and each object without a named parent ele-
ment is called an 'item'.

Note that in addition to being valid, the JSON should follow naming rules for XML ele-
ments. For example, "adress_line_1:" is a valid key name in JSON, but it cannot be con-
verted to a valid element name in XML because the colon is reserved for namespaces. For
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XML naming rules and best naming practices, see: XML elements on W3Schools.

* Excel files saved in "Strict Open XML" format are not supported yet.

e PCL and PostScript (PS) files are automatically converted to PDF format by the Connect
Server. To allow for this, the default Connect Server and (if it is secured) an authenticated
user must be configured via the Preferences (see "Connect Servers preferences" on
page 804).

Note that when used in a production environment (e.g. a Connect Workflow process) the
conversion to PDF may influence the processing speed, depending on the available pro-
cessing power.

» Some advanced PCL to PDF options are available by calling LincPDF (PlanetPress Con-
nect's PCL to PDF converter) command line module; see "Advanced PCL to PDF options"
on page 214.

» Extracting data from a PDF that comes from a Windows printer queue (a PDF converted
to PostScript, converted back to PDF by an Input task in Workflow) might not work. The
problem lies in the conversion of the original PDF to PostScript. PostScript code is usually
optimized to print and not to keep text searchable, by maintaining character identities for
example.

The rule of thumb is: if copy-paste from Acrobat works, so will data mapping; if not, the
DataMapper won't either. If the original is a PDF, it is recommended to find an alternative
way to get it in the system instead of going through a print operation.

* Rotated pages in a PDF are supported (if rotated 0/90/180/270 degrees). The Extract step
will be able to extract data from horizontal and vertical lines of text on rotated pages.
Motion steps (such as the Repeat step and the Goto step) however, can only work as
expected if text on a page has the same orientation as the page, not when text has been
rotated after the page was rotated.

The page number and rotation of a page are shown in the status bar at the bottom, next to
the region selection information.

With a wizard

Data mapping wizards are available for PDF/VT, XML, JSON, CSV/XLSX/XLS and database tabular
files, because these files are structured in a way that can be used to automatically set record bound-
aries.

The wizard for PDF/VT and AFP files cannot extract data, only metadata. After opening such a file with
the wizard, you can build the data extraction workflow for data and metadata in the PDF.

The other wizards use the Extract All step to extract data, but they cannot create detail tables, so they
are less suitable for files from which you want to extract transactional data.
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There are two ways to open a data file with a wizard: from the Welcome screen or from the File menu.

* From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the e icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select the appropriate file type.
e From the File menu

1. Inthe menu, click File > New.

2. Click the Data mapping Wizards drop-down and select the appropriate file type.
The steps to take with the wizard depend on the file type. See:

e "Using the wizard for CSV and Excel files" on page 205

» "Using the wizard for databases" on page 207

e "Using the wizard for PDF/VT or AFP files" on page 211

e "Using the wizard for XML files" on page 213. This wizard can also be used for JSON files.

Generating a counter

Instead of creating a data mapping configuration for a certain type of data file, you may create a data
mapping configuration that only contains a series of sequential numbers. This is a solution if, for
instance, you need to create sequential tickets or anything that has an ID that changes on each record.

Note: You can'’t join this configuration to another data file. It is just a counter to be applied on a
static template.

To generate a counter:

¢ From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the @ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select Generate counters.
¢ From the File menu

1. Inthe menu, click File > New.

2. Click the Data mapping Wizards drop-down and select Generate counters.

You can set the following parameters:
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» Starting Value: The starting number for the counter. Defaults to 1.

* Increment Value: The value by which to increment the counter for each record. For example, an
increment value of 3 and starting value of 1 would give the counter values of 1, 4,7, 10, [...]

* Number of records: The total number of counter records to generate. This is not the end value
but rather the total number of actual records to generate.

» Padding character: Which character to add if the counter's value is smaller than the width.

» Width: The number of digits the counter will have. If the width is larger than the current counter
value, the padding character will be used on the left of the counter value, until the width is equal
to the set value. For example for a counter value of "15", a width of "4" and padding character of
"0", the value will become "0015".

» Prefix: String to add before the counter, for example, adding # to get #00001. The prefix length is
not counted in the width.

 Suffix: String to add after the counter. The suffix length is not counted in the width.
Opening a data mapping configuration

To open an existing data mapping configuration, in the "Menus" on page 290, select File > Open. Make
sure that the file type is either DataMapper files or Connect files. Browse to the configuration file to
open, select it and click Open.

Alternatively, click on File > Open Recent to select one of the recently opened configuration files.

Saving a data mapping configuration

A data mapping configuration file has the extension .OL-datamapper. The file contains the settings, the
extraction workflow ('Steps'), the Data Model and the imported Data Samples (excluding database
source files such as mySQL, oracle, etc).

To save a data mapping configuration:

* Inthe "Menus" on page 290, click on File > Save, or click on Save As to save a copy of a data
mapping configuration under a different name.

* Inthe "Toolbar" on page 357, click the Save button.

If the data mapping configuration has not been saved before, you have to browse to the location where
the data mapping configuration should be saved and type a name, then click Save.

Down-saving a data mapping configuration

The Connect software is backwards compatible: data mapping configurations that were made with an
older version of Connect can always be opened with the newest version of the software.

But newer data mapping configurations cannot be opened with an older version of the software.
Connect, however, allows you to save a data mapping configuration in the format of a previous version
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of the software, so that you may restore a data mapping configuration that was accidentally opened and
saved in a newer version, or share a data mapping configuration with users of a previous version of
Connect.

Note that it may not always be possible to down-save a data mapping configuration to a an older ver-
sion. For instance, a JSON-based data mapping configuration cannot be saved to a version earlier than
2021.1 because the JSON data type did not exist prior to that version.

To down-save a data mapping configuration, select File > Save a Copy, from the menu. Select the
software version and click OK. Next you can select a location and give the data mapping configuration
a name, as usual.

To save a copy, follow the same procedure without selecting a previous version of the software.

Note: Since it was not possible to create a data mapping configuration for a JSON file (without
conversion to XML) until version 2021.1, these data mapping configurations cannot be saved in
the format of an earlier version.

Using the wizard for CSV and Excel files

The DataMapper wizard for CSV and Excel files helps you create a data mapping configuration for such
files. The wizard automatically detects delimiters and extracts all data in one extraction step.

The wizard interprets each line in the file as a record. If your data file contains transactional data, you
will probably want more lines to go in one record and put the transactional data in detail tables.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping con-
figuration is best created without a wizard (see "Creating a new data mapping configuration" on
page 200).

There are two ways to open a CSV file or Excel file with a wizard: from the Welcome screen or from the
File menu.

e From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the & icon at the top right, or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select CSV/XLSX/XLS.

4. Click the Browse button and open the file you want to work with.
5

Click Next.
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¢ From the File menu
1. Inthe menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From CSV/XLSX/XLS File.
3. Click Next.

4. Click the Browse button and open the file you want to work with.

5

. Click Next.

Note: Excel files saved in "Strict Open XML" format are not supported yet.

After selecting the file, take a look at the preview to ensure that the file is the right one and the encod-
ing correctly reads the data. Click Next.

For an Excel file you can make the following settings:

* First row contains field names: Uses the first row of the Excel sheet as headers, which auto-
matically names all extracted fields.

+ Sheet: Select the sheet from which the data should be extracted.

» Sort on: Allows to select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will be sor-
ted as a text.

For a CSV file the wizard will display the different settings it has detected, allowing you to change them:

* Encoding: Defines which encoding is used to read the file.
» Separator: Defines which character separates each field in the file.
« Comment Delimiter: Defines which character starts a comment line.

» Text Delimiter: Defines which character surrounds text fields in the file. Separators and com-
ment delimiters within text are not interpreted as separator or delimiter; they are seen as text.

* Ignore unparseable lines: Ignores any line that does not correspond to the settings above.

» First row contains field names: Uses the first line of the CSV as headers, which automatically
names all extracted fields.

» Sort on: Allows to select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will be sor-
ted as a text.

Page 206

PlanetPress.
elalal=



Tip: The Sort on option, combined with the Stop data mapping option of the "Action step" on
page 257, allows to process only a group of items without having to examine all records. (See
also: "Action step properties" on page 333.)

Verify that the data are read properly.
Finally click Finish. All data fields are automatically extracted in one extraction step.
Using the wizard for databases

The DataMapper wizard for database files helps you create a data mapping configuration for a data-
base file. The wizard extracts the data in one extraction step.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping con-
figuration is best created without a wizard (see "Creating a new data mapping configuration" on
page 200).

Opening a database file with a wizard

There are two ways to open an XML file with a wizard: from the Welcome screen or from the File menu.

e From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the & icon at the top right or
select Help > Welcome on the menu.

2. Click New DataMapper Configuration.
3. From the Using a wizard pane, select Database.
4. Use the drop-down to select the database type.
5. Click Next.
¢ From the File menu
1. Inthe menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From databases.
3. Click Next.
4. Use the drop-down to select the database type.
5. Click Next.

Wizard settings for a database file

After opening a database file with a wizard there are a number of settings to make, depending on the
database type (see below).

On the last page of the dialog, click Finish to close the dialog and open the actual data mapping con-
figuration.
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Note: After creating the initial data mapping configuration you may use a custom SQL query via
the Input Data Settings; see "Settings for a database" on page 224.

Tip: The Sort on option, combined with the Stop data mapping option of the "Action step" on
page 257, allows to process only a group of items without having to examine all records. (See
also: "Action step properties" on page 333.)

MariaDB, MySQL, SQL Server or Oracle

+ Server: Enter the server address for the database.
» Port: Enter the port to communicate with the server. The default port is 3306.
+ Database name: Enter the exact name of the database from where the data should be extracted.

+ User name: Enter a user name that has access to the server and specified database. The user
only requires Readaccess to the database.

+ Password: Enter the password that matches the user name above.

+ Table name: The selected database is a set of related tables composed of rows and columns cor-
responding respectively to source records and fields. Select a table from which you want to
extract data.

* Encoding: Choose the correct encoding to read the file.

» Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will
be sorted as a text.

Microsoft Access

» Password: Enter a password if one is required.

« Table name: The selected database is a set of related tables composed of rows and columns cor-
responding respectively to source records and fields. Select a table from which you want to
extract data.

e Encoding: Choose the correct encoding to read the file.

» Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will
be sorted as a text.
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ODBC Data Source

» ODBC Source: Use the drop-down to select an ODBC System Data Source. This must be a data
source that has been configured in the 64-bit ODBC Data Source Administrator, as PlanetPress
Connect is a 64-bit application and thus cannot access 32-bit data sources.

» This ODBC source is MSSQL.: Check this option if the ODBC source is MSSQL (SQL Server).
The options below appear under MSSQL-ODBC advanced configuration:

 Windows authentication: Select to use the Windows user name and password that are
used by the Connect Service.

+ SQL Server authentication: Select to use the User name and Password set below to con-
nect to the SQL Server:

e User name: Enter the SQL Server user name.
+ Password: Enter the password for the above user name.

» Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will
be sorted as a text.

JDBC

Since JDBC can connect to multiple types of databases, a specific database driver and path to
this driver's JAR file must be specified.

» JDBC Driver: Use the drop-down to select which JDBC Driver to use for the database con-
nection.

+ JAR file path: Enter a path to the JAR file that contains the appropriate driver for the database.
+ Server: Enter the server address for the database server.
+ Database name: Enter the exact name of the database from where the data should be extracted.

« User name: Enter a user name that has access to the server and specified database. The user
only requires Read access to the database.

» Password: Enter the password that matches the user name above.

+ Advanced mode: Check to enable the Connection String field to manually enter the database
connection string.

» Connection string: Type or copy in your connection string.
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» Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending (Z-A)
order. Note that sorting is always textual. Even if the selected column has numbers, it will
be sorted as a text.

Note: To instruct the SQL Server driver to not use encryption, the ";encrypt=false" parameter
needs to be present in the connection string. For more information see "Known Issues" on
page 102.

Using the wizard for JSON files

The DataMapper wizard for JSON files helps you create a data mapping configuration for a simple
JSON file. The wizard provides limited options for specifying source records and boundaries, and adds
one extraction step.

Note:

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping configuration"
on page 200).

The topic Setting up detail tables with JSON describes how to turn repeating items in an array or
object in JSON into detail tables.

There are two ways to open a JSON file with a wizard: from the Welcome screen or from the File menu.

¢ From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the & icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select JSON.

4. Click the Browse button and select the file you want to work with. Click Next.
* From the File menu

1. Inthe menu, click File > New.

2. Click the Data mapping Wizards drop-down and select From JSON File.

3. Click Next.

4. Click the Browse button and select the file you want to work with. Click Next.

After selecting a JSON file, specify if and how the JSON file must be split into multiple records.
This is done by selecting an object or array as parent element. Its direct child elements - objects and
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arrays, not key-value pairs - can be seen as individual source records. If the root is selected, there will
be only one source record.

Whether source records are output as individual records depends on the trigger. Either:

» Select On element to create a new record in the output for each object or array in the parent ele-
ment.

» Select On change to create a new record each time the value in a certain key-value pair
changes. Only key-value pairs that exist at the root of a child element can be evaluated.

When you click Finish, a data mapping configuration will be set up with one Extract all step.

All data found in child elements of the selected parent element are extracted to fields at the root of the
Data Model. If a value consists of an object or array, the entire object or array is extracted to one data
field.

Field names are derived from keys, objects and arrays in the first record, but those aren't necessarily
the same in a subsequent record. If following records have a different structure, for example if a record
has more child elements compared to the first record, some data may not get extracted.

Any elements outside the selected parent element are repeated in the source records, but they don't
get extracted automatically.

Using the wizard for PDF/VT or AFP files
AFP input is only available in PReS Connect.

The pages in PDF/VT and AFP files can be grouped on several levels. Additional information, such as
TLEs (a TLE is a Tagged Logical Element) in AFP files, can be attached to each level in the structure.
The structure and additional information are stored in the file's metadata.

The DataMapper wizard for PDF/VT and AFP files lets you select a level to trigger the start of a new
record and it also enables you to extract the additional information from the metadata. You can extract
data from the content afterwards.

Tip: How to extract information from the metadata in the extraction workflow itself is explained in:
"Extracting metadata" on page 232.

If the data file doesn't contain any metadata, each page is a new record - in other words, a boundary is
set at the start of a new page -, which is exactly what happens when you open the file without a wizard.

You can open a PDF/VT or AFP file with a wizard using the Welcome screen or the File menu.
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* From the Welcome screen

1. Open the PlanetPress ConnectWelcome page by clicking the @ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.
3. From the Using a wizard pane, select PDF/VT or AFP.

4. Click the Browse button and open the PDF/VT or AFP file you want to work with. Click
Next.

* From the File menu
1. Inthe menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From PDF/VT or AFP.
3. Click Next.

4. Click the Browse button and open the PDF/VT or AFP file you want to work with. Click
Next.

After selecting the file, select the following options in the Metadata page:

» Metadata record levels: Use the drop-down to select what level in the metadata defines a
record.

» Field List: This list displays all fields on the chosen level and higher levels in the PDF/VT or AFP
metadata. The right column shows the field name. The left column displays the level on which itis
located. Check any field to add it to the extraction.

Note: NOP (No Operation) records in AFP files cannot be extracted.

Click Finish to close the dialog and open the actual Data Mapping configuration.
On the Settings pane, you will see that the boundary trigger is set to On metadata. The selected
metadata fields are added to the Data Model.

Note: Extracting data from a PDF that comes from a Windows printer queue (a PDF converted
to PostScript, converted back to PDF by an Input task in Workflow) might not work (see the Con-
nect Knowledge Base.)

The rule of thumb is: if copy-paste from Acrobat works, so will data mapping; if not, the DataMap-
per won't either.

Note: Rotated pages in a PDF are supported (if rotated 0/90/180/270 degrees). The Extract

step will be able to extract data from horizontal and vertical lines of text on rotated pages. Motion
steps (such as the Repeat step and the Goto step) however, can only work as expected if text on
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a page has the same orientation as the page, not when text has been rotated after the page was
rotated.

The page number and rotation of a page are shown in the status bar at the bottom, next to the
region selection information.

Using the wizard for XML files

The DataMapper wizard for XML files helps you create a data mapping configuration for an XML file.
The wizard lets you select the type of node and the trigger that delimit the start of a new record. Next,
the wizard extracts the data in one extraction step.

This wizard can also be used to extract data from a JSON file. JSON files are automatically converted
to XML.

If there is no root element in the JSON it will be added and each object without a named parent element
is called an 'item’.

Note that in addition to being valid, the JSON should follow naming rules for XML elements. For
example, "adress_line_1:"is a valid key name in JSON, but it cannot be converted to a valid element
name in XML because the colon is reserved for namespaces. For XML naming rules and best naming
practices, see: XML elements on W3Schools.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping con-
figuration is best created without a wizard (see "Creating a new data mapping configuration" on
page 200).

There are two ways to open an XML/JSON file with a wizard: from the Welcome screen or from the File
menu.

* From the Welcome screen

1. Open the PlanetPress Connect Welcome page by clicking the e icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.
3. From the Using a wizard pane, select XML.

4. Click the Browse button and select the file you want to work with. For a JSON file, change
the file type to JSON first. Click Next.

* From the File menu
1. Inthe menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From XML File.
3. Click Next.
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4. Click the Browse button and select the file you want to work with. For a JSON file, change
the file type to JSON first. Click Next.

After selecting a file, you have to set the split level and trigger type:

« XML Elements: This is a list of node elements that have children nodes. Select the level in the
data that will define the source record.

e Trigger: Select On element to create a record for each occurrence of the node element selected
in the XML Elements field, or select On change to create a record each time the element is dif-
ferent. (Check the option to include attributes in the list of content items that can trigger a bound-

ary.)

Note: The DataMapper only extracts elements for which at least one value is defined in the file.
Attribute values are not taken into account.
Attribute values (prefixed with an @ sign in the Data Viewer) are not extracted automatically.

Click Finish to close the dialog and open the data mapping configuration.
Advanced PCL to PDF options

The Connect DataMapper uses LincPDF to convert PCL files to PDF files. By default, the only options
it passes to LincPDF are the input and output file names. Therefore, everything depends on LincPDF’s
own default settings. However, in order to extract data from a PCL file it might be necessary to take
some of the options into account that were set to create the PCL spool file, such as Edge-to-Edge,
page X and Y offset values, page width and height in the case of a custom page type, or the number of
lines per page to generate the correct number of PDF pages.

This topic's intention is to provide you with a method to make LincPDF take these advanced settings
into account, so the generated PDF can be correctly read in the DataMapper.

Note: The method described in this topic can only be done using PlanetPress Workflow.

Requirements

To be able to import PCL input files, you will need the PCL Input license, in addition to PlanetPress Con-
nect.
To check if you have a PCL Input license:

1. Open the Connect Software Activation module.
2. Click on the "i" icon next to the PlanetPress Connect Server product.

3. When the License File Details window opens, expand the PlanetPress Connect Server, then
expand the DataMapper node. If the Inputs.PCL entry is present in that node, you have a PCL
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Calling LincPDFC via an external program

To set advanced conversion parameters, the PCL input file has to pass through an additional Workflow
process before entering the process in which the data mapping takes place. The extra Workflow pro-
cess should call the LincPDF command line module LincPDFC via the External Program plugin with

the desired advanced conversion parameters. To create such a Workflow process:

1. Add alocal variable to your process and name it incPDFOptions.

2. Add another local variable named workingDir and give it a default Windows path (for example:
C:\PCL2PDF\).

3. Add a plugin to capture the PCL File. You may use any input plugin that imports the PCL file into
the process, such as Folder Capture, LPD Input, etc.

4. Using the Change Emulation plugin, change the Emulation to ASCII. This type of emulation
allows to set the number of lines per page, remove or add lines or even remove some HP PCL
escape sequences if necessary.

5. As the number of options you pass to LincPDFC may be high, it is recommended to assign all the
desired options to the local variable lincPDFOptions. To do that you can use either the Set Job
Infos and Variables plugin or a Run Script Action plugin, for example with the following
JavaScript:

Watch.Setvariable("1incPDFOptions”,"-z:1 -*e -*f -u3 -s -pXOff:-0.155 -pYOff:@.15 -dAuthor:\"OL Connect\" -dTitle:\"" + Watch.Ex-
pandString("%0") + "\"");

This example sets the following options or parameters:
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Argument Description

EdgeToEdgePrinting -z Oor1 Set the flag of “Allows edge-to-edge printing”(default:
FALSE).

Constant Alpha -n:num 0-1 Specify constant alpha value defined in PDF 1.4 (default:
0.5).

UsePolygons *e Oor1 When enabled, Lincoln’s PCL interpreter will output vector

graphics in a simpler mode (default: FALSE).

OutputRgb *f Oor1 When set (1), LincPDF will convert CMYK as RGB col-
orspace before writing (default: FALSE).

-u3 Emulate 300 DPI printers

-s Ignore Redundant Font ID
Page X Offset -pXOff:num number Specifies page’s X-direction offset (default: 0).
Page Y Offset -p YOff:num number Specifies page’s Y-direction offset (default: 0).
PDF Author -dAuthor:$s string PDF document’s author (default: null).
PDF Title -dTitle:$s string PDF document’s title (default: filename).

6. Next, use the External Program plugin to convert the PCL to PDF with the above %{lincPDFOp-
tions} options.

In the General tab:

» Set the Executable file to: C:\Program Files\Objectif Lune\OL Con-
nect\LPDFConv\Bin\LincPDFC.exe

e Setthe Parameters to: -i"%F" -0"%{workingDir}\ Temp\%O. pdf" %{lincPDFOptions}

* As aminimum, LincPDFC requires an input file, which is set here via the parameter —i to
which we are assigning the current job file path and name “%F”, and an output file path and
name set here using the —o parameter with a dynamic value of "%{work-
ingDirf\Temp\%O.pdf".

» Select the "Run minimized" option to run the program in the background

* You may select to Log the program output for additional troubleshooting. This is optional;
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however when activated LincPDFC detailed conversion will be added to the Workflow log.

;ﬁ Watch. SetVariable{"lincPDFOptions®, "-z -n:1.0 =-*e -*f -ul -5 -pX0£f:-0.155 -pYO££:0.15 - —
|1 dRuthor:\"0L Conmect}” -dTitla:\"" + Watch.ExpandString(==0°) +"%"");
|| 4 |Fokder Copture s
| wedkmgDiri\ln E xternal Program
| Call an extemal executable progranm. £
: Change Emulation
oy Jasa —
I 'y .Eemdl On Erlu:ltl Comments |
} Run Script Progean
ta |5t anFg.F Job Ophons Exacutable e
» -_— - . T = -
& s Files Dibpectf Luned0L Connect\LPDF Corn B int\LincFDFC e :"I
i External A Paramelers
& | |CAAB\LincPDFC. exe [%F" o %bwoskingDi)\Temp\%0.pd™ %{incPDFOptions) |
| | Stait in
5 2 Foldes Caplure |I2:'\F'm-;m-n Files\Objech LuneV0L Connect\LPDFComaBin' J
_| S workingDir}\Temp  Fiun irimi
= Progam output capbue
f Change Emulation
’ﬂ!@' POF [v Log the progranm output
Store the program outpat in variable
= | =
f & and Tr Enldes
essages Eat code
Phagin Extemal Program eled fl Store the et code in vanable
%2 =l
5t :-"-I‘='I phiger Foldes Caplure - 1235227 ¥ Verily retum value
o nr;d'U _ If the exit code is Ve Retun
Parzed mask: Using Separation CE_Carmier =
ripedt path % lwoekingD el \T emg |Mﬂm LI | 0 j Fadao ﬂ
Parged path: CADLENCRYFPTEDAMOIDER

7. Save the output of LincPDFC using the —o folder specifier in the parameter (%
{workingDir}\Temp, in this case.)

In another Workflow process, import the created PDF with the Folder Capture input plugin, specifying
the output folder of the previous process (%{workingDir}\Temp in the example) as input folder, and
%0.pdf as the file mask.
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N

Folder Capture

LhJ
Extemal Program - )
o | 1G5 ABinhLincPDFC exe Capture  file from a list of folders
==
4 |Folder Capture General | Other | On Enor | Comments
%lwoakingDi\Temp
Fodder list
1 HlworkingDi\T emp
»__ JChange Emulation
‘s, ) |FoF
[l
Send To Folder
4 *wcakingDin Ot
—
Masks
|50, pof

Once you have the PDF as job file, you may pass it to the Execute Data Mapping plugin for further pro-
cessing.

LincPDFC Options

To view the available options that can be set in LincPDF, run the executable (LincPDFC.exe) in a com-
mand prompt window. It will display a help message with available options.

;ion 18.8.143931
poration. All rights reserved.

“Program File ztif Lune“~0L ConnectsLPDFConu~Bin

Objectif Lu H st LPDFConvsBin 2LincPDFC.exe
i u 6.6.14
Co.. a divizion of Biscom. Inc.

LaimcPDF —ilnput.PCL [—oOutput .PDF1 loptionsl

[options ]
PCL#PDF Options:
Weit I format
Uze F Ll SC command
for details
Informnation” for details
Output non
Do not embed PCL fonts
Ignore RG ro ID
lIzse old font substitution

ct blend mode in PDF 1.4 {B™16>
er in HPGL mode

: font mapping
tRiA z b i - = alpha value in PDF 1.4 <(@.8™1.8>
: =} ! ] " For detalls
1 with grayscolor Fill
{B-Standard.l-Roman.2-An=zi)
Ignore undant Font
Uze 14 - ndard PDF fonts
Emulat @ DPI printers

/*0Open Windows Command Prompt

Change directory

cd C:\Program Files\Objectif Lune\OL Connect\LPDFConv\Bin
C:\Program Files\Objectif Lune\OL Connect\LPDFConv\Bin\LincPDFC.exe

LincPDF for Command-Line, Version 2.6.6.14
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Copyright (c) 2001-2007 Lincoln &amp;amp; Co., a division of Biscom, Inc.
Usage: LincPDF -iInput.PCL [-oOutput.PDF] [options]
[options]

PCL/PDF Options:

-a : Write PDF streams in ASCII format

-b : Use form feed for bad ESC command

-c : see "PCL Font Options" for details

-d : see "Document Information" for details

-e : Output non-editable PDF file

-f : Do not embed PCL fonts

-g : Ignore RG macro ID

-j : Use old font substitution

-k:num : Select blend mode in PDF 1.4 (0~16)

-1 : Start parser in HPGL mode

-m : Do not use font mapping

-n:num : Set constant alpha value in PDF 1.4 (0.0~1.0)
-p : see "Page Setup" for details

-q : Replace pattern with gray/color fill

-r:num : Select Encoding (0-Standard,l-Roman,2-Ansi)
-s : Ignore Redundant Font ID

-t : Use 14 standard PDF fonts

-u3 : Emulate 300 DPI printers

-ua[l-10] : Create PDF/A output and use [1-10]th ICC Profile. See ICC Pro-
files for details

-v : View the result PDF file

-w : see "Watermark Options" for details

-x : Duplex printing for even pages output

-y : see "PDF Security Options" for details

-z : Allow edge-to-edge printing

-*a# : Auto Scan Direction: 1 for on and 0 for off
-*b : Skip same macro RG w/o RG creation

-*c : Use SMPTE RGB colorspace

-*d : Suppress blank pages

-*e : Use Polygons

-*f : Output CMYK as RGB colorspace

Document Information:

-dTitle:$s : PDF Title

-dSubject:$s : PDF Subject

-dAuthor:$s : PDF Author
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-dKeywords:$s : PDF Keywords

-dVersion:num : PDF Version (multiply by 10)

Page Setup:

-pWidth:num : Page Width (required only if Page Type is Custom)
-pHeight:num : Page Height (required only if Page Type is Custom)
-pXOff:num : Page X Offset (see also Measurement)

-pYOff:num : Page Y Offset (see also Measurement)

-pMeasure:num : Page Measurement (O-inch, 1l-mm, 2-point)
-pOrient:num : Page Orientation (0-Portrait, 1l-Landscape)
-pType:num : Page Type (0O-Letter, 1-A4, 2-B5, 3-Legal, 4-Exec.,
5~8-Env., 9-Tabloid, 10-A3, 11-Custom, 12-A5)

PCL Font Options:

-cPoint:num : PCL Font Point (0.25~999.75)

-cPitch:num : PCL Font Pitch (0.1~576)

-cNumber:num : PCL Font Number (0~1000)

-cSymbolSet:$s : PCL Font SymbolSet (e.g. 8U-US, 10U-EU)
-cSource:num : PCL Font Source (0O-internal, 1-left, 2-right, 3-soft)
-cTextPath:num : PCL Font TextPath (0-horizontal, l-vertical)
-cEncoding:num : PCL Font Encoding (see Encoding in LincPDFContrl.doc)
Watermark Options:

-wApply:num : Watermark Apply to (0-Whole, 1-Por~Land, 2-0dd~Even, 3-
lst~Res

t)

-wType:num : Watermark Type (0-Text, l-Image)

-wFont:num : Watermark Font type (0~13)

-wStr:$s : Watermark Text String

-wSize:num : Watermark Font Size (1~1000)

-wGray:num : Watermark Text Grayscale (0O-darkest ~ 100-lightest)
-wDir:num : Watermark Text Direction (0~7)

-wPath:$s : Watermark Image File Path

-wPos:num : Watermark Image Position (0~2)

-wOnTop: Watermark on Top

PDF Security Options:

-yEnable : Enable PDF Encryption

-yUserPassword:$s : Open PDF Password

-yOwnerPassword:$s : Change PDF Permission Password
-yPrintDocument: Enable Document Printing

-yChangeDocument : Enable Document Changing

-yAddAnnotations : Enable Adding Text Annotations

Page 220

elalal=



-yCopyContents : Enable Copying Text and Graphics from Document
-yUsel28Bit : Use 128-bit Encryption
-yAssembleDocument : Enable Assemble Document (128-bit encryption only)
-yExtractText : Enable Text and Graphics Extraction (128-bit encryption
only)
-yLowResolutionPrint : Enable Lower-level Resolution Printing (128-bit
encryption only)
Tips ————————=— ===
using quotation mark for complicated string, for example,
-dKeywords:"keyl, key2"
you can convert multi- PCL files at one time, for instance,
-iFilel.pcl -iFile2.pcl
for second watermark, please add 'l' after each keyword, for example,
-wSize:10 to set first watermark font size, -wSizel:12 for the second.
ICC Profiles for output intent are stored in the folder pointed to by
"ICCPath
" defined
in the register or in the default folder c:\program files\lincoln\lincpd
f and the
profiles info are described in the text file: CMYKICCProfiles.txt in the
same folder.

C:\Program Files\Objectif Lune\OL Connect\LPDFConv\Bin
*/

Data mapping workflow

A data mapping workflow is a series of extraction instructions, called steps. These steps process
and extract the data from the source and store them in records whose structure is determined in the
Data Model (see "The Data Model" on page 260). Together with the data source settings, the Data
Model, and the sample data, this is what makes a data mapping configuration (See "Data mapping con-

figurations" on page 199).

The data mapping workflow is shown on the Steps pane at the left (see "Steps pane" on page 321).
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Creating a data mapping workflow

A data mapping workflow always starts with the Preprocessor step and ends with the Postprocessor
step. These steps allow the application to perform actions on the data file itself before it is handed over
to the data mapping workflow ("Preprocessor step” on page 249) and after the Data Mapping workflow
has completed ("Postprocessor step" on page 258).

When you create a new data mapping configuration, these steps are added automatically, but they
don't actually do anything until you configure them.

In between the Preprocessor and Postprocessor step, the workflow can contain as many steps as
needed to extract the required data.

Defining properties and runtime parameters

Before adding steps, define the properties and runtime variables that you will need in the data mapping
configuration.

A data mapping configuration's properties hold data that can be used throughout the data mapping
workflow to compare against in conditions or to complement the existing data.

Runtime parameters are properties that will pass information from OL Connect Workflow to the data
mapping configuration.

All properties are defined in the Preprocessor step.
For more information see "Properties and runtime parameters" on page 227.
Adding steps

Extracting data is the main way to build a data mapping workflow; see "Extracting data" on page 229.
Extract steps, Condition steps and Repeat steps can be added after selecting data in the Data Viewer.
All steps can be added via the Steps pane:

1. Inthe extraction workflow on the Steps pane, select the step after which to add the new step.

2. Right-click on the Steps pane and select Add a Step; then select one of the step types.

To add a first Step inside a Repeat or Condition structure, click on the initial step of the Repeat/Condi-
tion structure. This highlights the entire structure and any Step you add now would be positioned imme-
diately after the structure. Click once more on the structure's initial step to highlight it alone. The next
Step added will now be positioned as the first child inside the structure.

Editing steps

The properties of each step in the extraction workflow become visible in the Step properties pane
when you select that step in the Steps pane.

The name of each step is shown in the Steps pane. You can change it under Description in the Step
properties pane.

The other properties are different per step type; see "Steps" on page 248.
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Rearranging steps

To rearrange steps, simply drag & drop them somewhere else on the colored line in the Steps pane.
Alternatively you may right-click on a step and select Cut Step or use the Cut#% button in the Toolbar.
If the step is Repeat or Condition, all steps inside it will also be placed on the clipboard. To place the

step at its destination, right-click any step and select Paste Step, or use the Paste El button in the tool-

bar. The pasted steps will be positioned below the selected step.

Keep in mind that steps may influence each other, so you may have to move other steps as well to
ensure that the workflow continues to function properly. In a Text file for example, an Extract step may
require a Goto step to be positioned immediately before it to move the current position to a certain loc-
ation in the source data.

Deleting steps

To delete a step, right-click on it in the Steps pane and select Delete Step.
Testing the extraction workflow

The extraction workflow is always performed on the current record in the data source. When an error is
encountered, the extraction workflow stops, and the data field on which the error occurred and all data
fields related to subsequent steps will be greyed out. Click the Messages tab (next to the Step prop-
erties pane) to see any error messages.

To test the extraction workflow on all records that are displayed, you can either:

* Click the Validate All Records toolbar button.

+ Select Data > Validate Records in the menu.

If any errors are encountered in one or more records, an error message will be displayed. Errors
encountered while performing the extraction workflow on the current record will also be visible on the
Messages tab.

Note: How many records are displayed in the Data Viewer (200, by default) is specified in the
Record limit on the Settings pane.

Data source settings

After opening a data file you have to make a number of settings to make sure that the source data is
interpreted and grouped the way you want. These settings are found on the Settings pane at the left.

¢ Input Data settings help the DataMapper read the data source and recognize data correctly.

* Boundaries mark the start of a new record. They let you organize the data, depending on how
you want to use them.
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» Data format settings define how dates, times and numbers are formatted by default in the data
source.

Input data settings (Delimiters)

The Input Data settings (on the Settings pane at the left) specify how the input data must be inter-
preted. These settings are different for each data type. For a CSV file, for example, it is important to
specify the delimiter that separates data fields. PDF files are already delimited naturally by page, so the
only input data settings for PDF files are instructions on how to parse the text on each page.

For an overview of all options, see: "Input Data" on page 307.

Settings for a CSV File

In a CSV file, data is read line by line, where each line may contain multiple fields, separated by a
delimiter. Even though CSV stands for comma-separated values, fields may be separated using any
character, including commas, tabs, semicolons, and pipes.

The text delimiter is used to wrap around each field just in case the field values contain the field sep-
arator. This ensures that, for example, the field “Smith; John” is not interpreted as two fields, even if the
field delimiter is the semicolon.

For an explanation of all the options, see: "CSV file Input Data settings" on page 307.

Settings for an Excel File

For an Excel file you have to specify which sheet to use. You can also set how many lines should be
skipped, if the first row contains field names or not, and how the data should be sorted. See: "Excel file
Input Data settings" on page 308.

Excel has its own way to display dates. You can specify if the Data Viewer should display dates just as
Excel does, or not. That's important because extracting a Date value will only be successful if the expec-
ted date format matches the actual format of a date in the Data Viewer.

This Editor Data Format setting is found on the Settings pane; see: "Editor Data Format" on page 318.
The expected date format is set somewhere else; see: "Default Data Format" on page 319.

Settings for a PDF File

PDF files have a clear and unmovable delimiter: pages. So, the Input Data settings are not used to set
delimiters. Instead, these options determine how words, lines and paragraphs are detected when you
select content in the PDF to extract data from it.

For an explanation of all the options, see: "PDF file Input Data settings" on page 308.

Settings for a database

Databases all return the same type of information. Therefore the Input Data options for a database
refer to the tables inside the database. Clicking on any of the tables shows the first line of the data in
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that table.

If the database supports stored procedures, including inner joins, grouping and sorting, you can use
custom SQL to make a selection from the database, using whatever language the database supports.
The query may contain variables and properties, so that the selection will be dynamically adjusted each
time the data mapping configuration is actually used in a Workflow process; see "Using variables and
properties in an SQL query" on page 320.

For an explanation of all the options, see: "Database Input Data settings" on page 309.

Settings for a text file

Because text files have many different shapes and sizes, there are a lot of input data settings for these
files. You can add or remove characters in lines if it has a header you want to get rid of, or unwanted
characters at the beginning of your file, for example; you can also set a line width if you are still working
with old line printer data; etc.

It is important that pages be defined properly. This can be done either by using a set number of lines or
using a string of text (for example, the character “P”), to detect on the page. Be aware that this is not a
Boundary setting; it detects each new page, not each new record.

For an explanation of all the options, see: "Text file Input Data settings" on page 310.

Settings for an XML file

XML is a special file format because these file types can have a theoretically unlimited number of struc-
ture types. The input data has three options that basically determine at which node level a new record
is created. You can:

» Select an element type to create a new delimiter every time that element is encountered.

» Enter an XPath to create a delimiter based on the node name of elements. The Show all ele-
ments option allows you to extract information from all elements, even when the delimiter is set to
a specific lower-level element.

* Use the root node. If there is only one top-level element, there will only be one record before the
Boundaries are set.

See also: "XML File Input Data settings" on page 311.
Note: The DataMapper only extracts elements for which at least one value is defined in the file.

Settings for a JSON file

For JSON files there are two input data options that determine where a new source record starts.
You can either use the object or array at the root and get one output record, or select an object or array
as parent element. Its direct child elements - objects and arrays, not key-value pairs - are then seen as
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individual source records. Any elements at the same level as the parent element or at a higher level are
repeated in each source record.

See also: "JSON File Input Data settings" on page 313.
Record boundaries

Boundaries are the division between records: they define where one record ends and the next record
begins. Using boundaries, you can organize the data the way you want.

You could use the exact same data source with different boundaries in order to extract different inform-
ation. If, for instance, a PDF file contains multiple invoices, each invoice could be a record, or all
invoices for one customer could go into a single record.

Keep in mind that when the data is merged with a template, each record generates output (print, email,
web page) for a single recipient.

To set a boundary, a specific trigger must be defined.

The trigger can be a natural delimiter between blocks of data, such as a row in a CSV file or a page in a
PDF file.

It can also be something in the data that is either static (for example, the text "Page 1 of" in a PDF file)
or changing (a customer ID, a user name, etc).

To define a more complex trigger, you can write a script (see "Setting boundaries using JavaScript" on
page 364). This option is not available with XML and JSON files.

A new record cannot start in the middle of a data field, so if the trigger is something in the data, the
boundary will be set on the nearest preceding natural delimiter. If for instance in a PDF file the text
"Page 1 of" is used as the trigger, the new record starts at the page break before that text.

For an explanation of all Boundaries options per file type, see "Boundaries" on page 313.
Data format settings

By default the data type of extracted data is a HTMLString, but each field in the Data Model can be set
to contain another data type (see "Data types" on page 275). When that data type is Date, Number or
Currency, the DataMapper will expect the data in the data source to be formatted in a certain way,
depending on the settings.

The default format for dates, numbers and currencies can be set in three places: in the user pref-
erences, in the data source settings, and per field in the Data Model.

By default, the user preferences are set to the system preferences. These user preferences become

the default format values for any newly created data mapping configuration. To change these pref-
erences, select Window > Preferences > DataMapper > DataMapper default format (see "DataMap-
per preferences" on page 786).
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Data format settings defined for a data source apply to any new extraction made in the current data
mapping configuration. These settings are made on the Settings pane; see "Settings pane" on
page 307.

Settings for a field that contains extracted data are made via the properties of the Extract step that the
field belongs to (see "Setting the data type" on page 268). Any format settings specified per field are
always used, regardless of the user preferences or data source settings.

Note: Data format settings tell the DataMapper how to read and parse data from the data
source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to
a DateTime object. How they are displayed in the Data Model depends on the preferences (see
"Default Format" on page 786).

Properties and runtime parameters

A data mapping configuration's properties hold data that can be used throughout the data mapping
workflow to compare against in conditions or to complement the existing data.

A number of properties are predefined, such as the path of the file that is currently being processed,
and the current position of the pointer in the data.

Itis also possible to define custom properties. For instance, a unique ID could be created to be added
to each record in the output for integrity checks later on, or a time stamp could be added to create
reports. A tag could be added to process certain records differently.

Ultimately data mapping configurations are meant to be used in automated processes, to extract data
from a particular type of data file.

Runtime parameters can pass values from an automation tool - PlanetPress Workflow, usually - to a
template, data mapping configuration or Job Creation Preset. The actual values of the parameters may
be different from one time that a process runs to the next, which means the output could be different
even when the same template, data mapping configuration and/or Job Creation Presets are used.

In a data mapping configuration, certain runtime parameters are predefined, such as the ones that refer
to the JoblInfo variables in Workflow. For an overview see "Fixed automation properties" on page 324.

You can also define custom runtime parameters. With those, you could, for example:

» Pass a JSON structure, containing boundary information as well as the name and location of
fields to be extracted dynamically from a data stream. This way, a generic data mapping con-
figuration could be used to process several kinds of different files.

» Define default values that are different from one data mapping instance to the next, even when
using the same data mapping configuration.
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Defining custom properties and runtime parameters
Defining properties

You can define custom properties under Properties in the "Preprocessor step” on page 249 (see
"Preprocessor step properties" on page 323).

To add a property:
1. Select the Preprocessor step on the Steps pane.

2. Onthe Step properties pane, under Properties, click the Add button -, See "Properties" on

page 325 for an explanation of the settings for properties.

Defining runtime parameters

Custom runtime parameters in a data mapping configuration are defined via the Parameters pane.
This can be found next to the Data Model pane at the right. If it isn't visible, use the menu: Window >
Show View > Parameters to make it visible.

Note: The source of a runtime parameter value must be set in the automation tool, e.g. OL Con-
nect Workflow, in the Runtime Parameters section of the OL Connect task that uses the data map-
ping configuration. (See All In One and Execute Data Mapping in the Online Help of Workflow.)

To add a runtime parameter, start by opening the data mapping configuration to which the parameter
should be added. Make sure the data mapping configuration is visible in the workspace; then open the
Parameters pane.

Note: Runtime parameters are always added to the file currently visible in the workspace.

To add a parameter:

1. Click the Add button. The Add Parameter dialog opens.

2. Give the runtime parameter a name. The name is needed to access the parameter in a script and
to set its source in the automation tool.

3. Optionally, set a debug value. Note that the debug value is never actually used outside of the
DataMapper. Its only purpose is to make it easier to design and test the data mapping con-
figuration. The actual value of a runtime parameter comes from the automation tool, e.g. the
Execute Data Mapping task or the All in One task in PlanetPress Workflow.

4. Click OK.
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Editing a runtime parameter

To modify a runtime parameter, click its name or value in the Parameters pane and enter the new name
or value.

To remove a runtime parameter, select it and click the Remove button (ﬁ).
Accessing properties and runtime parameters
There are different ways to access properties and runtime parameters in a data mapping workflow.

* Property-based fields. A property-based field is filled with the value of a property. See "Prop-
erty-based field" on page 266.

» Step settings. Properties can be selected in the Condition, Multiple Conditions and Repeat
step properties (see "Condition step" on page 253, "Multiple Conditions step" on page 256 and
"Repeat step" on page 251).

» Script. Scripts can access properties through the "DataMapper Scripts API" on page 360. (See
also: "Using scripts in the DataMapper" on page 362.)

* The sourceRecord objecthas aproperties array that lets you access custom prop-
erties that are added to each individual record, i.e. the scope of the property is set to Each
record. (See: "sourceRecord" on page 396.)

To change the value of such a property you could use an Action step (see "Action step"” on
page 257). Note that the property's value will be reset at the beginning of each source
record.

* The data object has a properties array that lets you access custom properties of the
data as a whole, i.e. the scope of the property is set to Entire data. (See: "data" on
page 374.) These are read-only.

» To access a runtime parameter inside of any JavaScript code within the data mapping
configuration, use automation.parameters.runtimeparametername. (See;

"Objects" on page 369.) Runtime parameters are read-only.

Note: Runtime parameters in a data mapping configuration are always of the type
String. Remember to parse the value if necessary, e.g. before using itin a cal-
culation.

Extracting data
Data are extracted via Extraction steps into fields in the Data Model. This topic explains how to do that.

Fields can also be filled with other data: the result of a JavaScript or the value of a property. To learn
how to do that, see "Fields" on page 264.
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Before you start
Data source settings

Data source settings must be made beforehand, not only to make sure that the data is properly read but
also to have it organized in a record structure that meets the purpose of the data mapping configuration
(see "Data source settings" on page 223). It is important to set the boundaries before starting to
extract data, especially transactional data (see "Extracting transactional data" on page 235). Bound-
aries determine which data blocks - lines, pages, nodes - form a record in the source data. Data that
are located in different records cannot be merged into a single record inside the record set that is the
result of the extraction workflow.

Preprocessor step

The Preprocessor step allows the application to perform actions on the data file itself before it is
handed over to the Data Mapping workflow. In addition, properties can be defined in this step. These
properties may be used throughout the extraction workflow. For more information, see "Preprocessor
step" on page 249.

Adding an extraction

In an extraction workflow, Extract steps are the pieces that take care of the actual data extractions.
To add an Extract step:

1. Inthe Data Viewer pane, select the data that needs to be extracted. (See "Selecting data" on
page 233.)

2. Choose one of two ways to extract the selected data.
* Right-click on the selected data and select Add Extraction from the contextual menu.
Note: For optimization purposes, it is better to add data to an existing Extract step

than to have a succession of extraction steps. To do that, select that step on the
Steps pane first; then right-click on the selected data and choose Add Extract Field.

» Alternatively, drag & drop the selected fields into the Data Model pane.

Tip: In a PDF or Text file, use the Drag icon %3 to drag selected data into the Data
Model.

With this method, a new Extract step will only be added to the extraction workflow if
another Extract step is not currently selected. Otherwise, the field is added to the currently
selected Extraction step.

Dragging data into an existing field in the Data Model will replace the data. The field name
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stays the same.
Drop data on empty fields or on the record itself to add new fields.

Special conditions
The Extract step may need to be combined with another type of step to get the desired result.

» Data can be extracted conditionally with a Condition step or Multiple Conditions step; see
"Condition step" on page 253 or "Multiple Conditions step"” on page 256.

* Normally the same extraction workflow is automatically applied to all records in the source data.
It is however possible to skip records, entirely or partially, or to stop data mapping using an
Action step. Add an Action step in a branch under a Condition step or Multiple Conditions step
(see "Action step" on page 257) and set the type of action to Stop processing record or Stop data
mapping, according to what is needed (see "Action step properties" on page 333).

» To extract transactional data, the Extract step must be placed inside a Repeat step. See
"Extracting transactional data" on page 235.

Note: Data cannot be extracted more than once in any record, unless the Extract steps are mutu-
ally exclusive. This is the case when they are located in different branches of a Condition step or
Multiple Conditions step.

Inside a Detail table, multiple Extract steps may extract the same data but each of them will cre-
ate a new child record in the Detail table.

If you tick the Append values to current record option when several steps are extracting the same
field, the step will error out.

Extracting data into multiple fields

When you select multiple fields in a CSV or tabular data file and extract them simultaneously, they are
put into different fields in the Data Model automatically.

In a PDF or Text file, when multiple lines are extracted at the same time, they are by default joined and
put into one field in the Data Model. To split them and put the data into different fields:

1. Select the field in the Data Model that contains the extracted lines.

2. Onthe Step properties pane, under Field Definition, click the drop-down next to Split and
select Split lines.

Page 231

Connect



Adding fields to an existing Extract step

For optimization purposes, it is better to add fields to an existing Extract step than to have a succession
of extraction steps.

To add fields to an existing Extract step:

1. Inthe Data Viewer pane, select the data that needs to be extracted. (See "Selecting data" on the
next page.)

2. Select an Extract step on the Steps pane.

3. Right-click on the data and select Add Extract Field, or drag & drop the data on the Data Model.

When data are dropped on the Data Model, they are by default added to the currently selected Extract
step.

Extracting metadata

The pages in PDF/VT files can be grouped on several levels. Additional information, such as TLEs - a
TLE is a Tagged Logical Element - in AFP files, can be attached to each level in the structure. The struc-
ture and additional information are stored in the file's metadata.

When setting up a data mapping configuration for these type of files, a metadata level can be set to
define a record.

Next, if you are using the wizard, you can select fields to be extracted from the metadata automatically.
It is also possible to extract information from the metadata without the wizard. Here's how to do that.

1. Goto the Steps pane.

2. Click the Extract step toolbar button. This adds an Extract step with one field. Alternatively you
could select an existing Extract step and add a field to it.

3. Onthe Extract step properties pane, under Field definition, set the field's Mode to Metadata.
4. Select the Level of the metadata on which the information can be found.

5. Select the Property to extract.

Alternatively you could create a JavaScript extraction (see "Using scripts in the DataMapper" on
page 362 and "extractMeta()" on page 384).

Editing fields
After extracting some data, you may want to:

* Change the names of fields that are included in the extraction.

» Change the order in which fields are extracted.
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» Set the data type, data format and default value of each field.
* Modify the extracted data through a script.

¢ Delete a field.

All this can be done via the Step properties pane (see "Extract step properties" on page 326), because
the fields in the Data Model are seen as properties of an Extract step. See also: "Fields" on page 264.

Testing the extraction workflow

The extraction workflow is always performed on the current record in the data source. When an error is
encountered, the extraction workflow stops, and the data field on which the error occurred and all data
fields related to subsequent steps will be greyed out. Click the Messages tab (next to the Step prop-
erties pane) to see any error messages.

To test the extraction workflow on all records that are displayed, you can either:

¢ Click the Validate All Records toolbar button.

+ Select Data > Validate Records in the menu.

If any errors are encountered in one or more records, an error message will be displayed. Errors
encountered while performing the extraction workflow on the current record will also be visible on the
Messages tab.

Note: How many records are displayed in the Data Viewer (200, by default) is specified in the
Record limit on the Settings pane.

Selecting data

In order to extract the data, it is necessary to first define the data to be extracted, by selecting it. How
this is done depends on the data source type. The following paragraphs explain how to create and
manipulate a data selection for each different type of data.

Data selections are used to extract promotional data ("Extracting data" on page 229), transactional
data ("Extracting transactional data" on page 235) and to apply a condition to an extraction (Condition
step). They can also be used to control the workflow through conditions and loops.

Right-clicking on a data selection displays a contextual menu with the actions that can be performed
with that selection or the steps that can be added with it. That menu also displays the keyboard short-
cuts.

Text or PDF file

To select data in a Text or PDF file, click on a starting point, keep the mouse button down, drag to the
end of the data that needs to be selected and release the mouse button. The data selection can contain
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multiple lines.

To resize a data selection, click and hold one of the resize handles on the borders or corners, move
them to the new size and release the mouse button.

To move the data selection, click and hold anywhere on the data selection, move it to its new desired
location and release the mouse button.

Note: In a Text or PDF file, when you move the selection rectangle directly after extracting data,
you can use it to select data for the next extraction.

However, moving the selection rectangle that appears after clicking on a field in the Data Model
actually changes which data is extracted into that field.

CSV/XLS/XLSX file or database recordset

Tabular data is displayed in the Data Viewer in a table where multiple fields appear for each line and
row in the original data.

To select data, click on a field, keep the mouse button down, drag to the last field that you want to
select and release the mouse button. You cannot select multiple lines with tabular data.

Alternatively you can select fields just like files in the Windows Explorer: keep the Ctrl button pressed
down while clicking on fields to select or deselect them, or keep the Shift button pressed down to select
consecutive fields.

XML file

XML data is displayed as a tree view inside the Data Viewer.

In this tree view you can select nodes just like files in the Windows Explorer: keep the Ctrl key pressed
down while clicking on nodes to select or deselect them, or keep the Shift key pressed down to select
consecutive nodes.

You can select multiple fields even if those fields are in different nodes.

To get a better overview you can collapse any XML level.
XMLPath

The Goto step is rarely used in XML extraction workflows. The DataMapper moves through the file
using Xpath, a standard query language to identify and navigate nodes in an XML document.

JSON file

JSON data is displayed as a tree view inside the Data Viewer. Arrays and objects are enclosed in
square or curly brackets, respectively: []or {}.
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In this tree view you can select elements just like files in the Windows Explorer. Keep the Ctrl key
pressed down while clicking on key-value pairs or brackets to select multiple elements, or keep the
Shift key pressed down to select consecutive elements.

You can select multiple key-value pairs, arrays and objects even if those are in different elements.

To get a better overview you can collapse any JSON level.

JsonPath

The DataMapper moves through JSON files using JsonPath, a path-like syntax to identify and navigate
elements in a JSON document. For an overview of the JsonPath syntax, see htips://github.com/json-
path/jsonpath.

In the DataMapper the JsonPath can be absolute (start with $ which is the root) or relative to the current
position (start with . which is the current element).

JsonPath can be used in a Repeat step, Extract step and Condition step, often eliminating the need for
a Goto step.

A JsonPath can be relative or absolute. Note, however, that with a relative JsonPath going up to a par-
ent element is not possible.

Tip: The full JsonPath to an element is displayed at the bottom left of the window when you
select it. To copy the path, right-click it and select Copy.

Note: If a key in a JSON file has a name that looks like a function (e.g. "TLIST(A1)"), then the
Extract step has to use a JsonPath with bracket notation instead of the default dot notation. For
information about the bracket notation see https://goessner.net/articles/JsonPath/.

Extracting transactional data

Promotional data are data about customers, such as addresses, names and phone numbers. In Con-
nect, each record in the extracted record set represents one recipient. The number of fields that contain
promotional data is the same in each record. These data are stored on the root level of the extracted
record.

Transactional data, on the other hand, are used in communications about transactions between a
company and their customers or suppliers: invoices, statements, and purchase orders, for example.
Naturally these data differ per customer. They are stored in detail tables in the extracted record. The
number of detail lines in a detail table can vary from record to record.
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abe SubTotal 93,76

abe TaxTotal 14.04
abe Total 10780
4 7] services [1] 1

abe Number TVDIGHD
abe Description High Definition Digital TV -
abe BasePrice 30.00 [
abe Rebates -28.19
abe Charges 67.25
abe SubTotal 39.06

abe AccountMumber G784589574527852
abe UserMame

abe Type Television

a T charges [8] 1 (][]
abe 1D TVDIGES
abe Description  TB Basic Digital Service
abe Price 30.00

a T details [6] 1
abe CODE MVHDLOC
abe 1D 55123

abe Description  Gangster Squad HD
abe TirmneStamp  2013-02-1619:24:33
abe Price 585

1

(For more information about detail tables, multiple detail tables and nested detail tables, see "Detail
tables" on page 298.)

Detail tables are created when an Extract step is added within a Repeat step. The Repeat step goes
through a number of lines or nodes. An Extract step within that loop extracts data from each line or
node.

How exactly this loop is constructed depends on the type of source data.

Tip: To break out of a loop and immediately jump to the next task following the current loop, use
an Action task and set its action to Break out of repeat loop.

Note that such loops work well when the data are structured uniformly, e.g. when all rows have the
same number of columns, and when detail data always start at the same point in the line. Obviously,
that is not always the case.

How to extract transactional data that is structured differently is explained in another topic: Extracting
data with a script.

The topic: "Extracting data of variable length" on page 245 explains a few ways to extract data from a
variable number of lines into one data field.
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From a CSV file or a Database
The transactional data (also called line items) appear in multiple rows.

1. Select afield in the column that contains the first line item information.

2. Right-click this data selection and select Add Repeat.

Settings |4, Steps = O || 71 *New config (CSV) &2
# || Tabular viewer # 15 | Zoom(%)
~
IFIJ ItemMNumber  temDesc ltemUnitPrice  htemOrdered  ItemShipped  [temBO  ltemTotal TotalOrdered TotalShipped TotalBO
2 PSMOD03 Upgrade (Starter te Web) 7495 3 3 0 22435 26 26 0
Ext Ha PSMO10 Document Design Training - 1day 1230 3 3 0 3750 26 26 0
raction
PSMO003 PSM Web 7095 2 2 0 15990 26 26 0
=) PSM002 PSM Praduction (unlimited) 4995 1 1 0 4995 26 26 0
- R PSMOD04 Upgrade (Starter to Preduction) 4495 3 3 0 13485 26 26 0
H PSMO08 B2C and Payment Module Upgrade 793 2 2 0 1590 26 26 0
I@ PSMODT1 PSM (price per class) - 1 day 2000 3 3 0 6000 26 26 0
PSMO06 Upgrade (Preduction to Web]) 375 2 2 0 8750 26 26 0
PSM001 PSM Starter (100K records) 905 3 3 0 2985 26 26 0
PSMO07 Additional 350K reccords 2500 3 3 0 7500 26 26 0
PSMO09 e-Learning - PSM Training program 393 1 1 0 595 26 26 0

This adds a Repeat step with a GoTo step inside it. The GoTo step moves the cursor down to the
next line, until there are no more lines (see "Goto step" on page 252).

3. (Optional.) Add an empty detail table via the Data Model pane: right-click the Data Model and
select Add a table. Give the detail table a name.

4. Select the Repeat step on the Steps pane.

5. Start extracting data (see "Adding an extraction" on page 230).
When you drag & drop data on the name of a detail table in the Data Model pane, the data are
added to that detail table.
Dropping the data somewhere else on the Data Model pane creates a new detail table, with a
default name that you can change later on (see "Renaming a detail table" on page 298).
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The extraction step is placed inside the Repeat step, just before the GoTo step.

Settings -ﬁ__Steps =0

Fo

]
-

Extract All

Extraction

==

Gato

B

From an XML file

The transactional data appears in repeated elements.
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1. Right-click one of the repeating elements and select Add Repeat.

Settings 41, Steps = O ||[e *Name ML) £3 = O/ pata model i e B
£ | XML viewer € 5 | Zoomw) [10 F] 0 0 @ || Neme Yalie NS
~ 4 T record [100] 1[B][E
IP] <+ Rep (REPD290771) Gt abe FULLNAME Percy Ludwick
<> SubTotal ( 45184.98) e D CU33615165
N <» TaxTotal { 3388.87) abe Gender Mr
Extraction <> Total ( 48573.83) e LastName Ludwick
E a ¢ ITEM e Firsthlame Percy
= <3 MNumber (PPX019) abe Address1 822, Confluence Court
Extractionl <> Description (PP Pen CADOX-12345) ahe Address2 Suite 7443
<> UnitPrice ({ 300.00) ave City Rockwood
= <> Ordered (2) abe State ON
< <> Shipped (2) ae Country ca
e <3 BackOrder (0} ae ZipCode X1R 5E4
W <> Total ([ 600.00) e Title Service Representative
a <> ITEM O abe Company Rockwood Engine Systems
<» Mumber (PPX027) abe Phone2 (555) 380-6476, #235
<> Description (PP Pen CADDX-92345) ac Email p.ludwick@oldrupa.com
<3 UnitPrice ( 300.00) abe Language EN
<> Ordered (2) abe MD3 C9B28FBAB37EGB4FET19C2C3EB0FDEBDE
<> Shipped (2) e LINE_ITEMS 24
<> BackOrder (0) abe Number INVE103083
<> Total ( 600.00) abe Date 2012-02-19
a < ITEM 0 abe DueDate 2012-03-20
<> Number (PPLOOT7) e Rep REPO290771
<> Description (PP Prn Lic. CAODL-22345) e SubTotal 45134.98
<» UnitPrice ( 1000.00) abe TaxTotal 3388.87
<> Ordered (1) abe Total 48573.85
<> Shipped (1) W

This adds a Repeat step to the data mapping configuration.

By default, the Repeat type of this step is set to For Each, so that each of the repeated elements
is iterated over. You can see this on the Step properties pane, as long as the Repeat step is
selected on the Steps pane. In the Collection field, you will find the corresponding node path.

Tip: You may edit the XPath in the Collection field, to include or exclude elements from
the loop. One example of this is given in a How-to: Using Xpath in a Repeat step.
The example in the How-to uses the starts-with () function. For an overview of XPath

functions, see Mozilla: XPath Functions.

In addition, it is possible to use JavaScript statements in an XPath in the Collection field to
dynamically select elements; see "Repeat Definition" on page 339.

The Goto step isn't used in XML extraction workflows in most cases. The DataMapper moves
through the file using Xpath, a path-like syntax to identify and navigate nodes in an XML doc-
ument.

2. (Optional.) Add an empty detail table via the Data Model pane: right-click the Data Model and
select Add a table. Give the detail table a name.

3. Select the Repeat step on the Steps pane.

4. Extract the data: inside a repeating element, select the data that you want to extract. Then right-
click the selected nodes and select Add Extraction, or drag & drop them in the Data Model.
When you drag & drop data on the name of a detail table in the Data Model pane, the data are
added to that detail table.

Dropping the data somewhere else on the Data Model pane creates a new detail table, with a
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default name that you can change later on (see "Renaming a detail table" on page 298).
The new Extract step will be located in the Repeat step.

Settings |41, Steps = O ||[Gi *Name (ML) 52 = O || Data model eaed ST 0
#1| XML viewer & 15 |Zoome [10 0 0 @ || Name Value
FS 4 7] record [100] 1[p][E
i <» Rep (REP02%0771) i abe FULLNAME Percy Ludwick
<> SubTotal ( 45184.98) abe D CU53615165
e :t <> TaxTotal ( 3388.87) abe Gender Mr
raction
= <> Total { 48573.85) abe LastName Ludwick
ez z 4 ¢ ITEM 0 abe FirstName Percy
= < NLH’V’!l.JEr (PPX019) abe Addressl 822, Confluence Court
Extraction <> Description (PP Pen CAQDX-12345) abe Address2 Suite 7443
= <> UnitPrice ( 300.00) abe City Rockwood
<> Ordered (2) abe State ON
- <> Shipped (2) sbe Country ca
Repeat <> BackOrder (0) abe ZipCode X1R 5E4
[,:.? . - <> Total ( 600.00) abe Title Service Representative
& o ~ 4 < ITEM ( s Company Rockwood Engine Systems
§ <3 Mumber (PPX027) abe Phone? (553) 380-6476, #235
o)ooaag <> Description (PP Pen CADDX-92345) ae Email p.ludwick@oldrupa.com
& <> UnitPrice ( 300.00) e Language EN
o
S <» Ordered (2) abe MDS C9B28FBAB3TEGBAFE19C2C3ES0FDEBDE
H <> Shipped (2) s LINE_ITEMS 24
[@ <> BackOrder (0) abe Number INV6103083
<> Total ( 600.00) abe Date 2012-02-19
~
= 4 o ITEM we DueDate 2012-03-20
<> Mumber (PPLOOT) abe Rep REP0290771
<> Description (PP Prn Lic. CAODL-22345) ac SubTotal 45124.98
<3 UnitPrice { 1000.00) are TaxTotal 3388.87
<> Ordered (1) ahe Total 48573.85
<> Shipped (1} i

From a JSON file
The transactional data appears in repeated elements.

1. Move the cursor to the parent element of the repeating elements. By default the cursor is loc-
ated at the top of the page, but previous steps may have moved it. Note that an Extract step does
not move the cursor.

a. Select the parent element of the repeating elements.

b. Right-click and select Add Goto. The Goto step will move the cursor to the start of the first line
item.

Instead of using a Goto step you could define the path to the collection of elements directly in the
JsonPath Collection field of the Repeat step. Note that this cannot be an absolute path. An abso-
lute path points to one element only.

2. Right-click the opening bracket of the first of the repeating elements and select Add Repeat.
This adds a Repeat step to the data mapping configuration.
By default, the Repeat type of this step is set to For Each. With this setting the Extract step goes
through the defined collection of elements, without the need for a Goto step within the loop. (With
the other Repeat type settings the loop must contain a Goto step.)
You can find the corresponding JsonPath in the JsonPath Collection field on the Step prop-
erties pane, as long as the Repeat step is selected on the Steps pane.

Page 240

elalal=



Tip: You may edit the JsonPath in the JsonPath Collection field to include or exclude
elements from the loop. For an overview of the JsonPath syntax, see hiips://-
github.com/json-path/jsonpath.

3. (Optional.) Add an empty detail table via the Data Model pane: right-click the Data Model and
select Add a table. Give the detail table a name.

4. Select the Repeat step on the Steps pane.

5. Extract the data: inside the first of the repeating elements, select the data that you want to
extract. Then right-click the selected nodes and select Add Extraction, or drag & drop in the
Data Model.

When you drag & drop data on the name of a detail table in the Data Model pane, the data are
added to that detail table.

Dropping the data somewhere else on the Data Model pane creates a new detail table, with a
default name that you can change later on (see "Renaming a detail table" on page 298).

The new Extract step will be located in the Repeat step.

About JsonPath

The DataMapper moves through JSON files using JsonPath, a path-like syntax to identify and navigate
elements in a JSON document. For an overview of the JsonPath syntax, see htips://github.com/json-
path/jsonpath.

In the DataMapper the JsonPath can be absolute (start with $ which is the root) or relative to the current
position (start with . which is the current element).

A JsonPath can be relative or absolute. Note, however, that with a relative JsonPath going up to a par-
ent element is not possible.

Tip: The full JsonPath to an element is displayed at the bottom left of the window when you
select it. To copy the path, right-click it and select Copy.

Note: If a key in a JSON file has a name that looks like a function (e.g. "TLIST(A1)"), then the
Extract step has to use a JsonPath with bracket notation instead of the default dot notation. For
information about the bracket notation see htips://goessner.net/articles/JsonPath/.

From a Text or a PDF file

In a PDF or Text file, transactional data appears on multiple lines and can be spread over multiple
pages.
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1. Add a Goto step if necessary. Make sure that the cursor is located where the extraction loop
must start. By default the cursor is located at the top of the page, but previous steps may have
moved it. Note that an Extract step does not move the cursor.

a. Select an element in the first line item.

b. Right-click on the selection and select Add Goto. The Goto step will move the cursor to the start of
the first line item.

Settings |51, Steps = 0| ([@ “Name (PDP) 12 = 0|4 Data model Ryed 870
£ | PDF viewer #1158 |zomen [0 O L@ || Name Vetie)
~ 4 1 record [134] 1[B]m
[Fjj S <> Field1 Mr Romeo Leininger<br /...
r.leininger@oldrupa.com
3 EN
Exrgtion 86EDFF7336B7E6CC96CECD67C77258EE

o=

PPX027 PP Pen CA00X-92345 300.00 3 3 o 900.00
H PPX019 PP Pen CA00X-12345 300.00 2 2 ] 600.00
PPL006 PP Prn Lic. CAOOL-12345 950.00 2 2 0 1900.00
[@ PPLO16 PP Prn Lic. CAOOL-B2345 1425.00 3 3 ] 4275.00
PPLO15 PP Prn Lic. CAOOL-A2345 1400.00 3 3 0 4200.00
PPLO10 PP Prn Lic. CAOOL-52345 1150.00 1 1 ] 1150.00
PPX025 PP Pen CAO0X-72345 300.00 1 1 0 300.00
PPX030 PP Pen CAQ0X-C2345 300.00 2 2 [} 600.00
PPL013 PP Prn Lic. CAOOL-82345 1300.00 1 1 0 1300.00
PPS004 PP Search CA00S-12345 28.99 1 1 [} 29.99
SUBTOTALS : 19 19 0 15254.99
TAXES : 1144.12
TOTAL: 16399.11
v
< >
Step Properties| 1 Messages B
Extract Step o

» Description

~ Extraction Definition

2. Add a Repeat step where the loop must stop.

a. Inthe line under the last line item, look for a text that can be used as a condition to stop the loop,
for example "Subtotals", Total" or "Amount".

b. Select that text, right-click on it and select Add Repeat. The Repeat step loops over all lines until
the selected text is found.

Settings | &1 Steps = O ||[@ *Name (PDF) 12 = B/ Data model Baeh &0

# || PDF viewer €5 8| zomm [0 HL P @ ||Nme alug
~ 4 [ record [134] 1[BIE
[Plﬂ 2 <> Field1 Mr Romeo Leininger<br /.
r.leininger@oldrupa.com
EN

Extraction

B86EDFF7336B7E6CC96CECD67CT7258EE

Ppg""" PP Pen CA00X-92345 300.00 3 3 o 900.00
Gato PPX(39 PP Pen CAOO0X-12345 300.00 2 2 0 600.00
— PPL006 PP Prn Lic. CAOOL-12345 950.00 2 2 ) 1900.00
— PPLO16 PP Prn Lic. CAOOL-B2345 1425.00 3 3 0 4275.00
H PPLO15 PP Prn Lic. CAOOL-A2345 1400.00 3 3 o 4200.00
8 PPLO10 PP Prn Lic. CAOOL-52345 1150.00 ab ik o 1150.00
W PPX025 PP Pen CA00X-72345 300.00 1 1 o 300.00
PPX030 PP Pen CAOOX-C2345 300.00 2 2 o 600.00
PPL013 PP Prn Lic. CA00L-82345 1300.00 1 1 1) 1300.00
PPS004 PP Search CA00S-12345 29.99 ab il o 29.99
SUBTOTALS : 19 19 V) 15254.99
TAXES: 1144.12
TOTAL: 16399.11
v
< >
Step Properties. i Messages ]

3. Include/exclude lines. Lines between the start and end of the loop that don't contain a line item
must be excluded from the extraction. Or rather, all lines that contain a line item have to be
included. This is done by adding a Condition step within the Repeat step.
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a. Select the start of the Repeat step on the Steps pane.

b. Look for something in the data that distinguishes lines with a line item from other lines (or the other
way around). Often, a "." or "," appears in prices or totals at the same place in every line item, but
not on other lines.

c. Select that data, right-click on it and select Add Conditional.

Settings | &1 Steps = B |||z *Name (PDR) &2 = B || Data model B e d =

< || PDF viewer €5 E|zome [0 HEO L@ || Neme Value
o 4 =1 record [134] 1 [BIE

IF;D] 2 <> Fieldl  MrRomeo Leinin...
Extrattion .nger@oldrupa.com I
'336B7E6CC96CECD67CT77258EE
Gato
= + PP Pen CAO0X-92345 300.00 3 3 0 900.00
= + PP Pen CA00X-12345 300.00 2 2 0 600.00
= + PP Prn Lic. CAOOL-12345 950.00 2 2 0 1900.00
s + PP Prn Lic. CAOOL-B2345 1425.00 3 3 0 4275.00
+ PP Prn Lic. CAOOL-A2345 1400.00 3 3 0 4200.00
- M PP Prn Lic. CAOOL-52345 1150.00 1 1 0 1150.00
E = + PP Pen CA0O0X-72345 300.00 1 1 0 300.00
: = + PP Pen CAO0X-C2345 300.00 2 2 0 600.00
H 5 + PP Prn Lic. CAOOL-82345 1300.00 1 1 0 1300.00
§ 2 + PP Search CA005-12345 29.99 ak ak 0 29.99
Soasai 2 SUBTOTALS : 19 19 0 15254.99
= TAXES: 1144.12
I% TOTAL: 16399.11

v
< >

Selecting data - especially something as small as a dot - can be difficult in a PDF file. To make
sure that a Condition step checks for certain data: Set the Right operand to Value (in the Step
properties pane). Make a selection in the Data Viewer and click the Use selected text button in
the Right Operand section. You will now be able to see whether or not the proper text is extracted
by the current selection. Repeat this until you are satisfied that the proper data is being extracted.
Click on the Use selection button in the Left Operand section to fill out the coordinates. The point
of origin of each character is at the bottom left of each of them and extends up and to the right.

In the Data Viewer, you will see a green check mark in the left margin next to each included line
and an X for other lines.
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4. (Optional.) Add an empty detail table to the Data Model: right-click the Data Model and select
Add a table. Give the detail table a name.

5. Extract the data (see "Adding an extraction" on page 230).
When you drag & drop data on the name of a detail table in the Data Model pane, the data are
added to that detail table.
Dropping the data somewhere else on the Data Model pane, or using the contextual menu in the
Data Viewer, creates a new detail table, with a default name that you can change later on (see
"Renaming a detail table" on page 298).

Note: In a PDF or Text file, pieces of data often have a variable size: a product description,
for example, may be short and fit on one line, or be long and cover two lines. To learn how
to handle this, see "Extracting data of variable length" on the next page.

ab.Select the amount or amounts.

e

b. Click on the end of the Repeat step (+*) in the Steps panel.

c. Right-click on the selected data and select Add Extraction.
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Extract the sum or totals. If the record contains sums or totals at the end of the line items list,
the end of the Repeat step is a good place to add an Extract step for these data. After the loop
step, the cursor position is at the end of line items.Alternatively, right-click on the end of the
Repeat step in the Steps panel and select Add a Step > Add Extraction.
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Tip: This how-to describes in detail how to extract an item description that appears in a variable
number of lines: How to extract multiline items.

Extracting data of variable length

In PDF and Text files, transactional data isn't structured uniformly, as in a CSV, database or XML file.
Data can be located anywhere on a page. Therefore, data are extracted from a certain region on the
page. However, the data can be spread over multiple lines and multiple pages:

» Line items may continue on the next page, separated from the line items on the first page by a
page break, a number of empty lines and a letterhead.

» Data may vary in length: a product description for example may or may not fit on one line.

How to exclude lines from an extraction is explained in another topic: "Extracting transactional data" on
page 235 (see From a PDF or Text file).
This topic explains a few ways to extract a variable number of lines.

Text file: setting the height to 0

If the variable part in a TXT file is at the end of the record (for example, the body of an email) the height
of the region to extract can be set to 0. This instructs the DataMapper to extract all lines starting from
the current position in a record until the end of the record, and store them in a single field.

This also works with the data.extract() method in a script; see "extract()" on page 375.
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Finding a condition

Where it isn't possible to use a setting to extract data of variable length, the key is to find one or more
differences between lines that make clear how big the region is from where data needs to be extracted.
Whilst, for example, a product description may extend over two lines, other data - such as the unit price
- will never be longer than one line. Either the area above or the one below the unit price will be empty
when the product description covers two lines.

Such a difference can then be used as a condition in a Condition step or a Case in a Multiple Conditions
step.

A Condition step, as well as each Case in a Multiple Conditions step, can only check for one condition.
To combine conditions, you would need a script.

Using a Condition step or Multiple Conditions step

Using a Condition step ("Condition step" on page 253) or a Multiple Conditions step ("Multiple Condi-
tions step" on page 256) one could determine how big the region is that contains the data that needs to
be extracted.

In each of the branches under the Condition or Multiple Conditions step, an Extract step could be
added to extract the data from a particular region. The Extract steps could write their data to the same
field.

Note: Data cannot be extracted more than once in any record, unless the Extract steps are mutu-
ally exclusive. This is the case when they are located in different branches of a Condition step or
Multiple Conditions step.

Inside a Detail table, multiple Extract steps may extract the same data but each of them will cre-
ate a new child record in the Detail table.

If you tick the Append values to current record option when several steps are extracting the same
field, the step will error out.

Create and edit the Extract step in the 'true' branch, then right-click the step on the Steps pane,
select Copy Step, and paste the step in the 'false' branch. Now you only have to adjust the region
from which this Extract step extracts data.

To learn how to configure a Condition step or a Case in a Multiple Conditions step, see "Configuring a
Condition step" on page 255.
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Using a script

A script could also provide a solution when data needs to be extracted from a variable region. This
requires using a Javascript-based field.
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1. Add afield to an Extract step, preferably by extracting data from one of the possible regions; see
"Extracting data" on page 229. To add a field without extracting data, see "Expression-based
field" on page 265.

2. On the Step properties pane, under Field Definition, select the field and change its Mode to
Javascript.
If the field was created with its Mode set to Location, you will see that the script already contains
one line of code to extract data from the original location.

3. Expand the script. Start by doing the check(s) to determine where the data that needs to be
extracted is located. Use the data.extract () function to extract the data. The parameters that
this function expects depend on the data source, see "extract()" on page 375.

Example: The following script extracts data from a certain region in a Text file; let's assume that
this region contains the unit price. If the unit price is empty (after trimming any spaces), the
product description has to be extracted from two lines; else the product description should be
extracted from one line.

var s = data.extract(1,7,1,2,"");
if (s.substring(l,3).trim().length == 0)
{ data.extract(12,37,0,2,""); } /* extract two lines */

else { data.extract(12,37,0,1,""); } /* extract one line */

The fourth parameter of the extract () function contains the height of the region. When working
with a Text file, this equals a number of lines.

With a Text file, the data.extract () method accepts 0 as its height parameter. With the height
set to 0 it extracts all lines starting from the given position until the end of the record.

Note that this script replicates exactly what can be done in a Condition step. In cases like this, it is
recommended to use a Condition step. Only use a script when no steps are sufficient to give the expec-
ted result, or when the extraction can be better optimized in a script.

Steps

In the DataMapper, steps are part of an extraction workflow (see "Data mapping workflow" on
page 221). They contain a specific instruction for the DataMapper, for example to extract data, create a
loop, or apply a condition. Some types of steps are containers for other steps.

The steps, displayed on the "Steps pane" on page 321, are executed sequentially, from top to bottom in
an extraction workflow.

Inside a Condition step, some steps may be skipped altogether when they are on a particular branch,
whereas in a Repeat step - a loop - several steps may be repeated a number of times.
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The Preprocessor and Postprocessor steps are special in that the former can be used to modify the
incoming data prior to executing the rest of the extraction workflow while the latter can be used to fur-
ther process the resulting record set after the entire extraction workflow has been executed.

Step types
These are the types of steps that can be added to a data mapping workflow:

* "Preprocessor step” below

» "Extract step" on the facing page

* "Repeat step" on page 251

» "Goto step" on page 252

e "Condition step" on page 253

» "Multiple Conditions step" on page 256
e "Action step" on page 257

» "Postprocessor step" on page 258

Preprocessor step

The Preprocessor step allows to modify the incoming data through a number of preprocessors prior to
executing the rest of the extraction workflow (see "Preprocessors” below). It also lets you define prop-
erties and runtime parameters that can be used throughout the data mapping workflow.

For a complete overview of the settings for a Preprocessor step, see: "Preprocessor step properties"” on
page 323.

Properties and runtime parameters

A data mapping configuration's properties hold data that can be used throughout the data mapping
workflow to compare against in conditions or to complement the existing data.

Runtime parameters are properties that will pass information from OL Connect Workflow to the data
mapping configuration.

For more information see "Properties and runtime parameters" on page 227.

Preprocessors

The Preprocessor step can contain any number of preprocessors. They will be run in sequence before
the data is sent to the data mapping workflow.
A preprocessor could remove certain records altogether.

One example of how a preprocessor could be used is given in a How-to: Using Preprocessors in
DataMapper.
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Note that preprocessors are not executed automatically while designing the data mapping workflow;
you must therefore execute them manually. The reason for this is that preprocessors can potentially be
quite lengthy operations that would hinder the automatic refresh of the display whenever anything is
changed in the data mapping workflow.

To add a preprocessor:
1. Select the Preprocessor step on the Steps pane.

2. Onthe Step properties pane, under Preprocessor, click the Add button .

3. Under Preprocessor definition, add the script. Preprocessing tasks must be written in
JavaScript (see "Using scripts in the DataMapper" on page 362 and "DataMapper Scripts API" on
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Extract step

The Extract step is essential in each and every data mapping configuration. It extracts data from the
data source, based on their location (a row and column in CSV or tabular data, an XPath in XML, a
JsonPath in JSON, or a region of the page in PDF and Text) or on JavaScript code. The data is stored
in the record set that is the result of the extraction workflow.
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Fields always belong to an Extract step, but they don't necessarily all contain extracted data. To learn
how to add fields without extracted data to an Extract step, see "Fields" on page 264.

Adding an Extract step

To add an Extract step, first select the step on the Steps pane after which to insert the Extract step.
Then:

» Inthe Data Viewer, select some data, right-click that data and choose Add Extraction, or drag &
drop the data in the Data Model. For more detailed information and instructions, see: "Extracting
data" on page 229.

« Alternatively, right-click the Steps pane and select Add a Step > Add Extraction. Make the
required settings on the Step properties pane.

If an Extract step is added within a Repeat step, the extracted data are added to a detail table by
default; see "Extracting transactional data" on page 235 and "Detail tables" on page 298.

Configuring an Extract step

The names, order, data type and default value of the fields extracted in an Extract step are properties of
that Extract step. These and other properties can be edited via the Step properties pane. For an explan-
ation of all the options, see "Extract step properties" on page 326.

Note: Data cannot be extracted more than once in any record, unless the Extract steps are mutu-
ally exclusive. This is the case when they are located in different branches of a Condition step or

Multiple Conditions step.

Inside a Detail table, multiple Extract steps may extract the same data but each of them will cre-
ate a new child record in the Detail table.

If you tick the Append values to current record option when several steps are extracting the same
field, the step will error out.

Repeat step

The Repeat step is a loop that may run 0 or more times, depending on the condition specified. Itis gen-
erally used for the extraction of transactional data; see "Extracting transactional data" on page 235.

Repeat steps do not automatically move the pointer in the source file. Therefore, when adding a
Repeat step, a Goto step that moves the cursor is inserted automatically inside the loop to avoid an
infinite loop, except with XML and JSON data.

When you select a node in an XML file and add a Repeat step on it, the Repeat step will automatically
loop over all nodes of the same type on the same level in the XML file.
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The same applies to JSON files. When you select an element in a JSON file and add a Repeat step on
it, the Repeat step will automatically loop over all elements on the same level in the JSON file.

Tip: To break out of a loop and immediately jump to the next task following the current loop, use
an Action task and set its action to Break out of repeat loop.

Adding a Repeat step
To add a Repeat step:

1. On the Steps pane, select the step after which to insert the Condition step.

2. Make sure that the cursor is located where the extraction loop must start. By default the cursor is
located at the top of the page or record, but previous steps in the extraction workflow may have
moved it down. If necessary, add a Goto step (see "Goto step" below).

Generally this step can be skipped when the data source is an XML file or JSON file.

3. Add the Repeat step: select data in the line or row where the loop must end, or select the
node/element. Then either:

¢ Right-click on it and select Add Repeat.
» Right-click the Steps pane and select Add a Step > Add Repeat.
» Select Steps > Add Repeat Step from the menu.

4. Make the required settings on the Step properties pane. See: "Repeat step properties” on
page 339.

For more detailed instructions per file type see "Extracting transactional data" on page 235.

Configuring a Repeat step

For information about how to configure the Repeat step, see "Repeat step properties" on page 339.

How to use it in an extraction workflow is explained in the topic: "Extracting transactional data" on
page 235.

Goto step

Although invisible, there is a cursor in the Data Viewer that represents the location that the extraction
workflow will be processing next in the current record. In an extraction workflow the cursor starts off at
the top-left corner of each record in the source data.

The Goto step can move the cursor to a certain location in the current record. The target location can
be relative to the top of the record or to the current position.

When the Goto step is used within a Repeat step, it moves the cursor in each loop of the Repeat step.
In this case the new location has to be relative to the current position.

Page 252

elalal=



The Goto step isn't used in XML extraction workflows in most cases. The DataMapper moves through
the file using Xpath, a path-like syntax to identify and navigate nodes in an XML document.

The DataMapper moves through JSON files using JsonPath, a path-like syntax to identify and navigate
elements in a JSON document. For an overview of the JsonPath syntax, see htips://github.com/json-
path/jsonpath.

In the DataMapper the JsonPath can be absolute (start with $ which is the root) or relative to the current
position (start with . which is the current element).

However, going up to a parent element is not possible with a relative JsonPath. In cases where an abso-
lute JsonPath is necessary a Goto step might be needed.

Adding a Goto step
To add a Goto step:

* On the Steps pane, select the step after which to insert the Goto step. In the Data Viewer, select
some data, right-click that data and choose Add Goto, to add a Goto step that moves the cursor
to that data.

« Alternatively, right-click the Steps pane and select Add a Step > Add Goto. Make the required
settings on the Step properties pane.

Configuring a Goto step

For information about how to configure the Goto step, see "Goto step properties" on page 352.

Condition step

A Condition step is used when the data extraction must be based on specific criteria. The Condition
step splits the extraction workflow into two separate branches, one that is executed when the condition
is true, the other when it is false.

Extract steps can be added to both the 'true’ and the 'false’ branch (see "Extracting data" on page 229
and "Extracting transactional data" on page 235).

In the Data Viewer pane, icons on the left indicate the result of the evaluation in the Condition step for

each line: ‘f when true and ﬁ when false.
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Adding a Condition step
To add a Condition step:

* On the Steps pane, select the step after which to insert the Condition step; then, in the Data
Viewer, select some data, right-click that data and choose Add Conditional.
In the Step properties pane, you will see that the newly added Condition step checks if the selec-
ted position (the left operand) contains the selected value (the right operand). Both operands
and the operator can be adjusted.
Note that the left operand is by default trimmed, meaning that spaces are cut off.
Selecting data - especially something as small as a dot - can be difficult in a PDF file. To make
sure that a Condition step checks for certain data: Set the Right operand to Value (in the Step
properties pane). Make a selection in the Data Viewer and click the Use selected text button in
the Right Operand section. You will now be able to see whether or not the proper text is
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extracted by the current selection. Repeat this until you are satisfied that the proper data is being
extracted. Click on the Use selection button in the Left Operand section to fill out the coordin-
ates. The point of origin of each character is at the bottom left of each of them and extends up
and to the right.

« Alternatively, right-click the Steps pane and select Add a Step > Add Conditional. Enter the set-
tings for the condition on the Step properties pane.

Configuring a Condition step

The condition in a Condition step is expressed in a rule or combination of rules. Rules have a left oper-
and, an operand type (for example: contains, is empty) and a right operand.

For an overview of all options on the Step properties pane, see "Condition step properties" on

page 347.

Inverting a rule

Inverting a rule adds not to the operand type. For instance, is empty becomes is not empty. To invert
arule, check the Invert condition option next to Operator under Condition on the Step properties
pane.

Combining rules

One rule is already present in a newly added Condition step. To add another rule, click the Add con-
dition button under Condition, next to Condition List, on the Step properties pane.
Step Properties 1 Messages = O
Condition step @

F Description

¥ Rule tree

Condition list: Condition name E -
Left operand

Rules are by default combined with AND. To change the way rules are combined, right-click "AND" in
the Rule Tree, on the Step properties pane, and select OR or XOR instead. (XOR means one or the
other, but not both.)

Page 255

Connect



Step Properties 1 Messages = O
Condition step )

F Description

* Rule tree

A[xl [}

AND el
OR
% xoR
Condition listt | Condition name v| B
Left operand

Renaming a rule
To rename a rule, double-click its name in the Rule Tree and type a new name.
Multiple Conditions step

The Multiple Conditions step is useful to avoid the use of nested Condition steps (Condition steps
inside other Condition steps).

In a Multiple Conditions step, conditions or rather Cases are positioned side by side.
Each Case condition can lead to an extraction.

Cases are executed from left to right.
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Adding a Multiple Conditions step

To add a Multiple Conditions step, right-click the Steps pane and select Add a Step > Add Multiple
Conditions.

To add a case, click the Add case button to the right of the Condition field in the Step properties pane.

Configuring a Multiple Conditions step

For information about how to configure the Multiple Conditions step, see "Multiple Conditions step prop-
erties" on page 349. The settings for a Case are the same as for a Condition step; see "Condition step
properties" on page 347.

Action step
The Action step can:
» Execute JavaScript code.

» Break out of the loop of a Repeat step.

» Set the value for a record property. Record properties are defined in the Preprocessor step; see
"Preprocessor step” on page 249.
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» Stop the processing of the current record and move on to the next one. Normally an extraction
workflow is automatically executed on all records in the source data. By stopping the processing
of the current record, you can filter out some records or skip records partially. Note that if the
extraction workflow has already extracted some data before it gets stopped, the record con-
taining that partial data will still be stored in the Connect Database; to skip a record entirely, the
Action step must occur before any data is extracted for that record.

» Stop the data mapping. If fields of the current record were already extracted, then those fields are
stored as usual, but the rest of the record and any following records are skipped.

The Action step can run multiple specific actions one after the other in order.

Adding an Action step

To add an Action step, right-click on the Steps pane and select Add a Step > Add Action.
Configuring an Action step

For information about how to configure the Action step, see "Action step properties" on page 333.

Postprocessor step

The Postprocessor step allows the application to further process the resulting record set after the entire
extraction workflow has been executed, using JavaScript.

For example, a post-processor can export all or parts of the data to a CSV file which can then be used
to generate daily reports of the Connect Workflow processes that use this data mapping configuration
(see "Data mapping configurations" on page 199).

A post-processor could also write the results of the extraction process to a file and immediately upload
that file to a Workflow process.

The Postprocessor step can contain any number of post-processors.
Adding a post-processor
To add a post-processor:

» Select the Postprocessor step on the Steps pane.

* On the Step properties pane, under Postprocessor, click the Add button ',

* Under Postprocessor definition, add the script. Postprocessor tasks must be written in
JavaScript (see "Using scripts in the DataMapper" on page 362 and "DataMapper Scripts API" on
page 360).
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Configuring the Postprocessor step

For an explanation of the settings for post-processors, see "Postprocessor step properties" on
page 356.

Testing postprocessors

Post-processors are not executed automatically while designing the data mapping workflow. The
reason for this is that post-processors can potentially be quite lengthy operations that would hinder the
automatic refresh of the display whenever anything is changed in the data mapping workflow.

In order to test post-processors you must execute them manually by clicking the Apply button in the
Post-processor step properties (see "Postprocessor step properties" on page 356).

Note: In the DataMapper and Designer, only one data record is active at any given time. There-
fore, the changes made by the post-processes are only visible on the current data record (i.e. the
one currently displayed). If you change data records, you must press the Apply button on the
Postprocessor step once more.

In order to test a case with multiple records you must either use the data mapping configuration in
a print job through the Designer or in the Execute Data Mapping task in Workflow so that all
records will be processed by the Postprocessor step.
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The Data Model

The Data Model is the structure of records into which extracted data are stored. It contains the names

and types of the fields in a record and in its detail tables. A detail table is a field that contains a record
set instead of a single value. The Data Model is shown in the Data Model pane, filled with data from the

current record.

Mame

w ] record [200]

abi

InvMumber
D

Gender
FirstMame
LastMame
Title
Cormpany
Address1
Country
State

Ermail

Phone
UzerMame
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MermberShip
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DueDate
SubTotal
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abe ProdMurmber
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12ulxgR2
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EM

skate

2016-06-01 12:00 AM
2016-07-071 12:00 AM
4148.21

622.23

4770.44

1]

53674

Thule Crossroad Railing Foot P...

199.95
3
3
0
599.25

The Data Model is not related to the type of data source: whetheritis XML, JSON, CSV, PDF, Text, ora

database does not matter. The Data Model is a new structure, designed to contain only the required

data.
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About records

A record is a block of information that may be merged with a template to generate a single document
(invoice, email, web page...) for a single recipient. It is part of the record set that is generated by a data
mapping configuration.

In each record, data from the data source can be combined with data coming from other sources.

Records can be duplicated by setting the number of copies in a script (see "record" on page 393).
Duplicates are not shown in the Data Model.

Creating a Data Model

A Data Model is created automatically within each data mapping configuration, but it is empty at the
start. To fill it you could use another Data Model (see "Importing/exporting a Data Model" below) or start
creating a data mapping workflow (see "Data mapping workflow" on page 221).

To learn how to add and edit fields, see "Fields" on page 264.

Importing/exporting a Data Model

To use a Data Model in another data mapping configuration, or to use it in a Designer template without
a data mapping configuration, you have to export that Data Model and import it into a data mapping con-
figuration or template.

Importing and exporting Data Models is done from within the Data model Pane, using the top-right

icons = and .

For information about the structure of the exported Data Model file, see "Data Model file structure" on
page 284.

When you import a Data Model, it appears in the Data Model pane where you can see all the fields and
their types.

Instead of a Data Model file, you can import a JSON file, or a Connect file that contains a Data Model.
The file's data model structure will be displayed in the Data Model pane.

You can delete or add fields, or change their type. Once the Data Model is imported and all the fields
are properly set, all you need to do is extract the information from the active data sample (see "Extract-
ing data" on page 229).

Note:
* Imported Data Model fields always overwrite existing field properties when the field name
is the same (although they will still be part of the same Extract step). Non-existent fields
are created automatically with the appropriate field settings. The import is case-insensitive.

* Allimported data model fields are marked as required in the Data Model (indicated with an
asterisk (*) next to their names). This is to prevent them from being removed, as the
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DataMapper immediately discards non-required fields that are not referenced by any
Extract step.

Editing the Data Model
The Data Model is generally constructed by extracting data; see "Extracting data" on page 229.

Empty fields and data tables can be added via the contextual menu; see "Adding empty fields via the
Data Model pane" on page 266.

Editing fields

You can modify the fields in the Data Model via the contextual menu that opens when you right-click on
something in the Data Model pane. For an explanation of the options in this menu, see "Data Model con-
textual menu" on page 295.

As long as a field or data table, added via the Data Model pane, remains empty, it can be edited
(renamed, deleted etc.) via the contextual menu.

Fields in a Data Model that are actually used in the extraction workflow cannot be edited via the con-
textual menu of the Data Model pane. They are related to a step in the extraction workflow and are
edited via the Step properties pane instead (see "Editing fields" on page 267).

Ordering and grouping fields in the Data Model

To make the Data Model clearer and more manageable, you can change the order of the fields in it and
create groups of fields. All grouping and ordering information is saved in the data mapping con-
figuration, so that when you reopen it, the Data Model will look the same.

Note that these changes have no impact on the order in which data are extracted, or on the final
records in the OL Connect database. They only help you organize the Data Model visually.

This also means group names are not used in scripts; fields and detail tables are accessed directly
through the record object (see the "Designer Script API" on page 1168 and "DataMapper Scripts API"
on page 360).

To change the order in which data are extracted, see "Renaming and reordering fields in an extraction
step" on page 267.

Moving fields

To move a field, a group of fields or a detail table, you can simply drag and drop it to some other place
in the Data Model.

Alternatively, you can right-click the field, group or detail table and select one of the options in the
Move menu, to move it up or down within the list or group.

Fields cannot be moved into another table. However, inside a table they can be moved up or down.
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Grouping fields

To group one or more fields, select the field(s), right-click and select Add group. Itis also possible to
create groups within groups; this is done in the same way.

To move a field into an existing group you can simply drag and drop it into the group or onto the name
of that group.

To delete a group, right-click it and select Ungroup. The fields will be moved up one level in the struc-
ture. To move a field out of an existing group you can also simply drag and drop it out of that group.
To delete an empty group, right-click it and select Delete.

Using the Data Model in templates

The Data Model is what enables you to create personalized templates in the Designer module.

You can drag & drop fields from the Data Model into the template that you are creating (see "Variable
data in the text" on page 708). For this, you need to either have a template and a data mapping con-
figuration open at the same time, or import a Data Model (see "Importing/exporting a Data Model" on
page 261).

The Data Model is reusable, meaning that it can be shared amongst different template layouts and out-
put types.

Different data mapping configurations could use the same Data Model, allowing a template to be pop-
ulated with data from different sources and formats, without the need to modify the template (see
"Importing/exporting a Data Model" on page 261).

In Workflow, when a data mapping configuration is used to extract data from a data source (see "Data
mapping configurations" on page 199), the extracted data is stored in a record set in the OL Connect
database.

Adding fields and data via Workflow

The Data Model is not extensible outside of the DataMapper. When it is used in Workflow - as part of a
data mapping configuration - the contents of its fields can be updated but not its structure.

There are a number of instances however, where fields may need to be added to the data model after
the initial data mapping operation has been performed. For instance, you might need to add a cleansed
postal address next to the original address, or retrieve a value from a database and add it to the record.

ExtraData field

You can add empty fields in advance to provide space in the Data Model for Workflow to store data. For
convenience, one field called ExtraData is automatically created at every level of each data record.
That means the record itself gets an ExtraData field, and each detail table also gets one.

By default the field is not visible in the DataMapper's Data Model, because it is not meant to be filled via
an extraction. It can be made visible using the Show ExtraData Field icon at the top of the Data Model.
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Workflow process
Data can be added to the Data Model in a PlanetPress Connect Workflow process as follows:

1. Use an Execute Data Mapping task or Retrieve Items task to create a record set. On the Gen-
eral tab select Outputs records in Metadata.

2. Add avalue to afield in the Metadata using the Metadata Fields Management task.
Data added to the _vger_fld_ExtraData field on the Document level will appear in the record's
ExtraData field, once the records are updated from the Metadata (in the next step).
Other fields have the same prefix: _vger_fld_.

3. Update the record/s from the Metadata. There are several ways to do this. You could, for
example:

* Use the Update Data Records plugin.
» Add an Output task and check the option Update records with Metadata.

» Select Metadata as the data source in the Create Preview PDF plugin.

Note: Many of these actions can also be performed using REST calls.

Please refer to PlanetPress Connect Workflow documentation for more information about the plugins
involved: Workflow's Online Help.

Fields

Extracted data are stored in fields in the Data Model (see "The Data Model" on page 260). Fields can

be present on different levels: on the record level or in a detail table (see "Detail tables" on page 298).
They can be moved up or down and put in groups (see below).

Fields with data belong to an Extract step and are accessible via the Step Properties pane (see "Extract
step properties" on page 326).

Location-based fields always contain extracted data: they read data from a certain location in the data
source.

Other fields may contain the result of a JavaScript (expression-based fields, or fields filled by an Action
step) or the value of a property (property-based fields).

Adding fields
Location-based field

Generally, location-based fields are added to a Data Model by extracting data; see "Extracting data" on
page 229. Location-based fields in detail tables are created by extracting transactional data; see
"Extracting transactional data" on page 235.
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Alternatively, you can add fields and detail tables directly in the Data Model pane (see "Adding empty
fields via the Data Model pane" on the facing page).

After adding a field or detail table this way, you can drag & drop data into it to convert it into a location-
based field. Without data it is not accessible via the Step properties pane.

Expression-based field

Expression-based fields are filled with the result of a (JavaScript) expression: the script provides a
value. Note that the last value attribution to a variable is the one used as the result of the expression.

There is a number of ways to add an expression-based field.

Via the Steps pane

1. Make sure there is no data selection in the Data Viewer.

2. Right-click on an Extract step on the Steps pane and select Add a Step > Add Extract Field.
(To add a new Extract step, select Add a Step > Add Extraction first.)

3. Onthe Step properties pane, under Field Definition, enter the script in the Expression field.

Via the Step properties pane

1. Select an Extract step on the Steps pane. (To add a new, empty Extract step, right-click the
Steps pane and select Add a Step > Add Extraction.)

2. Onthe Step properties pane, under Field Definition, click the Add JavaScript Field button next
to the Field List.

Step Properties| 1 Messages = 0

Y
+ Field Definition

Field List: D v 4

[ ] Add Unique ID to extraction field

3. On the Step properties pane, under Field Definition, enter the script in the Expression field.

By changing a field's mode

Alternatively you can change a location-based field into a JavaScript-based field.

1. Select the field in the Data Model.
2. Onthe Step properties pane, under Field Definition, change its Mode to JavaScript.

3. Enter the scriptin the Expression field.
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Tip: The default extraction method for fields in a CSV or XLS(X) file is data.extract (colum-
nName, rowOffset).Changingthe expressionto usethe data.extractByIndex (index,
rowOf fset) method will allow the data mapping configuration to extract data from files that
have the same structure, but different column names.

Property-based field

A property-based field is filled with the value of a property (see "Properties and runtime parameters"
on page 227).

Custom properties can be added via the Preprocessor step; see "Preprocessor step” on page 249.

A property-based field cannot be added directly. To fill a field with the value of a property, you have to
change an existing field's Mode to Properties.

1. Select the field in the Data Model.
2. Onthe Step properties pane, under Field Definition, change its Mode to Properties.

3. Select the property from the Property drop-down list, or click the button to the right, to open a fil-
ter dialog that lets you find a property based on the first few letters that you type.

Another way to add the value of a property to a field is by setting the field's Mode to JavaScript and
entering the corresponding property in the Expression field, e.g. data.properties.myProperty;.

Adding empty fields via the Data Model pane

You can add fields and detail tables directly in the Data Model pane. Right-click anywhere on the Data
Model and a contextual menu will appear. Which menu items are available depends on where you've
clicked. If you right-click inside the record itself, you can add a field, detail table or group. A field will be
added with no extraction, while a detail table will be added with no fields inside.

Here's how you can fill the field with data.

» Drag & drop data into it. The field will be converted into a location-based field and is then access-
ible via the Step properties pane.

» Fill the field with an Action step (see Extracting data with a script). Fields that are filled this way
are not accessible via the Step properties pane.

Adding fields dynamically

Outside of the DataMapper the Data Model cannot be changed. It isn't possible to add fields to it when
using the data mapping configuration in an automated process. It is however possible to add data to
existing fields via Workflow; see "Adding fields and data via Workflow" on page 263.
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Editing fields

The list of fields that are included in the extraction, the order in which fields are extracted and the data
format of each field, are all part of the Extract step's properties. These can be edited via the Step prop-
erties pane (see "Extract step properties" on page 326).

Tip: To change the name of a field quickly, right-click it in the Data Model and select Rename.

Renaming and reordering fields in an extraction step

The names of fields, as well as the order of fields in an extraction step, can be changed via the prop-
erties of the Extract step that they belong to.

1. Select the Extract step that contains the fields that you want to rename. To do this you could click
on one of those fields in the Data Model, or on the step in the Steps pane.

2. On the Step properties pane, under Field Definition, click the Order and rename fields button.

Step Properties 1 Messages =

S
+ Field Definition

Field List: Nurmber v |

[]Add Unique ID to extraction field

3. Now you can rename and order the fields; see "Order and rename fields dialog" on page 332.

About field names:

» Fields cannot have the same name, unless they are located on a different level in the
record (e.g. root level, detail table).

* Itis recommended that you do not use spaces in field names.
When a data field is dragged into a template, the data field name is used in the selector of
the script that is created, but any spaces will be removed.
Also, data fields may be used as Metadata in a Workflow process, and spaces are not per-
mitted in Metadata field names.

The order of fields in an extraction step may be different from their order in the Data Model. To
make the Data Model clearer and more manageable, you can change the order of the fields in it
and create groups of fields. See also: "Ordering and grouping fields in the Data Model" on

page 262.
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Setting the data type

Fields store extracted data as a String by default. The data type of a field can be changed via the prop-
erties of the Extract step that the field belongs to.

1. Select the Extract step that contains the field. You can do this by clicking on the field in the Data
Model, or on the step in the Steps pane that contains the field.

2. Onthe Step properties pane, under Field Definition, set the Type to the desired data type. See
"Data types" on page 275 for a list of available types.

Changing the type does not only set the data type inside the record. In the case of dates, numbers and
currencies, it also means that the DataMapper will expect the data in the data source to be formatted in
a certain way. If the actual data doesn't match the format that the DataMapper expects, it cannot inter-
pret the date, number or currency as such. If for example a date in the data source is formatted as
"yyyy-mm-dd" but the default format adds the time, the date cannot be read and the DataMapper will
stop with an error.

The default format for dates, numbers and currencies can be set in the user preferences ("DataMapper
preferences" on page 786), in the data source settings () and per data field (in the Extract step prop-
erties, see "Data Format" on page 331).

Setting a default value

You may want to set a default value for a field, in case no extraction can be made. Make sure to set the
data type of the field via the step properties (see above). Then right-click the field and select Default
Value.

The default value must match the selected data type. If the data type of the field is set to Integer, for
example, you cannot enter a value of 2,3. A default date must be formatted as a DateTime object
("year-month-day" plus the time stamp, for example: 2012-04-11 12.00 AM); see "Date" on page 278.

Modifying extracted data

To modify extracted data - the contents of a field - you have to write a script. The script can be entered
as a Post function in a location-based field or as an Expression in a JavaScript-based field.

Post function

On the Step properties pane, under Field Definition, you can enter a script in the Post function field to
be run after the extraction. (Click the Use JavaScript Editor button to open the "boundaries" on

page 370 dialog if you need more space.)

A Post function script operates directly on the extracted data. Its results replace the extracted data. For
example, the Post function script replace("-", ""); replaces the first dash character that occurs inside the
extracted string. The code toLowerCase(); converts the string to lowercase letters.

Note that the function must be appropriate for the field's data type.
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JavaScript Expression

Alternatively you can change a field's Mode from Location to Javascript:

1. Select the field in the Data Model.

2. On the Step properties pane, under Field Definition, change its Mode to JavaScript.

You will see that the JavaScript Expression field is not empty; it contains the code that was used to
extract data from the location. This code can be used or deleted.

Note:
The last value attribution to a variable is the one used as the result of the expression.

Deleting a field

The list of fields that are included in an extraction is one of the properties of an Extract step. To delete a
field:

1. Select the field: click on the field in the Data Model, or select the Extract step that contains the
field that you want to delete, and in the Step properties pane, under Field Definition, select the
field from the Field List.

2. Inthe Step properties pane, under Field Definition, click the Remove Extract Field button next
to the Field List drop-down.

Step Properties| 1 Messages = 0

+ Field Definition

Field List: ID v | [ _

[ ] Add Unique ID to extraction field

Detail tables

A detail table is a field in the Data Model that contains a record set instead of a single value. Detail
tables contain transactional data. They are created when an Extract step is added within a Repeat
step; see "Extracting transactional data" on page 235.

In the most basic of transactional communications, a single detail table is sufficient. However, it is pos-
sible to create multiple detail tables, as well as nested tables. Detail tables and nested tables are dis-
played as separate levels in the Data Model (see "The Data Model" on page 260).

Detail tables can be included in a template via a Dynamic Table ; see "Dynamic Table" on page 742.

Renaming a detail table

Renaming detail tables is especially useful when there are more detail tables in one record, or when a
detail table contains another detail table. For this detail table, ‘products’ would be a better name.
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1. On the Data Model pane, click one of the fields in the detail table.

2. Onthe Step Properties pane, under Extraction Definition, in the Data Table field, you can find
the name of the detail table: record.detail by default. Change the detail part in that name into
something else.

Note: A detail table’s name should always begin with ‘record.’.

3. Click somewhere else on the Step Properties pane to update the Data Model. You will see the
new name appear.

Creating multiple detail tables

Multiple detail tables are useful when more than one type of transactional data is present in the source
data, for example purchases (items with a set price, quantity, item number) and services (with a price,
frequency, contract end date, etc).

(i *Name (XML) 52 =a
ST [SEIICE REPTEseriiative]
<> Company [Rockwood Engine Systems)
<» Phone2 ([555) 380-6476, #235)
< Email (p.ludwick@oldrupa.com]
<*» Language (EN)
<» MDS5 (C9B28FBAE37EGBAFE19C2C3EE0FDEBDE]
4 <r INVOICES 1 T )}
4 £ INVOICE [ L L L |'I |'I |'I
<> Number [INVE103083)
<> Date (2013-03-15)
<> DueDate (2013-04-05)
<> Rep (REPD2907T1)
4% SubTotal [ 74.90)
€% TaxTotal [ 11.22)
<% Total | 86.12)
4 ¢» PURCHASES T—— T—— T—= 1T T
<» Item (RT1485)
<» Description (Router)
& Qty (1)
<> Price (14.75)
<» SubTotal [14.75)
PURCHASES T—=— T—— T—— 1 T
<» Item (CBLS6E6)
<» Description (Cable)
& Qty 4
<> Price (8.96)
<» SubTotal (35.24)
4 <> SERVICE (T n T T il T
<* Mumber (H5F75ME]
<> Description (HighSpeed FibreOptics TSME/S Dupley)
<» BasePrice (84.95)
<» Rebates (-30.00)
<» Charges [0}
<» SubTotal [44.95)
<» AccountNumber (1687635787)
<> UserMame [u210V3432)
<*» Type (Internet]
4 <» SERVICE n T T 1 T Second Table
€% Mumber [PHBASICRES)
<» Description (Basic Residential Phone Service]
<» BasePrice (33.95)
<*» Rebates (-14.32)
<» Charges [10.32)
<» subTotal (29.95)
<% AccountNumber (22555380647622)
<» UserMame (r45g456h]
<» Type (Phone)}

First Table

S
-

To create more than one detail table, simply extract transactional data in different Repeat steps (see
"Extracting transactional data" on page 235).
The best way to do this is to add an empty detail table (right-click the Data Model, select Add a table
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and give the detail table a name) and drop the data on the name of that detail table.

Else the extracted fields will all be added to one new detail table with a default name at first, and you
will have to rename the detail table created in each Extract step to pull the detail tables apart (see
"Renaming a detail table" on page 269).

Setting: | Bl = B |[[Fie "Name povy) 52 = B ||E pata model B3 e |
I<] <» Phone2 ((555) 702-3520, #665) # 1| Mame Value
= <» Email (atincher@oldrupa.com) 4 T record [3] (il 2 [B][E
IF:L] <> language (EN) abe FULLNAME Amie Tincher
: <> MD5 (BES479B97BEEDAEIST0837291B7105CE) we ID CU44643835
Exrattion ‘ <: LTVSJ\.:SE?CEIW ! 1|J T 1 T 1 T - 1= 2 Gender M
abe LastMName Tincher
<> Mumber (INV8559825) abe FirstMame Amie
= <> Date (2013-03-15) abe Addressl 356, Chambers Street
Extraction] S s DI we Address2 P.0. Box 6049
= = <> Rep (REP88200122) abe City St Mary's
o= <> SubTotal ( 125.96) ae State ON
: o o 104z - ot 18
8 - ae ZipCode L6J 5L1
Iﬁ 4 <> PURCHASES (T—— T—— f—— 1 L ) abe Title Driver/Sales Workers
<> Item (RT1483) e Company St. Mary's Pest Control Ltd
<> Description (Router) abe Phone? (555) 702-5520, #665
<> Qty (1) abe Email atincher@eldrupa.com
<> Price (1475)
s Language EN
<> SubTotal (14.75) e MD5 BE9479B978EE0AE3ST0R3...
4 <> PURCHASES (T—— T—— T—— 1 1 } e Number INV8559825
<> Item (CBL5686) ane Date 2013-03-15
<> Description (Cable) abe DueDate 2013-04-05
<« Qty (3) ae Rep REPS200122
<> Price (8.96) sbe SubTotal 125.96
<> SubTotal (26.88) ane TaxTotal 18.86
4 <> PURCHASES (T—— T—— T—— T 1 ) e Total 144,82
<> Item (FST3678)
<> Description (Fasteners)
<> Oty (30
<> Price (0.25)
<» SubTotal (12.5)
4 e SFRVICF (1 hi ki 1 T T L ¥
< >
Step Properties| 1 Messages =]
Extract Step @ -
» Description
+ Extraction Definition
Data Table: | record v
v Append values to current record
v
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Settings |1, Steps = O ||[@id *Name (XML) 2 = B ||E pata model B e )
[S] <> SubTotal (14.73) ~

£ Name Value
7 9T EENDGS T T 9 SDeodm @ 250
IFI] - DE'" ——— we FULLNAME  Amie Tincher
" Q:;‘:; fon {-ane e D CU44643835
Extraction <> Price (8.96) s Gender Miss
- ¢ SubTotal (26.88) abe LastMName Tincher
R2E) - e FirstN A
EE 4 <> PURCHASES (T—— T—— T—— 1 1 ] L L
= ey e Address] 356, Chambers Street
Extraction1 i e Address2 P.0. Box 6049
<> Description (Fasteners) .
@ < Qty (50) abe City St Mary's
= e Stat ON
= & Price (0.25) - Cj;t =
Repeat < SubTotal (12.5) e 3" HTE
»
= 4 < SERVICE (T " 1 1 1 1 1 e ciptode -
gess resee R TR e Title Driver/Sales Waorkers
H - : : e Company St. Mary's Pest Control Ltd
z Description (HighSpeed FibreOptics 75MB/S Dupl
€  Exraction? :; E::Szc‘:”(gi 9'% Lot Lplcs e Phone2 (555) 702-5520, %665
] v abe
g E:_ <> Rebates (-40.00) ke Emnail a.tincher@oldrupa.com
g e e Language EN
YT e e MD5 BEQ479B978EEDAE3GT083...
: e Numb INV8550825
<> AccountMurnber (1687635787) Sl
o <> Userlame (u21CV342) =Rna IS 03.13
H A e DueDate 2013-04-05
a ype (Intern
e R REP2200122
Regeat1 4 <> SERVICE (T m 1 1 1 1 1 - SEZT o oot
e SubTotal !
—— Qj resse < Number (PHBASICRES) . ATeH o
8 = <> Description (Basic Residential Phone Service) v Total 144,82
§ Extraction3 <» BasePrice (33.93) + O detail (6] Vi
H < Rebates (-1432) z Py
H 4= < Charges (22.32) o
8 e Description  Router
I < SubTotal (41.95) -
e
<5 Accounthumber (22555705552022) ?" TS
- e Price 7
gao 10009 " <> UserName (wd37t478) i e SubTotal2 1475
. - = e Number2
H Step Properties| 1 Messages T
~ e BasePrice
@ Extract Ste, )
P 4 abe Rebates
» Description ake Charges
e SubTotal3
~ Extraction Definition e Accounthur
Data Table: | record.detail » i $cermama
abe Type
v [[] Append values to current record
< > — v

Nested detail tables

Nested detail tables are used to extract transactional data that are relative to other data. They are cre-
ated just like multiple detail tables, with two differences:

» Forthe tables to be actually nested, the Repeat step and its Extract step that extract the nested
transactional data must be located within the Repeat step that extracts data to a detail table.

* In their name, the dot notation (record.services) must contain one extra level (record.ser-
vices.charges).

Here is an example.

An XML source file lists the services of a multi-service provider: Internet, Cable, Home Phone, Mobile.
Each service in turn lists a number of "charges", being service prices and rebates, and a number of
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"details" such as movie rentals or long distance calls.

XML viewer & 15 | Zoom(%) | 100 H 2 2 @

<» Rep (REP2800122) -
<» SubTotal ( 93.76)
<» TaxTotal { 14.04)
< Total { 107.80)
a <» SERVICE (T T | T
<» Number (TVDIGHD)
<> Description (High Definition Digital TV)
<» BasePrice (30.00)
<» Rebates (-28.19)
<> Charges (67.25)
<» ExtraServices (24.70)
<» AccountMumber (6784383574527852)
<> SubTotal (39.08)
<> Type (Television)
a <» Charges (T T T )]
2 <> CHARGE (1 T T
<» |0 (RETVCRTCFAPL)
<» Description (Contribution to CRTC FAPL)
<» Price (-0.13)
a ¢» CHARGE (T T T
<» |D (RETVPROG)
<» Description (PROMO: Pregramming Credit)
<» Price (-14.20)
a <» CHARGE (T 1 T
<> |0 (RBTVHDEBOX)
<» Description (PROMO: Free HD Receiver Rental)
<> Price (-13.86)
4 <> DETAILS (T T T
la <> DETAIL (T T T
<> CODE (MVHDLOC)
< |10 [33123)
<» Description (Gangster Squad HD)
<x TimeStamp (2013-02-16 19:24:33)
<» Pnce (2.93)
la <> DETAIL (T T T
<> CODE (MVHDLOC)
< |0 (33234)
<» Description (Indiana Jones: Raiders of the Lost Ark)
<» TimeStamp (2013-02-23 18:02:46)
<» Price (2.95)
la <> DETAIL (T T T
<> CODE (MVHDLOC)
<> |D (33343)

#o Nacmrimtinn (lndians lamer and the Temnle of Nansst
= i —

Data to be Nested
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The services can be extracted to a detail table called record.services.

Settings | &, Steps| = 01| e "Name (L) 23| = 5 | Data model eaed 8 0
© 2 | XML viewer & 15 |Zoomea [10 0 O @ || Neme Value
pe 4 = record [3] K[ 3
INVOICERUN (T T ) A e FULLNAME Melba Lumpkin
|F]j| >CUSTOMER(T T 1 T 1 T 1 T 1 1 1 1 1 71 % 1 71 1) we ID CU35682808
< @ FULLNAME (Melba Lumpkin) e Gender Miss
Bdrefttion < ID (CU35692808) e LastName Lumpkin
<> Gender (Miss) e FirstName Melba
¢ LastName (Lumpkin) e Address] 564, Hidden Valley Drive
Extraction] < FirstName (Melba) s Address2 Suite 9530
<> Address] (564, Hidden Valley Drive) e City Gore Bay
= <> Address2 (Suite 9530) ae State ON
T <» City (Gore Bay) e Country ca
H <> State (ON) e ZipCode FaU 583
IW <> Country (CA) e Title Machine Tool Cutting Oper...
< ZipCode (F3U 5B3) e Company Gore Bay Geme Group
<> Title (Machine Tool Cutting Operator/Tender) e Phone2 (555) 631-670, #854
¢ Company (Gore Bay Game Group) e Email m.lumpkin@oldrupa.com
<> Phone2 ((555) 631-670, #354) e Language EN
<» Email (m.lumpkin@oldrupa.com) abe MD3 A376734A49841E9F04696FEE...
¢ Language (EN) e Number INY4839392
<> MDS (A376734A40841EQFD496FBEOBCE04A3) s Date 2013-03-15
la <> INVOICES (T LIS e DueDate 2013-04-05
4 ¢> INVOICE (T A A A A 1 T T T ) e Rep REP2200122
& Number (INV4839382) e SubTotal 9176
<> Date (2013-03-15) e TaxTotal 1404
<> DueDate (2013-04-05) ae Total 107.80
< Rep (REP220D122)
< SubTotal ( 93.76)
<> TaxTotal ( 14.04)
¢ Total ( 107.80)
4 < SERVICE (T L L L L L 1 1 L L
> Number (TVDIGHD)
<5 Description (High Definition Digital TV)
<> BasePrice (30.00)
¢» Rebates (-28.19)
< Charges (67.25)
< BrtraServices (24.70)
<> AccountMumber (6784589574527852)
¢ SubTotal (30.08)
< Type (Television)
a <> Charges (T 1 1 )]
4 ¢ CHARGE (1 T L L ]
< ID (RBTVCRTCFAPL)
<> Description (Contribution to CRTC FAPL)
& Price (-0.13) =
. s runesE o b . b .
- >
- | Step Properties| 1 Messages| =
" " HP i
The "charges" and "details" can be extracted to two nested detail tables.
Settings |, Steps| = O | “Name ot 22 | = O/ pata model ed & T 0
- XML viewer & 5 |Zoome [100 [£] © © @ || Neme Value
i 4 [T record [3] 1| 3
4 <> INVOICE (T 1 1 1 1 1 T T n ) e st FULLNAME Melba Lumpkin
P:ﬂ & Number (INV4839382) we ID Ccu3ses2aoe
o <> Date (2013-03-15) e Gender Miss
Extraction <5 DueDate (2013-04-05) we LastMame Lumpkin
E < Rep (REPSEOD122) e FirstName Melba
= <> SubTotal ( 93.76) ave Address] 564, Hidden Valley Drive
Extragtion] > TaxTotal { 14.04) e Address2 Suite 9530
5 Total ( 107.80) e City Gore Bay
@ - 4 ¢ SERVICE (1 1 1 L L 1 1 1 1 L e State an
- <> Number (TVDIGHD) e Country cA
Repeat <> Description (High Definition Digital TV) we ZipCode F2U 583
<> BasePrice (30.00) e Title Machine Tool Cutting Oper...
geose| @poceng ¢ Rebates (-28.19) e Company Gore Bay Game Group
S tameton2 o e ) w: Phone2 (555) 631-670, 854
H H <> BxraServices (24.70) s Email m.lumpkin@oldrupa.com
H 4 <> AccountMumber (6784589574527852) e Language EN
H H ¢ SubTotal (30.06) we MDS A376734A49841ESFO4696FEE...
H < Type (Television) e Number INV4839392
- 4 ¢ Charges (1 1 1 ) e Date 2013-03-15
= 4 ¢ CHARGE (T T 1 T ) s DueDate 2013-04-05
H < ID (RBTVCRTCFAPL) we Rep REPB800122
= <> Description (Contribution to CRTC FAPL) e SubTotal 9176
W @ Price (-0.13) e TaxTotal 1104
4 > CHARGE (1 T 1 1 ] e Total 107.80
<> ID (RBTVPROG) 4 [T detail [1] 1
<> Description (PROMO: Programming Credit) e Number2 TVDIGHD
< Price (-14.20) we Description  High Definition Digital TV
4 <> CHARGE (1 L n 1 ) e BasePrice 3000
<» 1D (RBTVHDBOX) ae Rebates -28.19
<> Description (PROMO: Free HD Recelver Rental) e Charges 6725
<> Price (-13.86) e BxtraServices 2470
4 ¢ DETAILS (T T T A 1 U u ) e AccountMumbe 6784580574527852
4 <> DETALL (T 1 1 1 1 T ) s SubTotal2 39.06
<> CODE (MYHDLOG) e Type Television
<» 1D (35123)
<> Description (Gangster Squad HD)
<> TimeStamp (2013-02-16 18:24:33)
<» Price (5.95)
4 ¢ DETAL (T L 1 L 1 T )
<> CODE (MVHDLOC)
¢ 1D (55234)
<> Description (Indiana Jones: Raiders of the Lost Ark)
< TimeStamp (2013-02-23 18:02:46) S
1 Drice 0%
7 >
< > Step Properties| 1 Messages e

Page 274

PlanetPress.




The nested tables can be called record.services.charges and record.services.details.

Settings | ., Steps = B || “Name (L) 52 = 5 |2 Data model eeed 570
£ | XML viewer € @ |zoomeg [0 B0 2 @ | Meme Volue
. 4 = record [3] GG 3
[F:E] 4 < SERVICE (T 1 1 T T T T 1 1 T o~ s FULLNAME Melbs Lumgkin
<» Number (TVDIGHD) abe 1D CU35692808
T <5 Description (High Definition Digital TV) e Gender Miss
Extraction ¢ BasePrice (30.00) s Lastame Lumpkin
pezi| © Rebates (-28.19) s FirstName Melba
= ¢ Charges (67.25) s Address] 564, Hidden Valley Drive
o] o BtrsSenices (24.70) e Address2 Suite 9530
© Accounthlumber (§784589574527852) s City Gore Bay
o= ¢ SubTotel (39.06) e State oN
= < Type (Television) e Country cA
Repeat 4 © Charges (1 1 1 ) s ZipCode F3U 583
____________ = 4 < CHARGE (T 1 1 1 ) e Title Machine Tool Cutting Oper...
[ © 1D RBTVCRTCRARL) e Company Gore Bay Game Group
b Zon2 ¢ Description (Contribution to CRTC FAPL) s Phone2 (555) 631-670, 854
© Price (0.13] s Email mlumpkin@oldrupa.com
o= 4 < CHARGE (1 1 " 1 ) s Language EN
- < ID (RBTVPROG) s MDS ~ABT6734A49841ESFO4696FEE...
Repeatl <> Description (PROMO: Pregramming Credit) s Number INV4839392
o . ¢ Price (-1320) s Date 2013-03-15
vooo iER ieeee 4 < CHARGE (T T T 1 ] e DueDate 2013-04-05
e Sion3 1D (RETVHDEOX) s Rep REPEB001ZZ
¢ Description (PROMO: Free HD Receiver Rental) e SubTotal 9376
o=y <> Price (-13.86) ae TaxTotal 14.04
s 4 < DETALS (1 1 1 1 1 T 1 ) v Total 10720
4 © DETAL (1 1 1 1 1 T ) 4 71 details [10] 1[I
Seheses ¢» CODE (MVHDLOC) v s Number2  TVDIGHD
H < > e Description High Definition Digital TV
s BasePrice 3000
Repeat Step Properties| 1 Messages -8 e Rebates 2819
- Prenrocessor - e Charges 6725
c? P! = we EtraSenvices 2470
Extractiond ¥ Fixed automation properties e AccountNumbe 6784589574527852
=l e SubTotal2 3906
~ Properties ae Type Television
Seseseed se D2
Name Scope Type Defsult Value ) i —
ehesee e Price
,,,,,,,,,,,, H s CODE
.............. - %
B8 0c0c0s0sasasd e Description3
5 ~ Preprocessor e TimeStamp
H abe Price2
H Name Type =
v
< > v

Now one "charges" table and one "details" table are created for each row in the "services" table.
Data types

By default the data type of extracted data is a String, but each field in the Data Model can be set to con-
tain another data type.

To do this:

1. In the Data Model, select a field.

2. On the Step properties pane, under Field Definition choose a data type from the Type drop-
down.

Changing the type does not only set the data type inside the record. In the case of dates, numbers and
currencies, it also means that the DataMapper will expect the data in the data source to be formatted in
a certain way. If the actual data doesn't match the format that the DataMapper expects, it cannot inter-
pret the date, number or currency as such. If for example a date in the data source is formatted as
"yyyy-mm-dd" but the default format adds the time, the date cannot be read and the DataMapper will
stop with an error.

The default format for dates, numbers and currencies can be set in the user preferences ("DataMapper
preferences" on page 786), in the data source settings () and per data field (in the Extract step prop-
erties, see "Data Format" on page 331).
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Note: Data format settings tell the DataMapper how to read and parse data from the data
source. They don't determine how these data are formatted in the Data Model or in a template. In
the Data Model, data are converted to the native data type. Dates, for example, are converted to
a DateTime object. How they are displayed in the Data Model depends on the preferences (see
"Default Format" on page 786).

The following data types are available in PlanetPress Connect.

e "Boolean" below

e "String" on page 283

e "HTMLString" on page 281

» "Integer" on page 281

* "Float" on page 281

» "Currency" on the next page
e "Date" on page 278

e JSON

* "Object" on page 282

The Object data type is only available in the DataMapper module. It can be used for properties in
the Preprocessor step, but not for fields in the Data Model.

Boolean

Booleans are a simple true/false data type often used in conditions and comparisons.
Defining Boolean values

¢ Preprocessor:
* In the Step properties pane, under Properties, add or select a field.

» Specify the Type as Boolean and set a default value of either true or false, followed by
a semicolon.

+ Extraction:
* [n the Data Model, select a field.

« On the Step properties pane, under Field Definition set the Type to Boolean.
The field value must be true or false.

« JavaScript Expression: Set the desired value to either true or false.
Example: record.fields["isCanadian"] = true;
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Note: The value must be all in lowercase: true, false. Any variation in case (True, TRUE) will
not work.

Boolean expressions

Boolean values can be set using an expression of which the result is true or false. This is done using
operators and comparisons.

Example: record.fields["isCanadian"] = (extract ("Country") == "CA");

For more information on JavaScript comparison and logical operators, please see w3schools.com or

developer.mozilla.org.

Currency

The Currency data type is a signed, numeric, fixed-point 64-bit number with 4 decimals. Values range
from -922 337 203 685 477.5808 to 922 337 203 685 477.5808. This data type is routinely used for fin-
ancial calculations: it is as precise as integers.

Defining Currency values

* Preprocessor:
« In the Step properties pane, under Properties, add or select a field.

» Specify the Type as Currency and set a default value as a number with up to 4 decimal
points, followed by a semicolon; suchas 546513.8798;

« Extraction: The field value will be extracted and treated as a Float.
e Inthe Data Model, select a field.
¢ Onthe Step properties pane, under Field Definition set the Type to Currency.

» Under Data Format, specify how the value is formatted in the data source (see "Extract
step properties" on page 326; for the default format settings, see "Data source settings" on
page 223).

« JavaScript Expression: Set the desired value to any Float value.
Example: record.fields["PreciseTaxSubtotal"] = 27.13465;

Note: While Currency values can be set to up to 4 significant digits, only 2 are displayed on
screen.
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Building Currency values

Currency values can be the result of direct attribution or mathematical operations just like Integer val-
ues (see "Integer" on page 281).

Date

Dates are values that represent a specific point in time, precise up to the second. They can also be
referred to as datetime values. While dates are displayed as UTC (Coordinated Universal Time) or
using the system's regional settings (see "Default Format" on page 786), in reality they are stored
unformatted.

Note: The Date property is stored in the Connect database with zero time zone offset, which
makes it possible to convert the time correctly in any location. PlanetPress Workflow, however,
shows the date/time as it is stored in the database (with 0 time zone offset). This is expected
behavior and the zone offset must be calculated manually in PlanetPress Workflow.

Extracting dates
To extract data and have that data interpreted as a Date, set the type of the respective field to Date:

1. Select the field in the data model.
2. Onthe Step properties pane, under Field Definition, specify the Type as Date.

3. Make sure that the date in the data source is formatted in a way that matches the expectations of
the DataMapper. If the date doesn't match the format that the DataMapper expects, it cannot be
interpreted as a date. For example, if a date in the data source is formatted as "yyyy-mm-dd" but
the DataMapper expects a time as well, the date cannot be read and the DataMapper will stop
with an error.

The expected date format can be set in three places:

* In the user preferences ("DataMapper preferences" on page 786).
* Inthe data source settings ("Data source settings" on page 223).

» Inthe field properties: on the Step properties pane, under Data Format, specify the
Date/Time Format.

4. Forthe letters and patterns that you can use in a date format, see "Defining a date/time format
on the next page.

Data format settings tell the DataMapper how to read and parse data from the data source.
They don't determine how these data are formatted in the Data Model or in a template. In the
Data Model, data are converted to the native data type. Dates, for example, are converted to a
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DateTime object. How they are displayed in the Data Model depends on the preferences (see
"Default Format" on page 786)..

Defining a date/time format

A date format is a mask representing the order and meaning of each digit in the raw data, as well as the
date/time separators. The mask uses several predefined markers to parse the contents of the raw data.
Here is a list of markers that are available in the DataMapper:

» yy: Numeric representation of the Year when it is written out with only 2 digits (i.e. 13)
* yyyy: Numeric representation of the Year when it is written out with 4 digits (i.e. 2013)

e M: Short version of the month name (i.e. Jan, Aug). These values are based on the current
regional settings.

e MM: Long version of the month name (i.e. January, August). These values are based on the cur-
rent regional settings.

« mm: Numeric representation of the month (i.e. 1, 09, 12)

e D: Short version of the weekday name (i.e. Mon, Wed). These values are based on the current
regional settings.

» DD: Long version of the weekday name (i.e. Monday, Wednesday). These values are based on
the current regional settings.

» dd: Numeric representation of the day of the month (i.e. 1, 09, 22)
* hh: Numeric representation of the hours

¢ nn: Numeric representation of the minutes

» ss: Numeric representation of the seconds

« ms: Numeric representation of the milliseconds.

e ap: AM/PM string.

» x: Indicates a time zone in the form of +05

» xx: Indicates a time zone in the form of +0500

» xxx: Indicates a time zone in the form of +05:00

» In addition, any constant character can be included in the mask, usually to indicate date/time sep-
arators (i.e./ - :) . If one of those characters happens to be one of the reserved characters listed
above, it must be escaped using the \ symbol.

Note: The markers that can be used when extracting dates are different from those that are
used to display dates in a template (see the Designer's "Date and time patterns" on page 1180).
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Examples of masks

Value in raw data Mask to use

June 25, 2013 MM dd, YYYY

06/25/13 mm/dd/yy

2013.06.25 yyyy.mm.dd

2013-06-25 07:31 PM yyyy-mm-dd hh:nn ap
2013-06-25 19:31:14.1206 yyyy-mm-dd hh:nn:ss.ms
Tuesday, June 25,2013 @ 7h31PM DD, MM dd, yyyy @ hh\hnnap

Entering a date using JavaScript
In several places in the DataMapper, Date values can be set through a JavaScript. For example:

» In afield in the Data Model. To do this, go to the Steps pane and select an Extract step. Then, on
the Step properties pane, under Field Definition click the Add JavaScript Field button (next to
the Field List drop-down). Type the JavaScript in the Expression field. (To rename the field, click
the Order and rename fields button.)

* InaPreprocessor property. To do this, go to the Steps pane and select the Preprocessor step.
Then, on the Step properties pane, under Properties add a property, specify its Type as Date and
put the JavaScript in the Default Value field.

The use of the JavaScript Date() object is necessary when creating dates through a JavaScript expres-
sion. For more information, see w3schools - JavaScript Dates and w3schools - Date Object.

Example: The following script creates a date that is the current date + 30 days:

function addDays (date, days) {

var result = new Date (date);
result.setDate (result.getDate () + days);
return result;

}
addDays (new Date (), 30);
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Float

Floats are signed, numeric, floating-point numbers whose value has 15-16 significant digits. Floats are
routinely used for calculations. Note that Float values can only have up to 3 decimals. They are inher-
ently imprecise: their accuracy varies according to the number of significant digits being requested.
The Currency data type can have up to 4 decimals; see "Currency" on page 277.

Defining Float values

* Preprocessor:
* Inthe Step properties pane, under Properties, add or select a field.

» Specify the Type as Float and set a default value as a number with decimal points, fol-
lowed by a semicolon; for example 546513.879;.

« Extraction: The field value will be extracted and treated as a Float.

¢ In the Data Model, select a field.

» On the Step properties pane, under Field Definition set the Type to Float.
« JavaScript Expression: Set the desired value to any Float value.

Example: record.fields["PreciseTaxSubtotal"] = 27.134;

Building Float values

Float values can be the result of direct attribution or mathematical operations just like Integer values
(see "Integer" below).

HTMLString
HTMLStrings contain textual data that includes HTML markup. They are essentially the same as String

values except in cases where the HTML markup can be interpreted.

Example: Assume that a field has the value He said <b>WOW!</b>.

If the data type is String and the value is placed in a template, it will display exactly as "He said
<b>WOW!I</b>" (without the quotes).

If the data type is HTMLString, it will display as "He said WOW!" (again, without the quotes).

Considering this is the only difference, for more information on how to create and use HTML String val-
ues, see "String" on page 283.
Integer

Integers are signed, numeric, whole 64bit numbers whose values range from -(2%63) to
(2763). Integers are the numerals with the highest precision (and the fastest processing speed) of all,
since they are never rounded.
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Defining Integer values

e Preprocessor:
* In the Step properties pane, under Properties, add or select a field.
» Specify the Type as Integer and set a default value as a number, such as 42.
« Extraction: The field value will be extracted and treated as an integer.
¢ In the Data Model, select a field.
» On the Step properties pane, under Field Definition set the Type to Integer.
« JavaScript Expression: Set the desired value to any Integer value.
Example: record.fields["AnswerToEverything"] = 42;
Building Integer Values

Integers can be set through a few methods, all of which result into an actual integer result.

« Direct attribution: Assign an integer value directly, suchas 42, 99593463712, record.field-
s.Total; ordata.extract ("TotalOrdered") ;.

+ Mathematical operations: Assign the result of any mathematical operation. For example:
22+51,3%6,10/5, record.fields["InvTotal"], or sourceRe-
cord.property.SubTotal.

For more information on mathematics in JavaScript , see w3Schools - Mathematical Operators.
For more advanced mathematical functions, see w3schools - Math Object.

Note: When adding numbers that are not integers, forinstance 4.5 + 1.2 ,around towards
zero rounding is applied after the operation was made.

In the previous example, the result, 5. 7, is rounded to 5.

In another example, -1.5 - 1 resultsin -2

Object

Objects hold addresses that refer to objects. You can assign any reference type (string, array, class, or
interface) to an Object variable. An Object variable can also refer to data of any value type (numeric,
Boolean, Char, Date, structure, or enumeration).
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Defining Object values

e Preprocessor:
* In the Step properties pane, under Properties, add or select a field.
» Specify the Type as Object and set a default value as a semi-colon.
String
Strings contain textual data. Strings do not have any specific meaning, which is to say that their con-
tents are never interpreted in any way.

Defining String values

* Preprocessor:
» Inthe Step properties pane, under Properties, add or select a field.

» Specify the Type as String and set a default value as any text between quotes, followed by
a semicolon.
Example "This is my text";

« Extraction: The field value will be extracted and treated as a string.

¢ In the Data Model, select a field.

* On the Step properties pane, under Field Definition set the Type to String.
» JavaScript Expression: Set the desired value to any string between quotes.

Example: record.fields["countryOfOrigin"] = "Canada";

Building String values

String values can be made up of more than just a series of characters between quotes. Here are a few
tips and tricks to build strings:

¢ Both single and double quotes can be used to surround strings and they will act in precisely the
same manner. So, "this is a string" and 'this is a string' mean the same thing. However, it's useful
to have both in order to remove the need for escaping characters. For instance, "I'm fine!" works,
but 'I'm fine!' does not since only 'I' is properly interpreted. 'I\'m fine!" works (escaping the ' with a
\).

» Itis possible to put more than one string, as well as variables containing strings, by con-
catenating them with the + operator. For example, "Hello " + sourceRe-

cord.property.FirstName + ", nice to meet you!".

» Adding more data to an existing string variable or field is possible using a combination of con-
catenation and assignment. For example, after the statements var myvar = "Is this the
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real life";,andmyVar += " or is this just fantasy?";,the value of myvar will
be, obviously "Is this the real life or is this just fantasy?".

For more information on string variables, see quirksmode.org.

Data Model file structure

The Data Model file is an XML file that contains the structure of the Data M model, including each field's
name, data type, and any number of detail tables and nested tables.

Example: promotional data

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<datamodel schemaVersion="1.0.0.3" name="Generic Address Block" version="1" xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig" xsi:s-
chemaLocation="http://www.objectiflune.com/connectschemas/DataModelConfig http://www.objectiflune.com/connectschemas/DataModelConfig/1_@_@_3.xsd"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<field type="string" name="Name" required="true"/>

<field type="string" name="Organization" required="true"/>

<field type="string" name="Addressl" required="true"/>

<field type="string" name="Address2" required="true"/>

<field type="string" name="Address3" required="true"/>

<field type="string" name="City" required="true"/>

<field type="string" name="StateOrProvince" required="true"/>

<field type="string" name="Country" required="true"/>

<field type="string" name="ZipOrPostalCode" required="true"/>

<field type="string" name="Extral" required="true"/>

<field type="string" name="Extra2" required="true"/>
</datamodel>

Example: transactional details, in a simple invoice format

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<datamodel schemaVersion="1.0.0.3" name="Transactional Invoice" version="1"
xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig"
xsi:schemalLocation="http://www.objectiflune.com/connectschemas/DataModelConfig http://www.objectiflune.com/connectschemas/DataModelConfig/1_0_0_
3.xsd"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<field type="string" name="ID" required="true"/>
<field type="string" name="Gender" required="true"/>
<field type="string" name="LastName" required="true"/>
<field type="string" name="FirstName" required="true"/>
<field type="string" name="Addressl" required="true"/>
<field type="string" name="Address2" required="true"/>
<field type="string" name="City" required="true"/>
<field type="string" name="State" required="true"/>
<field type="string" name="Country" required="true"/>
<field type="string" name="ZipCode" required="true"/>
<field type="string" name="Title" required="true"/>
<field type="string" name="Company" required="true"/>
<field type="string" name="Phone2" required="true"/>
<field type="string" name="Email" required="true"/>
<field type="string" name="Language" required="true"/>
<field type="string" name="Number" required="true"/>
<field type="datetime" name="Date" required="true"/>
<field type="datetime" name="DueDate" required="true"/>
<field type="string" name="Rep" required="true"/>
<field type="currency" name="SubTotal" required="true"/>
<field type="currency" name="TaxTotal" required="true"/>
<field type="currency" name="Total" required="true"/>
<table name="detail">
<field type="string" name="Number2" required="true"/>
<field type="string" name="Description" required="true"/>
<field type="currency" name="UnitPrice" required="true"/>
<field type="integer" name="Ordered" required="true"/>
<field type="integer" name="Shipped" required="true"/>
<field type="integer" name="BackOrder" required="true"/>
<field type="currency" name="Total2" required="true"/>
</table>
</datamodel>
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Example: nested tables (one table into another)

<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<datamodel schemaVersion="1.0.0.3" name="Nested Table Example" version="1"
xmlns="http://www.objectiflune.com/connectschemas/DataModelConfig"
xsi:schemalocation="http://www.objectiflune.com/connectschemas/DataModelConfig http://www.objectiflune.com/connectschemas/DataModelConfig/1_0_0_
3.xsd"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<field type="string" name="RecordField" required="true"/>
<table name="details">
<field type="string" name="DetailsTableField" required="true"/>
<table name="nestedtable">
<field type="string" name="NestedTableField" required="true"/>
</table>
</table>
</datamodel>

Example: default values

Default values can be added to any field with the defaultValue attribute:

<field type="string" name="RecordField" required="true" defaultValue="My Default Value">

DataMapper User Interface

The main ingredients in the DataMapper's user interface are the following:

* "Menus" on page 290

» "Toolbar" on page 357

e "Settings pane" on page 307

» "Steps pane" on page 321

* "The Data Viewer" on page 304

e "Step properties pane" on page 323
» "Messages pane" on page 306

e "Data Model pane" on page 294

» Parameters pane (see "Properties and runtime parameters" on page 227)
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Keyboard shortcuts

This topic gives an overview of keyboard shortcuts that can be used in the DataMapper.

Keyboard shortcuts available in the Designer for menu items, script editors and the data model pane
can also be used in the DataMapper; see "Keyboard shortcuts" on page 953.

Although some of the keyboard shortcuts are the same, this isn't a complete list of Windows keyboard
shortcuts. Please refer to Windows documentation for a complete list of Windows keyboard shortcuts.

Menu items

The following key combinations activate a function in the menu.

Key com- Function

bination

Alt Put the focus on the menu. (Alt + the underlined letter in a menu name displays the corresponding menu.) The menu can
then be browsed using the Enter key, arrow up and arrow down buttons.

Alt +F4 Exit
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Key com- Function
bination

Ctrl+C Copy

or Ctrl + Insert

Ctrl +N New

Ctrl+O Open file

Ctrl + Shift + O

Open configuration file

Ctrl+ S Save file
Ctrl +V Paste

or Shift + Insert

Ctrl + X Cut

Ctrl + Wor Ctrl + F4 Close file
Ctrl+Y Redo

or Ctrl + Shift +Y

Ctrl+ Zor Undo
Ctrl + Shift+Z

Ctrl + Shift+ S Save all
Ctrl + Shift + W or Close all
Ctrl + Shift + F4

Ctrl + F5 Revert
Ctrl + F7 Next view

Ctrl + Shift + F7

Previous view

Ctrl + F8

Next perspective

Ctrl + Shift + F8

Previous perspective

Ctrl + F10

Save as

Ctrl + F12

Send to Workflow / Package files
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Key com-

bination

Function

F4 Ignore step/Reactivate step

F6 Add an Extract step

F7 Add a Goto step

F8 Add a Condition step

F9 Add a Repeat step

F10 Add an Extract field

F11 Add an Action step

F12 Add a Multiple Conditions step
Alt+ F12 Add a Case step (under a Multiple Conditions step)
Home Go to the first step in the workflow
End Go to the last step in the workflow
Alt+V Validate records

Shift + F10 Open context menu

or Ctrl + Shift + F10

Viewer pane

The following key combinations activate a function in the Viewer.

Key combination Function
Alt + - Open system menu
Ctrl + - Zoom out

You can also use the mouse's scroll wheel in combination with the Ctrl button to gradually zoom in or out.

Ctrl + + Zoom in

Ctrl + Shift + E Switch to Editor
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Key combination Function

Ctrl + F6 Next editor (when there is more than one file open in the Workspace)

Ctrl + Shift + F6 Previous editor (when there is more than one file open in the Workspace)

Data Model pane

Key combination Function

PageUp Go to previous record

PageDown Go to next record

Alt+ CR Property page

Alt + PageDown Scroll down to the last field

Alt + PageUp Scroll up to the first field
Steps tab

Key combination Function

Ctrl + - Zoom out

Ctrl + + Zoom in

Edit Script and Expression windows

The following key combinations have a special function in the Expression and in the Edit Script win-
dows (expanded view).

Key combination Function

Ctrl + space Content assist (auto-complete)
Ctrl+ A Select all

Ctrl+D Duplicate line

Ctrl +1 Indent (Tab)
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Key combination Function

Ctrl+J Line break

Ctrl +L Go to line; a prompt opens to enter a line number.

Ctrl + Shift+ D Delete line

Shift + Tab Shift selected lines left

Tab Shift selected lines right

Ctrl +/ Comment out / uncomment a line in code

Ctrl + Shift +/ Comment out / uncomment a code block
Menus

The following menu items are shown in the DataMapper Module's menu:
File Menu

* New...: Opens the dialog to create a new data mapping configuration; see "Creating a new data
mapping configuration" on page 200.

* Open: Opens a standard File Open dialog. This dialog can be used to open Templates and data
mapping configurations.

» Open Recent: List the most recently opened Templates and configurations. Clicking on a tem-
plate will open it in the Designer module, clicking on a data mapping configuration will open it in
the DataMapper module.

» Close: Close the currently open data mapping configuration or Template. If the file needs to be
saved, the appropriate Save dialog will open.

» Close All: Close any open data mapping configuration or Template. If any of the files need to be
saved, the Save Resources dialog opens.

» Save: Saves the current data mapping configuration or Template to its current location on disk. If
the file is a data mapping configuration and has never been saved, the Save As dialog appears
instead.

o Save As...: Saves the current data mapping configuration or Template to a new location on disk.
In the case of Templates, it is saved to a location that can be different than the local repository.

Page 290

elalal=



» Save All: Saves all open files. If any of the open files have never been saved, the Save As dialog
opens for each new unsaved file.

+ Save a Copy: Save a copy of the current data mapping configuration in the selected Connect ver-
sion's format. See "Down-saving a data mapping configuration" on page 204.

* Revert: Appears only in the Designer module. Reverts all changes to the state in which the file
was opened or created.

+ Add Data: Adds data either to the current data mapping configuration or to the open template. In
data mapping configuration

* From File...: Opens the dialog to add a new data file to the currently loaded data mapping
configuration. Not available if the currently loaded data mapping configuration connects to
a database source.

* From Database...: Opens the Edit Database Configuration dialog. Not available if the cur-
rently loaded data mapping configuration is file-based.

» Send to Workflow: Opens the "Send to Workflow dialog" on page 937 dialog to send files to a
local PlanetPress Workflow software installation.

» Exit: Closes the software. If any of the files need to be saved, the Save Resources dialog opens.
Edit Menu

¢ Undo: Undoes the previous action.
+ Redo: Redoes the last action that was undone.

« Cut Step: Removes the currently selected step and places it in the clipboard. If the step is a
Repeat or a Condition, all steps under it are also placed in the clipboard. If there is already a step
in the clipboard, it will be overwritten.

» Copy Step: Places a copy of the currently selected step in the clipboard. The same details as the
Cut step applies.

» Paste Step: Takes the step or steps in the clipboard and places them in the Steps after the cur-
rently selected step.

» Delete Step: Deletes the currently selected step. If the step is a Repeat or Condition, all steps
under it are also deleted.

» Cut: Click to remove the currently selected step, or steps, and place them in the clipboard.
» Copy: Click to place a copy of the currently selected step, or steps, in the clipboard.

» Paste: Click to place any step, or steps, from the clipboard before the currently selected step in
the "Steps pane" on page 321.
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Data Menu

» Hide/Show datamap: Click to show or hide the icons to the left of the Data Viewer that displays
how the steps affect the line.

» Hide/Show extracted data: Click to show or hide the extraction selections indicating that data is
extracted. This simplifies making data selections in the same areas and is useful to display the
original data.

» Validate All Records: Runs the Steps on all records and verifies that no errors are present in
any of the records. Errors are displayed in the "Messages pane" on page 306.

Steps

» Ignore Step/Reactivate Step: Click to set the step to be ignored (aka disabled) or to reactivate
it. Disabled steps do not run when in DataMapper and do not execute when the data mapping
configuration is executed in Workflow. However, they can still be modified normally.

+ Add Extract Step: Adds an Extract Step with one or more extract fields. If more than one line or
field is selected in the Data Viewer, each line or field will have an extract field.

» Add Goto Step: Adds a Goto step that moves the selection pointer to the beginning of the data
selection. For instance if an XML node is selected, the pointer moves to where that node is loc-
ated.

» Add Condition Step: Adds a condition based on the current data selection. The "True" branch
gets run when the text is found on the page. Other conditions are available in the step properties
once it has been added.

» Add Repeat Step: Adds a loop that is based on the current data selection, and depending on the
type of data. XML data will loop on the currently selected node, CSV loops for all rows in the
record. In Text and PDF data, if the data selection is on the same line as the cursor position, the
loop will be for each line until the end of the record. If the data selection is on a lower line, the
loop will be for each line until the text in the data selection is found at the specified position on the
line (e.g. until "TOTAL" is found).

« Add Extract Field: Adds the data selection to the selected Extract step, if an extract step is cur-
rently selected. If multiple lines, nodes or fields are selected, multiple extract fields are added sim-
ultaneously.

« Add Multiple Conditions: Adds a condition that splits into multiple case conditions.

« Add Action Step: Adds a step to run one or more specific actions such as running a JavaScript
expression or setting the value of a Source Record Property.
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View Menu
e Zoom In: Click to zoom in the "Steps pane" on page 321.
e Zoom Out: Click to zoom out the "Steps pane" on page 321.

Window Menu

* Show View
* Messages: Shows the "Messages pane" on page 306
» Data Model: Shows the "Data Model pane" on the facing page.
» Steps: Shows the "Steps pane" on page 321.

+ Parameters: Shows the Parameters pane. See "Properties and runtime parameters" on
page 227.

» Settings: Shows the "Settings pane" on page 307.
» Step Properties: Shows the "Step properties pane" on page 323
* Reset Perspective: Resets all toolbars and panes to the initial configuration of the module.
* Preferences: Click to open the "Preferences" on page 782 dialog.
Help Menu

« Software Activation: Displays the Software Activation dialog. See "Activating a License" on
page 50.

* Help Topics: Click to open this documentation.

e Contact Support: Click to open the Objectif Lune Contact Page in the default system Web

browser.
« About PlanetPress Connect Designer: Displays the software's About dialog.
+ Welcome Screen: Click to re-open the Welcome Screen.
Panes

The DataMapper screen contains the following panes.

» "Settings pane" on page 307. The Settings pane contains settings for the data source.
o "Steps pane" on page 321. The entire extraction workflow is visible in the Steps pane.
e "The Data Viewer" on page 304. The Data Viewer shows one record in the data source.

e "Step properties pane" on page 323. The Step properties pane contains all settings for the step
that is currently selected on the Steps pane.
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e "Data Model pane" below. The Data Model pane shows one extracted record.
» "Messages pane" on page 306.

Data Model pane

The Data Model pane displays the result of all the preparations and extractions of the extraction work-
flow. The pane displays the content of a single record within the record set at a time.

Data is displayed as a tree view, with the root level being the record table. On the level below that are
detail tables, and a detail table inside a detail table is called a nested table.

The Data Model is also used as a navigation tool between records and in all detail tables.

For more information see "The Data Model" on page 260.
Filter

To find a certain table, group or field in a large Data Model, start typing characters in the Filter box. This
immediately narrows down the list of displayed items to all tables, groups and fields whose name con-
tains the characters that were typed. Note that the filtering is case-insensitive.

Data Model toolbar buttons

* Import Data Model = : Click to browse to a file that contains a Data Model. This may be:
» A Data Model file (*.OL-datamodel).
* A JSON file (*.json; see the note below).

* A Connect template (*.OL-template), data mapping configuration (*.OL-datamapper) or
'typed' JSON file (*.json; see the note below).

The file's data model structure will be displayed in the Data Model pane without data.
* Export Data Model E : Click to browse to a location to save the Data Model file. The available
file types are:
» A Data Model file (*.OL-datamodel).
* A JSON file (*.json): A JSON object or an array of JSON objects representing records.
* A'typed' JSON file (*.json).

Typed JSON follows the structure of a JSON Record Data List (see the REST API Cook-
book). Data field types are determined by the schema object in the JSON.

When a Data Model is exported to a JSON file or typed JSON file, detail tables are expor-
ted, but groups are not.
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* Synchronize Fields and Structure L% Click to synchronize the Data Model fields and struc-

ture in the currently loaded template and data mapping configuration. If you click this button when
working on the data mapping configuration, the Data Model gets updated to the one in the tem-
plate. If you click it when working on the template, the Data Model gets updated to the one in the
data mapping configuration.

* Show the ExtraData field @ : Note that this field is not meant to be filled via an extraction. It is

meant to be used in a Workflow configuration to add data to the Data Model; see "Adding fields
and data via Workflow" on page 263.

» Collapse All: Collapse all fields on the record level, in all detail tables and in all groups.

¢ Minimize/Maximize: Click to minimize or maximize the pane. See Moving and Merging Panes.

Data Model contextual menu

The Data Model is generally constructed by extracting data; see "Extracting data" on page 229.

It is however possible to modify the Data Model, even if no data is present in the pane. To do this, open
the contextual menu within the pane itself by right-clicking on something in the Data Model pane.
Depending on where you've clicked, it can contain the following options.

Note: Moving and grouping fields in the Data Model has no impact on the order in which data
are extracted, or on the final records in the OL Connect database. They only help you organize
the Data Model visually.

To learn how to change the order in which data are extracted, see "Renaming and reordering
fields in an extraction step" on page 267.

« Add Field: Click to add a new field at the current level (record or detail table). Enter the field
name in the dialog; if you want you can change the field's data type and set a default value. Then
click OK to add it to the Data Model.

« Add Table: Click to add a new detail table at the current level (record or existing detail table).
Enter the table name in the dialog and click OK to add it.

» Add Group: Click to create a new group at the current level (record or existing group). Enter the
group name in the dialog and click OK to add it. Any selected fields will be added to the group.
(See also: "Ordering and grouping fields in the Data Model" on page 262.)

Note: Rename, Delete and Set Type are only available for Data Model fields or detail tables that

are not filled via an extraction.
Fields and detail tables that are filled via an Extract step are to be changed (renamed, deleted
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etc.) via the properties of that Extract step; see: "Editing fields" on page 267 and "Renaming a
detail table" on page 298.

* Rename: Click to rename the selected table, field or group. Enter the new name and click OK to
rename.

* Required: Click to indicate that the field should be retained, even if there is no Extract step that
references it. The DataMapper immediately discards non-required fields that are not referenced
by any Extract step.

» Delete: Click to delete the selected table or field.
» Set Type: Use the list to select the field type (see "Data types" on page 275).

* Ungroup: Delete the selected group. The fields in the group will be moved up one level in the
Data Model.

+ Default Value: Click to set the default value for a field. This value is used if no extraction is
present, or if an extraction attached to this field returns no value.

* Move: Click to move the selected field within the current level or group in the Data Model. (See:
"Ordering and grouping fields in the Data Model" on page 262.)

» Top: Move the field to the first place.

* Up: Move the field one step up.

* Down: Move the field one step down.

» Bottom: Move the field to the last place.
» Collapse All: Collapse the fields on the record level, in all detail tables and in all groups.
« Expand All: Expand the fields on the record level, in all detail tables and in all groups.

» Copy: Copy the field's contents to the clipboard.
Field display

Fields in the Data Model pane are displayed in specific ways to simplify comprehension of the display
data:

» The column on the left displays the name of the field.

» The column on the right displays the current value of the extracted field based on the record
shown in the Data Viewer, if an Extract step has an extraction for this field (see "Extracting data"
on page 229).

Page 296

elalal=



» Theicon to the left of the name indicates the data type of the field (see "Data types" on
page 275).

» Afield name with an asterisk to the right indicates that this field is required. All imported data
model fields are initially marked as required to prevent them from being removed, since the
DataMapper immediately discards non-required fields that are not referenced by any Extract
step.

» Afield with a grey background indicates this Data Model field does not have any attached
extracted data.

» Afield with a white background indicates that the field has attached extracted data but the step
extracting the data is not currently selected.

» Afield with a blue background indicates that the field has attached extracted data and the step
extracting the data is currently selected.

« Afield or table with red text indicates a difference between the data model in the data mapping
configuration and template.

Record navigation

Records can be navigated via the Data Model pane. The default record level navigates between
records both in the Data Model pane and the Data Viewer, while each detail table has a similar nav-
igation that influences that table and each detail table under it.

« Expand/Contract: Click to hide or show any fields or tables under the current table level or in the
current group (see "Grouping fields" on page 263).

» Table Name: Displays the name of the table as well as the number of records at that level (in
[brackets]). At the record level this is the number of records. In other levels it represents the num-
ber of entries in a detail table.

 Number of Records: The number of available records in the active data sample. This is affected
by the Boundary settings (see "Record boundaries" on page 226 and "Settings pane" on
page 307) and the Preprocessor step ("Preprocessor step" on page 249).

* First Record: Go to the first record in the data sample. This button is disabled if the first record is
already shown.

* Previous Record: Go to the previous record in the data sample. This button is disabled if the first
record is shown.

» Current Record: Displays the current record or table entry. Type a record number and press the
Enter key to display that record. The number has to be within the number of available records in
the data sample.
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* Next Record: Go to the next record in the data sample. This button is disabled if the last record is
shown.

* Last Record: Go to the last record in the data sample. This button is disabled if the last record is
already shown. If a record limit is set in the Settings pane ("Settings pane" on page 307) the last
record will be within that limit.

Detail tables

A detail table is a field in the Data Model that contains a record set instead of a single value. Detail
tables contain transactional data. They are created when an Extract step is added within a Repeat
step; see "Extracting transactional data" on page 235.

In the most basic of transactional communications, a single detail table is sufficient. However, it is pos-
sible to create multiple detail tables, as well as nested tables. Detail tables and nested tables are dis-
played as separate levels in the Data Model (see "The Data Model" on page 260).

Detail tables can be included in a template via a Dynamic Table ; see "Dynamic Table" on page 742.

Renaming a detail table

Renaming detail tables is especially useful when there are more detail tables in one record, or when a
detail table contains another detail table. For this detail table, ‘products’ would be a better name.

1. On the Data Model pane, click one of the fields in the detail table.

2. On the Step Properties pane, under Extraction Definition, in the Data Table field, you can find
the name of the detail table: record.detail by default. Change the detail part in that name into
something else.

Note: A detail table’s name should always begin with ‘record.’.

3. Click somewhere else on the Step Properties pane to update the Data Model. You will see the
new name appear.

Creating multiple detail tables

Multiple detail tables are useful when more than one type of transactional data is present in the source
data, for example purchases (items with a set price, quantity, item number) and services (with a price,
frequency, contract end date, etc).
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|5 *Name (XML) &2 =]
U TSEIVICE REDTESETILALve]
<» Company [Rockwood Engine Systems)
<> Phane2 ((555) 380-6476, £235)
¥ Email [p.ludwick@oldrupa.com]
<» Language (EN]
<» MDS [C9B28FBAB37EGBAFE19C2C3EE0FDEBDE)
4 <y INVOICES (1 T )
4 <> INVOICE [ m m m n n n
<2 MNumber (INVE103083)
4» Date [2013-03-15)
<% DueDate [2013-04-05)
<> Rep [REP0290771)
<> SubTotal [ 74.90)
<» TaxTotal [ 11.22)
<> Total [ 86.12)
4 <3 PURCHASES == T—— f—== 1 T
<> Item [RT1485)
<» Description (Router)
<x Gty (1)
<» Price (14.75)
<» SubTaotal (14.75)
PURCHASES [T—=— T—— f—— 1 T
<> Item (CBL5686)
<% Description (Cable]
<> Qty (4)
<* Price (8.96)
<» SubTotal (35.84)
4 <> SERVICE n T T 1 T
<» Humber (HSF7SME)
<» Description [HighSpeed FibreOptics 73MB/S Duplex)
<» BasePrice (84.95)
<» Rebates (-40.00)
<» Charges (0)
<» SubTotal [44.95)
¢ AccountNumber [1687635787)
€% UserMame [u21CV342)
<» Type (Internet)
4 <> SERVICE (T n T T m T Second Table
<* MNumber [PHBASICRES)
<» Description (Basic Residential Phone Service)
<» BasePrice (33.95)
<* Rebates (-14.32)
<» Charges [10.32)
<» SubTotal (29.95)
<» AccountNumber (22555380647622)
<> Userlame [r45g456h)
<¥ Type (Phone)}

First Table

[N
-

To create more than one detail table, simply extract transactional data in different Repeat steps (see
"Extracting transactional data" on page 235).

The best way to do this is to add an empty detail table (right-click the Data Model, select Add a table
and give the detail table a name) and drop the data on the name of that detail table.

Else the extracted fields will all be added to one new detail table with a default name at first, and you
will have to rename the detail table created in each Extract step to pull the detail tables apart (see
"Renaming a detail table" on the previous page).
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Semngsli Stepsl = 5[ Nome oML 2 = 5 (¥ pata model e 5 T80
® 0 <> Phone2 ({535) 702-3520, #665) * 1| Mame Value
= <> Email (a.tincher@oldrupa.com) 4 T record [3] (<] 2 [p][E
<> Language (EN) ae FULLNAME Amie Tincher
<> MD5 (BE9479B97BEEOAE397083729187105C8) e ID CU44643835
= 4 <» INVOICES (T T abe Gender Miss
Extraction 4 <> INVOICE (T 1 T 1 T 1 T - 1= e Lasthame Tincher
<» Number (INV8359825) ate FirstMame Amie
= <> Date (2013-03-15) abe Address] 356, Chambers Street
Extraction S s DI e Address? P.0. Box 6049
<> Rep (REP88200122) abe City St Mary's
<> SubTotal { 125.96) s State ON
<> TaxTotal { 18.86) ae Country cA
<> Total ( 144.82) abe ZipCode L6 501
4 <> PURCHASES (T—— T—— T—e T 1 ) awe Title Driver/Sales Workers
<> Item (RT1483) e Company St. Mary's Pest Control Ltd
<> Description (Router) abe Phone? (555) 702-5520, #665
< Oty (1) abe Email atincher@oldrupa.com
<> Price (14.75) s Language EN
<> SubTotal (14.75) e MD5 BE9479B978EEOAE397083...
4 <> PURCHASES (T—— T—— T—— 1 1 } e Number INVE553825
<> Item (CBL5686) ac Date 2013-03-15
<> Description (Cable) abe DueDate 2013-04-05
© Oty (3) e Rep REP2300122
<> Price (8.96) sbe SubTotal 125.96
<> SubTotal (26.88) abe TaxTotal 18.86
4 <> PURCHASES (T=— T—— T—= 1 1 ) e Total 144,82
<> ltem (FST3678)
<> Description (Fasteners)
<> Oty (500
<> Price (0.25)
<» SubTotal (12.3)
4 ¢» SFRVICF (T Al il bl T T bl ¥
< >
Step Properties| 1 Messages =)
-
Extract Step @
» Description
+ Extraction Definition
Data Table: | record hd
v Append values to current record
v
SminQSI'ﬁ Step5| = O || [ *Name (XML) E2 o @Datamodeﬂ R ed & T 0
® P9 <> SubTotal (14.73) 1 Name Value
= 4 <> PURCHASES (T—— T—— f—— 1T 1 ) 4 T record 3] B4 2[RI
<> ltem (CBL3686) abe FULLMAME Amie Tincher
<> Description (Cable) ae D CU44642835
T < Oty (3) abe Gender Miss
Extraction <> Price (8.96) abe LastName Tincher
<> SubTotal (26.88) abe FirstName Amie
= 4 <> PURCHASES (T—— T—— T—— 1 1 ! e Address] 356, Chambers Street
P« <> ltem (FSTS878) abe Address2 P.0. Box 6049
<> Description (Fasteners) awe City St. Many's
<> Oty (50) ae State ON
= <> Price (0.25) e Country CA
Repeat <> SubTotal (12.3) ae ZipCode L6 5L1
esss/ P hoses = 9@ HLE i ! ! B K ! ave Title Driver/Sales Workers
H [ d <> Number (HSF75ME) e Company St. Mary's Pest Control Ltd
H H <> Description (HighSpeed FibreOptics 75MB/S Duplex) e Phone? (555) 702-5520, #665
@  Extraction2 - )
H <> BasePrice (84.95) abe Ernail atincher@oldrupa.com
§ <> Rebates (-40.00) ac Language EN
s spichoracs (0 e MDS BEG4798978EEDAE3STR...
<> SubTotal (44.95) s Mumber INV8539825
= <> AccountMumber (1687635787) e Date 2013-03-15
B <> UserName (u21CV342) e DueDate 2013-04-05
R <> Type (Intemet) ac Rep REP8800122
Repeat! - 4 < SERVICE (1 1 T T L q u e SubTotel 125.96
— - ¢» Number (PHBASICRES) ) e TaxTotal 1836
B @: ¢ Description (Basic Residential Phone Service) e Total 14482
g Extraction3 <> BasePrice (33.95) 4 [T detail [6] (D
o) <> Rebates (-14.32) b ltem RT1485
°
5 <> Charges (22.32) she Description  Router
H <» SubTotal (41.99) we Oty 1
<> AccountMumber (22555705552022) e Price 1475
haces <5 UserName (wd57t478) = e SubTotal2 1475
o <
e = abe Mumberd
H Step Properties| 1 Messages = abe Description2
H P
~ she BasePrice
lﬁ Extract Step @ e Rebates
» Description abe Charges
abe SubTotald
« Extraction Definition abe AccountNum
ahe UserName
Data Table: | record.detail > we Type
¥
v [] Append values to current record
< 2 R %
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Nested detail tables

Nested detail tables are used to extract transactional data that are relative to other data. They are cre-
ated just like multiple detail tables, with two differences:

e Forthe tables to be actually nested, the Repeat step and its Extract step that extract the nested
transactional data must be located within the Repeat step that extracts data to a detail table.

* In their name, the dot notation (record.services) must contain one extra level (record.ser-
vices.charges).

Here is an example.

An XML source file lists the services of a multi-service provider: Internet, Cable, Home Phone, Mobile.
Each service in turn lists a number of "charges", being service prices and rebates, and a number of
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"details" such as movie rentals or long distance calls.

XML viewer & 15 | Zoom(%) | 100 H 2 2 @

<» Rep (REP2800122) -
<» SubTotal ( 93.76)
<» TaxTotal { 14.04)
< Total { 107.80)
a <» SERVICE (T T | T
<» Number (TVDIGHD)
<> Description (High Definition Digital TV)
<» B